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1.3 Typographical Conventions. . . ...,
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This chapter introduces the concept of desktop publishing and lists
some of the special features of Ovation Pro. It summarises all the
documentation provided with the software and describes the order in
which it should be read.



2 INTRODUCTION

1.1 Overview .

A desktop publisher allows you to take text and
pictures and arrange them on the page in virtually
any way you wish. Text may be typed in directly
or imported from another source, such as a file or
another word processor. You can then alter the
style of the text and control how it flows around
the page. Pictures can be imported from file or
from another application such as Draw or Paint,

and then scaled, cropped, rotated etc. as required.

Once the page has been completed, it may be

printed out on a wide range of printers, such as
dot-matrix, ink jet, laser and even professional

typesetting machines.

Ovation Pro

Ovation Pro brings together word processing with _
state-of-the-art page layout features to deliver a
extremely powerful desktop publishing system. *
You may usévation Pro to create just about any
type of document, from a single-page letter to an
entire book, or from a simple leaflet to a complex,
advert.

Even with such a vast range of features available,
Ovation Pro is still easy-to-use, thanks to a superb
user interface that makes the software easy to
learn and instinctive to use. It is also extremely
fast and responsive, and of course in et .
You See Is What You G&/YSIWYG) manner, .
faithfully represents the document on the screen
exactly as it is printed.

Special features d@vation Pro, include:
» Toolbox attached to the active document.

» Context sensitive info palette gives .
information and options about the current
operation.

» Definable button bar allows you to choose  *
which options you would like to appear on a
bar across the top of the document.

* Irregular frames drawn using lines and curves®
Text can flow inside or around irregular
frames, and pictures are cropped inside them.

* Rotated text frames with fully editable text.

e Multi-step Undo/Redo. The number of steps
that may be undone is determined by the size
of a user definable buffer.

CHapPTER 1

Drag and Drop for text and objects within the
same page as well as to another page or
document.

User-definable named colour system allows
you to use colours consistently throughout
your documents. You can even create your
own colour charts.

Automatic drop-caps. These are large capitals
that are often seen at the start of paragraphs.

Pasteboard around document for temporary
storage of objects and to allow objects to bleed
off the page.

Advanced justification with fully controllable
letter spacing. This allows you to fit text into
narrow columns easily.

Advanced automatic hyphenation control.

Multi-column frames, frames with rounded
corners, skewed frames and vertical alignment
of text in frames.

Automatic text flow around irregular pictures.

Picture cropping can easily be achieved using
a special tool.

Frame borders and auto drop shadows on
rectangular frames.

Straight and curved line drawing.

Grid and ruler guidelines for easy page design.
Plus facility to snap to other objects.

Full page and chapter handling with separate
master pages for each chapter. Easy-to-use
headers and footers.

Character selector and single-shift font change
allow you to easily insert special characters
from other fonts.

Extensive printing capabilities including
pamphlet and galley printing, tiling and other
formats.

Integrated script language based on a subset of
the C programming language.
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1.2 Ovation Pro Documentation - Appendices
The separate CD Guide gives details of the The appendices at the end of this guide list
minimum systems requirements to run character sets, summarise key short-cuts and

Ovation Pro, and how to install it on your system. pProvide other advanced information not normally

If you are a beginner to desktop publishing you required in everyday use.

should read the separate tutorial which describes- Glossary
how to create a simple document step-by-step. This explains many of the terms used in desktop

This reference guide describes all the features of Publishing.
Ovation Pro, but does not attempt to teach you - The disc based version of the manual

desktop publishing or good document design. Fonf possible use a 256 colour or greater mode when
this you are recommended to refer to the many reading this manual on screen. The pictures of
specialised works on typography, book, magazingyindows will look clearer if a zoom of 111% is

and layout design. used to view the manual.

Itis assumed that you are familiar with the The pictures in this manual may differ slightly
Windows deSktOp environment and f|||ng System.from what you see on screen. In genera|

If you are not, please read the relevant sections 1S Sans Serif is used as desktop font and

your computer user guide. Windows NT has been used to enhance readability.
The chapters in this reference guide may be The latest version of this manual can be found on
divided into a number of groups: the Ovation Pro web site.

- The Basics How to use the electronic manual

Chapter 2 describes ti@vation Pro user interface

and how to create, print and save a simple of continuous development of the program that
document. Chapter 7 details options that change a1 could never have information on the latest

the way the document may be viewed on Screen'developments of the program. But you can now
- Adding Style also use an electronic version. This version may

Chapters 3, 4, 5 and 6 describe how to type in tex@lso not always contain the very latest information
and add style to that text. You can add local text but it is far better and it is easier to update.

or paragraph effects, or define named styles that |f you use the disc version, do use a copy for your
may be applied at the press of a key. investigations. The disc version has been set up
- Objects so that you can "play" with it. That means you
can see or discover how text, styles, effects,
frames, pictures and lines have been added to a

The original manual (1996) was printed. Because

Chapters 8 and 9 describe how to draw and
manipulate frames, which are the basic building

blocks of desktop publishing. Chapter 10 deals document.
with manipulating pictures in frames. Start your explorations on the electronic Tutorial.
- Page Handling Menus

All aspects of handling pages, chapters, master If your menus show more or less entries than
pages and stylesheets are described in Chapter hown in this manual it is because of additional
software in the form oDvation Pro applets. This
is nothing to worry about.

- Miscellaneous

Chapters 12 to 18 describe all the remaining
features, such as printing, spell checking and
customisation. The integrated script language an
introduction to which is given in chapter 19, is
intended for advanced users who have a
knowledge of the C programming language.
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1.3 Typographical Conventions - Key Short-cuts
The following typographical conventions are used-ollowing a menu reference, as mentioned above
throughout this user guide. at-Menus, a possible key short-cut is added right
- Key Presses aligned.

d L E.g. pressing Ctrl+H
Key presses are shown capitalised in normal typ&yill open the Change Shape menu

Press the Page Up and Page Down keys to  \\hile pressing Ctrl+Shift+Z

scroll the window up or down by one screen. opens the Zoom window

- Mouse Clicks

and pressing Ctrl+F4
Mouse clicks are shown capitalised in normal typeloses the document.
Left Click to zoom up by 50%. - References
- Dialogue Boxes References to illustrations or other parts of the

Names of dialogue boxes, and options on them atser guide are shown in italics:

shown in bold type: -These are explained in detail, later in this user

Click onOK on theNew dialogue box. guide(see 11.2)
This means: see Section 11.2.

- Menus
Menu options are shown in bold type: -This is the final resulffig. 8.24) '
TheMisc=>Macros dialogue box allows Thfhr;;z;?; see Figure 8.24, i.e. figure 24 in

macros to be created and edited.
-Please refer tBppendix Avhich gives full

details.
This means that you should consult Appendix A.

The example above means chooseMiaeros
option on theMisc menu from the menu bar of an
Ovation Pro document. Where necessary it will

be mentioned as: - Technical Terms
Menue. ... oo Key i‘l;]hi?a?i[:s;tlme a technical term is used, it is shown

In this example the possible key short-cut has
been added as "Key("Key" is only used as
example, it does not exist as such in the program.)

Inside the document window is tdefault
master framento which text may be typed or

o _ _ _ _ _ imported.
To ease finding certain options while reading this

manual the menu option is given on a row of its ~ Fllenames | |
own under Headings, Sub-headings or where ~ Filenames and pathnames are shown in Courier

appropriate within the text. type:

Some options are only available when the Master ~ T0 run the software, double click on the file
Page has been opened. In that case references to Help.dpd

menus are mentioned as follows - Messages
MasterpageMenu........ =R Warning and error messages are displayed in
Courier type:

The error messadéot enough free
memory will be displayed.
- Special Folders

The directoryOvation Pro is installed in (usually
C:\Program Files\DavidPilling\Ovat
ionPro) is shown as <OPD>.
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1.4 If you have Problems

If you discover a problem wit®vation Pro
please report it in writing by either letter, fax or
email to:

Ovation Pro Support

David Pilling
P.O. Box 22
Cleveleys
Blackpool
FY5 1LR.
Fax: +44 (0)870 0520941

Email: ovation@davidpilling.net

Please describe briefly the steps that must be
followed to reproduce the problem, and if

necessary send a copy of any problem documents.
Also include the following information about the

system you are using:

* The version oDvation Pro you are running
(found on thdnfo dialogue box).

» The version of Windows you are using.
* The amount of RAM you have installed.
* Any additional software that is running.
» Any additional hardware that is fitted.

» If you are having problems when printing, give
details of the printer and printer driver you are

using.

Please do not return any discs or packaging until

requested to do so.

IF You HAVE PROBLEMS
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1.5 Latest Information

TheOvation Pro CD Guide provides
supplementary information on usif@yation Pro

and on software and resources supplied with it.

CHapPTER 1



Getting Started

2.1 Loading Ovation Pro. . ......... .. e
2.2 TheHelpMenu. ... . .
2.3 Loading Existing Documents . .......... ...t
24 OpeningaNew Document .. .......... .. ... ... .. .........
25 The Document Window. . . ...
2.6 The TooIbOoX . ...
2.7 TheInfo Palette. . . ... ...
2.8 The Button Bar . ... i e
2.9 Document ZoOm . . . ... o e
210 Interactive Help. .. ....... ... .. . . . ..

This chapter explains how to run Ovation Pro, and how to load
existing documents and create new documents. It also describes the
document environment in detail, and introduces the toolbox, info palette

and button bar. It is assumed you have installed Ovation Pro according

to the separate installation instructions.
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2.1 Loading Ovation Pro 2.2 The Help Menu

LocateOvation Pro on the start menu and click on ~ Menu=>Help.......

it (usually under Programs->David Pilling). This menu provides the following options which
Alternatively you may click on th@vation Pro are described in detail later in this user guide.
icon on the desktop if you created one during

installation.

- About Ovation Pro

Displays information about the version of

Ovation Pro you are usingfig. 2.2) The version
number given should be quoted in any
correspondence with David Pilling concerning this
product.

- Help Topics
Launches the Windows help viewer with the
Ovation Pro help file.

About Owvation Fro
Fegister...

Help topics

Help What's this?  Shift+F1

Fig. 2.1 - Ovation Pro Help menu.

¥ About Ovation Pro |

Frogram name: Cwation Fro
ersion: 2,75 (05-October-04)

Author; David Filling
Copyright @ David Filling 2004

email davidisdavidpilling.net

web: hitp: fweee. danddpilling. net

This program's home page:  http:/ S d avidpilling. net/ ovationpro.htrml

Fig. 2.2 - The About dialogue box.
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2.3 Loading Existing Documents Loading Ovation Documents

To load arOvation Pro document, double-click ~ You may also load ol@vation documents by
on the document’s icon. This operation also loadglragging them to th@vation Pro window or by

Ovation Pro if it has not been already loaded. ~ double clicking them. However, please note the

Alternatively, drag the existing document to the following points:

Ovation Pro window. * The Ovationl Applet must be installed.

Font Mapping » Ovation documents will be bigger in size
when loaded int®vation Pro and when re-

If you load anOvation Pro document that uses _ _
saved inOvation Pro format.

fonts that are not present on your system, a
warning box will be displayeffig. 2.3). * You will be warned if you load a@vation
document intdvation Pro then attempt to re-

Click on Stop loading documentto stop the ; oY -
save it, overwriting the original document.

document from being loaded.
Ovation Pro does not supportestedobjects,

S0 any nested objects @vation documents
will not be nested i®vation Pro. This will

not matter if you just wish to view or print the
document, but if you wish to edit it, objects
may need to bgroupedto keep them together.

Click onPermanent replacemento permanently
replace the missing fonts. If the document is
subsequently re-saved, then the replacement fonts
will be saved and the original fonts will be lost.
See Appendix A for more information on how the
replacement fonts are chosen.

Ovation line and border styles are emulated
fairly closely inOvation Pro, but they may not
be an exact match. Extended border styles in
Ovation are not supported i@vation Pro.

Click onTemporary substitution to temporarily
replace the missing fonts until the document is
closed or until the missing fonts are made
available. See Appendix A for more information
on how the replacement fonts are chosen. » The operation of master pagedwation Pro
is significantly different fronOvation. This
will not matter if you just wish to view or print
the document, but editing the master pages in
Ovation Pro may result in objects appearing
twice in the document.

» Aslightly different missing font window
which does not have the temporary
substitution facility will appear if any fonts are
missing.

T Missing fonts |

ﬁ‘o This document uses 1 font (Bauhaus 53)
A which is not present. Do you wish to

reflove the docurment with a new font?

Permanent replacement | Stop loading document

Temporary substitution

Fig. 2.3 - Warning box if fonts are missing when loading a document.
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2.4 Opening a New Document
Menur>Files>New... Ctrl+N

TheNewdialogue box is shown ifig. 2.4.The
default page is A4 with 10mm margins all around,
but if you want a different paper size or margins,
change the page size or margins as required and
click OK when complete. At this stage you should
not change any other options on this dialogue box.
TheNewdialogue box is explained in detail later

in this user guidésee 11.2)

If required you can edit the default document
(see 15.2)

®Newdocument _______________EE|

Page Ad 8| H| 29mm
- — I Sideways
Colour Bl ow| 210mm
— [ Default master frame
Columng | 1 =] <] ﬂl
Top 10mim Left | 10rmm Header| Omm
Battarm 10mim Right [ 10mm Footer| Omm

" Double sided ¢ [eft € Right & firrar

Cancel 8]

Fig. 2.4 - The New document dialogue box.
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2.5 The Document Window Scrolling the Document
The document window is a standard window, but The amount of the document that is in view in the
with atoolbox info paletteandbutton bar window depends upon the size of the window and

attachedfig. 2.5) You can have more than one the current zoonfsee 2.9) You can move the
document open at the same time, but only one ca#pcument around in the window in the following
be active. Clicking inside a document window  Ways:

makes it active; indicated by the title bar. Typing « Use the horizontal and vertical scroll bars in
and other operations always apply to the active the usual way.

window. Only the active window has the toolbox

and info palette attached. Press the Page Up or Page Down key to scroll

the window up or down by one screen.
The document window title bar shows the name of

the document. If it is followed by thecharacter,
it indicates that the document has been changed
but not yet saved.

Holding down the Shift key whilst pressing the
Page Up or Page Down key scrolls the
document to the top of the preceding or of the
following page.

Title bar Button bar Close icon \

¥ Document1 dpd
File Edit Yiew Text Style 0Object Fage Misc /Applets Help

+++
+++

|Fol == PlolzE sl=-lB= gg vy &

| L
.:’ |
" \
i Caret -
Wk
)
(Ea%)
L Default master frame
\Toolbox
-
I:I Info palette / Scroll bars
O 4| \ | M 4
N
/\/ Text frame ¥| 10mm | 190mm Avial E
U 1.1 v 1omm W[ 277em [N B| 7| U@ 1] 2

Fig. 2.5 - The active document window.
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Default Master Frame

Inside the document window is tdefault master
frameinto which text may be typed or imported.
The size of this frame is determined by the
margins set in the default document.

This frame is anasterframe, meaning that it is

generated by the master pages and will appear o

CHAPTER 2

The Caret

The red I-shaped vertical bar is called the caret
and indicates where text will appear when typed
or imported into the document. When a new
document is opened, the caret is automatically
positioned in the top left corner of the default
faster frame ready for text entry.

all pages of the chapter. The size and position of @he caret is always displayed in the active text
master frame can only be changed on the masterframe (unless there is a text selection). If there is

pages or by making the frame lo¢s¢e 11.3)

Text that overflows at the bottom of the default
master frame, automatically flows onto the next
page.

The default master frame has a red outline to
indicate that it isactive Left click outside it (in
the margins) to make it non-active with a grey
outline. Click back inside it to make it active
again.

no active text frame, the caret will disappear and
text cannot be entered.
The Main Menu

Almost allOvation Pro operations are available
from the main mengfig. 2.6)

¥ Documentl .dpd

File Edit
|l eyl
Fig. 2.6 - The main menu.

Wiew Text Stde Object Page
g | 4| v+l =l

- -1

Misc  Applets
=l

Help
- I |.l_|| WI
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2.6 The Toolbox

Thetoolboxis attached to the left-edge of the

active documen(fig. 2.7)

The top eight tools are the main tools for DTP
work, including editing text and manipulating
objects. One of these tools will always be
selected; by default it is tt&electtool which is
used for selecting objects and editing text.

THe TooLBox 13

Moving the Toolbox

By default the toolbox is attached to the left edge
of the document window. However, if required
you may move it to a new position by dragging on
its background or by pressing Shift and dragging
on a tool. If the document window is moved, the
toolbox moves relative to it.

You may use an option ddhoicesto detach the

The bottom four tools provide the four shapes thattomboX from the windowsee 15.5)

may be used when drawing frames and lines. On&hanging the Toolbox Shape

of these will always be selected; by defaultitis You can change the toolbox shape by right
the Rectangletool.

To select a tool, left click on it. Apart from the
Frame andLine tools, tools remain selected until
another tool is chosen. TlR@ame andLine tools
normally revert back to th&electtool once the

object has been drawn.

8|05 <[4 5]

=
|

L_J

t+— Select tool
t+—— Frame tool
+— Line tool
t+— Path Edit tool
+— Rotate tool
t+— Link tool
t+— Crop tool
t+—— Zoom tool
t+— Rectangle
t+— Ellipse

t+— Straight line segment

+—— Curved line segment

Il |0 OO

Fig. 2.7 - The toolbox.

clicking on the toolbox background and dragging
up and down until the required shape is achieved
(fig. 2.8)

The position and shape of the toolbox may be
different for each open document. They are not
saved with documents, but may be saved as
default(see 15.2)

Re-ordering the Tools

You can swap the order of tools by holding down
Ctrl and dragging one tool onto another tool. The
positions of the two tools are swapped. The order
of tools may be saved with the application choices
(see 15.3)

—
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=
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o
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|| e
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Fig. 2.8 - Other toolbox shapes.
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2.7 The Info Palette Current Page & Chapter
Theinfo paletteis attached to the bottom of the ~ The current chapter and page number are shown
active document. It isontext sensitivee. it in the icon in the bottom left corner of the info

provides information and options according to thepalette. The number is in the fop, wherec is
currently selected tool or objeffigs. 2.9 to 2.14)  the chapter number aqds the page number.

So, if you are working on text, it gives options  |f there is more than one page visible in the
concerned with changing the font, size and style document window, the current chapter/page is the
of the text. one in the centre of the window.

The icon in the top left corner of the info palette

shows the name of the current tool, or if the Select
tool is active, it shows the type of object selected.

I Text frame XI Smm WI 181mm I Tirmes Mew Roman Ell 12pt El
I 1.14 \-‘I 12mm HI 270mm Iﬁﬁlﬂglgl_]l_zl Il

Fig. 2.9 - The info palette displayed when a Text frame is active.

[ Picture frame x| 9.02mm  w[137.44mn - Scale [ 24 j %[ 3.16mm ::IIAI 0 j
| 1.14 ¥ | 141.32mm H| 14.14mm Aspect | 100 :|| v | D.1mm :ll tr

Fig. 2.10 - The info palette displayed when a Picture frame is active.

| Line x[ 185 36mn e[ 42 76mm LinewidthIDQEmm EI

| 1.14 v [18372mn H[ 33.3mm

Fig. 2.11 - The info palette displayed when aLine is active.

| Path edit mode x| —| .= 1|
| 1.14 Y | ] A | 28| B

Fig. 2.12 - The info palette displayed when in Path Edit mode.

| Rotate Al O :II | _I_I Crosshair  ge | ag° | 180°| a0 |
J U
114 rrr 45° | 136°| -138° 45|

Fig. 2.13 - The info palette displayed when the Rotate tool is active.

[ Document zoom  Zoom [ 100 j 5n%| ?5%|1DD%| Fit window | Fit screen |

115 Previous | 150% | 200% | 200% |  Fitwith | Fit height |

Fig. 2.14 - The info palette displayed when the Zoom tool is active.
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Moving the Info Palette

By default the info palette is attached to the
bottom of the document window. However, if
required you can move it to a new position by
dragging on its background or by pressing Shift
and dragging on one of the two icons at the left-
hand side. If the document window is moved, the
info palette moves relative to it.

You may use an option d@dhoicesto detach the
info palette from the windoysee 15.5)

The info palette position may be different for each
open document, but it is not saved with
documents. However, its position may be saved as
default(see 15.2)

THe INnFo PaLeTTE

15
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2.8 The Button Bar

The button bar provides access to common
functions inOvation Pro. It is located at the top of =
every document windo\ffig. 2.15).A default set

of buttons are provided on one row, and these ar¢ g
listed in the next column. You can scroll the

B |BE |

the button bar.

To change the number of rows position the pointe—
on the button bar (but not on a button), hold the -E
Ctrl key and drag with the right button. —

& |

You can change the position of a button on the
button bar by pressing Ctrl and dragging it to the
required position. The button will be placed
before the button over which it is dropped.

To insert or delete a gap before a button, hold the
Ctrl and Shift keys and right click on the button.

The new positions may be saved if required using
the Saveoption in the Macros dialogue box.

O v D e

Menuw>Misce>Macros...

TheMacros dialogue box also allows you to add,

+4+
+4+
+4+

remove or define further buttons, and save them i
the defaul{see 17.6A larger set of buttons is
also available from which you may choose those
that suit your requiremenfsee 17.7).

< O E | |5 [ =

R4

CHAPTER 2

Default Buttons

File info dialogue boxsee 3.1)
Saveasdialogue boxsee 3.10Q)
Print dialogue boxsee 3.11)

Select all(see 3.6)

Cut selection(see 3.7)

Copy selection(see 3.7)
Pasteselection(see 3.7)
Deleteselection(see 3.7).
Show/hideClipboard (see 2.2)
Undo (see 3.4)

Redo(see 3.4)

Show/hideRulers (see 7.3)
Show/hideGuidelines(see 7.3)
Enable/disabl&rid and grid lock(see 7.4).
Zoom dialogue boxsee 7.5)

Modify text/picture box(see 4.6 & 10.7).
Text Colour dialogue boxsee 4.5)
TextFormat dialogue boxsee 5.4).
Display tab rule(see 5.5)

Modify object dialogue bofsee 9.1)
Frame border dialogue boxsee 9.6)
SpellcheckWord (see 14.4)
SpellcheckStory (see 14.3).

PR & BRl&lex0 s PO

+++
+++
+++

@ Ef«mm B0 v

4

Fig. 2.15 - The default button bar.
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2.9 Document Zoom - Zoom allows you to enter any zoom value

You can view and edit the document in a range oP&tween 10% and 1000%. Press return to update
preset zooms or any variable zoom. The default e document. You may also step up and down by
z0om is 100% which shows your document on 170 using the up and down arrows. Or by 10% if

screen at approximately 100% of the true printed € Shift key is held down as well.
size. - Previousrestores the zoom that was current

To change the zoom choose the Zoom tool before the zoom tool was chosen.
(fig. 2.16) Now move the pointer over the point in- 50%, 75%, 100%, 150%, 200% and400% are
the document you wish to zoom in on, and click the standard preset zooms.

Select to zoom up by 100% or Right click to Z00m gt \yindow sets the document zoom so that an

down by 50%. The current zoom is shown in the g tire nage (or pair of pages) fits in the document
info palette. window.

You may enlarge a particular area of the - Fit screensets the document zoom so that an

document by dragging a box around that area witQtira page (or pair of pages) fits on the screen.

the Zoom tool. o
. _ - Fit width sets the document zoom so that a page
When the Zoom tool is selected, the info palette fits the total width of the screen

rovides the following optiondig. 2.17
P g optiondig ) - Fit height sets the document zoom so that an

The Zoom tool can be accessed by holding downgpire page (or pair of pages) fit the total height of
Control and Alt when the Select tool is current. i screen.

This will often be a handy short cut. _ )
) , (Further information on zoom: see 7.5).
For example with the Select tool current a single

click with Select whilst holding down Control and
Alt will double the scale.

8Os

r—
L—J

+——— Zoom tool

SEOTR

Fig. 2.16 - The Zoom tool.

I Document Zoom Zonml 100 j 5D%| 75%|1DD%| Fit window | Fit screen |
1.15 Previous |

150% | 200% | 400% | Fitwicth | Fit height |

Fig. 2.17 - The info palette displayed when the Zoom tool is active.



18 GETTING STARTED CHAPTER 2

2.10 Interactive Help

Ovation Pro supports Windows standa@bntext
Sensitive Help

Most Ovation Pro windows have a ? symbol in
their title bars. If you click on this the pointer will
change to a ? pointer. When in this mode if you
click on any object in a@vation Pro window a
context sensitive help window will appear with
information about the thing you clicked on.

As well as the ? button in the title bar you can also
enter context sensitive help mode by pressing
Shift+F1 or by selecting it from the Help menu.

Context sensitive help is a good way to explore
the program. For example it works with the
buttons on the button bar.

Some windows do not have a ? in the title bar, but
Shift+F1 still works in them. The main
Ovation Pro window is an example.

¥ Document zoom EE ¥ Document zoom HEHE

CA0% O 7h% < 100% Ca0% V% & 100%
 150% © 200%  400%  150% ¢ 200% ¢ 400%
™ Variable |14? % v || © Variable | 47 % < ||
Fit window Fit screen J Left click to set the document
?q zoom so that an entire page (or
Fit width Fit height ‘r - pair of pages) fits an the screen.

Cancell Apply | O I| Cancell Apply | ] |

Fig. 2.18 - Interactive help in action.
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This chapter describes all aspects of typing, editing and importing text.
Once you have created a simple document, it explains how to save and
print the document, and finally how to quit Ovation Pro.
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3.1 Typing & Editing Text Word Wrap

You can type and edit text whenever there is an Ovation Pro automatically re-formats text to fit
active frame containing the caret. A later chapter into the active frame, so there is no need to press
will describe how to draw your own frames, but Return at the end of each line. If a word is too
this chapter assumes you have opened a new long to fit on a line, it is automatically transferred
document as described in the previous chapter to the start of the next line. Similarly, if a word at
(see 2.4)You should have a document window the beginning of a line is reduced sufficiently in
open, with the caret in the default master frame length for it to fit on the end of the previous line,
ready for text entry. The Select tool should be  then it will be automatically moved up.

chosen(fig. 3.1) New Paragraph & New Line

Try typing a few words at the keyboard. The carePress Return to start a new paragraph, putting the
moves to the right of each character as you type. caret at the start of the next line. You can

The style and format of the text you type is optionally add white space at the end of a
determined by the style call@&bdytext . By paragraph to separate it from the next paragraph.
defaultBodytext uses the font Arial (equivalent This is calledSpace afte(see 5.4).

to Helvetica) at a size of 12pt, and is suitable for ChooseMisceinsert>New line or press Shift
general-purpose word processing. Return to start a new line, without starting a new
Type more words until you have filled a completeparagrapl{see 5.1).

line. If necessary the window automatically scrollgye,, paragraph and new line characters may be

sideways so that the portion of the page you are ge|eted, causing paragraphs and lines to be joined
editing always remains in view. back together.

The entire text in a frame or in a number of linked
frames is referred to asséory.

Fig. 3.1 - The Select tool.
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Caret Movement Deleting Text

If the Select tool is chosen, and the pointer moved#ress Backspace to delete the character to the left
over an active text frame, the pointer shape of the caret, or Delet\e to delete the character to
changes to thext insertion tool (fig. 3.2)You the right of the caret.

may position the caret by clicking with this tool:  pregg shift Backspace to delete the word before

» If you click within some text, the caret appearsthe caret, or Shift Delete to delete the word
at that position. containing the caret.

» If you click beyond the end of a line, the caret Press Ctrl Backspace to delete from the caret to
appears at the end of that line. the start of the line, or Ctrl Delete to delete from

« If you click in an empty frame, the caret the caret to the end of the line.

appears in the top left corner of the frame. Press Ctrl Shift Delete to delete the line at the
caret. This also deletes a Return or New Line at

The caret may also be moved using the cursor :
the end of the line.

keys on the keyboard:

. Caret left/right one character You may also delete selected blo¢gse 3.7).

Tl Caret up/down one line Automatic Page Creation/Deletion

N "~ Caret left/right one word If text fills the default master frame, a new page is
Or e Caret up/down one paragraph added with its own master frame. The text then
HomeEnd Caret to start/end of line flows automatically into that frame. This process
~oM Caret to start/end of text story is calledautomatic page insertioand the frames
Ay AL Scroll up/down through story are said to bénked

Where® andUrefer to the Ctrl and Shift keys.  If you delete sufficient text from a document to
Tab Key leave the default master frame on the last page

completely empty, the last page is deleted. This is
calledautomatic page deletiohis only happens
if the last page does not contain any additional

Pressing Tab inserts a tab character into the text,
causing subsequent text to be aligned to the next
tab stop. The default tab stops are at 10mm :
intervals, but these may be changed if required objects.

using the tab rulefsee 5.5) It is possible to alter this behavioseg 15.1p

Transposing Characters

A common typing mistake is to transpose
character pairs e.feild  andotfen . This can
easily be corrected by positioning the caret
between the two characters and pressing

Ctrl Shift Q.

I

Fig. 3.2 - The Text Insertion tool.
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Force Page Break Document Info
Menu>Misc>Insert=>New Page Ctrl+Return Menur>File=>Info

You can force a page break in the default master ~gsefilecInfo to display a dialogue box that

frame at any time by pressing Ctr+Return or iy e5 information about the documéfig. 3.3)
choosingMisc=>Insert=>New page) This inserts

a new page and forces the text after the caret to
the top of it. Date is the time and date stamp of the file. If the

document has not been saved, it is the time and
pdate the document was created.

Documentis the name of the document.

Doing this in a multi-column frame will force the
caret and following text to the next column. Wit
linked frames the caret is forced to the next linkedSizeis the size, in bytes, of the entire document
frame. (in bytes).

The page break character may also be deleted, Story sizeis the size of the text story containing
causing text that follows to flow back onto the  the caret (in bytes).
previous page, the previous column or the

previous frame Words is the total number of words in the

document i.e. all stories.

Moving Around Pages _ Words in story is the number of words in the text
Once you have a document with a number of  story containing the caret. If a selection has been
pages, you may use the following keys to move madeSelection wordsgives the number of words

around the pages. selected including partially selected words.

UPage Up Start of previous page Pageis the current page number i.e. the one in the
LPage Down  Start of next page centre of the document window.

APage Up Start of first page in chapter Total is th ber of in th

"Page Down Start of last page in chapter do a pagteS|s € humber of pages in the

APage Up Start of first page in document ocument.

~OPage Down  Start of last page in document Chapter is the current chapter number.

“Cursor Up ~ move page down one line Total chaptersis the number of chapters in the
ACursor Down move page up one line document.

Where * means the Ctrl key, andhe Shift key.

You can also move directly to any page using
Menu>Page>Goto page(see 11.1) F5

Remember that the number of the page shown on
the info palettésee 2.7)s the one present in the
centre of the document window.

About this file K|
Document 03 Text.dpd
Date 1:32 28th March 2004
Size | BRI =election size _

Waords | 5143 Selection waords

Page| 2¢ Total pages| 20

Chapter| 1 Total chapters| 1

Fig. 3.3 - The document Info dialogue box.
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3.2 Inserting Special Characters Hard hyphen inserts a non-breaking hyphen.
MenusMiscelnserte. .. Words separated by a hard hyphen are never split
between linegsee 5.7) Ctrl+Shift+ -

There are a number ways of inserti_ng special Soft hypheninserts a soft hyphen that doesn’t
characters and control sequences into a docume%lppear until it is needed to split the word at the

Insert Menu end of a lingsee 5.7) Ctrl+ -

TheMiscr>Insert menu allows a number of Merge taginserts a field for the mail merge
special control characters to be inserted at the  facility (see 12.5).

caret(fig. 3.4). , : .

Fixed Spaceopens a window allowing you to
Chapter number inserts the current chapter insert a custom shift. The shift can be both
number. horizontal (as with a normal space) and vertical.
Page numberinserts the current page number. ~ YOU can enter the size of the shift in absolute units
for example inches. Alternatively @nits

Dateinserts the current date. The date format ma)ém/lOOOis checked the units used are thousandths

be setirChoices(see 15.5) CrHD ot an em, the advantage of this is that the space is
Active date inserts the current date which is proportional to the font size. As elsewhere
updated automatically each time the document isQvation Pro takes the em space size as the point
loaded. The date format may be seChmices size of the font.

(see 15.5).

Two other options are provided, the inserted space
Time inserts the current time. The time format  can be made non-breaking (see hard space above).
may be set ilChoices(see 15.5) Finally the space can bedalimiter. A delimiting

The Choiceswindow is selected via: space is used to break up text into words, whilst a

’ non-delimiting space adjusts the spacing between
characters. To understand the relevance of this
think about counting the number of words in some

Menu=>Misc=>Choices.w....... Characters

New pageinserts a page bredkee 3.1) text with spaces in - how do you decide where
Ctrl+Return words begin and end? There is a text effect in

New line starts a new line, but not a new Ovation Pro that underlines words, delimiting

paragrapl{see 5.1) Shift+Return spaces in common with normal spaces would not

Hard spaceinserts a non-breaking space. Words be underlined, non-delimiting space would be.

separated by a hard space are never split betweelfithe caret is before an existing fixed space in text

lines. Ctrl+Space  when the window is opened the values in the
window will show the values for the space, and
when the window is closed the new space will
replace the old one.

It is possible to enter negative values for the shifts.
Chapter numkber
Page number % insert space  HE|
Disie L Vertical | Omim|
Active date
T Harizantal | Ormm
Mew page Cirl+Return ™ Units em/1000
Mew line shift+Feturn
Hard space Ctrl+Space I™ Mon-breaking
Hard hyphen Chrl+Shift+ I Delimiter
=oft hwphen Ctrl+-
Mergetag... Chrl+Shift+hd Cancel oK
Fixed space...

Fig. 3.4 - The Insert menu. Fig. 3.5 - The Insert space window.
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Menu=>Misc=>Characters F11 displayed. This menu is not available unless the

Most fonts contain a wide range of special document feature level is greater than 4.

characters that are not accessible directly from thmserting Characters using Alt

keyboard. You can easily obtain these using  The icon at the bottom right shows the keypress
Misc>Characters. This opens a dialogue box  for the highlighted character. This is useful if you

displaying all the characters in the character set, wish to insert special characters directly from the
for the current fon(fig. 3.6) Just click on a keyboard using the Alt key.

character to insert it at the caret. The selected
character will be inserted in your document and )
y from the keyboard by holding down Alt and

the Characters window will close. If you want to . .
y typing the code number on the numeric keypad.

insert more than one character, right click the firs : .
characters and left click on the last character youRNhen Altis released, the character is inserted at
the caret. So to type the bullet character ¢, hold

want down Alt, type 0149 on the keypad, and then
You can change the font displayed, using the fontelease Alt.

menu at the top of the dialogue box. This font is
used for the inserted characters only and any
typing afterwards will be in the original font i.e.

the one that was current before opening As an alternative you can use the “United States-
Characters. International Keyboard Layout”, when this is

The fieldsBold andltalic are automatically ticked enabled the right Alt key in combination with

depending on the font chosen from the font menuother keys can be used to generate extra
haracters. See “How To Use the United States-

nternational Keyboard Layout in Windows XP”,
Microsoft Knowledge Base ID : 306560. This

feature is available in older versions of Windows
You can put the caret into these icons and type ingo.

glyph names or coc_JIe values and the hightlight W”JAnother possibility is to use the Windows
move to the matching character.

Character Map program. This is accesible from
The character set menu at the bottom of the  the Windows Start Menu->Accessories->System
window lets you choose which selection is Tools. However note that not all characters are

Characters m

Font I Timas New Roman ﬂl [T Bold [ ltalic

You can type characters not normally accessible

A full list of codes is given iM\ppendix B

The icons below the character grid show the glyp
name of the highlighted character and its code
number in decimal and hexadecimal.
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Fig. 3.6 - The Characters dialogue box.
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available inOvation Pro unless Unicode support Single Shift Font (SSF) F12

has been enabled by setting the document featurghis facility allows you to switch to another font
level to 5 or greater. to insert a single character and then return to the
If the document feature level is 5 or greater previous font. The default single shift font is
another technique can be used. Type the Symbol which contains a range of symbols, but
hexadecimal code number of the character into thH&U can choose another fqsee 15.7)

text and then pres8it+X this will replace the Single shift font is accessed using the key F12.

code number with the corresponding character. Uncertainty principle ApAx-h

The process works in reverse, positioning the
caret just after a character and pressifigX will
replace it with its character code.

To produce the line above, typmcertainty
principle followed by a space, then press F12
and type D. Then type p, F12 again, D then x.
This works because in Symbol font, D appears as
the ‘Delta’ character.

You may also use the Alt key to insert characters
not normally accessible from the keyboard.

Jack of Diamonds ¢

To produce the line above, typack of

Diamonds followed by a space, then press F12,
hold down Alt, type 0169 on the keypad, and then
release Alt. This works because the diamond
character has code number 169 in the Symbol font.

SeeAppendix Bror a full list of characters in
Symbol font.
Combining SSF and Characters

If you press F12 before openi@paracters, the
font used inCharacters will be set to the single
shift font.

Changing Single Shift Font (SSF)
Menur>Misc>Choicesvy Text

TheChoicesmenu allows you to set the SSF.
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3.3 Importing Text

Instead of typing in text, you may drag text files

CHAPTER 3

Importing Ovation Pro documents
It is possible to import a@vation Pro document

directly from disc. The imported text is inserted atinto another as separate chapt{eee 11.6)Of

the pointer position and takes the style of the

preceding text.

If you import text into a frame that is too small
and that frame isn’t linked, the text will overflow

(see 8.3)

course you can also import the contents or a
selection of them from on@vation Pro

document into another either by dragging or by
Copy andPaste In these cases if certain styles of
a document from which the text is taken do not
exist in the document to which the text is

Text files can also be inserted by using Import onimported, these styles will be addaee 6.8).

the File menu, this will let you use the standard
Windows Open dialogue to find the file.

You can load a text file using Open on the File
menu causing a new default document to be
opened and the text file inserted into it.

Stripping Return Pairs

If you hold down the Ctrl key when dragging a

Importing Other Types of files

Please refer to th®vation Pro release notes for
details of other formats that may be imported.

If you attempt to import a file that is not
supported, you will be asked to confirm whether
you wish to procee(fig. 3.7).1f you do proceed,
only the text content of the file will be imported.

text file into a document, single Return characters
in it will be converted to spaces and pairs of
Return characters will be converted to single
Return characters. This is useful when importing
text from text editors which terminate each line
with a Return, since i@vation Pro the line

breaks will not necessarily fall in the same places.
If Ctrl is not held down while importing text,
Return characters will be unaffected.

Smart Quotes

When text is imported, plain single quotation
marks (') or double quotation marks () enclosing
text are converted to fancy open and closing

single (") or double (*”) quotation marks
respectively. This gives a more professional
appearance to quotations and expressions such as
“fish ‘n’ chips” and “rock ‘n’ roll”.

This facility is called ‘smart quotes’ and can be
disabled if requiredsee 15.7).

T Ovation Pro 7] |

ﬁl'-(Ll Inserted file is of type Data (*.dat) not
4 Text. Are you sure you want to proceed?

N\

Mo | Yes

Fig. 3.7 - The text import warning box.
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3.4 Undo & Redo
Menucw Edite>Undo

Undo

Edit=>Undo (fig. 3.8)cancels the last operation
performed, restoring your work to its previous
state. You can undo anything that changes a
document, such as deleting or editing text,
changing styles or manipulating objects. You
cannot undo things that just change the way a
document looks e.¢/iew menu options.

Ctrl+z

A special feature oDvation Pro is that you can
undo more than one operation. The number of
undo operations that can be performed depends
upon the size of the undo buffer which can be
increased or decreased as requiss@ 15.5)

Unbpo & Rebo 27

Redo Ctrl+Y

Redocancels the last undo operation performed.
TheRedooption will be shaded if there is no
further operation that can be re-done i.e. the
document is up-to-date.

Note that if you edit a document after using undo,
theRedofunction will not be available.

Clear undo buffer
Menu=>Misc=>Clear undo buffer

Whilst the undo buffer is automatically flushed
when you save a document, you may need to flush

it manually if you run out of memory when
editing a document. You can do this using the
optionMiscr>Clear undo buffer. This minimises

the memory used by a document by flushing the

Undo is shaded if there is no further operation thagndo buffer and recovering any memory used by

can be undone.
By default, the undo buffer is automatically

deleted objects.
Saving the Undo Buffer

flushed before saving a document. This mean¥ou can use an option @hoiceswhich causes
that after the document has been saved, you the undo buffer to be saved with documents

cannot undo operations that were carried
before saving.

(see 15.5)
Making Undo Use Less Memory

There are three reasons for automatically flushingyhen you delete an object such as a frame or

the undo buffer before saving a document:
As you edit a document, deleted objects are

picture, that object is retained in memory and a
reference to it placed on the undo buffer so that

retained so that they can be put back. Flushinghe deletion can be undone. As a result even with

the undo buffer when the document is saved,
recovers the memory used by these objects.

It ensures that the saved document uses as
little disc space as possible.

Anyone receiving the document cannot use
undo to see the contents of previous versions.

Undo Deselect Ctrl+Z
Beda (Sl
Cut Picture frame el -+
Copy Ficture frame  Cirl+C
Paste cliphoard el -+
Delete Ficture frame  Cel+k
Efmbied chjest

Select all i+,
Clear

Eitl... i+

Fig. 3.8 - Undo and Redo

a very small undo buffer, it is possible that
significant amounts of memory may be used
storing deleted objects. Eventually, as other
operations are carried out, references to deleted
objects are pushed off the undo buffer and the
objects are removed from memory.

So, if you have little free RAM available for your
document, you may wish to disable the undo
buffer completely so that deleted objects are not
retained. You can do this by setting the undo
buffer size on the Choices window t¢sge 15.5)

Alternatively, you could save the document at

regular intervals, since this has the effect of

flushing the undo buffer and deleting any

referenced objects.

The exact text following the words$ndo
andRedoon theEdit menu is context
sensitive and is not mentioned here.
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3.5 Revert to Saved
Menuc>Filer>Revert to saved

Revert to savedrestores the document to the

most recently saved version. A warning prompt is
displayed before proceediffig. 3.9) Click on
Discard to delete the current document and reload
the previously saved one, or Gancelto cancel

the operation.

Revert to savedis shaded and unavailable if the
document has not changed since it was last saved
or if it has never been saved.

T Ovation Pro 7] |

Fevert to previous version of file and
discard this version?

&0

Discard | Cancel |

Fig. 3.9 - The Revert to saved warning box.

CHAPTER 3
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3.6 Selecting Text Clearing a Selection

Many operations are applied to a text selection. There are a number of ways to clear a selection:
The selection may be any amount of text from a « Click once anywhere in the document.

single character to an entire story. . ChooseEditeClear (fig. 3.8)

There are a number of way to select text: .
» Select something else.

1. Left click and hold down the mouse button at

the start of the text to be selected, drag to the Overtyplng . ] .
end of the text and then release. Note that if you type anything while text is
selected, the selection will be deleted and replaced

2. Left click to position the caret at the start of with the text typed.

the text to be selected. Hold down Shift and ) - . )
Left click at the end of the text. Further Left  This facility may be disabled dbhoices
clicks with Shift can be used to adjustthe ~ (S€€ 15.7)

range of the selection at either end.

3. Use one of the following short-cuts:

» Left Double-click with on a word to select that
word including following spaces;

» Left Triple-click on a line to select that line;

» Left 4 clicks anywhere in a paragraph to select
that paragraph;

» Left 5 clicks anywhere in text to select the
entire story

4. Chooseedit=>Select allto select all the text in
a story. Ctrl+A

5. Hold down Shift and use the usual caret
movement keys. For example Shift + Home
will select all the text between the start of the
current line and the caret.

After any of these operations the selected text is
highlighted, i.e. inverted (normally white text on a
black background).

Note, it is not possible to have more than one
region of text selected at any time.
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3.7 Cut, Copy, Paste & Delete Transferring Text Between Documents
MenuEdit........... Ovation Pro uses special rules to deal with
clashing style names when using cut, copy and

TheCut, Copy andPasteoptions on thédit paste between documents.

menu(fig. 3.8) are used to move or copy text

within the same document or to another documenthe situation occurs when text containing a
defined style is transferred to another document

which contains a style of the same name, and that
style has a different definition. If this situation
occurs, by defauldvation Pro renames the style

in the transferred text. So if you e8ibdytext

in one document and then transfer it to another

Please note that if there is no selected text, the document containingodytext , the transferred
following options are used to manipulate other  style will be rename&odytext01.

selected objects, such as frames, pictures or ”nei\lternatively you may use an option Ghoices

+ : .
Cuttext Cul _X Menur>Misc=>Choices>Text
Cut deletes the selected text and places it on the

clipboard. The previous contents of the clipboard that causes the clashing style name to be
are overwritten by this operation. discardedsee 15.7)Then the transferred text will

take over the style attributes from the receiving
Copy text Ctrl+C

document.
Copy copies the selected text onto the clipboard.
The previous contents of the clipboard are
overwritten by this operation.

Paste text Ctrl+Vv

Pasteinserts the text that is on the clipboard into
the document at the caret. Text can be pasted into
anyOvation Pro document, not just the one from
which it was cut or copied. After pasting, the
clipboard contents remain unchanged so you can
paste more than once.

They do this via a clipboard, which may be
viewed using th€lipboard option on the View
menu. Text or pictures are displayed on the
clipboard in exactly the same format as they
appear in the document.

The above rules for clashing style names, also
apply to clashing colour names.

UseCut followed byPasteto move text.
UseCopy followed byPasteto copy text.

Delete text Ctrl+K

Deletedeletes the selected text. It does not place
the deleted text on the clipboard. This option is
only available if there is some text selected.

You may also delete selected text by pressing
Delete on the keyboard.

If Overtype has been set iBhoices
Menu>Misc= Text>oOvertype

selected text will be deleted when entering new
text.
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3.8 Drag & Drop Transferring Between Documents

Instead of usingut, Copy andPasteto move or ~ The rules given earlier for dealing with clashing
copy text via the clipboard, you can use the drag Style and colour names when using cut, copy and
and drop facility to do this directly. paste, also apply to drag and dspe 3.7)

To use drag and drop, first select the text you wishiserting Pathname

to move or copy. Left Click over the selection so Holding down the Alt key and then dragging a file
that the drag and drop tool is display@éd. 3.10)  or directory from a Windows Explorer window
Now drag until the pointer is over the required  into anOvation Pro document, will insert the full
insertion point and release the button to insert thegpathname into the text.

text.

If you drag and drop within the same document,
the text ismoved if you drag and drop to another
document, the text isopied

If you hold down Shift while dragging, the above
operations are transposed. So, if you drag and
drop within the same document, the textopied

if you drag and drop to another document, the text
is moved

If you start a drag operation and wish to cancel it,
press Esc.

i

Fig. 3.10 - The drag and drop tool.
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3.9 Find & Replace Case Sensitive

Menu=Edit=>Find Ctrl+E If Case sensitivas not selected, the search will
match all occurrences of the search string, making
ne distinction between upper and lower case
Characters. So searching faoc  will match with

Edit=>Find opens a dialogue box which allows
you to search a story or document for a string, an

optionally replace the found string with another abc, Abc andABC etc. The replace string will

string (fig. 3.11) match the upper-case/lower-case format of the
By default if there is no selected text, the search found string. So replacing withgr in the

starts at the caret and continues to the end of theexample above givgsyr , Pgr and PQR.

story. If there is a selection, only the selection is If Case sensitivés selected, the search will only

searched. : .
match occurrences of the search string with
The options in th&ind dialogue box are exactly the same upper-case/lower-case format.
described below. So searching foAbc will only match withAbc
and notabc or ABC The replace string is
Menu=>Edit=>Find next F3 substituted unchanged.

. . Whole Word
Edit>Find next searches from the current f Whol qi | 4 th b wil
position for the next match of the previously used ole word is not selected, the search will
search string. This provides a quick way of match occurrences of the search string even if
resuming a search perhaps after doing some boundgd by other letters and numbers. So
editing around a string found searching foher would match witithere  and
' other .

_ If Whole word is selected, the search will only
Find match occurrences of the search string that are not
Type in the string that you want to search for.  bounded by other letters and numbers. So
Pressing Tab in this field will place the caretin  searching foher would match witther and
the Replace withfield below. (her) , but not withthere andother .

Replace with

Type in the replacement string that will be
substituted for the search string when it is found.
Leave this field blank if you do not want to
replace the search string or if you want to delete
the search string.

Pressing Return in either the Find or Replace field
will start the search i.e. it is equivalent to clicking
onGo.

HE|
Find || =]
Replace with I LI

[T Casesensitve [ Wholeword [ All stories

[7 Find from stat | Wildzcards I Count |

Cancel | Go

Fig. 3.11 - The Find dialogue box.
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All Stories Go

If All storiesis not selected, the search starts at Click onGo to start the search. If the search string
the caret and continues to the end of the story. If cannot be found, the messdget found is
there is a selection, only the selection is searchedlisplayed in thé-ind dialogue box. Click on

If All stories is selected, the search starts at the Cancelto close the dialogue box.

caret and continues through each story until the When the first occurrence of the search string is

end of the document. ButFind from start is found, theText found dialogue box is displayed
selected as well the search starts at the beginningfig. 3.12),indicating the operations available. The
of the first story. found string is selected in the document.

Find From Start Click onContinue to find the next occurrence of

If Find from start is not selected, the search the search string.

starts at the caret. Click onReplace to replace the search string with

If Find from start is selected, the search starts ~ the replace string, and continue to the next
from the beginning of the current story rather tharpccurrence. If the replace string is blank, the
the caret position or start of the marked area. It isfound string will be deleted.

useful if you wish to search an entire story but  Click onEnd of file replaceto find and replace
have forgotten to, or do not wish to move the caref|| occurrences of the search string without

to the start of the story. stopping for further instructions.

Find from start does not apply if you have a Click on Stop to abandon the search.
selection or ifAll stories is selected. In the latter

case it starts at the beginning of the first story in
the document.

If the search string cannot be found, the message
Not found s displayed. Click oistop to close
the dialogue box. Alternatively €ontinue is

Count clicked on searching will recommence from the
Click onCount to count all the occurrences of the start of the story or iAll stories is selected, from
search string. The number counted is displayed irthe start of the document.

the icon to the left of th€anceloption.

Count acts in the same way as stated above under
the sectiond\ll Stories andFind From Start.

Previous searches

Pressing cursor down in the find or replace fields
allows you to step through previous search and
replace strings. When the search field is changed
in this way the replace field will change to the
corresponding replace string. However stepping
through previous values for the replace field will
not change the search field.

Textfound |

Replace

End of file replace

Found

Cancel

Fig. 3.12 - The Found dialogue box.
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Wildcards Although not displayed in the extended Find
Click onWildcards to display the extendeeind dialogue box the following wildcards can also be
dialogue boxfig. 3.13. In this mode you can used:

introduce wildcards or special characters into the\c matches the chapter number
search string (and in one case, into the replace \e embedded frame

string). \f new frame

To insert a wildcard, position the caret correctly ind page number
the search string and then click on the required \h  active date
wildcard icon. The escape sequence for that \m  merge tag
wildcard is inserted into the string. If you wish ~ \P new page

you may type the wildcard escape sequence \s  fixed space
directly into the string. \w  one item of white space, i.e. space, non

. . breaking space or tab
In the following table, the escape sequence is gsp

shown first, followed by the icon name, followed

by a description of the wildcard function. Notele ,im,\s  andiw - cannot appear in the

replace string.
\ Any char matches any single character.

\d Any digit matches any single digit O to 9.

\a Any alpha matches any single alphanu-
meric character. Ato Z, ato z, 0 to 9 and

\* Any string matches any string of
characters.

\& Found refers to the string found and is
used in the replace string. For example, if
you search foc\.t , putting \&s in the
replace string will replaceat , cot and

As well as wildcards it is possible to use glyph

names in the search and replace strings. This

allows characters which cannot be entered into
—Windows text icons to be used. A complete list of
glyph names can be found in Appendix H. For
example {fl} represents the fl ligature. This does
mean that if you want to search for text that looks
like a ligature name an extra { must be used. So
{{fl} will find the text {fl} in the previous

. sentence.
cut with cats, cots andcuts .
\\ \\=\ matches the \ character. Macro expansion is supported in the find and
\ New line matches the new line character. replace string¢see Chapter 17)

\n New para matches the new paragraph
character i.e. Return character.
\t Tab matches the tab character.

Find Iﬂ:uund

El
Replace with I ;I

[ Case sensitive [ Wholeword [ All stories

| Find from start  [v Wildcards I Count
L Any charactar W Any digit Ya Any alpha
VoAny string & Found Bo=h
U Mew ling ‘n Mew paragraph it Tab
Cancel Go

Fig. 3.13 - The extended Find dialogue box with wildcards.
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3.10 Saving Documents Saving Text Stories

Menu=File=>Save As... In addition to saving entire documents, you may

To save the document chods&e=>Save As... Just save text stories.

The standard Windows Save window will appear TO Save a text story, position the caret in the story,
(fig. 3.14).If the document, hasn’t been saved ~ and choosé&ilec>Savestory. Now use the

before, a default name will be supplied e.g. standard save box to save the story as a plain text
Documentl , Document2 , etc. If you wantto  file. You may also save the storyliL format
change the name, edit it in the usual way. by choosindDDL before savingsee Appendix J)

Ensure tha©vation Pro is selected for Save as 10 save selected text, select the text required then
type, and click on Save. An icon representing thechooseFiler> Save selectionNow save the file in

file appears in the Winows explorer display to  the usual way.

confirm that the file has been saved and the name

of the file is updated in the document window title

bar.

You may also save documents in DMo¢ument
description languageformat by choosin@pDL
before savingsee Appendix l)

Menuc>Filer>Save Ctrl+S

If a document has already been saved and has a
full pathname assigned to it, it can be resaved with
the same filename by using this entry on the file

menu.
Save As |

Save In; I _A tanual j gl

| 112_Examples @) 07 _Wiew. dpd #]15_Custorn.dpd & Appendix_D.dpd =] I
@] 00_Cortent.dpd  [#] 08_DrawObj.dpd  [#] 16_Colours.dpd &) Appendix_E.dpd

] 01_Intro.dpd & 09 WorkOb.dpd  [#]17_Macros.dpd & Appendix_F.dpd
=] 02_Started.dpd  [#] 10_Pictdpd &) 15_Appletdpd &) Appendix_G.dpd
] 03_Textdpd #]11_Pagesdpd  [#]19_Scriptdpd & Appendix_H.dpd
=) 04_Fffectdpd ] 12_Print.dpd &) Appendix_Adpd  [#] Appendix_|dpd

#|05_Formatdpd  [#]13_Print++.dpd  [#] Appendix_B.dpd  [#] Appendix_J.dpd
=] 06_Style.dpd =] 14_Spell.dpd =) Appendix_Cdpd  [#] Glossany.dpd

« | [
File name: Save
oave as ivpe:  |Chwation Fro j Cancel

Fig. 3.14 - The Save dialogue box.
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3.11 Basic Printing Pause

Menu=>FEile=>Print... Ctrl+P If Pauseis selectedQvation Pro will pause
between each page printed until you click on
Continue on thePrinting dialogue box (see
overleaf).

Before you can print, you must load a printer
driver suitable for your printer. Ensure that the
printer driver has been configured correctly, for
such things as resolution and number of colours. Reverse

If Reverseis selected, the order of printing is

ChooseFilec>Print or press Ctrl P to display the
reversed.

Print dialogue boxfig. 3.15) The name of the
current printer driver is displayed in the title bar. Collate

A brief description of the options on tReint If Collate is not selectedvation Pro prints
dialogue box is given below, but more detailed ~Multiple copies of each page, so pages are printed
information is given later in this user guide in the order 1,1,1, 2,2,2, 3,3,3.

(see 12.2) If Collate is selected when printing multiple
Copies copies,Ovation Pro prints multiple copies of the

Copiesis the number of copies of each page that document, so pages are printed in the order 1,2,3,
you want to print. 123123

No Pictures

If No picturesis selectedQvation Pro will

ignore pictures and just print text. Only the picture
frame guideline is printed. On some printers

Format

Format should be set thlormal the first time
you start a print job.

All Pages . ' printing pictures is very slow, so this option may
All pagesprints all pages in the document. be useful for quickly printing draft copies.
Rangeallows you to print the range of pages Tumble

specified in the writable field. If Tumble is selected andll Sidesis selected,

All Sides then printing on the even sides will be rotated by

All sides prints both left and right hand pages. 180 degrees. Kfeft/Right or Front/Back are

Left andRight allow you just to print one side of selected all printing will be rotated by 180 degrees.

the document. This is useful if you want to print aPrint Setup

double-sided document by printing one side then Print setupextends thé&rint dialogue box to

turning the paper over and printing the other. provide further advanced printing options
(see 12.3).

Chapter 12 gives information on many advanced
printing options available.

2 Print 1]
Printer HP Caolor Laserlet PS E
Copies| 1|+ ] Format Mormal Bl

& Al pages " Range 19 to 38

& Al sides ™ Right i Left

[ Pause [T Reverse [ Collate

I Mo pictures [ Reflect I~ Tumhble

[ Print setup et Cancel Frint

Fig. 3.15 - The Print dialogue box.
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Set

Click on Setto set the options in tHerint
dialogue box, without actually printing the
document. These options will be saved with the
document when it is saved.

Print

Click onPrint to print the document. The pointer
changes to an hourglass and fmmting dialogue
box is displayedfig 3.16) It shows thd>ageand
Copy being printed.

The green bar gives a visual indication of how
much of the print job has been completed, but
please note that this is only accurate to the nearest
whole page.

Click onCancelto terminate printing. Please note
that only a limited amount of multitasking is
possible when printing i.e. when the hourglass
turns back to the standard pointer. So there may
be a delay befor€anceltakes effect. Usually it is
quicker to press Escape instead.

Click onPauseto pause printing. Again, there
may be a delay befoRausetakes effect. When
paused, th€auseoption changes tGontinue
which you should click on to continue printing.

Printing BigDoc.dpd |

F'agel 215 CDp'_I,I'I 1 Record [
Separation %—
[

Fause | Cancel |

Fig. 3.16 - The Printing dialogue box.

Basic PrinTING

37



38 WoRkKING WiTH TEXT

3.12 Closing Documents & Quitting

When you have finished working on a document,
close it by clicking on the close icon of the
document window. If the document has been
modified since it was last saved, a warning will be
displayed(fig. 3.17) Click onSaveto save the
document before closing it; click @iscard to

close the document losing the latest changes; click
on Cancelto cancel the close operation and retain
the document in memory.

If you have finished usin@vation Pro, you can
remove the program from the computer’s memory
by choosingexit on theFile menu(fig. 2.2)

Again, you will be warned if your document has
been modified since it was last sayéd. 3.18)

Click onDiscard to quitOvation Pro losing the
latest changes made to any modified documents,
or click onCancelto cancel the quit operation.

¥ Ovation Pro H E3 |

This document has been modified?

& _.

Discard | Cancel Save

Fig. 3.17 - Confirm box when closing a modified document.

1 Ovation Pro = E3 |

1 document modified.

Discard | Cancel |

Fig. 3.18 - Confirm box when quitting Ovation Pro.

CHAPTER 3



Adding Effects

4.1 Applying Text Effects. . ... ..o
4.2 Changing Font . ....... ... .. . i
4.3 Changing Size. . ...
4.4 Miscellaneous Effects. . . ....... ...
4.5 Text Colour . ... e
4.6 Advanced TextEffects .. ...... ...

This chapter describes how to add a wide range of local style effects to
your text. These are applied directly to a selection or at the caret. They
provide the easiest and most direct way of adding style to a document.

Local format effects such as tab, indent and alignment which affect
whole paragraphs are described in Chapter 5.

Local effects are normally used when you wish to make a simple
change to a document, such as making a word bold. If you are
producing a short or simple document, then it is practical to use
combinations of effects; since if you want to change them, it is
reasonably quick in a short document.

In long or complex documents you should use defined styles
described as in Chapter 6. These allow style and format effects to be
combined together in a named style and applied in a single
operation. Defined styles can easily be modified at a later stage,
automatically updating all occurrences in the document.
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4.1 Applying Text Effects Moving the Caret

MenucSTexts .. If you move the caret into another part of the
document, any characters typed will be displayed
iRfthe style that was current for the text
immediately before the new caret position.

Local effects are used to change the appearance
text in the document. Most effects may be
combined, so for example, you can have text in a

larger size that is bold and underlined. Clearing Effects

You can clear all locals effects from the current

The optiong=ont, Size Effect andColour on the selection by choosing the optitocal effects

Text menu(fig. 4.1) provide the basic effects that

may be applied. Thlodify text dialogue box (fig. 4.2)
provides all the basic effects plus a range of Menu> Styles>RemovevLocal effects _
advanced effects, all from a single dialogue box. Ctrl+Shift+L

Changing Existing Text

You can apply an effect to any amount of text
from a single character to an entire story. To do
this, select the text requirésee 3.6)and then
choose the required effect from the appropriate
menu or dialogue box.

Applying Style Effects as you Type

As you are typing, you can choose the required
effect from the appropriate menu or dialogue box,
and then continue typing. Any text subsequently
typed at the caret will use that effect. However, if
you move the caret before typing any text, the
effect will be removed.

hodify text... FR

Fant... Ctrl+ZShift+F
Dize b
Effect »
Colour...

Farmat... Editstyle..  Cirl+Shit+E |
Alignment ¢ Femove All styles and effects Cirl+0

. R :
Leading v Bodytext Chl+F1 Local effects Cirl+Shift+L
Tabs... Ctrl+Tak

Ch Mumber Heading

Fig. 4.1 - The Text menu. Fig. 4.2 - Use Local effects to remove all effects.
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4.2 Changing Font
Menum Textw Font... Ctrl+Shift+F
To change text to a new font, select the text or

CHanGING FonT 41
The font menu has some special features. Whils
has the input focus if you type the name of the
font you want the selected item will move to it.
Usually only the first letter or two of the name

position the caret as required, then choose the nepill be sufficient to locate it uniquely.

font from theFont menu(fig. 4.3) The font menu
is available froneither theText menu(fig. 4.1)or
the info palettdfig. 4.4) Applying a font in this
way, overwrites any other font already present.
Current Font

If there is no selection, the font that is current at

the caret is ticked on tHeont menu and indicated
on the info palette.

If there is a selection, the font that is present
throughout the entire selection is ticked on the
Font menu and indicated on the info palette. If

Fonts with a + to their right have more than one
family member and you can open a sub-menu of
family members by pressing the cursor right key.
Alternatively if Ctrl is held down the family
member menu will open as the selected font on
the main menu is changed.

Normally if you want to change font you click on
the family name on the main font menu (e.g.
Arial). Any effects like Bold then automatically
select the appropriate family member (e.g. Arial
Bold). However if you select the font from a sub

there is no tick on the menu and no font name onmenu that particular family member is used
the info palette, it means that there is more than regardless of any effects.

one font present in the selection.

Architecture T -
Arial T+
Arial Black i)
Benguiat Bk BT i)
Bookmark T+
Chaucer i)
ClearTypeSans T+
Comic Sans M3 Hr+
CommaonBullets T

Compacta BT
CopprplGoth BA BT T
Corpus T+
Courier Mew Hr+
Curatar T+

Fig. 4.3 - Top of the Font menu.

The symbols to the immediate right of the font
names indicate the font type.

B TrueType
{} OpenType
& PostScript Type 1

As with normal Windows menus the cursor keys,
Home, End, Page Up and Page down can be us:
to move the selected item around the menu.
Moving the mouse pointer to near the top or
bottom of the menu will make it scroll. The menu
will have a scroll bar (if there are enough fonts)
which you can use to move around it.

Current font Font menu

Text frame ¥|  Hmm | 18Tmm

A 12pt

Trinity

1.44 ¥ 12mm H| Z70mm

N B| /| u|@| 1| :|[E =|=

Fig. 4.4 - The info palette displays the current font and provides a Font menu for

choosing a new font.
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4.3 Changing Size Units

To change the size of text, select the text or The default units for type size are points (pt). In
position the caret as required, then choose the sif®@mputer terms, 1pt equals 1/72 of an inch. The
required from the Size merfig. 4.5) The Size table below gives metric and imperial equivalents

menu is available from either the Text menu for the standard type sizes.
(fig. 4.1)or the info palettéfig. 4.6) pt mm in
Standard Sizes 8 2.82 0.11
The Sizemenu offers a range of standard sizes, 10 3.53 0.14
shown below at actual size. 12 4.23 0.17
6 point 14 4.94 0.19
_ 18 6.35 0.25
10 point 24 8.47 0.33
12 point 36 12.70 0.50
14 point Other units supported are the didot and the cicero
] still used at times for book printing. The didot is
18 pOIﬂt the equivalent of the point outside the UK and the
. USA. There are 12 didots in 1 cicero. 1 point is
24 p0|nt 1/72th of an inch. A didot is 0.0148 inch or about

1/68th of an inch. Some examples of metric and
imperial equivalents for didots are:

36 point Gt mm it

8 3.01 0.12
10 3.76 0.15
12 4.51 0.18
14 5.26 0.21
and for cicero's:
cicero mm inch
8 36.10 1.42
10 45.12 1.78
Bpt 12 54.15 2.13
10pt 14  63.17 2.49
v 12pt
i ft As fonts are nowadays generally computer
; generated printers tend to use mm's or pt's for
18pt .
sizes.
24t
36pt Within Ovation Pro units can be specified in
—_— didots by using di, d or D the unit abbreviation
_ after the value and ciceros using ci or Cl. See
Fig. 4.5 - The Appendix J for the complete set of supported units.
Size menu.
Current type size Size menu
Text frame | Pmmo oy 18Tmm Trinity Bl 12¢t ¥
1.44 [ 12em W[ 27omm [N B| £ U@ 1] 2 |[E

Fig. 4.6 - The info palette displays the current type size and provides a Size menu for changing to a new size.
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Other Sizes
Menuw Texto> Size...

The current type size icon on the info palette
allows you to enter any size between 1pt and
1000pt. The default unit is points, but if you wish
you may specify another unit e.g. 5mm or 0.25in.
The value will be converted to points next time
the menu is displayed.

Sizes may be specified to two decimal places. It is
also possible to enter a calculation. If you enter 12
+ 50%, the result will be 18pt. You can add or
subtract by numbers or a percentage.

Similar comments about units and calculations
apply to all the writable icons @vation Pro, see
Appendix J for more information.

Current Size

If there is no selection, the type size that is current
at the caret is ticked on ti&zemenu and
indicated on the info palette.

If there is a selection, the type size that is present
throughout the entire selection is ticked on the
Sizemenu and indicated on the info palette. If
there is no tick on the menu and no size given on
the info palette, it means that there is more than
one size present in the selection.

CHaNGING Size
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4.4 Miscellaneous Effects Normal
Menu=Text Effect Normal deselects other effects such as Bold, Italic
etc.

The TexteoEffect menu(fig. 4.7) provides the o
effects that may be applied to selected text or at This is normal text
the caret. Effects may also be chosen by clicking gg|d

on icons on the info palet(éig. 4.8) Bold selects the bold variant of the current font. It

Please note that applying effects toggles them onis useful for highlighting word€Bold can only be
and off. For example, if you appBold to some used if there is a bold version of the current font
normal text, the text will change to bold as available.

expected. However, if you appBold to some
text that is already bold, the bold effect will be
cancelled and the text changed to normal.

Example ofbold text

Italic

Italic selects the italic variant of the current font.
It is useful for emphasizing wordsalic can only
be used if there is a italic version of the current
font available.

Example ofitalicisedtext

Underline

This effect underlines all characters including
spaces and punctuation characters.

Example of underlined text
Advanced underline effects may be specified on

theModify text dialogue box. Ctrl+F6
¥ Mormal Crl+Shift+M
Bold Ctrl+B
ltalic Crl+|
Linderline  Cirl+Ll
Reverse Cirl+Shift+4'
superscript  Chrl+Shift+=
Subscript  Cirl+=
Fig. 4.7 - The Effect menu
Text frame ¥ Hmmo | 18Tmm Trinity H
1.44 v 1zom W[ 27omm [N B 7| U@ 1] 2
Normal // \\Subscript
Bold Superscript
Italic

. Reverse
Underline

Fig. 4.8 - The info palette allows a range of effects to be applied to the selected text or to
the caret.
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Reverse Current Effect
Reverseswaps the text foreground and If there is no selection, any effects that are current
background colours. By default this produces  at the caret are ticked on tRéect menu and
white text on a black background. indicated (in orange) on the info palette.

Example offaas text If there is a selection, any effects that are present
Superscript throughout the entire selection are ticked on the

Effect menu and indicated on the info palette. If
_ an effect is not ticked on the menu and not
Example ofsuperscripttext indicated in orange on the info palette, it means

The Size Of the Superscript may be Speciﬁed in that |t |S not present throughout the Se|eCtI0n
MiscroPreferencegsee 15.14)

Subscript

This effect produces subscript text.

This effect produces superscript text.

Example ofsubscripttext

The size of the subscript may be specified in
Misc=>Preferenceqsee 15.14)
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4.5 Text Colour Tints

Menu=Text=Colour... If you do not specify a tint, the chosen colour is

. . applied exactly as shown in the sample. This is
The Text=Colour opens a dialogue bdig. 4.9) referred to as a solid colour and has 100% tint.

which allows you to change the colour of text. . .
: . You can apply a tint of the solid colour by
Colour can be applied to a selection or at the care . .
choosing a percentage from the tint menu or by

if there is no sele.ctlon. _ entering a value between 0 and 100 in the writable
The scrollable window lists all the colours icon. Alternatively, use the up and down buttons

available. A sample of each colour is given, to change the tint value one percent at a time.
followed by its name. You can add your own

colours to the list usiniliscr>Edit colours
(see 16.2).

Left click on a colour to choose it. The two
coloured squares at the bottom of the dialogue box
show the chosen colour and the previous colour
i.e. the one that was current before the dialogue
box was opened.

Click onOK to apply the colour to the text.

Alternatively double-click on a colour to select it
and apply the colour in one operation.

Please note that the procedure described above for
selecting a text colour, is the standard system of
selecting colours throughoGQlvation Pro.

# Colour picker |
" 10
W 5k [ 0
[ ] white -
Transparent A0
B Red -
1] i
. Blue 0
[ Cyan — 80
. Magenta a0
M1 wona... ;I ~‘,-II:”:I
Previous colour
\. Timl 100 o || ﬂl‘*
Current coIourmprim Tint menu
Cancel | 024

Fig. 4.9 - The standard Ovation Pro colour picker.
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4.6 Advanced Text Effects
Menur> TextcoModify text

F6

The Text>Modify text dialogue boxfig. 4.10)

provides a wide range of advanced text effects

Apvancep Text EFFects 47
Font
Changes the font of the tefeee 4.2).
Size

Changes the size of the t€gee 4.3)

that may be applied to a selection or at the caret. ~ ¢

Current Text Effects

TheModify text dialogue box reflects all the
settings that are current at the caret or throthouNormal displays text in the case in which it was

a selection.

If any effects are not present throughout a
selection, they are indicated on tedify text

dialogue box as follows:

1. If the effect is set by a value in an icon, that

icon will be blanked out.

2. If the effect is set by a button, the button will

be indicated with a cross.

For example, the dialogue box showrfign4.10

shows the effects present in a selection. S8ize

andH scaleare blank, it means that they are not

present throughout the selection.

The same is true f@old which is indicated with
a ‘crossed’ button. Blank buttons such as that for

Italic, indicate that the effect is switched off _
throughout the selection. Ticked buttons such as Changes the background colour of the text using
Underline, indicate that the effect is switched on the colour picke(see 4.5)The default

throughout the selection.

This provides a menu with three options for
specifying the case of the text:

typed or imported.

Title changes the first letter of each word to upper
case and the rest to lower case. Any individual
characters are changed to upper case.

This Text Is In Title Style.

All caps changes all letters to upper case.
THIS TEXT IS IN ALL CAPS.

All lower changes all letters to lower case.
this text is in all lower.

Foreground

Changes the colour of the text using the colour
picker(see 4.5)

Background

background colour is transparent.

T T
Fant Trinity "H| Hecale| 100 2
Size | 12pt E Track | O
Case | Mormal E Wshit| O %
Foreground - E Rotate| O  °
Background é E Skew| O °
™ Bold I~ ltalic ™ Underline E
[T Superscript [T Subscript [ Strikeout E
[T Small caps [T Reverse
Apnly Cancel | QI

Fig. 4.10 - The Modify text dialogue box.
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H scale Tracking is identical to kerning described above,
Horizontal scale allows you to compress or but is applied to selected text rather than letter
expand text horizontally. You can scale text from Pairs. Negative tracking is useful for fitting text
10% to 1000% of the normal unscaled width onto lines, although if your text is justified you
without changing the text height. may obtain better results using enhanced

justification(see 5.7)Positive tracking can give

o e .
75% horizontal scaling attractive results for titles and headings.

100% horizontal scaling

125% horizontal scaling Texttracked -100
Text tracked O

. . 0
The default horizontal scale is 100%. Text tracked 250

Track .
If there i lection Tracking i ival v shift
Kérr?irr?gls no selection Tracking Is equivalent to This effect shifts text vertically above or below

_ _ _ the baselineV shift is expressed as a percentage
Kerning moves the characters on either side of thef the type size. A positive value shifts the text up
caret further apart or closer together. Characters and a negative value shifts the text down.

are moved apart using positive kerning values or shift

closer together using negative values. Kerning is Vertical 100%

normally used to improve the appearance of Vertical ... -50%
shi

certain letter pairs such as AV and WA which

look better if they are moved closer together. In Ro_tate _
the examples below the first pair of letters are  This effect rotates characters about their centres,

pair have a kerning value of -200. anti-clockwise, and a negative value rotates text
clockwise. The best results are obtained with

AV upper case text.

TEXT RO ATED TO 20°
AV TEXT ROTA TEDTO -20°

Kerning values are specified in units of .001 of an
em space and can be any integer value between
-1000 and 1000. I@vation Pro, an em space is
defined as the current point size.

Please note that the latest outline fonts incorporate
auto-kerning which automatically improves the
appearance of some letter pdsse 5.4)

However, you may wish to use tfieack option

for fine tuning.
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Skew

This effect skews text to the angle specified. A
positive value skews the text to the right and a
negative value, to the left. The angle is specified
in degrees and must be within the range -80° to

80°.

Text skewe0°
Textakewed-20°

Bold

Bold selects the bold variant of the current font

(see 4.4)

Example ofbold text

Italic

ltalic selects the italic variant of the current font

(see 4.4)

Example ofitalicised text

Superscript

This effect produces superscript téste 4.4)
Example ofsuperscripttext

Subscript

This effect produces subscript tézee 4.4)
Example ofsupscripttext

P Underline spe.. [HE3 |

™ YWard [~ Double

Width|  Thin B
Colour é *H
Cancel | I

4.11 - The Underline specification dialogue box.
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Underline

This effect underlines text. Click on the icon to
the right of thdJnderline option to display the
Underline specificationdialogue boxfig. 4.11)

Word underline underlines all characters except
spaces.

Double underline underlines with a double line.

Example of underlined text
Text word underlined
Double underlining

Width opens a menu allowing you to specify the
width of the underlinindfig. 4.12) The width is
specified as a percentage of the type size of the
first character on the lind@hin is 2%,Medium is
4% andThick is 8%. You can enter a value in the
icon which shows the width in the range of 1% to
50%.

It is also possible to enter an absolute underline
width in size units, points etc. Values followed by
a % will be taken as a percentage anything else
will be taken as absolute with a default unit of
points.

Colour allows you to specify the underline colour
using the standar@vation Pro colour picker. The
default colour isTransparent, which has a

special significance when used for underlining. It
causes the underline colour to be the same colour
as the text being underlined. This means that if the
text colour is changed, the underline colour will
change to match.

v Thin
kedium
Thick

4.12 - The Width menu
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Strikeout

This effect draws a line centrally through the text.

Example-of-text-with-strikeout.

Click on the icon to the right of tHgtrikeout
option to display th&trikeout specification
dialogue boxfig. 4.13) Width andColour
options are the same as for underline above.
Small caps

This effect changes all lower case letter to small
capitals. The default size is 65% of normal
capitals, but this can be changed in
Misc=>Preferencegsee 15.14) Citrl+Shift+P

ExampLE oF SvaLL Caps

Reverse

Reverseswaps the text foreground and
background colourésee 4.4)

Example offg¥=I§]s text

¥ Strikeout spe__. H |

Width | Thin %
Colour Wéﬁ

Cancel | QR

4.13 - The Strikeout specification dialogue box.

CHAPTER 4
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This chapter describes how to format paragraphs using local format
effects. These are applied directly to an individual paragraph or
selection of paragraphs and take effect immediately.

Local effects are normally used when you wish to make a simple change to a
document, such as justifying a paragraph. If you are producing a short or simple
document then it is practical to use combinations of local effects, since if you
want to change them, it is reasonably quick to do so in a short document.

In long or complex documents you should use defined styles described in
Chapter 6. These allow style and format effects to be combined together in a
named style and applied in a single operation. Defined styles may easily be
modified at a later stage, automatically updating all occurrences in the document.
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5.1 Applying Format Effects Copying Format Effects
Menu=Text=>EFormat You can copy the format attributes from one
aragraph to another. To do this, place the caret in
e destination paragraph (or select a range of
paragraphs), then hold down Shift and right click
in the source paragraph. This facility does not
copy text effects such as bold and italic.

dClearing Effects

You can clear all local format effects from the

_ caret or from a selected region by choosing
Format effects can only be applied to whole Styles>RemovesLocal effect (fig. 5.2)
paragraphs. A paragraph is defined as being the

text between two Return characters, so it may be a
single line heading or a multiple line paragraph.

Local format effects are used to change the form
of paragraphs of texlignment andLeading on
the Text menu(fig.5.1) provide the basic format
effects. The Format dialogue box provides the
complete range of text formatting effects.

Tabs opens the tab ruler and allows tab stops an
indents to be set.

If you want to start a new line within the same
paragraph chooddisc>Insertr>New Line or
press Shift Return.

Changing a Single Paragraph
To change the format of a single paragraph,
position the caret in the paragraph and choose the

required effect from the appropriate menu or
dialogue box.

Changing Multiple Paragraphs
If you select a number of paragraphs, formatting

will affect all paragraphs wholly or partially
selected.

bodify text.. FR

Faont... Ctrl+Shift+F
oize J
Effect *

Colour...
Editstle.  Cl+Shift+E |

Format... Femove Al styles and effects  Cirl+Q)

Alignment " Local effects Ctrl+Shift+L
Leading > v Bodytext Ctrl+F1

Tabs... Ctrl+Tab L2z _ Heading

Fig. 5.1 - The Text menu. Fig. 5.2 - Use Local effects to remove effects.
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5.2 Alignment Justify

Menu= Text>Alignmente Justify aligns paragraphs so that both left and

To align selected paragraphs choose the alignmerrll%'ht edges are aligned to the margins. It does this

you require from thélignment menufig. 5.3)or by inserting extra space between the words on

) ) each line.
from the info palettéfig. 5.4)
Justify aligns paragraphs so that both left and right
Left edges are aligned to the margins. It does this by

Left aligns paragraphs to the left margin, leaving inserting extra space between the words on each
the right edge ragged. This is the default state. It is line.

also referred to as ‘flush left’, ‘ranged left’ or By defaultOvation Pro uses the Windows font
‘ragged right'. manager to justify text by inserting extra space
Left aligns paragraphs to the left margin, leaving between the words only. However it is possible to
the right edge ragged. It is also referred to as achieve greater control over justification by
flush left’, ‘ranged left’ or ‘ragged right’. inserting extra space between letters. This feature
Centre is called letter spacin@ee 5.7)

Centre aligns paragraphs centrally between the Current Alignment
left and right indents, leaving both left and right e alignment that is current at the caret or

margins ragged. throughout a selection is ticked on thiignment

Centre aligns paragraphs between the left and right menu and indicated in orange on the info palette.

margins, leaving both margins ragged. ) ) .
If there is more than one alignment setting in a

Right selection, there will be no tick on the menu and no
Right aligns paragraphs to the right indent, alignment indicated on the info palette.
leaving the left edge ragged, It is also referred to
as ‘flush right’, ‘ranged right’ or ‘ragged left’.
Right aligns paragraphs to the right indent, leaving
the left edge ragged, It is also referred to as ‘flush
right’, ‘ranged right’ or ‘ragged left’.

v Left Cirl+L
Centre  Cil+E
Right Cirl+R
Justify  Cirl+d

Fig. 5.3 - The Alignment menu.

| Textframe  x[tomm |w[190mm | | Trinity B[ 12t G
| 1.1 y[1omm |H[zr7mm | [N B| 7| U|R| 1| 2| E 2| &=
/

Centre align

Left align

Right align
Fully Justify

Fig. 5.4 - The info palette allows you to align or justify paragraphs.
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5.3 Leading Absolute Leading

Menur> Textr>Leading= This is the distance between the base lines of each

The Leading menu(fig. 5.5)allows you to set the line of type(fig. 5.6)

vertical spacing between lines of text. The example below uses 17pt absolute leading.
Notice that the line spacing is equal throughout

}he paragraph, regardless of the type sizes present.
ftis important that the value specified is large
enough to accommodate the biggest type size

Singlespaceis the default leading and should be
suitable for most purposes. It is equivalent to 209
relative leadindsee overleaf).

Single space is the default leading and should be otherwise lines will overlap.

suitable for most purposes. It is equivalent to 20%

relative leading (see overleaf). This example uses 17pt absolute leading. Notice that
Double spacegives increased line spacing and is e neSPACINGis equal throughout the
equivalent to 120% relative leading. paragraph, regardless of the type sizes present.

Double space gives increased line spacing and is Absolute leading is useful if you wish to align text

equivalent to 120% relative leading. with other objects, such as lines. In the example

below, the lines have been duplicated at 6mm
Other leading values can be entered in the Modifyertical offsets and the text is set to 6mm absolute
Format window(see the next sectign)sing one  leading.
of the three methods described belalsolute

(Va|ue entered as Suc[n&Jative (Va|ue followed Absolute leading is useful if you wish to align text
by a %)or incrementaleading (value preceded by with other objects, such as lines. In this example
a+orbya-). the lines have been duplicated at 6mm vertical

Please note that the default units for absolute anc offsets and the text is set to 6mm absolute leading.

incremental leading are points, but you may

specify another unit after the value e.g. 5Smm.  You may see type described as ‘10 set on 17’ or
10/17. This means 10pt text with 17pt absolute
leading.

Modify text.. FB

Faont... Ctrl+Zhift+F
oize *
Effect k

Colour. Op

Format...
Alignment *

Leading v Single space 45pt
Tahks... Ctrl+Tak Double space q

Fig. 5.5 - The Leading menu.

Fig. 5.6 - Absolute leading.
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Relative Leading
This is specified as a percentage of the current

LeaDING 55

Incremental Leading
This is specified as a value to be added to, or

type size. For example, if the type size is 45pt andubtracted from, the current type size. For
the leading is 20%, the line spacing is 45pt + 20%xample, if the type size is 45pt and the leading is

of 54pt(fig. 5.7).

To use relative leading you must ad#hto the
value e.g15%

Relative leading is the default type of leading
because it produces line spacing that is
proportional to the type size being used. In the
example below, the line spacing is increased to
accommodate the larger type on the third line.

This example paragraph uses 20% relative leading.
Relative leading is popular because it produces well

proportioned linéSPACINGhat is relative to the
type size being used.

Op 54.09pt (45pt + 20% of 45pt)

|
qR

Fig. 5.7 - Relative leading.

+5pt, the line spacing is 45pt + §fig. 5.8).

To use incremental leading you must prefix the
value with a + or - e.gt5pt or-2pt .

The example below uses +5pt incremental
leading. Notice that the gap between the lines is
equal throughout the paragraph, irrespective of the
type size.
A positive value specifies the gap between the lines.
This example uses +5pt incremental leading. Notice
that the gap between the lines is equal throughout the
paragraph, regardless of the type size.

Negative incremental leading closes the gap
between lines and can cause them to overlap. The
example below uses 12pt and 24pt text with -12pt
incremental leading.

Spétial

Current Leading

The leading that is current at the caret or
throughout a selection is ticked on tteading
menu.

If there is more than one leading value in a
selection, there will be no tick on the menu.

Op 50pt (45pt + 5pt)

|

qR

Fig. 5.8 - Incremental leading.
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5.4 The Format Dialogue Box For example, th&ormat dialogue box shown in
Menue Text=>Eormat fig 5.9_show_s the formatting effect_s presentin a
] . . selection. Sinc&pacebefore andAlignment are
TheFormat dialogue box(fig. 5.9)provides all blank, it means that they are not consistent

the formatting options that may be applied to the throughout the selection.

current paragraph or a selection of paragraphs. . ) o
The same is true fakuto hyphenation which is

indicated with a ‘crossed’ button. Blank buttons
such as that fddrop capital, indicate that the

Please note that the indent options on this
dialogue box may also be specified on the tab

ruler (see 5.5). effect is switched off throughout the selection.
Current Format Options Ticked buttons such asuto kerning, indicate
TheFormat dialogue box reflects all the settings that the effect is switched on throughout the
that are current at the caret or throughout a selection.

selection.

If any effects are not present throughout a
selection of paragraphs, they are indicated on the
Format dialogue box as follows:

1. If the effect is set by a value in an icon, that
icon will be blanked out.

2. If the effect is set by a button, the button will
be indicated with a cross.

®Modifyformat  HH|
Left indent| Omm| Right indent | Omm
15t Indent| Omm Alignment | Left EI
Space befare T Space after T
Leading | 20% Paragraph level [0

Dropcap| 3 T Auto insertl 123 r EI

v Auto keming [ Auto hyphenation *H
[T Locktogrid [T Enhanced justification *H
Apply Cancel | Ol

Fig. 5.9 - The Format dialogue box.
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Left Indent

Left indent defines the left margin of the current
paragraph or selected paragraphs. It may be used
to distinguish paragraphs from surrounding text.

The left indent is measured from the left-hand
frame inse(fig. 5.10) or from the standoff of any
obstructing framefig. 5.11).

If the left indent value is preceded by the +
symbol, the indent is measured from the left edge
of the frame bounding bgiig. 5.12) ignoring
any obstructing frameg$ig. 5.13)

=

Theme-
chanical
typewriter, which

originated in the
USA about a centu-
ry ago, represent-
ed the first

Frame bounding box

Tre Formar DiaLocue Box

Frame inset

ma- <«

Fig. 5.10 - The left indent is measured from the

= &

left-hand frame inset.

-

=

The|mechanical
typewriter, which
originated in the
USA about a
century ago,
represented the
first major advance
over pen or pencil.
Its two principal ad-

-

|

Fig. 5.11 - The left indent is measured from the
left-hand frame inset or from the standoff of any

-

obstructing frames.

>

The|
mechanical
typewriter, which
originated in the
USA about a century
ago, represented the
first major advance
over pen or
pencil. Its

—

=

5 £

Fig. 5.12 - If the left indent has a + prefix, the indent

is measured from the left edge of the frame

bounding box.

-

The mechanical
typewriter, which
originated in the

USA about a century
ago, represented the [

first major advance

=

over pen or pencil.
Its two principal ad-
vantages were that a

-

-

Fig. 5.13 - If the left indent has a + prefix, the indent
is measured from the left edge of the frame

bounding box ignoring obstructing frames.

57
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Right Indent

Right indent defines the right margin of the
current paragraph or selected paragraphs. It may
be used to distinguish paragraphs from
surrounding text.

The right indent is measured from the right-hand
frame insetfig. 5.14) or from the standoff of any
obstructing frame€fig. 5.15)

If the right indent value is preceded by the
symbol, the indent is measured from the right
edge of the frame bounding big. 5.16)
ignoring any obstructing framégg. 5.17)

If the right indent value is preceded by the
symbol, the indent is measured from the left-hand
inset or edge instead.

Frame bounding box

CHAPTER 5

The] me-

chanical  type-
writer, which orig-
mpnated in the USA
about a century
ago, represented

Frame inset

D 1

The|

"| " mechanical
type-writer, which
originated in the

ago, represented the
first major advance
over  pen or

the first ma- J

jor
5 i

Fig. 5.14 - The right indent is measured from the
right-hand frame inset.

=

pencil. Its

. =

bounding box.

I = |
The]  mechanical
typewriter,  which
originated in the
USA about a
Fentury ago, m
represented the
first major advance
over pen or pencil.
Its two principal ad-

. = [ll

Fig. 5.15 - The right indent is measured from the
right-hand frame inset or from the standoff of any
obstructing frames.

-

Fig. 5.16 - If the right indent has a + prefix, the
indent is measured from the right edge of the frame

I =

The| mechanical
typewriter,  which
originated in the

USA about a century
mago, represented the

first major advance
over pen or pencil.
Its two principal ad-
vantages were that a

. =

£

Fig. 5.17 - If the right indent has a + prefix, the
indent is measured from the right edge of the frame
bounding box ignoring obstructing frames.
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1st Indent Alignment

This is the first line indent and defines the left ~ This option opens a menu allowing you to specify
margin for the first line of the paragraph only. paragraph alignmerfsee 5.2)
First line indent is specified as an offset from the Space Before

normal left indent. This sets the amount of extra space inserted above

If the 1st indent is given a positive value, then thea paragraph.
first line of the paragraph will be indented from
the left indent by that amou(ftg. 5.18) When
used in this way, the first line indent is often Space After

called theparagraph indent. This sets the amount of extra space inserted below

Default units forSpacebefore are points.

Another use of the first line indent is to create a & Paragraph.

hanging indent. This is where the first line indent Instead of pressing Return to insert a blank line

is positioned to the left of the left indgifig. 5.19  between paragraphs, it is better toSeaceafter

and fig. 5.29) The example shown has a left to the same value as the type size. If at a later
indent of 10mm and first line indent of -10mm.  stage you want smaller gaps between paragraphs,
The number on the first line of each paragraph you can reduce th®paceafter value.

starts at the first line indent. A tgb a_fter the bullet Default units forSpaceafter are points.

forces subsequent text on the first line to start at ]

the left indent. All subsequent lines start at the left€@ding

indent. This sets the amount of space between lines. The
I 0
When using hanging indents, if you want to start %effa;umlt \t/.al:e IS 20%. See sectii for more
new line at the left indent, you should use information.
Menu>Miscr>Insert=>New line Shift+Return.
If you use Return, a new paragraph will be
inserted and typing will commence at the 1st
indent.
i = £l i = £l
The|mechanical 1. 1sfline indent is

typewriter, which
originated in the USA
about a century ago,
mrepresented the first majorg
advance over pen or
pencil.

Its two principal
advantages were that a

. = |

Fig. 5.18 - The text in this frame has a Omm
left indent, and a 10mm 1st indent.

Left indent |  Omm|

1st Indent | 10mm

As seen in the Modify Format window; see Fig. 5.9

useful for creating

numbered or

bulleted lists such as

m this.

2.  Each number or
bullet should be fol-
lowed by atab
character.

. =

|

&

Fig. 5.19 - The text in this frame has a 10mm
left indent, and a -10mm 1st indent.

Left indent | 10mm|

1st Indent | —10mm

As seen in the Modify Format window; see Fig. 5.9



60 FormarTting TeEXT CHAPTER 5

Drop Cap Lock to Grid

Menu>TextcoFormat.... In a multi-column or multi-frame layout, text in
Drop cap changes the first character in the one column or frame may not align horizontally

selected paragraphs taleop cap (fig. 5.20)The with text in the other€fig. 5.21) Lock to grid

depth of the drop should be entered in the writabl@igns text in the selected paragraphs baseline
icon provided. grid. If Lock to grid is enabled, the baselines of

_ S affected text are shifted to align to the grid
The drop cap depth is specified in lines, based ONfig. 5.22)

the depth of the first line. , L . ,
The baseline grid origin and grid spacing are set

Auto Kerning on Misc>Preferences(see 15.14)
Auto kerning uses the kerning data provided with

fonts to improve the appearance of certain
character pairs by adjusting the white space
between them.

Auto Hyphenation

Auto hyphenation automatically hyphenates
words that run over the ends of lifese 5.6)

Please note that this facility only works with fonts Enhanced Justification
that contain kerning data. Enhancedjustification allows you to control

word and letter spacing in justified tgsee 5.7)

1|
|

[DTP ORIGINS | principal acvantages

. were that a c tent
Themechanical by :st could vs::-;:zemuch
typewriter, which ’ F‘l ith a ty it

S . aster with a pewrl er
nated in the USA . .
[JEEELt . cerlwtu , than with pen or pencil [

renresented thr: ﬁrg;:' and that the writing
P! produced was consistent
major advance over pen

. and clearly legible. It
or pencil. lts two ¥ legt
was not surprising, then,

. = |

-

Fig. 5.21 - The baselines of text in columns do not align.

t hel = hanical £l F: = £]
e/mechanica
typewriter, which DTP ORIGINS principal advantages
originated in the The[mechanical were that a competent
USA about a typewriter, which typist could write much
mrentury ago, represented [ [j:)rigin ated in the USA faster with a typewriter 0
the first major advance about a century ago, than with pen or pencil
over pen or pencil. lts represented the first and that the writing
two principal advantages major advance over pen | produced was consistent
were that a competent or pencil. lts two and clearly legible. It
o = &l L = £

Fig. 5.20 - Drop cap, 4 lines deep. Fig. 5.22 - Use Lock to grid, to align the baselines of text.
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5.5 The Tab Ruler Moving Tabs
Tab stops are inserted into the document by To move a tab, click over it and drag it to the
pressing the Tab key. required position. Alternatively, click on it to

The tab ruler allows you to specify the exact tab hlghllght it in red, then enter the required position

. " in thePositionicon onTabs dialogue box. Press
and indent positions for the current paragraph or e
: Return to set the tab to the new position.
selection of paragraphs.
You can select a number of tabs by left clicking
Menuci>-TextE:>Tabs... _ Ctrli+Tab over the first one, then holding down Control and
After choosingTabs, the tab ruler is placed over |eft clicking over any other tabs you wish to add

the top of the current paragraph or selection of o the selection. A selection of tabs can be moved

paragraphéfig. 5.23) The ruler is the width of the in one operation by dragging any of the tabs in the
frame less the insets. The markings on the ruler selection.

are in the current units. Left click over the ruler markings to deselect all

Setting Tabs tabs.

To set a tab, choose the type of tab you require Deleting Tabs
from theTabs dialogue box, then click on the .

. . ... _To delete a tab or selection of tabs, drag them
white area of the tab ruler at the required position, own onto the tab ruler
Further clicks on the tab ruler will set more tabs og '
the chosen type. Clear

If you want to set tabs at precise positions, selectAlternatively all tabs can be removed by clicking

the type of tab you require, then enter the exact ©" the Clear button.
position in the icon labelleBosition. Press
Return to set the tab.

When you have finished setting tabs, click@ik
to update the document.

Beyond the position of the last tab stop explicitly
setOvation Pro will generate virtual stops every
10mm.

v ]
TTT T[T I T T[T T T T T[T I T[T T T T[T T T[T I T T[T TTT[TITI
[ 20 40 B0 80 100

N Tooal. o TTHOL A L

The mechanical tyvpewriter Whiclr pre e
‘ altyl Ml ¥ Tabs |

a century ago, represented the fu

pencil. Its tvo prmeipal advantas | & | g tap £ Left indent
typist could write much faster wi| ¢ centre tab  First indent
or pencil and that the writing pro | ¢ Right tab  Right indent

Melearly legible. It was not swpris |~ pecimal tah |
heralded an ‘office revolution’ i
manufacturers made fortunes, Ty | 120 leader I
gchool curriculum. Despite its m
mechanical typewriter suffered ¢ Fosition I 29rmm ||
ag the typast hit
I = Clear | Cancel | Ok

Fig. 5.23 - The tab ruler is displayed above the current paragraph.
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Left Tab Decimal Tab

The left tab causes text to be left aligned to the tabhe decimal tab causes decimal points to be
stop(fig. 5.24) aligned to the tab stdfig. 5.27) The decimal
Centre Tab point character is usually a full stop, but may be
The centre tab causes text to be centred on the tnge f'.n.ed mMscc}Prefgrences(see 15.14)in
stop(fig. 5.25) .adclllt.lon the vvptable icon can be used to set an

individual decimal tab character for the currently
Right Tab selected tab. If this is left blank the setting from
The right tab causes text to be right aligned to thedocument Preferences will be used.

tab stop(fig. 5.26) Text that doesn't contain a decimal point character

is right aligned to the tab stop.

e e
r|||||||||||||||||||||II‘ r|||||||||||||||||||||II‘
F al F al
January January
February February
March March
April April
m May 0 0 May 0
June June
July July
August August
September September
4 = 1 4 = 1
Fig. 5.24 - Left tab. Fig. 5.26 - Right tab.
4 v § 4
|||||||||||||||||||||||j I__IIIIlIIII||||||||||||Ij
[ b i b
January 123.45
February 78.56
March 9.25
April 0.125
m May 0 0 5 m
June 10
July 100
August ABC.DE
September GHI
4 = 1

Fig. 5.25 - Centre tab.

. =

Fig. 5.27 - Decimal tab.
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Tab Leader
TheTab leaderis a string of one to four
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Setting Indents
The tab ruler may also be used to set the positions

characters that are automatically printed in the talf the indents. Indents may also be set on the

space.

Typically theTab leader string is set to a full stop

Format dialogue box, so please refer to that
section of this user guide for full details on the

(or a full stop and a space character), and is ofterPP€ration of indentsee 5.4)

used in the contents pages of books and
magazinegfig. 5.28)

Different Tab leader strings can be set for each
tab. The string shown in the icon will be for the
currently selected tab.

[ = Bl
CONTENTS
Introductionl ........ 1
Getting Started .. .. .. 4
BasicDTP.......... a

Advanced DTP .. ... 10 m
Pictures. . ......... 12
Objects .. ......... 14
Index. ............ 16
Glossary . ......... 18

4 = £

Fig. 5.28 - Page numbers
tabbed right with ‘dot-space’ tab

ThelLeft indent and1stindent are displayed
together at the left end of the tab ruler, and the
Right indent is displayed at the right end of the
tab ruler(fig. 5.29)

You may drag the indents to re-position them.
Alternatively, click on an indent to highlight it,
then enter the required position in fPesition
field of theTabs dialogue box.

You can move théeft indent andlstindent
together by selecting them both and dragging in
one operation.

Unlike tabs, you cannot delete indents.

1stindent Right indent

/ Left indent \

r'd )
r
TTTT

E TTTT m
The mechanical typewriter, which

originated in the USA about a

century ago, represented the

first major advance over pen or
m pencil . Its two principal m
advantages  were that a
competent typist could write
much faster with a typewriter
than with pen or pencil and

. = [ll

Fig. 5.29 - Indents may be set on the tab ruler.
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5.6 Automatic Hyphenation Auto Hyphenation

Normally when a word runs over the end of a linelf Auto hyphenationis enabled, words that run
the entire word is transferred to the start of the over the end of lines are automatically hyphenated.

next line. This process is callewrd wrap Ovation Pro uses a hyphenation algorithm and an
Alternatively, you may hyphenate words so that exceptions dictionary to determine the best place
they are split at the end of lines. This enables texin a word for a hyphen. The exceptions dictionary
to be fitted better into frames; especially in narroveontains words that should not be hyphenated or
columns. In justified text, it also reduces the size should only be hyphenated in a specific way. You
of the gaps between words. may edit or add words to the exceptions dictionary

You may manually hyphenate a word by typing a if required(see 14.8)

hyphen- at the required place. If that word runs  please note that hyphenation exceptions do not
over the end of a line, it is split at the hyphen.  take effect until the text is re-flowed.

Soft Hyphen The hyphenator ignores words that already
Alternatively you may insert softhyphen by contain a normal, soft or hard hyphen, or words
typing Citrl -. A soft hyphen does not appear until containing non-alphabetic characters. In some

it is needed i.e. if editing the text causes the wordcases it may decide there is no suitable place for a
to run over the end of a line. In this situation, the hyphen, in which case the word is not hyphenated
soft hyphen becomes visible and the word is splitand word wrap occurs.

at the hyphen. If editing causes the word to Move s he automatic hyphenator splits a word

away from the end of a line, the soft hyphen will incorrectly, you may do one of two things:

disappear. . -
1. Add the word to the exceptions dictionary

specifying the correct hyphen position or
specifying that the word should not be
hyphenated at all.

You may delete a soft hyphen when it is visible
using Delete or Copy in the usual way. You may
also delete an invisible soft hyphen. To do this,
step through the word containing the soft hyphen

until the caret steps over the invisible hyphen, ~ 2- Type a soft hyphen using Ctrl - at the start of
then press Delete. the word. This will stop the word from being

hyphenated.
Hard Hyphen

If you want a hyphen in a word, but do not wish to
split the word at that hyphen, you may insert a
hard hyphen using Ctrl Shift -.
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Auto Hyphenation Options
Menu= Text>Format...

TheAuto hyphenation dialogue boxfig. 5.30)
allows you to control certain aspects of the
automatic hyphenator. This box is displayed by
moving the pointer of the icon to the right of

Auto hyphenation.

It is not good practice to hyphenate very short
words, saMinimum charactersin word
specifies the smallest size word that will be

hyphenated.

Minimum before hyphen specifies the minimum

Automatic HYPHENATION 65

Hyphenation zonespecifies a zone measured

from the right margin. The start of the last word in
the line must be outside this zone, for it to be
considered for auto hyphenation. The hyphenation
zone only has an effect on text that is left aligned.

If Break last word of paragraph is selected, the
hyphenator will attempt to break the last word in
the paragraph should it run over the end of the
line. Generally this is not regarded as good
practice, so this option is normally not selected.

The hyphenator does not normally split capitalised
words, but you may seleCapitalised words if
you wish it to do so.

number of characters in the word that must
precede the hyphen. This prevents the hyphenator
splitting a word too close to its start.

Minimum after hyphen specifies the minimum
number of characters that must follow the hyphen.
This prevents the hyphenator splitting a word too
close to its end.

It is not good practice for too many consecutive
lines to end with a hypheMaximum
consecutivehyphensprevents this by specifying
the maximum number of consecutive lines that
may end with a hyphenated word. If this limit is
reached, the word at the end of the line will not be
hyphenated. A value of 0 means that there is no
maximum limit.

¥ Hyphenation specification HE

Minirmum characters in sword 5|

Minimum befare hyphen | 2
Minimurn after hyphen | 2

Maximum consecutive hyphens | 3

Hyphenation zone Opt
[T Break last word of paragraph

[T Break capitalised words

Cancel ]2

Fig. 5.30 - The Auto hyphenation dialogue box.
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5.7 Enhanced Justification Word Spacing
Menu=Text>Eormat. .. Minimum andMaximum are the expansion

When a paragraph is justified, both left and right limits for word spacing. The values are specifie.d
edges are aligned to the maréins. Normally this %> percentages, where 100% represents the width
done by increasing the gaps between words untiI.Of a ?ta”df"“‘?' space c.hgracter. Iftext gannot be
the line fits; this is calledord spacingIn some J.UStmEd W'th.'n. these limits, letter spacing is
circumstances, especially in narrow columns, this'ntr()du_ced (i It‘ I? enabled).
can result in large gaps appearing in lines of text.Réducing théinimum value should enable you
If these gaps join up over a number of consecutivé® fit more text into lines, although some clarity

lines, an undesirable effect called ‘rivers of white’Will be lost as words get closer together.

may be produced. Increasing thélaximum value allows word

Auto hyphenation can help reduce these spacing to become much greater before any
problems, but for best results you should use attempt is made to use letter spacing. This value
Enhancedjustification . This gives control over ~ has no effect if letter spacing is not enabled.
word spacing, and allows you to introduce letter | etter Spacing

spacing, should word spacing become excessivejinimum andMaximum are the expansion

Enhanced justification is controlled from the limits for letter spacing. The values are specified
dialogue box which is displayed by moving the as percentages, where 100% represents the width
pointer over the icon to right &nhanced of a standard space character. A normal letter
justification (fig 5.31) space is 0%.

To disable letter spacing, $dtnimum and
Maximum to 0%.

A negativeMinimum value may cause letters to
overlap.

A largeMaximum value will give excessive letter
spacing which is regarded as bad practice.

¥ Enhanced justification |

—Letter spacing —'WWaord spacing

Minimurn | O] 9 Minimum | 78 o4

Maximum | 25 % | | Maximum | 125 9%

™ Single words

Flugh zone| Omm

Cancel 8]

Fig. 5.31 - The Enhanced justification dialogue box.
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Enhanced Justification Rules

Ovation Pro tries each of the following steps,
until the text becomes justified.

1. Increase word spacing from 100% up to

Maximum.

2. Decrease word spacing from 100% down to

Minimum .

3. Set word spacing tdlaximum and increase
letter spacing from 0% t®laximum.

4. Set word spacing tdinimum and decrease
letter spacing from 0% tlinimum .

5. Increase word spacing froktaximum until

the line fits.

Notice thatOvation Pro attempts to justify the
text using word spacing before trying letter
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Justification Examples

The examples below show how the same
paragraph may be justified in two different ways.

The first exampléfig. 5.32) uses standard
justification. Word spacing is increased until text
fits on a line, and there is no letter spacing.

The second examp(ég. 5.33) uses enhanced
word and letter spacing:

Word spacingvlinimum 75%
Word spacinglaximum 125%
Letter spacingvlinimum 0%
Word spacinglaximum +25%

Notice that there are fewer large gaps between
words and more text fits into the frame.

spacing, and increases spacing before decreasing.

I = 1|
The| mechanical
typewriter, which
originated in the USA
about a century ago,
represented the first major
advance owver pen or
opencil. Its  two principalg
advantages were that a
competent  typist could
write much faster with a
typewriter than with pen
or pencil and that the
writing  produced  was
. = |
Fig. 5.32 - Standard justification.

-

I = Bl
The mechanical typewriter,

which originated in the
USA about a century ago,
represented the first major
advance over pen or
pencil. Its two principal
madvantages were that ag
competent typist could
write much faster with a
typewriter than with pen or
pencil and that the writing
produced was consistent
and clearly legible. It was
. = |
Fig. 5.33 - Enhanced justification with
letter spacing.
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Other Justification Options

Normally when text is justified, if there is only a
single word on a line, it becomes left justified
(fig. 5.34) If Single words is selected, a single
word on a line is justified by adding sufficient
letter spacindfig. 5.35)

Flush zoneallows you to control justification of
the last line in a paragraph Normally the last line
of a justified paragraph is not justified. However,
if the end of the line is near to the right margin, it
may look better justified.

Flush zonedefines a zone measured from the
right indent. If the end of the last line of the
paragraph falls within the flush zone, then that
line is justified.

By defaultFlush zoneis set to 0, which means
that the last line of a paragraph will never be
justified.

I = | I = |

It was| not surprising,
then,  that  the
typewriter heralded
an ‘office revolution’
in which typewriter
manufacturers made
[jortunes. Typingg
became part of the
school  curriculum.
Despite its  many
advantages, the
mechanical

typewriter  suffered
. = |

-

Fig. 5.34 - The single word

is not justified.

It was| not surprising,
then, that the
typewriter heralded
an ‘office revolution’
in which typewriter
manufacturers made
pfortunes.  Typingg
became part of the
school curriculum.
Despite its many
advantages, the
mechanical
typewriter suffered
. = |

-

Fig. 5.35 - The single word is
justified.

CHAPTER 5
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5.8 Automatic Paragraph Numbering Ovation Pro lets you automatically insert a
It is possible to automatically insert bullet points character before the bullet and a character after it -

or number paragraphs. These facilities are in this example the brackets around the numbers.

controlled from the Format dialogue box. In addition you can arrange for the bullet to be
followed by a tab character. Finally it is possible

Menu=Text>Format. .. to choose a different style for the numbering. For
Paragraph Level example Roman numbers or a letter.
This lets you set a level for each paragraph. If you are going to climb Mount Everest you

Levels can be in the range 0 to 7. In older versions need to take;
of Ovation Pro which do not support this feature, a) Warm pullover

the paragraph level defaults to 0. b) Boots and socks
Uses of the paragraph level are structured c)  Woolly Hat
documents with automatic numbering of d) Map and compass
paragraphs and automatic contents generation. ~ €)  Sandwiches

f)  Money for bus fare home
Auto Insert

Auto insertion controls the automatic insertion of apother aspect of paragraph numbering is in
paragraph numbers or bullet points at the start of 5y ctured documents. At the simplest level, each

each paragraph paragraph in the document may be given a
Bullet points are symbols inserted before each number, allowing easy reference. More often the
entry in a list for emphasis. document will be split into chapters, the chapters

If you are going to climb Mount Everest ensurdnto sections, and the sections into sub sections.
you have: Thls_process can continue through sub sub
OWarm pullover sections and so ofQwvation Pro supports up to 8

OBoots and socks levels of paragraph numbering. This is an example.

OWoolly Hat
OMap and compass Chapter 1 - Getting ready for the expedition
OSandwiches 1.1 Raising funds
OMoney for bus fare home 1.1.1 Visiting the bank manager
Note that the bullet symbol is in a different fontto 11 o Arranging a jumble sale
the text which follows it. In fadDvation Pro 1.2 Gathering supplies
allows you to use a defined styfkee Chapter 6) 1.2.1 Army and Navy stores

for these, which means they can notonly be ina 1 2 2 kpitwear world

different font, but a different point size, colour etc. 1 2 3The big butty sandwich bar

You could of course produce the above list by

inserting each bullet by hand, the point of this  oply headings are shown. Normally the above sub
feature is that by merely applying an effect or  nheadings would be followed by the text of the

style the bullets can be generated. document. Notice that in this exameation

In paragraph numbering, instead of the bullet Pro has been told to include the chapter number as
point, numbers are used for each member of the part of the paragraph numbig. 5.36)

list. Most people will have encountered documents
If you are going to climb Mount Everest six  like this and used them successfully, yet the
essential items are structure is quite subtle. The numbering of sub
(1) Warm pullover sections is reset when there is a new section at a
(2) Boots and socks higher level. So section 1.2 is followed by 2.1 - as
(3) Woolly Hat the first number changes from 1 to 2, the second
(4) Map and compass number is reset to 1, its starting value. The general
(5) Sandwiches rule is that when a section number changes all

(6) Money for bus fare home more subordinate section numbers are reset.
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This is made to work i@vation Pro by allowing The bullet window(fig 5.36)allows the format of
paragraphs to be given a level value. Level one the bullet to be set.

has the highest priority, and level 7 the next to
Iovyest. _So level 1 is what section headings are paragraph numbers will be displayed. This choice
written in, and level 7 would be_ used for sub-sub-cq 15 which of the following two sections in
sub-sub-sub-_sgb-sub-sub sections. In the examplﬁe window is relevant.

above'l.1 Raising fundsis a paragraph in level

Bullet andNumber select if bullet points or

1.“1.1.1 Visiting the bank manage a For bullet point8Bullet symbpl shows the: .
paragraph in level 2. You can confirm this by symbol used and t.he menu icon tq the right will
positioning the caret in the text and pressing open the usudvation Pro chars window
Control F to look at the ‘Format’ window. allowing you to change the symbol.

Level zero has the lowest priority, but it is special "Or number&lumber format shows the number

because its number can always appear after the format and the menu icon to the right opens a
lowest priority other level in use in a paragraph Menu to set the forma&tart number lets you
number. So if your document only needs two ~ €nter the starting number.

levels of sections (like the example above) you The final group of icons is common to bullet
can have the paragraph numbers shown in a points and numberS§tyle lets you optionally set a
sensible way e.g. 2.2.1.1 rather than style for rendering the bulle€haracter before
2.2.1.1.1.1.1.1.1 (showing all 7 levels). andCharacter after allow you to enter characters
To repeat this, in a paragraph number like 1.2.3 {© be displayed before and after the bulleth

the number ‘1’ is the level 1 number, the 2’ is after controls if a tab will be inserted after the
from level 2 and the ‘3’ from level 3. However jt Pullet point. This is often useful in combination
is possible to arrange things so that the ‘1’ is the With hanging indents and so on.

chapter number and the ‘3’ is the level 0

paragraph number. Supposing though that 1.2.3

represents the level 1, 2 and 3 numbers. Then

1.2.3 will only appear at the start of a level 3

paragraph. The next level 3 paragraph will display

1.2.4. If the paragraph is in level 2 then the

number would appear as 1.2 and the next level 2 |
paragraph will have number 1.3. e — -

. " Bullet & Number
Its necessary to be clear that one style and either

another style or an effect are involved when — Bullet

talking about bulleting. The first style is actually Bullet symbol I_El

used to render the bullet (red, 15pt, Dingbats). Th

other style or effect is what tel@vation Pro that — Numbet

bullets should be inserted. The problem is that on o .
would like to call both these styles “the bullet Number format [ 123/c.n..— |
style”. The first instinct is to define a new style Start number | 1

called ‘BulletStyle’ and immediately the meaning

is lost. Which of the two styles is ‘BulletStyle’?
. . . W

So in this document the style used for rendering style Bodytext 4 EI

the bullet is called ‘BulletPoint’ and the one that is Character before W Tab after

used to insert bullets is called ‘BulletList’. —_—
Character after

The icon to the right ofuto insert in the Format
window shows the bullet format, the option icon
to the right of that controls if bulleting is on or off.
Finally the menu icon on the far right opens the
bullet window.

Cancel e

Fig. 5.36 - The Bullet dialogue box also showing that the
chapter number is included as part of the number format.
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The format menyfigure 5.37)sets the format
used for paragraph numbers.

The top part shows the way the numbers are
displayed.

123 normal Arabic numbers.
il lower case Roman.
Il upper case Roman.
abc lower case letters ato z
ABC upper case letters.

123anumbers for all levels except the last for
which a lower case letter is used.

123Athe same but with an upper case letter.

The bottom part controls what numbers are
displayed.

n current level number.
n.n...all levels from level 1 to the lowest one.

c.n... the same but preceded by the chapter
number.

In the format windows the icon to the right of

Auto insert displays the text from the two parts of
the bullet format menu e.g. 123/n is Arabic style

numbering for the lowest level.

A subtle point is that a given point in the text can
only have one paragraph level value and it must
have such value. So wherever you position the
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generation. As far as bulleting is concerned such
text is ignored when it comes to calculating
paragraph numbers.

If a section contains some numbered paragraphs,
then some paragraphs of the same level with
bullets (as opposed to numbers), followed by
more numbered paragraphs, then the effect will be
that numbering is reset to the start value after the
bulleted area. This may be a useful trick to reset
numbering for special effects.

Level O has another special feature, this is that a
level O paragraph which does not have bulleting or
numbering active will reset the level 0 number.
This means that level 0 can be used for producing
a number of lists within a text story which does

not have any higher level text. For an example see
the first page of this section, where the after the
list numberered (1), (2)... the next list a,b,...
follows starting with the letter a, and with no
intervening higher level paragraphs to reset the
level O number.

caret in a document, it is possible to ask what the

level is and get a unique answer.

Note that it is possible to assign a level to some

text without automatic paragraph numbering being

active. This is intended to support contents

v 123
iii
Il
abc
ABC
123a
1234

Ll
n.n...
...

Fig. 5.37 - The Bullet Format menu.
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Notes:



Defined Styles

6.1 OVBIVIBW . . o ottt e e
6.2 The Edit Style Dialogue BoX. . . ...... ..
6.3 Creating Styles . . . ... .
6.4 Editing Styles . ... ...
6.5 Renaming & Deleting Styles. . .. ........ . ... . L
6.6 ApplyINg Styles . . ..o
6.7 Removing Styles. . . ... .. . . .
6.8 Merging Styles . ... .

Local text and format effects described in chapters 4 and 5 allow you to
instantly alter the style of text. However, if you need to apply

combinations of effects, it is much easier to define a style that combines

all the required effects, and then apply that style in a single operation.
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6.1 Overview Scope

A defined style is a combination of effects with a Normally, a style is applied to a selected region,
unique name that can be applied to text in a singleut you may also definestopewhich specifies
Operation_ It enables you to app|y Comp]ex the amount of text that will be affected when the
combinations of effects quickly and consistently Style is applied. For example, a style with
throughout the document. So if you want headinggaragraph scopés applied to entire paragraphs.
to be 18pt bold, you could define a style called  This can save a lot of time because it eliminates
Heading to be 18pt bold, and apply ittothe  the need to select paragraphs before applying
appropriate headings. styles.

A further advantage of a defined style is that if ~Keypresses

you change its definition, all text in that style is  Another time saver is the ability to assign a
automatically updated throughout the document. keypress to a defined style. The style can then be
So if in the example above, you decide that applied at the press of a key.

headings should be 24pt instead of 18pt, you need

only change styléleading to 24pt. Once this

has been done, all headings will automatically

change to 24pt.

Bodytext

Initially all text in Ovation Pro appears in a pre-
defined style calle@odytext . By default
Bodytext is 12pt Arial, but you may edit the
definition as required. So if you ruiwation Pro
and type in a letter, the text of that letter will
appear in 12pt Arial. If you then change
Bodytext to 13pt, all the text in the letter will
be automatically updated.

You may overlayBodytext with other defined
styles or local effects. These may overwrite
various attributes dBodytext . Local effects are
always applied on top of all other styles,
irrespective of the order in which they were
applied.

Overlayed styles and effects may be removed
from a selected region, but the base style,
Bodytext , must remain.
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6.2 The Edit Style Dialogue Box The bottom panel of the dialogue box shows a
Menu>StylebEdit Style... Ctrl+Shift+E summary of the attributes of the selected style. So

) _ Bodytext sets the font to Times New Roman, the
ChooseStyleEdit style (fig. 6.1)to opena size to 12pt, the text foreground colour to Black
dialogue box which allows you to create, edit,  qtc.

rename and delete styl@wgy. 6.2).
_ _ _ The buttonsT'ext, Format andTabs are used to
The small window in the top left of the dialogue it the selected style.

box lists all the styles that have been defined. If _ _ _
necessary, use the scroll bar to scroll through theAY change_s made_ n tl@'_t style dialogue '?OX’
are not applied until you click d@K. If you click

list. One style in this window will be pre-selected _ _
ready for editing. The pre-selected style is the on Cancelthe dialogue box will be closed and all
the styles will remain unchanged.

style at the caret, or if there is more than one styl
at the caret, the one that was applied last. Pressing Menu over the list of defined styles
opens a save box which can be used to save all the

Initially there is only one style, Bodytext, so this > _
style definitions as a text file.

is pre-selected.
Clicking and dragging a style in the list of defined
styles lets you reposition it. This is useful if you

] find it convenient to have the styles on the style
The centre panel of the dialogue box showsa  anuin a particular order.

preview of what the selected style looks like. The
preview shows text attributes such as font, size
and colour, but not format attributes such as
alignment and leading. If the previewed text is too
big, it is cropped to fit the preview box.

You may select another style for editing by
clicking on it.

¥ Edit style HE|
List of defined styles \ M Scope | Faragraph
tCh Number Key
Ch Heading
Ch Cantents Text... Farmat... Tabs...

Ch Intra

Style preview\ . =] Y Fename Delete

A
The quick brown fox
Style summary

B Times Mew Roman + 12pt+ Blacdk F + Transparent B + H.5cale 100 +
Before Opt + After Spt+ Leading 20% + Tab ruler

Edit style... Cirl+Shift+E
Rermowve »
Save As. Apply Cancel Ok
v Bodytext Cirl+F1
Ch Mumber ‘

Fig. 6.2 - The Edit style dialogue box allows you to create, edit,
Fig. 6.1 - The Style menu. rename and delete styles.
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6.3 Creating Styles
Menu> Style>Edit styles..>New

To create a new style click dfew and type the
name of the style into tHéew style dialogue box
(fig. 6.3) The name must not be the same as an
existing style name.

By defaultBasedon is not selected, so a
completely blank style is created i.e. all attributes
will have no effect.

If Basedon is selected, the new style will be
based on the style that was selected wihexw
was chosen. However, you can base a new style

on any another style by choosing it from the menu.

Click onOK to create the new style and close the
dialogue box. The style you have created is added
to the list in theEdit style dialogue box, and is
automatically selected ready for editing.

T New style EE
Style name |

Based on Bodytext r ﬂl

Cancel ] 4

Fig. 6.3 - The New style dialogue box.

CHAPTER 6
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6.4 Editing Styles
Menu> Style>Edit styles..coText...

to edit is selected in tHedit style dialogue box

(fig. 6.2)
Text Attributes

To edit the text attributes of the selected style,
click onText. This opens th#odify text
dialogue boxfig. 6.4)providing all the text
effects described earlier in this user guide

(see 4.6)

the left of options such &ont andSize

A ‘cross’ in this icon indicates that when the style

If you editBodytext

is becaus®odytext
To edit a style, first ensure that the style you wishdefine everything.

Attributes such aBold andltalic may have three
states; a cross, a tick or blank. A cross in the icon
indicates that the attribute will have no effect. A
tick means that the attribute is set on, and a blank
means it is set off.

For example if you have some text that is Bold
and Underlined, and apply a style where Bold is
crossed, Italic is ticked and Underline is blank, the
Notice however that there is an additional icon to resulting text will be Bold and Italic. This is
because Bold has no effect, Italic is applied and
Underline is removed.

is applied to text, the attribute will have no effect.
When you create a new blank style, all attributes
are in this state.

If an attribute is ticked, it will have an effect when
the style is applied. Attributes automatically
become ticked if you alter them, or you can
change a cross to a tick by clicking on it.

T Modify text |
Font Trinity V¥ "H|Hscale| 100 %
Size| 12pt V Track| O ™
Case | Mormal W E Woshift| O %
Furegruund- v E Rotate| 0O I
Background Wé I E Skew| U = v
™ Bald ™ ltalic ™ Underline E
[T Superscript T Subscript T Strikeout E
[T Smallcaps T Reverse
Apply | Cancel | 0]

Fig. 6.4 - The Modify text dialogue box is used for editing styles. If an attribute is

‘crossed’ it will not be applied to the text.

Epiming STyLES

you will notice that all
attributes are ticked and cannot be changed. This
is the base style and must
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Format Attributes
Menuw>Stylec>Edit styles..=>Format...

To edit the format attributes of the selected style,
such as alignment and leading, clickFesrmat.
This opens th&ormat dialogue box described

earlier in this user guid@ee 5.4).

As in theModify text option described above, 1

format attributes have no effect if they are 2.
crossed, applied if they are ticked or removed if
they are blankfig. 6.5)

Tab Attributes
Menu> Style>Edit styles...oTabs...

To edit the tab settings for the selected style, click

onTabs. This opens th&ab dialogue box 4
(fig. 6.6)and tab ruler described earlier in this user’
guide(see 5.5) S.

An additional option on th&ab dialogue box,
Apply ruler, allows you to determine whether the
tab ruler will be applied or not. A cross indicates
that it will have no effect; a tick indicates it will
be applied.

3.

In the writable icons next tioeader and to
Decimal tabyou can set individual leader strings
and decimal tab characters for each tab. The
default decimal tab setting as set in Preferences

Menuc>MisceyPreferencesy Text
Ctrl+Shift+P

is used if thddecimal tabicon is left blank.

CHAPTER 6

Example

Assume you want to create a style that will set
text to 14pt Bold. It should change nothing else,
so that the font and all other attributes are
determined by Bodytext and any other underlying
styles.

. First useNewto create a blank style.

Click onText to open théModify text
dialogue box. Since the style is completely
blank, all the attributes have a cross beside
them.

Now choosd 4pt from theSizemenu. Notice
that the Size option becomes ticked. Click on
Bold so that it is also tickedfig. 6.4)

Click onOK to apply the changes.

The preview will now show 14pt Bold text and
the style summary will confirm that these two
attributes have been assigned to the style.

T Modify format HE
Leftindent| Omm| K Rightindent| Omm X
15t indent [ Omm X Alignment Left v El
Space before | Opt v Space after|  Opt W
Leading| =20% W Paragraph level | U < | Remove effect
Dropcap| 3 X Auta in n [ ﬂl
Apply effect
v Auto keming [~ " Auto hyphenation H
[ Locktogrid X Enhanced justification H
No effect /
Apply | Cancel | Dk

Fig. 6.5 - The Format dialogue box is used for editing styles. If an attribute is

‘crossed’ it will not be applied to the text.
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Scope 6.5 Renaming & Deleting Styles
The Scopemenu(fig. 6.7)allows you to specify  Rename
the amount of text affected when the style is

_ To rename the selected style, clickRenameto
applied.

open theRenamestyle dialogue box. Type in a
Selectioncauses the style to be applied to the texhew name and click 00K .
selection. If there is no selected text, the style is pgjete

applied to the caret. Click onDeleteto delete the selected style. All

Paragraph causes the style to be applied to the occurrences of the style are deleted from the
entire paragraph that contains the caret, or to all Jocument.

paragraphs wholly or partially in the selection.
Paragraph is automatically selected if the
Format dialogue box has been used, since these
attributes normally only apply to whole
paragraphs.

Word causes the style to be applied to the word at
the caret, or to all the words wholly or partially in
the selection.

Line causes the style to be applied to one whole

line of text.

Story applies the style to the whole of the current

story. ®Tabs  HE|
Key

_ I Apply ruler
You can assign a keypress to the selected style by

pressing the required key combination. & Left tab ~ Left indent

You can use almost any key in combination with  Centre tab & First indent
rl, Shift, Alt or the Windows k r

Ctrl, Shift, Alt or the Windows key or a € Right tab € Right indent

combination of them. However, to avoid

overriding existing key shorts cuts, we " Decimal tab I

recommend that you do not use any of the

function keys mentioned in the key short-cut Tab leader I

overview(see Appendix E)

You can remove the keypress from the selected Position I | | 4]
style by pressin@elete.

For the keypress to be seen the scrolling window Ol | Cemeel | QK
of style names must have the input focus shown
by a dotted line around a style name. You can give
it the focus by clicking on a style name or by
tabbing until the input focus reaches it.

Fig. 6.6 - The Tab dialogue box.

oelection
v Faragraph

YWlord

Line

otony

Fig. 6.7 - The Scope menu.
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6.6 Applying Styles Changing Words
If the scope of the style you are selecting is set to
MenurStyle Word, the style is applied to the word containing

To apply a style, first select the text to be the caret; there is no need to select the word.
changed, then choose the required style from the

Style menu(fig. 6.8) If there is a selection, the style is applied to all

words that are wholly or partially selected.
Changing Selections

If the scope of the style you are applying is set to
Selection the style is applied to the selection. If
there is no selection, the style is applied at the
caret, and any text subsequently typed will appe
in that style. Note however, that if you move the
caret before typing, the style will not be applied.

Overlaying Styles

By default all text is displayed in the pre-defined

style calledBodytext . You may overlay any

number of additional styles on top Bddytext

For example, if you apply a style that sets ltalic,
and overlay it with a style that sets Bold, the

resulting text will be Italic and Bold.

Changing Paragraphs The attributes of the last style overlayed,

If the scope of the style you are selecting is set t0qyenyrite those conflicting attributes of the style
Paragraph, the style is applied to the paragraph peneath. For example, if you apply one style that
containing the caret; there is no need to select thgqis the text size to be 14pt, and overlay it with
textin the paragraph. another style that sets text size to be 18pt, the

If there is a selection, the style is applied to all  resulting text will be 18pt.

paragraphs that are wholly or partially selected. Styles and Effects

In Ovation Pro, a paragraph is defined as the text You can apply a combination of defined styles

between two carriage returns, which may be a  and local effects to the same region of text. In this

single line or multiple lines of text. situation, the defined styles are applied first and
the local effects are overlayed on top, irrespective
of the order in which they are applied.

Edit style... Ctrl+Shift+E

Femowe r
¥ Bodytext Cirl+F1

Ch Number

Ch Heading

Ch Contents Cirl+Shift+F1

Ch Intro Cirl+Shift+F2

MoFoints Fz2

Heading hift+F1

Fig. 6.8 - The Style menu.



SecTion 6.7 RemovinG StyLES 81

Current Style 6.7 Removing Styles
If there is no selection, the styles that are current Menur>StylecoRemove

atthe caret are ticked on tBeyle menu. TheRemovemenu(fig. 6.9)lists all the styles that

If there is a selection, any styles that are present agre present at the caret or somewhere within the

throughout the selection, are ticked on &tgle selection. The order of the styles on the menu
menu. If a style is not ticked on the menu, it shows the order in which they were applied in the
means that it is not present throughout the document (the last style applied being at the top of
selection. the menu)_

Click on the style name to remove it from the
caret or selection.

Notice thatBodytext is not displayed on the
Removemenu. This is becau@odytext must

be present beneath all other styles, and cannot be
removed.

TheLocal effectsoptions removes all local
effects at the caret or selection.

If you remove all styles and local effects from a
selection, the selection will be displayed in

Bodytext style.
Editstle.  Ctl+Shit+E |
Remowe All styles and effects  Crl+C
v Bodytext Crl+F1 Local effects Cirl+Shift+L
Ch Mumber BoldwWord
Ch Heading Caption

Th Mhntants Ttel+ Shift+F1 I

Fig. 6.9 - The Remove menu.
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6.8 Merging Styles Another way in which styles may get merged is

You can merge the styles from another documentVhen text s copied between documents.
or stylesheet by dragging a document or styleshe@tproblem area is where a style in the text being
onto theEdit style dialogue boxfig. 6.2) copied has the same name as a style in the

If a style being merged has the same name as griestination document but different values. What
existing style, a warning box is displayed happens depends on the settings in the Text
(fig. 6.10) Since Bodytext exists in every handling choices window

document, this warning box will always appear at Menur>Miscr>Choices>Text

least once. If Rename styless selected the styles of the

For each style name clash, the warning box imported text will be used and if their names exist
provides a number of options. they will be renamed (Style01, Style02, ...) .
Otherwise the imported styles with the same
names will take on the values of those in the
document into which the text is being imported.

Skip causes the style to be ignored and not
merged.

Overwrite causes the style being merged to

overwrite the existing style The same point applies to the transfer of colours if

_ Rename colourss selected idext choices.
Renamechanges the name of the style being

merged so that it doesn’t clash with any existing
style.

Cancelaborts the merge operation.

T Merge styles |
Duplicate style 'Bodytext' found.
1550 P ¥ ¥
Chverwrite | Fename Cancel skip

Fig. 6.10 - This warning box is displayed for each style name clash.
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7.1 TheViewWMenu. ............ .
7.2 NEeW VIEW . .o e e
7.3  ViewOptioNS. . .. ..
T4  Grid. ... e
7.5 Document Zoom . . .. ...

This chapter describes options that change the way the document looks
on the screen. They do not affect how the document is printed.

The Options window lets you set the layout of the document on screen.
You can select which tools or facilities are available.

The Grid window allows objects to be easily lined up, locked to certain
points and text lined up and locked to certain lines which can be
changed.

Zoom changes the magnification of what is seen on screen.
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7.1 The View Menu
Menu=Viewry.........

TheView menu(fig. 7.1) provides a range of
options that control how the document is viewed
on-screen. View options are saved with
documents and can also be saved as default

(see 15.2)
My ey
Optians... Ctrl+Shift+0)
Grid... Ctrl+Shift+ G
£00am... Ctrl+ZShift+2
Clipboard... Cil+Shift+B

Separations

Fig. 7.1 - The View menu.

CHAPTER 7

7.2 New View
Menuc>ViewsoNew view

New view allows you to have any number of
windows open on the same document. Each
window can be scrolled to a different part of the
document and can have its own independent zoom
and view options. You can edit the document in
any of the windows; all the others will be updated
automatically. Typically this feature is used to
open a new view at a small scale, providing an
overview of the entire page.

The number of views that are currently open is
shown after the document name on the title bar.

Use the normal close icon to remove new views if
they are not needed.

¥ view options |

W Toaolbox V¥ Pictures

¥ Button bar [ Guidelines
¥ Info palette [ Print margins
[ Rulers [T Facing pages
[ Pasteboard I~ Invisibles

[ Spelling errors ¥ Use proxies

Apply Cancel Ol

Fig. 7.2 - The Options dialogue box.
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7.3 View Options
Menu>View=>Options=

Options

Options opens a dialogue box allowing a number

of miscellaneous view options to be enabled and

disabled(fig. 7.2).

Toolbox

Toolbox opens and closes the toolbox.

Ctrl+Shift+O

Button Bar

Button bar opens and closes the button bar.
Info Palette

Info palette opens and closes the info palette.
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Rulers

Rulers shows or hides the page ruléiig. 7.3)
Rulers are a visual aid for measuring, positioning
and resizing objects.

Ruler markings are in the current document units
and the origin is at the top left corner of the
document. Both units and origin may be changed
on Preferencegsee 15.12 & 15.13)

If you click on a ruler, a ruler guideline is created.
Ruler guidelines are drawn across the page
vertically or horizontally and are a further aid for
positioning object¢see 8.4).

¥ Document] dpd =] E3
Eile Edit “iew Text Stvle Dbject Page Misc Applets Help
H & = o e|xol s | P ol
zu‘ 40 B a0 100

L1 11 | L 111 L 111 | L1 11 L1111 | L1 11 L 111 | L1111 L1111 | L 111 1111
20 -
40
A h
4] | AN

Fig. 7.3 - Document with Rulers shown.



86 Document ViEw CHAPTER 7

Pasteboard Spelling Errors

Pasteboardshows or hides the document Spelling Errors will make words which are not in
pasteboard. The pasteboard is a grey margin  the spell check dictionaries for the current
around the page that may be used like the normatlocument be displayed with a red underlisee
page, but is not printedig. 7.4) Typically it is 14.1).

used to temporarily store objects. The contents of

the pasteboard are saved with the document.

If objects overlap from the page onto the
pasteboard, only the part of the object on the page
is printed. However, iBleedis specified when
printing, a strip of the pasteboard around the
document is also printgdee 12.3)

The size of the pasteboard may be defined in
Preferenceg(see 15.13)

™ Documentl.dpd * at 30% =] E3
Eile Edit iew Text Stele Ohject Fage Misc Applets Help
@ &

2B & = &l e|Eol s &l

Fig. 7.4 - Document at 30% zoom with an object on the Pasteboard (shown in grey).
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Pictures
Pictures shows or hides pictures in picture

View OpTiONS 87

Print Margins
Most printers cannot print right up to the edge of

frames. By default pictures are shown, but if yourthe page, s€rint margins allows you to see the

document contains pictures that are slow to
redraw, you may wish to hide them. Frames

margins around the paper that cannot be printed
(fig. 7.5) You should always ensure that

containing hidden pictures are indicated with a  everything on the page to be printed is inside these

cross through thertfig 7.5).
Guidelines

margins.
The print margins are obtained from the printer

Guidelines shows or hides guidelines. By default drivers, so they will only be displayed if a printer
guidelines are shown, but you may wish to hide driver has been loaded.
them to see how your document will look when

printed.
There are three types of guidelir(ég 7.5).

* Frame guidelines
e Column guidelines
* Ruler guidelines

¥ Document?. dpd * M=l 3
File Edit “iew Picture Stde Ohject Page Misc Applets Help
) e T B HITH -
R & e el xo s <] PlosE
20‘ 40 B0 a0 100
e b b b b berr b bvv b bvnia b by
_: \ Ruler guideline
20
_] Frame
] IS = f1 guideline
40 - m il
3 Column
7] Print margin guideline
] 15 \\ - il
B0 Hidden picture
4| | A

Fig. 7.5 - Document with print Margins shown. The frame contains a hidden picture.
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Facing Pages

WhenFacing pagesis not selected, pages are
displayed vertically, one on top of another.

WhenFacing pagesis selected, pages are
displayed in horizontal paif§ig. 7.6) Non-

CHAPTER 7

Invisibles

Invisibles shows or hides special symbols that
represent invisible characters in the document. It
is useful for finding where paragraph breaks have
been inserted or to check that double spaces have

existent pages such as the page before page 1, 48t Peen inserted between words.

shown in grey.

Page 1

Page 2

Page 3

Page 4

Fig. 7.6 - The arrangement of a 4-page
document when Facing pages is enabled.

This feature is for information only and does not
affect the format or final printout of the document.

The invisible characters and the symbols used to
represent them are shown below.

New line -
New paragraph 1
New page 8§
New frame |
Space .
Non-breaking space
Fixed space °
Tab »
Soft hyphen

End of story o
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7.4 Grid Lock grid switches grid lock on or off. Grid lock
causes new objects to align to the grid as they are

obvious one is th®bject Grid which is used for created and existing objects move in steps of the

drawing things. In addition to this, there is the ~ 9rd spacingsee 8.4)Clicking onGrid on the
Text Baseline GridFig. 7.9) View menu also switches the grid lock on or off.

The grid does not have to be shown in order to use
the grid lock.

There are two grids i@vation Pro. The most

The Object Grid

Menu>View=>Grid Ctrl+Shift+G : . .
For fine movements, even with the grid lock set,
This Grid option allows you to superimpose a  press and hold the mouse button on the object to
rectangular grid on the document. It is useful for be moved and use the cursor keys.
lining up objects or checking their relative size.
The grid is made up of ‘major points’, marked by

a cross, and ‘minor points’ marked by a dot
(fig. 7.7) Sub divisionsallows you to set the number of sub

divisions between each major point.

Spacingallows you to set the distance between
the major points on the grid.

The grid is controlled from th&rid dialogue box
(fig 7.8).

Show objectdisplays the grid in the colour
chosen from the palette shown.

¥ Documentl.dpd

File Edit %iew Ficture Style Ohject Fage Misc A

e ] e e T e s Y

T T T T [T Show object ™ Lock

Spacing | 10rmr|

Sub divisions 2

IR m

[T Show hazeline [ Lack

a

|- [ Cancell oK

F oo+ -+ -+ o+ o+t

<]

Fig. 7.7 - Document with the Object Grid shown. Fig. 7.8 - The Grid dialogue box.
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The Baseline Grid 7.5 Document Zoom

Menu=View=Grid Ctrl+Shift+G You can view and edit the document in a range of
This is a grid which text baselines can be preset zooms or any variable zoom you require.
anchored to, if the text style has the appropriate The default zoom is 100% which shows your
attribute set. document on screen at approximately 100% of the

Menuw>Format...=>Lock to grid true printed size.

) . ! . One way to change the zoom is to use the Zoom
The baseline grid configuration is set from y g

document preferences and is independent of the tool (see 2.9)

object grid. Unlike the object grid whichisan ~ You may also set the zoom using the Zoom
attribute of the current document view the dialogue boxfig. 7.10)

baseline grid is part of the document structure. For  Menu=View=Zoom Ctrl+Shift+Z

example whilst you can have 2 different object Choose50%. 75%, 100%, 150%, 200% or

grids on display |n_d|fferent VIEWS, clt_aarly text has400% to set one of the standard preset zooms. See
to be anchored to just one grid at a time.

Appendix Bor keyboard short-cuts.
The grid window allows the display of the text

baseline gridfi. 7.8) Choosevariable to specify any zoom between

10% and 1000%. Enter the zoom value in the
There is also a button which allows objects to be writable icon, or use the up and down buttons to

locked to the text baseline grid. If this is selected alter the current value in 1% steps.
locking to the baseline grid takes precedence ove,E
locking to guidelines in the vertical direction. This
means that you can snap objects to the baseline

grid whilst simultaneously snapping to vertical
guidelines. Fit screensets the document zoom so that an

eentire page (or pair of pages) fits on the screen.

it window sets the document zoom so that an
entire page (or pair of pages) fits in the document
window.

If both lock to the baseline and the object grid ar

selected the object grid will take precedence.  Fit width sets the document zoom so that an
entire page (not a pair of pages) fits on the screen.

Fit height sets the document zoom so that an
entire page (or pair of pages) fits on the screen.

¥ Document] dpd

File Edit Miew Text Stle Object Pag

3| 1| & 5| &1 3] ¢

x|

® Document zoom HEE |

Ca0% V8% 100%

 150% ¢ 200% © 400%

& “fariable |923 o, ;l;'

Fit wiindouw Fit screen

Fit width Fit height

Cancell Apply | Ol I|

Fig. 7.9: The Baseline Grid Fig. 7.10 - The Zoom dialogue box.
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This chapter describes the tools for drawing and editing objects. You
can draw objects anywhere on the page, even overlapping other
objects, but not across page boundaries. There are three types of
objects: frames, lines and ruler guidelines.

Frames are the basic building blocks in Ovation Pro. They are used to
hold the text and pictures that appear on the page and are normally
rectangular (but may be any closed shape).

Lines are normally straight or curved open paths, but may be any shape
(open or closed). Even if line paths are closed, they cannot contain text
or graphics. Typically, Lines are used to add additional graphics to the
page and for this purpose are better than frames because they use less
memory.

Ruler guidelines are used to help align objects on the page.
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8.1 Drawing frames

Frames irDvation Pro may be rectangular,
elliptical or irregular. In the latter case they may
be constructed from straight and curved line
segments. To draw a frame, left click on the
Frame tool and on the required shape from the
toolbox(fig 8.1).

Normally after drawing a frame or line, the Select

tool is automatically re-selected ready for text
entry. If you wish to draw a number of frames in
succession, choose the Frame tool by right
clicking, whereupon it will remain selected until
another tool is chosen.

An empty frame can contain either text or a
picture. If you wish to put a picture in a text

CHAPTER 8

Rectangular Frames

Move the crosshair to where you want one corner
of the rectangle to be, then left click and drag to
the opposite corner. Finally release the button
complete the operatiqgfig. 8.2)

To draw a perfect square, hold down Shift while
drawing the rectangle (or use grid lock):

Menucw>Viewe>Grid Ctrl+Shift+G

Elliptical or Circular Frames

Ellipses are arranged to fit within a rectangular
area. Move the crosshair pointer to the centre of
the area then left click and drag to the required
size. Finally release the button to complete the
operation(fig. 8.3)

frame, you must delete all the text first. Similarly, 10 draw a perfect circle, hold down Shift while
if you want to put text in picture frame, you must drawing the ellipse (or use grid lock).
delete the picture first. To delete a picture select it

first by double clicking on it and then delete it
using the menu

Menu>Edit=>Delete picture Ctrl+K

R
E Frame tool
'J@
W
C7)
r—
]
E. Rectangle
! Ellipse
N, Straight Line Segment
U Curved Line Segment

Fig. 8.1 - The toolbox.

EI = Bl

| |

4 = &l

Fig. 8.2 - Arectangular Fig. 8.3 - An elliptical
frame. frame.

4 = I Bl 4

| | | 1
= = &l I'_.& = &l

Fig. 8.4 - A straight- sided Fig. 8.5 - A curved-sided
irregular frame. irregular frame.
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Irregular Frames 8.2 Drawing lines

Choose Straight Line Segment or Curved Line  The Line tool in allows you to draw rectangles,
Segment from the toolbox. Left click where you ellipses, straight line§ig. 8.7)and curved lines
want the line to start, then move to the endpoint (fig. 8.8) You can draw single lines or sequences
and left click again. You can keep adding line  of connected lines. By default lines sequences a
segments to the path by moving to the endpoint adpen path, but can be closgig. 8.9 & 8.10)

each new line and left clicking. Alternatively click using an option in Path Edit Modsee 8.11).
and drag to each new endpoint, to allow auto-

scrolling at the edge of the window. You cannot
go beyond the page boundaries.

To draw a line, choose both the Line tool and the
required shape from the toolb¢hg. 8.6) The
method of drawing lines is identical to that

At any time you can change between straight ancdescribed on the previous page for frames.
curved lines by choosing the required type from

the toolbox. To draw perfectly horizontal or
vertical lines, hold down Shift to constrain pointer
movement to the horizontal or vertical.

Remember that objects drawn with the line
tool cannot contain text or pictures.

Left double-click or right click to finish the path.
When drawing frames, the path is closed
automatically(figs. 8.4 & 8.5)

The shape of irregular frames can be edited in
Path Edit Moddsee 8.11)

I = =1
m m
I:" 4 Line tool
. = &1 [ = &1
Fig. 8.7 - A straight line. Fig. 8.9 - An open path
6 line.
) - _ o
=] I = =1 r g
L_J
||:| p Rectangle m m i .
! Ellipse
/\/ Straight Line Segment
Y . 03 = £ = &l
Q) Curved Line Segment
= Fig. 8.8 - A curved line. Fig. 8.10 - A closed path

Fig. 8.6 - The toolbox. line.
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8.3 Text Overflow and Linking Frames  Linking Frames

Once you have drawn a frame, you may type or To link two frames, select the Link tool from the
import text into it(see 3.1 & 3.3)If you type past toolbox(fig. 8.11a) Now click in the first frame
the bottom of the frame or import a story that is and drag the pointer to the second frame. During
too big, theoverflow flagwill be displayed in the this operation, the pointer will change to a link
bottom right corner of the fran{éig. 8.12) In this  Symbol. After linking, the overflow flag will

situation, the overflowed text will not be visible ~ disappear from the first frame, but may be
and cannot be edited. displayed in the second frame if there is still not

enough space for the entire text st@ry. 8.13) If
you wish you can then link the second frame to a
third frame. You can link any number of frames

1. Delete some of the text to make space for thetogether in this way, even if they are on different
overflowed text. pages.

There are a number of things you can do to
remove the overflow flag:

2. Make the frame big enough to display all of  Editing Text in Linked Frames

the text. Once frames are linked, text will flow automa-
3. Link the overflowed frame to another empty tically between them, and may be edited as
frame, so that the text will automatically flow normal. Caret movement will work correctly
into the second frame. between the frames, and you may select text
across them by clicking or dragging in the usual
way.

A =
TheIrrrech anical

typewriter, which
originated in the USA
about a century ago,
mrepresented the first majorg
«— Link tool advance over pen or
pencil. Its two principal
advantages were that a
competent typist could

. =

BIC |5 [ A s>

=
|

| I

Fig. 8.12 - Frame with overflow flag.

|0 OO

The mechanical write much faster with a
typewriter, which t sewriter than with pen
_ originated in the USA or pencil and that the
Fig. 8.11a - The toolbox. about a century ago, writing produced was
represented the first major consistent and clearly
advance over pen or legible. It was not
| Unkame — Delete link| pencil. Its tmpprincipal sfrprising. then, that the
| 1.90 advantages were that a typewriter heralded an
competent typist could ‘office revolution” in
Fig. 8.11b - The info palette having selected

the Link Tool Fig. 8.13 - Two linked frames with link shown.
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Linking Frames on Master pages.

Frames on the Master pages can be linked. As
well as the usual type of linking there is another

kind called ‘auto-linking’. This means that when To create this type of document, open the maste
the text in a master frame overflows in the pages and draw the labels as required. Now use
document, it will flow into the same frame on the the Link tool to link all of the labels in the order
next page i.e. a page will be automatically createghat you wish text to flow through them. Link the
with new frames linked to those on the preceding|ast label back to the first label. This link will be
page. shown in green, indicating that it is an auto-link
Often this feature is used with a chain of linked and will generate a new page when it overflows.
frames, where the last frame in the chain is auto- Close the master pages, and save the document
linked to the first frame in the chain. When the  a template.

last frame overflows, a new page is inserted and You can now type in the labels. Note that since v
the text flows into the first frame on the new pagegre using linked frames, you can use Ctrl Return

a new page of labels is inserted. Each label on t
master page is linked to the next label, and the ¢
label on the master page is linked to the first.

To create an auto-link, use the Link tool in the
usual way, but drag back onto the first frame in
the linked chair{fig. 8.14) In the case of a single
frame, drag back onto that frar(fey. 8.15)

An 'auto-link' is shown in green when the Link
tool is selected.

It is possible to have more than one auto-link
chain in a chapter.

to start a new label.

If you wish to import data e.g. names and addres
from a file, the data needs to be formatted
correctly first. Each field should be separated by
Line Feed (0Ox0A) or Carriage Return (Ox0D) or
both and each record by a Form Feed (0x0C). If
your data is in CSV format, then you will need to
convert your file before it is imported.

Name<0A>

To delete an auto-link, choose the Link tool, click pqqress 1<0A>
over the link so that it is selected i.e. shown in redaggress 2<0A>
Now press Delete or click the 'Delete link' button pgstcode<0C>

on the info palette.
A typical use of auto-linking is a template

document for labels. The idea is to draw the label

Name<0A>
Address 1<0A>
LI Is also possible to use mail merge to solve this

on the master pages so that as each page is ﬁ"ecp’roblem(see 12.5).

& Master Document1 dpd * at 40% M=l B3
Eile Edit Yiew Text Stile Je:t Page Misc _ File Edit Wiew Text ﬁly\ Object Page Misc
- Applets  Help : k Applets  Help
x| 2e&l = s ale]xol 5| s g 2 e ) e Y
F ==
B “#
& P
2 L
L [
frame 2
% % \ frame 2 @
O frame 1 @
Q \ 0
o =
A — The auto-link of the %
el Main Master frame - N
is also shown 4 frame 1
c
frame 3 g
Is)
o
frame 4

Fig.8.14 - Autolink: text flows from frame 1 to 2, then to 3
and to 4 and finally to frame 1 on following page.

Fig.8.15 - Auto-linking column 1 results in overflowing

text appearing on next page in column 1. Frame 1
overflows to frame 2, then to frame 1 on following page.
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Show Flow Special Notes

When you choose the Link tool, arrows are drawrrl he following points should be considered when
in the document indicating where text flows linking frames:

(fig. 8.13) 1. You cannot link to or from the Main frame,

Changing a Link

If you link from a frame that already has an 2

outward link, the original link is removed and text
flows according to the new link.

Unlinking Frames

To unlink frames, choose the Link tool so that you
can see the arrows that show text flow. To remove
a link, left click on the appropriate arrow, so that
it is highlighted i.e. shown in bladkg. 8.16).

Now press Delete to remove the link. Or click on
the Delete box on the info palefteg. 8.11b)

An auto-link will be shown in red when selected. 5

In the case of a chain of linked frames with an
auto-link the auto-link must be removed before
you can remove or change the other links. 6

Removing a link has the effect of removing the
text from the linked frame (and any subsequently
linked frames) and joining it back to the end of the
previous frame. This will cause the previous
frame to overflow, but no text will be lost.

Frame Break

You can force the caret to the start of the next
linked frame by pressing Ctrl Return, or by
choosing

Menu>Miscr>Insertm>New page

The break character may also be deleted, causing
text that follows to flow back into the previous
frame.

since this is already linked.
You cannot link picture frames.

3. If a frame contains text, it can only be linked

to an empty frame that doesn’t already have an
inward link or to the first frame of a chain of
linked frames as long as these linked frames
are empty.

4. If a frame is empty, it can be linked to any text

frame that doesn't already have an outward
link or to the first frame of the chain of linked
frames.

. You cannot delete linked frames. But a page

with linked frames can be deleted if all linked
frames are within that page only.

. You cannot cut or copy linked frames to the

clipboard, or copy linked frames using drag
and drop.

The mechanical write much faster with a
typewriter, which writer than with pen
originated in the USA r pencil and that the
about a century ago, writing produced was
represented the first major consistent and clearly
advance over pen or legible. It was not
pencil. Its two principal surprising, then, that the
advantages were that a typewriter heralded an
competent typist could ‘office revolution” in

Fig. 8.16 - Two linked frames with highlighted arrow.
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8.4 Drawing Aids Object Snap
There are a number of facilities available to help When drawing, moving or resizing objects, the
you draw and manipulate objects. edges of the objects snap into alignment with the

edges of other objects on the same page. Top

Cancelling qn Operation . . _ edges snap to top edges, bottom edges to bottor
Most operations concerned with manipulating edges et¢fig. 8.19)

objects can be cancelled by pressing Esc at any
time. So if you are in the middle of drawing a
frame, pressing Esc will cancel the operation.

Object snap may be disabled Preferences
(see 15.13)and is automatically disabled if grid

) lock is enabled.
Auto Scrolling Grid
ri

The document window will automatically scroll if ) ) )
you drag close to its edges. The speed of scrollin§f OPJject grid lock is enabletsee 7.4)and an
is determined by how close the pointer is to the OPJECt IS drawn or resized, its edges will snap to

window edge; the closer it is, the faster it scrolls. the grid. If an object is moved, it will jump in
steps of the grid spacing.

If grid lock is enabled, thBenu=>Object=>Snap

to grid option will snap the top left corner of the
selected object to the nearest grid point. The siz
of the object is not altered.

Nudging the Pointer

When drawing, moving and resizing objects you
may position the pointer more accurately by
pressing the cursor keys to ‘nudge’ it one pixel in
the required direction. In this case Object snap
(see next paragraph) is overruled.

& =5 a1 & =5 £l
& =5 £l

m i m I
m " m

! =5 | ! =5 |

Fig. 8.17 - The selected frame is dragged in the direction of the arrow so that the left and
bottom edges snap to the larger frame. The right edge of the selected frame is then
dragged to the right until it snaps to the right edge of the larger frame.
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Ruler Guidelines
Menur>Views>Options=>Rulers  Ctrl+R

When rulers are enablésee 7.3)you can draw
your own vertical or horizontal guidelines across
the page. Edges of object will snap to these
guidelines when dragged close to them.

To draw a vertical guideline, left click on the
horizontal ruler at the required position.
Alternatively, left click then drag the guideline to
the required position. To draw a horizontal
guideline, do the same, but on the vertical ruler.

To move a guideline, move the pointer over the
guideline, so that the pointer changes to the
guideline tool(fig. 8.18) Now drag the guideline
to the required position. You can also drag a
number of selected guidelines in a single
operation.

To select guidelines, left click over the first one,
then Ctrl left click over other guidelines to add
them to the selection. Selected guidelines are
shown in red.

¥ Document! dpd *

I Tt

File Edit %iew Text Style Object Page Misc Applets Help
O s|s| | o]
B0 a0 1

CHAPTER 8

To move a selected guideline to an exact position,
chooseMenu=>Object>Modify and enter a value
in the dialogue box displaydtilg. 8.19)

To delete a guideline drag it to the extreme edge
of the page. Alternatively, to delete selected
guidelines choosEdit=>Delete

To delete all vertical guidelines, Citrl left click on
the horizontal ruler. To delete all horizontal
guidelines Ctrl left click on the vertical ruler.

Guidelines are normally drawn over the top of all
frames, but an option on

Ctrl+Shift+P

allows them to be drawn behind instead

(see 15.13)Snap to ruler guidelines may be
disabled orMisc=>Preferenceqsee 15.13)and is
automatically disabled if grid lock is enabled.

Menuw>Misce>Preferences

IS E3
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Cancel 0]

Fig. 8.18 - Document with vertical and horizontal ruler guidelines.

Fig. 8.19 - Modify guideline.
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8.5 Selecting objects Another way of selecting all the objects in an are

Before you can make changes to an object you is to construct a select box around the area by
must select it. Ensure that the Select tool is activd10lding down Ctrl Shift and pressing the left
(fig. 8.20)then left click over the object. This mouse button at one corner of the area to be

selects the object and deselects any other objectS€lected and dragging the box to the opposite
corner. Release the button when all the objects t

When an object is selected, it is enclosed in a redyg gelected are wholly within the select box; the
‘bounding box’ with 8 blue ‘*handles’ located objects will then be selected.

around its edges. The bounding box is a _ .

rectangular guideline that completely encloses thdf e object you want to select is obscured by
object(fig. 8.21 & 8.22) A handle is a small another object, hold down Ctrl Shift and double-
square which can be dragged to resize the objectc/iCk 0ver the top object to select the object
beneath. You may keep doing this to select
progressively deeper objects until you eventually
return to the top object.

In addition to frames and lines, you may also
select ruler guidelines. When selected they are

shown in red, but do not have handles.
If you want to permanently group a number of

You can select more than one object by holding objects, us®bject=>Group or Ctrl+Shift+K
down Control and left clicking each additional (see 9.11)

object. Control left clicking on an object that is
already selected causes it to be deselected.

Select tool

TR

—1
1|
|

=

L

2|10 OO

4 = 1
Fig. 8.21 - An active Fig. 8.22 - An active elliptical
rectangular frame with eight frame with eight handles for

Fig. 8.20 - The Select tool. handles for resizing. resizing.
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8.6 Moving Objects Drag and Drop

To move an object, first ensure the Select tool is YOU can move or copy objects using the drag and
selected. Then left click over the object and keep drop facility. Unlike the normal move operation

it pressed and completely still until the Move  described above, you can drag and drop objects to
pointer appearéfig. 8.23).Now drag the object to any page in the same document or in a different
its destination (which may be anywhere on the ~document.

same page) and release the button. If you hold  To drag and drop selected objects, hold down Alt

down Ctrl, you may drag the object immediately then drag them to the required position.
with the right button, without holding the button

down until the Move pointer appears. If you drag and drop within the same document,

objects arenoved if you drag and drop to another
If you have a number of objects selected, movingdocument, objects ampied

one of them will move the entire selection. You
can move a mixed selection of frames, lines and
ruler guidelines if you wish.

If you hold down Shift Alt while dragging, the
above operations are transposed. So, if you drag
and drop within the same document, objects are

To constrain movement to the vertical or copied if you drag and drop to another document,

horizontal, hold down Shift while dragging. objects arenoved

You can position objects precisely using the info |f you start a drag operation and wish to cancel it,

palette or théVlodify dialogue boxsee 9.1) press Esc.

Using the Info Palette Please note that you cannot drag and drop master
X andY on the info palettéfig 8.24)are the objects or linked frames. But you can move linked

coordinates of the top left corner of the selected frames within a chapter.

object or group. Coordinates are measured from For drag and drop of selected tere 3.8
the top left corner of the pagé.andY may be

modified to change the position of the object.

Press Return after modifying the values to update

the document.

If there is a selection of objects,andY refer to
the first object selected. In this casXindY are
modified, the first object is moved to the position
specified and the rest are moved proportionally.

01 01

X'
| Text frame X|2{Jmm |W|4{Jmm | | Trinity ﬂl 12p ﬂ
o O o |l 1 Y[2omm |H|emm | [N B|/|U|R1]2] E =

Fig. 8.23 - The Fig. 8.24 - The info palette gives the position of the selected object. You can reposition it
Move tool moves by changing the X and Y values.
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8.7 Resizing Objects Using the Info Palette

To change the shape or size of an object move th& andH on the info palettéfig. 8.26)are the
pointer over one of the 8 handles so thatthe ~ Wwidth and height of the selected object or group.
Resize pointer appeaffig. 8.25) Now press the W and H can be modified to change the size of
left mouse button and drag the mouse until the object. Press Return after modifying the values t
object is the size and shape that you want. Thereupdate the document.

are two types of handles: If there is a selection of object8] andH refer to
» Corner handles will resize the object both the first object selected. In this cas®fandH
horizontally and vertically. are modified, the first object is resized as specifit

» Centre handles will make the object either and the rest are resized proportionally.

wider or longer. X andY on the info palette refer to the distance
from the top left corner of the page to the top left
corner of the object frame. By changing these
values you can reposition the object frame.

If you hold down Ctrl while dragging, the original
shape (aspect ratio) of the object will be
maintained. If you hold down Shift, the object
bounding box shape will be constrained to a Resizing Picture Frames

square. If you resize a picture frame using the right mous

If you have a number of objects selected, resizing?uuo_n' th? picture is re5|zeq too. Th|_s only
one of them will resize the rest proportionally. unctions in both X and Y directions if Aspect

) . . ) ) lock has not been selected. This can be set in
You can resize objects precisely using the info

palette or th©bjectr>Modify dialogue box oF7 Menur>Picturer>Modify picture F6
(see 9.2)The size®V andH mentioned on the If aspect lock has been set the picture will be
info palette refer to the first object selected. resized according to the vertical size of the frame
o O o

0 m

T
1|
=

v

Fig. 8.25 - Move the pointer over a handle
and drag the resize tool to resize the object.

| Text frame X|2{Jmm |W|4{Jmm || Trinity ﬂl 12pt ﬂ
| 1.1 Y[omm |H[omm | [N B|7|UIR| ]| 2] FE &&=

Fig. 8.26 - The info palette gives the size of the selected object. You can resize it by
changing the W and H values and move it by changing the X and Y values.
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8.8 Rotating Objects Using the Info Palette

You can rotate text frames, picture frames and When the Rotate tool is chosen, the info palette
lines. To rotate an object choose the Rotate tool Provides a number of options concerned with
on the toolboxfig. 8.27)then left click and drag ~ rotating objectgfig. 8.28)

on any part of the object until it is at the desired A is the angle of rotation of the selected object or
angle(fig. 8.24) You may select a number of group. The angle of rotation is in degrees and is
objects either before or after choosing the Rotateapplied anti-clockwise. You may type in a new
tool, and rotate them all by dragging on any objecfalue followed by Return to rotate the object to

in the selection. the desired angle. Alternatively click on the up

The centre of rotation for the object or selection igand down icons to increase or decrease the angle.

indicated by a small crosshair which is initially at |f there is a selection of objedtsrefers to the
the centre of the object or selection, but may be first object selected. In this caseAifis changed,

dragged to another position. Please note that if  the first object is rotated as specified and the rest
you choose the rotate tool when there is no are rotated incrementally.

selected object, the crosshair will not appear until

you select one or more objects. Clicking on the 3 x 3 grid will position the

_ _ crosshair at the same relative position on the
Note that the Picture frame info palette does not selected object or selection. The 9 points relate to

show the angle of rotation of the frame but the  the centre, the fours corners and the centres of the
angle of rotation of the picture within the frame  four sides.

fig. 10.9). - .

(fig ) If Crosshair is selected, objects are rotated about
the crosshair, otherwise they are rotated about
their centres.
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C < Rotate tool i i
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Fig. 8.24 - Use the Rotate tool to rotate

|:| the object around the crosshair.

O

Y [ Roate A @ —“‘-,:Il:lljpcmshair o | 9 [ -180°| -s0° |

& | 1.98 wintnl 45° | 1as° | -135°| -a5° |
Fig. 8.27 - The toolbox. Fig. 8.28 - When the Rotate tool is chosen, the info palette provides options to set the

angle of rotation and alter the position of the centre of rotation.
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8.9 Editing Objects using the Edit Menu Paste frame/line/selection Ctrl+Vv
Menu=Edit=.......... Pasteinserts the object or objects that are on the

This section describes the options on the Edit gggi&gﬁ;ﬁgggﬁ;ﬁié\gtfr:ecnhgosggrs 0
menu (fig. 8.29) concerned with objects. Some of bp

these options use the clipbodfig. 8.30)which th;sttgg lz:dcgptiﬁigfkwmre the object Is to be
can be viewed using the Clipboard option on the P ’ '
View menu(see 2.2) An object can be pasted into a@yation Pro

. document, not just the one from which it was cut
The optionClear, Cut, Copy andDeleteapply or copied. After pasting, the clipboard contents

to selected objects provided that no text or picture .
. . ) remain unchanged.
is selected, otherwise they will apply to the text or

picture. This option is only available if the clipboard
contains an object or selection of objects.

Clear
Clear deselects all selected objects. Delete frame/line/guideline/selection
Select All Cirl+A This option deletes the selected object or objects.

Select allselects all objects on the current page. Undo/ Redo (IZtrI+Z [ Curi+y
This is only possible if there is no active frame, Undo cancels the last operation performed,

otherwise it selects all the text in the active framerestoring your work to its previous staRedo

) ) cancels the last undo operation performed.
Cut frame/line/selection Ctrl+X P P

Cut deletes selected objects, and places them on! N€Undo andRedooptions when applied to
the clipboard, overwriting the previous contents. objects are identical to those described previously

_ _ for text(see 3.4)
Copy frame/line/selection Ctrl+C

Copy copies the selected objects onto the
clipboard, overwriting the previous contents.

Undo Caret left  Cirl+Z
Bedo Caret left  Chrl+y

Cut Group ]+

Copy Group Crl+C T Clipboard M[=1 k3
Easte clipboard  Cirl+/

Delete Group Crl -+,

Embed alject

Selectall Chrl+A, Fig. 8.29- The Edit menu.
Clear

Eind... Ctel+F

Find next F3

Fig. 8.29 - The Edit menu. Fig. 8.30 - The clipboard containing a text frame.
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8.10 Embedding Objects
Menu=>EditcoEmbed object
Normally in Ovation Pro objects are anchored to

the page, buEditroEmbed object allows you to
embed an object or group into a text story such

that the object moves with its associated text when

the text reflows.

How to Embed an Object

First draw the object anywhere on the page and
Cut or Copy the object so that it is placed on the
Clipboard. Now position the caret at the required
insertion point in the texfig. 8.31) and choose
Embed object.

The embedded object is aligned with the text's

baseline and behaves just like a large character

which moves with its surrounding text when

editing causes text reflow. The text after the caret
is shifted to the right to make space for the object,

and the line of text is shifted down to
accommodate its heigffig. 8.32)

I =
The mechanical typewriter, which

originated in the USA about a century ago,
represented the first major advance over
pen  or ncil.  Its two principal
advantages| were that a competent typist
could write much faster with a typewriter
than with pen or pencil and that the
mwriting  produced was consistent  andp
clearly legible. It was not surprising, then,
that the typewriter heralded an ‘office
revolution’ in which typewriter
manufacturers made fortunes. Typing
became part of the school curriculum.
Despite its  many advantages, the
mechanical typewriter suffered one major
. = |

&l

Fig. 8.31 - A text frame with the caret positioned
ready for embedding an object.

CHAPTER 8

Important Points

Embed object is only available if the

clipboard contains an object or group of
objects. If the clipboard contains a selection of
objects that are ungrouped, only the first object
in the selection will be embedded.

You cannot ungroup an embedded group.

You can resize an embedded object as you
would a normal object, but you cannot move it
except by moving the text in which it is
embedded.

A text overflow will occur if you try to embed
an object into a frame that is too small to
contain it.

After embedding, the clipboard contents
remain unchanged.

The mechanical typewriter, which
originated in the USA about a century ago,
represented the first major advance over

pen or pencil. Ms twa  principal

advantagesy = pwere that a
competent typist could write much faster
with a typewriter than with pen or pencil
and that the writing produced was
consistent and clearly legible. It was not
surprising, then, that the typewriter

heralded an ‘office revolution’ in which

Fig. 8.32 - An embedded frame is aligned to the
text baseline. The text is shifted to the right and
the line moved down to make space for the object.
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Modifying an Embedded Object * The bottom of an embedded object is aligned

Menus>Objecte.. .. with the text's baseline, but you can shift it up
o and down vertically usiny.Shift on the

* Ifthe embedded object is a frame, all the Modify text dialogue box. All other options on

normal operations can be applied to the text or  his dialogue box are not applicable.

picture contents of the frame. _ . .
* Relative leading (i.e. that specified as a

* From theObject->Modify dialogue box oF7 percentage) is calculated from the size of the
(see 9.2you can apply all options except for text in the line and not from the size of the
X,Y andLock. embedded object.

* From theObjectr> Text flow dialogue box you Embedding Pictures Directly

can only apphstandoff You can drag a picture directly from disc into a

* Border andShapecan be applied, but all text story. A picture frame is then automatically
other options on th@bject menu are not embedded at the pointer position, and the picture
applicable. placed in it.

* You can select an embedded object just like
normal text andCut, Copy, PasteandDelete
it using options on thEdit menu.

* An embedded object can be placed in a
paragraph on its own by ensuring there is a
Return character directly before and after it
(fig. 8.33).

» Options on théormat dialogue box such as
Indent, Alignment, Spacebefore and
Spaceafter can be applied to a paragraph that
contains an embedded objetbs can also be
applied.

The mechanical typewriter, which
originated in the USA about a century ago,
represented the first major advance over
pen or pencil. s two principal
advantages o o

. = |
were that a competent typist could write
much faster with a typewriter than with
pen or pencil and that the writing
produced was consistent and clearly
legible. It was not surprising, then, that the

Fig. 8.33 - Embedded frame in a separate
paragraph with Centre alignment.
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8.11 Path Edit Mode If you select the end point of a curved segment,
Menur>ObjecteShape Cirl+H the control point for the Bezier curve IS sh(_)wn in
. ' ' orange and may be dragged to reposition it
The shape of objects drawn using straight and  (fig. 8.35).1f you hold down Shift while you drag
curved line segments, can be edited in Path Edit g control point, the corresponding control point in

Mode. the next curve is also moved to keep the angle of
You cannot edit the shape of rectangles or  join constant.

ellipses without changing them to polygons

first usingObject>Shape(see 9.9) To edit another path, left click over it. If the object

_ _ you want to edit is obscured by another object,
To edit a path, choose the Path Edit Mode tool omolding down Alt and double-clicking over the top
the toolbox(fig. 8.34)and left click on the path to object will select the one underneath. You can

be edited. This is not necessary if an objectis  keep doing this to select progressively deeper
selected before entering this mode. objects.

The end points of each segment are shown in blug you find that editing paths is too slow because
and may be dragged to reposition them (they will surrounding text is continually being redrawn, you
snap to the grid if grid lock is enabled). You can can disable the redraws using an option on
constrain movement to horizontal or vertical by . . ,

holding down Shift while dragging. When moving Menur>Misce» Choicess Viewss.... _
a point you may use the cursor keys to nudge theDeselect ‘Instant updates on path ei¢e 15.6).

pointer in any direction. When you have finished editing your object, leave
Left click over an end point to select the line Path edit mode by choosing the Select tool on the
segment. Left click whilst holding down Control toolbox.

on a point to add or remove a line segmentto or  please note that in Path Edit Mode most of the

from the selection. Selected end points and line usual Ovation Pro operations are not available.
segments are displayed in red. If you have a

number of end points selected, moving one of
them will move the entire selection.

Path Edit Mode tool

8O

=
|

| I

Control points

N\

] Selected
end point

) LI

Fig. 8.35 - An irregular object in path edit mode with

I2|<|(

an endpoint selected. The two control points may be
Fig. 8.34 - The toolbox. dragged to change the angle of join.
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Path Edit Options

In Path Edit Mode, the info palette provides a
number of options concerned with editing the
selected patffig. 8.36) All of the options may be
applied to a single selected segment or to a
selection of segments.

The writable iconX andY are the coordinates of
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Make horizontal moves the selected end point
either up or down to make the line segment
horizontal (relative to the object rotation).

Make vertical moves the selected end point either
left or right to make the line segment vertical
(relative to the object rotation).

Add point adds a new segment into the selected

the selected end point. Coordinates are measuregegment, of the same type as the selected segment

from the ruler origin (normally the top left corner
of the page). These values may be modified to
change the position of the point. If there is a
selection of pointsX andY refer to first end point
selected. In this case XfandY are modified, the
first end point is moved to the position specified
and the rest are moved incrementally.

Change to straight linechanges the selected
curved line segment or move segment into a
straight line.

Change to curvechanges the selected straight
line segment or move segment to a curved line.

Delete segmenteletes the selected segment.

Flatten path straightens the join between two
curved lines or a straight line and a curved line, so
that the tangent is continuous at that point.

Open/close pathturns a closed path into an open
one, or an open path into a closed one.

Snap to grid aligns the selected end point to the
grid. The grid or grid lock must be enabled for this
option to work.

Change to movechanges the selected straight line

segment or curved line segment to a move
segment i.e. an invisible line.

Change to move Make horizontal
Change to curve Make vertical
Change to straight line \ / /Choose curve

| Path ecit mode X| | | — 1 | =
e P AN

Add point / / \
Delete segment Snap to grid

Flatten path
Fig. 8.36 - The info palette in Path Edit Mode

Open/close path
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Editing the Inset and Standoff Curves Editing the Inset Curve

The description above explains how to edit the To edit the Inset curve, click on the object you
shape of objects constructed using straight and wish to edit and then toggle toose curve
curved line segments. However, you may also ediiutton on the info palette until you are in the Inset
the ‘curves’ which repel text inside and outside a mode.

frame. This facility only applies to frames, and nofrpg |nset curve is positioned around the inside of
lines which are always transparent and do not  h6 frame and repels the text flowing in the frame.
repel text. You cannot edit the Inset or Standoff By default it is the same shape as the frame, but
curves for rectangles or ellipses without Changingpositioned 1mm in from the edge of the frame
them to polygons first using tt@bject>Shape (i g 37) The default inset distance is specified
option(see 9.9). Cl+H 51 theModify dialogue boxsee 9.1) F7
Clicking onChoosecurve on the info palette
(fig. 8.36) allows you to toggle through the
following three modes:

The frame outline is drawn in grey with the Inset
curve drawn in grey with the end points in blue.
You can now edit the Inset curve using the same
F Default mode: this allows you to edit operations described on the previous pages

the shape of the object. (fig. 8.38).
If you wish to reset the Inset curve to its original
shape and position, reset the Inset value on the
Modify dialogue box to 1mm.

Inset mode: this allows you to edit
i the Inset curve.

mmmememne Standoff mode: this allows you to
- edit the Standoff curve.

Both Inset and Standoff curves are attached to the
frame shape and are moved and resized when the
frame is moved and resized.

]
q’he mechanical  typewriter,  which q’he L
originated in the USA about a century ago, mechanical typewriter, which

represented the first major advance over
pen or pencil. Its two principal advantages
were that a competent typist could write
much faster with a typewriter than with pen
or pencil and that the writing produced was
consistent and clearly legible. It was not
surprising, then, that the typewriter
heralded an ‘office revolution’ in which
typewriter manufacturers made fortunes.
Typing became part of the school
curriculum. Despite its many advantages,
the mechanical typewriter suffered one
major drawback. As soon as the typist hit
=

Fig. 8.37 - The outer line is the frame guideline
and the inner line is the default Inset curve.

originated in the USA about a century
ago, represented the first major
advance over pen or pencil. Its two
principal advantages were that a
competent typist could write much
faster with a typewriter than with pen
or pencil and that the writing
produced was consistent and clearly
legible. It was not surprising, then,
that the typewriter heralded an ‘office
revolution” in which  typewriter
manufacturers made u
fortun

|

Fig. 8.38 - The Inset curve has been edited
causing the text to flow inside the new shape.
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Editing the Standoff Curve Editing Picture Runaround
Menuw>Object>Text flow  Ctrl+Shift+T ThePicture option on thebject=>Text flow
To edit the Standoff curve, click on the object yC,udialogue box automatically modifies the default

wish to edit and then toggle tiEhoosecurve Standoff curve so that it follows the shape of the
button on the info palette until you are in the picture instead of the frame. Using the facilities
Standoff mode. described in this chapter you may edit the

Standoff curve to fine-tune the runaround shape to

The Standoff curve is the positioned around the your exact requirements.

outside of the frame and repels text flowing
around the outside of the frame. By default it is
the same shape as the frame, but positioned 1mm
out from the edge of the fran(ig. 8.39) The

default standoff distance is specified on the
Objectr> Text flow dialogue boxsee 9.7).

The frame outline is drawn in grey with the
Standoff curve drawn in grey with the end points
in blue. You can now edit the Standoff curve
using the same operations described on the
previous pagefig. 8.40)

If you wish to reset the Standoff curve to its
original shape and position, reset Standoff
value on thél'ext flow dialogue box to 1mm.

The mechanical typewriter, which The mechanical typewriter, which
Griginatw:l in the USA about a ceqiury ago, originated in the USAg_about a century
represe nted the ago, represented the first major
first major advance over pen or
advance over pen pencil. Its t w o
o r pencil. principal advantag
Its two principal es were ghat a
advanta ges were compete nt typist
that a compete could write
nt typist could m u c h faster
write much with 4 typewriter
faster with a than with & pen or pencil
typewrity gr than and thae he writing
with pen or pencil and that the writing produced was consistent and clearly
produced was consistent and clearly legible. It was not surprising, then, that the
Fig. 8.39 - The inner line is the frame guideline Fig. 8.40 - The Standoff curve has been edited

and the outer line is the default Standoff curve. causing the text to flow around the new shape.
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Notes:



Working with Objects

9.1 MOdify . .
9.2 Modify Text Frame. . . . ... ... e e
9.3 Modify Picture Frame . . ......... .. .. . i
9.4 Modify Line . .. ...
9.5 Modify Object . . ... .
9.6 Border. . ... e
9.7 Text Flow around a Frame or Picture . . . ...................
9.8 Duplicate Object . .. ...
9.9 ShapeofObject ......... ... ... ... . . .. . .
9.10 Front/Back. .. ...
9.11  Group/UNGrOUP . . . vvv e et e e e e e e e e
9.12 Make Local/Make Master . ...,
9.13 SnaptoGrid........ .. .. ...

This chapter describes all the options on the Object menu concerned
with manipulating objects.
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9.1 Modify
Menu>Object->Modify nnnn F7

The Object>Modify option(fig. 9.1)allows you
to alter the properties of selected objects.

The properties that can be altered depend upon the
type of objects selected, so 4 different dialogue
boxes may appear:

Modify text frame,
Modify picture frame,
Modify line,

Modify object.

The latter is displayed if the selection or group
contains mixed types of objects.

In a selection, the settings shown in the dialogue
box refer to the first object selected. If you alter

X, Y, Width, Height, Angle or Skewthe first

object is altered as specified, and all other objects
are altered proportionally.

Only those properties that you change are updated
in the document when you click @K .

TheModify option can also be used to set the
exact position of ruler guidelinésee 8.4)

¥ Modify text frame |
Origin | ¥2.57mm Radius | Omm
tdodify... F7 -
Border Origin ¥ | 269.76mrr Inset T
Text flow... Ctrl+Shift+T Width| 97 43rmm Fill colaur "E
shape... Ctrl+H —_— —
Height| 12mm Align Tap H
Duplicate...  Cirl+Shift+0 —
Ungroup  Cirl+ShifteK Angle| O ° v|«[Columns |1 »|«|°0
Mars loca Skew| 0 ° v|a|Firstline | Accent “H
Frant I~ Lock
Back.
Snap to grid
e Apply | Cancel | Ok
Atrange...
Fill...

Fig. 9.2 - The Modify text frame dialogue box allows you
Fig. 9.1 - The Object menu. to alter the properties of text frames.
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9.2 Modify Text Frame
Menu>Object>Modify... F7

TheModify text frame dialogue box is displayed

if a text frame is selected or if the selection

contains only text framg$ig. 9.2)

Origin X/Origin Y

These values are the coordinates of the top left

corner of the selected frame. They may be
modified to change the position of the object.
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Skew

This is the angle of skew for the selected frame.
You can enter a new value or click on the up and
down icons to change the skew angle one degree
at a time. A positive value skews the frame to the
right (fig. 9.5)and a negative value, to the left

(fig. 9.6) The angle is specified in degrees and
must be within the range -80° to 80°.

If a multi-column frame is skewed, the columns
are also skewed.

Coordinates are measured from the top left corner

of the page.

Width/Height

These values are the width and height of the
selected frame. They may be modified to change
the size of the frame.

Angle

Radius

This value is the corner radius of rectangular
frames(fig. 9.7) The radius must be a positive
value smaller than half the length of the shortest
side. This value is ignored if the frame is not
rectangular in shape.

This is the angle of rotation of the selected frame.

The angle is in degrees, and is applied clockwise
(figs. 9.3 & 9.4) You may type in a new value
followed by Return or use the up and down icons

to increase or decrease the angle by one degree.

Fig. 9.3 - Frame rotated 60°.

-

Fig. 9.4 - Frame rotated -45°.

I

-

Fig. 9.5 - Frame skewed 25°.

= = = |
Thel mechanical The[ mechanical Thel mec h-\
typewriter, which typewriter, which anical  typewriter,
originated in the originated in the which originated in
USA about a USA about a mthe USA  about apm
century ago, century ago, century ago, rep-
represented the represented the resented  the  first
first major advance first major advance wajor advamy
= g M £l

Fig. 9.6 - Frame skewed -25°.

—
I —

Fig. 9.7 - Frame with round corners.
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Inset Align

Inset is the gap between the edge of the frame arfthis option specifies how text is aligned vertically
the text flowing inside the frame. It prevents the in the frame. The submenu provides four options:

text from touching the sides and improves the 14 s the default setting and causes text to be
appearance of frames that have a frame border aligned with the top of the franfég. 9.10)

(fig. 9.8 & 9.9) The default inset is 1mm and is _ }
Bottom causes text to be aligned with the bottom

set in
, , of the frame(fig. 9.11)
Menur>Misc=>ChoicesvText ) _
. Centre causes text to be vertically centred in the
The inset normally follows the shape of the frame(fig. 9.12)

frame, but it can be made any shape by editing the N )
Inset curve as described in the previous chapter. Justify inserts additional white space between the

This is useful if you want to have a different inset IN€S Of text so that it fills the frame vertica(lyg.
on different sides of the frame. If the inset curve i§-13)

edited, the value fdnset is blanked out. Please note th&ottom, Centre andJustify do
Resetting this value will reset the inset so that it not work if the frame is overlapped by another
follows the shape of the frame. object that causes the text to reflow or if the frame
Fill colour is not rectangular. In this case the text reverts to

This is the current background colour of the | 0P &llgnment.

selected frame. To change the background colour
click on the icon to the right of the colour to
display the standar@vation Pro colour picker.
Frames can be made transparent by choosing
Transparent from the scrolling window.
Transparent frames are ideal for overlaying text
onto graphics e.g. adding a caption to a picture.

More advanced possibilities are available using

the Fill applet.

0 = —l I = 1| I = |
Tthel mechanical The[ mechanical )
typewriter, which typewriter, which Thel mechanical
priginated in the USA originated in the USA typewriter, which
about a century ago, about a century ago, originated in the USA

Bepresented  the  firs] Mepresented the first] fabout a century ago[]
major advance over pen major advance over represented  the  first
pr pencil. lts two pen or pencil. major advance over
principal advantages pen or pencil.

. = | . = | . = |
Fig. 9.8 - Frame with Omm Inset. Fig. 9.10 - Text aligned Top. Fig. 9.12 - Text aligned Centre.

@ = B @ = £l s = &l
Thel mechanical The| mechanical
typewriter, which The] mechanical typewriter, which
onginatec in the LSA typewriter,  which originated in the USA
about a century ago, iginated in the US

1 oo m [ergina A

represented the first about a century ago, [ubout a century o]
major advance over represented  the  first represented  the  first
pen or pencil. Its two major advance over major advance over
principal  advantages n or pencil. n or pencil.

= = = PG £ o TP 2l

Fig. 9.9 - Frame with 2mm Inset. Fig. 9.11 - Text alignedBottom. Fig. 9.13 - Text fully justified.
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Columns

This option specifies the number of columns in
the text frame. The default gutter (the space
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First Line

When text is flowed into a frame, a decision is
taken how far down the first line of text is placed

between the columns) is 5Smm, but this and other tha sub menu provides four options:

advanced settings can be modified from the
Column specificationdialogue boxfig. 9.14)
which is opened by clicking on the icon to the
right of theColumns option.

Gutter width allows you to specify the gap
between the columns.

Column width allows you to specify the width of
the columns.

If Display column guidesis selected, a vertical
line is drawn centrally in each gutiig. 9.15)

Guide width allows you to specify the thickness
of the column guideffig. 9.16) You may choose

Accent- the maximum size of the fonts in the line
using all the available characters is calculated.
This includes high bit or accented characters.

Ascender- this is similar but only the characters
with codes less than 127 are used. This includes
all the ‘normal’ ASCII characters used in English

Fit - the exact height of the line is calculated and
used.

Grid - the baseline is snapped to the text baselir
grid (see 5.4)

Older versions oBvation Pro used the Accent

a standard width from the menu or enter your ow$€tting by default.

value at the bottom of the menu. The default
width is Thin which is the thinnest line possible
on the output device.

Guide colour allows you to specify the colour for
the column guide using the stand@nwhtion Pro
colour picker.

¥ Column specification HE

& Gutter width amm

¢ Column width | 51.38mm

Notice that the first two (and last) options give a
distance which is independent of the precise
characters used in the line - the base line of a ro
of mmmmm’s is positioned in the same place as
row of MMMMMM'’s. For the fit option the
mmmm’s would be placed higher.

Lock

This option locks the frame so that it cannot be
accidentally moved or resized by dragging. If a
frame is locked it has no handles, and the pointe
changes to the lock symbol if you try to move the
frame.

— Colurnn guide
i i I = | .
I Display column guides Thf:l mechanical| | advance over pen Thin
Guide widthl 1rmm *H typewriter, which| | pr pencil. Its two 0.25mm

— originated in the| | principal ad- 0.5rmrm

Guide CD|DUY- A TUSA  about  al | vantages were thatg < e

— century ago,| | @ competent typist Pt

represented  the | could write much armm

Cancel | Ok first ~ajor| | faster with a
. = |

Fig. 9.14 - Dialogue box for setting
column specification.

Fig. 9.15 - Frame with two columns and a
green coloured column guide.

Fig. 9.16 - Column
Guide Width menu.
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9.3 Modify Picture Frame The inset normally follows the shape of the
Menur>Object>Modify ... E7 frame, but it can be made any shape by editing the
o ] . Inset curve as described in the previous section.
TheModify picture frame dialogue box is This is useful if you want to have a different inset

displayed if a picture frame is selected or if the o gifferent sides of the frame. If the inset curve is
sglectlon or group contains only picture frames edited, the value fdnset is blanked out.

(fig. 9.17) Resetting this value will reset the inset so that it
Operation is identical to that described for text ~ follows the shape of the frame.

frames above except that the optidtign and
Columns are not applicable to picture frames and . ) )
do not appear in the dialogue box anset Additional information

operates slightly differently for picture frames ~ The Arrange applet provides a number of ways of
than for text frames. aligning and spacing out frames. See the Help file

Inset of the applet.

In a picture frame the inset is a border inside the
frame, of the width specified and the colour of the
frame fill colour. If a picture is made to fit a frame
(see 10.4)it will be scaled to fit inside the inset
(fig. 9.18 & 9.19) The default picture frame inset
is Omm, but this may be changed on Fheture
Choicesdialogue boxsee 15.7)

Menu=>Misc=>ChoicesvPicturew

¥ Modify picture frame

Origin | 8.94mm Radius| Omm
Origin ¥ | 196.21mm Inset | Omm
Width | 96.65mm Fill colour ﬁl

Height 73.66mm

Angle] 0 ° x| a]
Skew| 0 ° =] 4]

™ Laock

Apply | Cancell Cil

Fig. 9.17 - The Modify picture frame dialogue box
provides options for altering the properties of picture frames. Fig. 9.19 - Picture frame with Imm Inset.
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9.4 Modify line Line width
Menu>Objecte>Modify... F7 This option allows you to set the line width to an)

TheModify line dialogue box is displayed if a
line is selected or if the selection or group
contains only lines.

Operation is similar to that described for text
frames above except that the opti&alius,

Inset, Align andColumns are not applicable and
Width andHeight have a different interpretation
for lines. There are also a number of new options

of the predefined values from the menu or enter
your own value at the bottom of the menu

(fig. 9.21) The default widthThin is the thinnest
line possible on the output device. You can
change the default line width on tG&oices
dialogue boxsee 15.9)

The width of a single selected line can be
increased or decreased in steps of 0.5mm using
Ctrl > or Ctrl <.

concerned with line styl@ig. 9.20)
Width/Height

These values refer to the width and height of the

bounding

Line colour

Allows you to set the line colour using the

box that contains the line. standardDvation Pro colour picker.

Pattern

This option displays a menu of dashed and dotte
line patterns that can be applied to lifies. 9.22)

Thin
¥ [1.25mrm
0.5mm
1rirm
¥ Modify line HE| -
Origin %| 14.82mm Line width | 0.25mm  *H A
Origin Y| 20.858mm Line colour *H
—_— = Fig. 9.21 - The Line width menu.
Width| 52.92rmm Fill colaur s J
Height| 20.74rmm Pattern | - *H
Angle] O ¢« 4] Join | Bevelled ™
Skew| O  ° =|a|Statcap| Butt °H v
I~ Lock End cap Butt *H -
Cancel | (0] :___:__:

Fig. 9.20 - The Modify line dialogue box.

Fig. 9.22 - The Pattern menu.
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Join Triangle adds a triangle to the end of the line,

Join specifies how lines are joined together and igllowing you to create lines with arrowheads. This

only significant on thick lines. There are three ~ option has its own submeifig. 9.27)allowing
types of joingfigs. 9.23 & 9.24) you to set the width and height of the triangle.

Choose one of the predefined values or enter your
own value at the bottom of the menu. Walth

andHeight values should be specified as
Round rounds off the point where the lines join. multiples of the width of the main line.

The default optioiBevelled cuts off the corner You can change the defaMitidth andHeight
where the lines join. values on th€hoicesdialogue boxsee 15.9)
Start cap/End cap Please note that you cannot generate arrowheads

These options specify what the end of lines look ©f @ réasonable size on a line of widifin; you
like. Caps only apply to open paths and are only must typically have a line width of at least
significant on thick lines. The window provides 0.25mm.

four options(figs. 9.25 & 9.26)

Butt, squares off the line at the end point. This is
the default option.

Mitred brings the outer edges of lines together to
a point.

Round adds a solid semicircular to the end of the
line.

Square adds a square to the end of the line. The
square has half the width of the line.

Mitred
Found
v Bevelled

Fig. 9.23 - The Pattern menu.

® Line Caps |

i+ Butt

o 777

Fig. 9.24 - Mitred, Round and Bevelled joins.

" Triangle
Wyidth [ 2 E ”
Height | 4 *f| — [ 2
*3
Cancel Ok — @ v xd
Fig. 9.26 - Butt, Round, Fig. 9.27 - The Triangle

Fig. 9.25 - Line caps menul. Square & Triangle caps. Height/Width menu.
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9.5 Modify Object
Menu>Object>Modify... F7

This dialogue box is displayed if there is a group
selected or if the selection contains mixed types of
objects i.e. text frames, picture frames and lines
(fig. 9.28).

The options provided are those that are common
to all types of objects in the selection or group.
Operation of these options is identical to that
described for text frames earlier.

W Modify object HE|
Crigin %| 20mm|

Origin ¥ | 201.52mm
Width| 67.54mm
Height m
Angle B LILI
Skew B Ll;l

[~ Lock

Apply | Cancel | I

Fig. 9.28 - The Modify object dialogue box.

Mobiry OBJsect
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9.6 Border for example black in the Draw file border will
Menuc>ObjectesBorder.. produce 100% of the current border colour

] o (including the tint set for it). White in the Draw
Normally the edges of frames are just guidelines, e il produce white in the border.

and are not printed, but you can add a border , ,
around the outside of a frame using Bwder The optionBorder determines whether the border

dialogue boxfig. 9.29) is applied to the frame. The action of choosing a

_ _ ] border style, automatically selects this option. If
The scrolling window in the top left corner of the you want to remove a border from a frame,

border dialo_gue box, shows aII_the border styles yeselect this option.
that are available. Use the vertical scroll bar to
scroll through the complete list, and click on the
border you wish to use. The chosen border is the
highlighted. It is possible to add additional simple
border stylegsee Appendix F) Width allows you to set the border width to any
of the predefined values from the menu or enter
your own value at the bottom of the menu. The
default widthThin is the thinnest line possible on
the output device.

The Colour option allows you to choose a colour
for the border using the standaslation Pro
colour picker.

Acorn Draw file borders can be used as well as
line borders. One example is supplied which
allows crop marks to be easily added to any
frame. InOvation Pro the border width is used to
scale the designs, so you may find some only looKlick onOK to apply the border to the selected
correct at a certain border width. frame or selection of frames. You can add borders

Note that borders are not storedivation Pro to rectangular, elliptical or even irregular frames

documents, so if you use a new border you must (f19s- 9:30 & 9.31).
provide it to anyone who you want to be able to Design sizds only available for Draw borders
use the document. and when selected sets the frame width to that of

Draw file borders can only be applied to the original border in the Draw file.

rectangular frames. If the border colour is

transparent, then the colours in the original Draw

file will be used (nb these are RGB colours), The mechanical

otherwise the brightness of the colour in the Draw typewriter, which

file will be used as a tint of the border colour. So originated in the USA
about a century ago,

®Frameborder  HEH] represented the first major
advance over pen or

L’Eﬂ pencil. Its two principal
i I v advantages were that a

competent typist could

-
| ]
W D WV Fig. 9.30 - Border around rectangular frame.

TS he

Hl wWidth|  1mm *H

The
mechanical
typewriter, which
r shadow  Cobu| 18] wietn[ 2mm 5

{ originated in the USA \
[T Use design size for border

v Barder Colour

[about a century ago, I|
'.,Irv:prf:&icntcd the  first .-'l
major advance over
pen or pencil. lts

Apply | Cancel | 024

Fig. 9.29 - The Border dialogue box. Fig. 9.31 - Border around circular frame.
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Adding Borders to Specified Sides Drop Shadow

You may use the four options in the top right You can add a drop shadow to rectangular frames
corner of the dialogue box to determine which by choosing th&hadowoption(fig. 9.33) The

sides of the frame the border is to be applied best drop shadow effect is obtained by applying a
(fig. 9.32) By default all four options are selected,border and a shadoffig. 9.34) In this case the
causing the border to be applied to all four sides. border is always applied to all four sides of the

Please note that these options only have an effectfame-
on rectangular frames. Borders on elliptical and You may choose the shadow colour and width
irregular frames are always applied to the entire using the options provided.

frame outline. WhenShadowis selected, the four options in the

top right corner of the dialogue box allow you to
choose the corner of the frame to which the
shadow is applied.

You cannot apply a drop shadow to an elliptical or
irregular frame.

I
The mechanical
typewriter, which
originated in the USA
about a century ago,
represented the first major

advance over pen or
™ Frame border | ) pen ar
pencil. Its two principal
ﬂ advantages were that a

competent typist could
I mmmm [ e

Fig. 9.32 - Border on top and bottom only.

The mechanical
typewriter, which

[ Border Culnur- *H| width| 1mm 3 originated in the USA
- — about a century ago,
3 Shadnw‘ Culnur- Bl width| Zmm *H represented the first major

advance over pen or
pencil. Its two principal
advantages were that a
Apply | Cancel | oK competent typist could

= Use design size for border:

Fig. 9.33 - The Border dialogue box with Shadow selected. Fig. 9.34 - Border and drop shadow.
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9.7 Text Flow
Menu>Objectr> Text flow... Ctrl+Shift+T

If a frame is positioned over another frame
containing text, the text may be repelled and flow
around the framélext flow controls how the text
flows around the framgig. 9.35)

It only applies to frames, and not lines which are
always transparent and do not repel text.

Runaround

These options control whether text flows around
the obstructing frame or behind it.

None causes the text to flow behind the frame
completely ignoring itfig. 9.36)

Frame causes the text to flow around the frame
shape leaving a gap around the frame of whose
size is specified bgtandoff (fig. 9.37)

Picture causes the text to flow around the shape
of the picture in the frame leaving a gap around
the frame specified bgtandoff (fig. 9.38) It is
only available if the frame contains a picture.

T Text flow HE

— Runaround — Text flow
" MNone & Wider side
&+ Frame O Left side
" Picture " Right side
¢ Both sides
StandnﬁlTrrﬂ " Neither side

Cancel | Ik

Fig. 9.35 - Text flow controls how text is repelled.
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the mechanical typewriter suffered one
major drawback. As soon as the typist hit

Fig. 9.36 - Runaround set to None.
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Fig. 9.37 - Runaround set to Frame.
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Picture Runaround Editing the Standoff Curve

ChoosingPicture runaround causé3vation Pro The standoff normally follows the shape of the

to trace the edge of the picture in the frame and frame or picture, but it can be made any shape by
then generate a Standoff curve of the same shapediting the Standoff curve in path edit mode

The Standoff curve follows the shape of the (fig. 9.39) This is useful if you want to have a
picture but stands off by the distance specified bydifferent standoff on different sides of the frame
the value ofStandoff (1mm by default). or if the text doesn’t flow around the picture

You can set picture runaround for Draw files or €X@ctly as you require.

bit-image files such as sprites which may have a If the standoff curve is edited, the value for
mask or a solid background. In the latter case, Standoff is blanked out. Resetting this value will
Ovation Pro detects the background colour and reset the text flow so that it follows the shape of
ignores it when tracing the sprite outline. the frame or picture again.

Furthermore, it sets the Inset curve to the exact

shape of the picture thus masking out the

background colour.

SettingPicture runaround automatically sets the
frame to a transparent background so that it does
not obscure the text that flows behind it.

Please note that there is a delay when setting
picture runaround while the picture is traced. The
length of the delay depends upon the size and
complexity of the picture. You can press Esc at
any time to cancel picture runaround.

You can control how accurate@vation Pro
traces the picture using tRainaround error on
the Choicesdialogue boxsee 15.8).

Menuc>Misce>ChoicesyPictures

The mechanical typewriter, which The mechanical typewriter, which

originated in the USA about a gentury originated in the USA_about a century
ago, represented major ago, represented the first major
advance| over or advance over pen or
pencil w o pencil. Its t w o
principal gdvantag principal advantag
es wer that a es were I"'hat a
compet ot typist compete nt typist
coul vrite could write
m u c|h fapter with m u c h faster with
a typewtiter r o with a typewrite® than with
pen or i at  the pen or pencil and that the
writin i uced writings Froduced

was consistent and clearly legible. [t was
not surprising, then, that the typewriter

Fig. 9.38 - Runaround set to Picture.

was consistent and clearly legible. [t was
not surprising, then, that the typewriter

Fig. 9.39 - Editing picture runaround.
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Text flow

These options control how text flows around
frames and pictures. The text can flow around the
Wider, Left, Right, Both or Neither sides.

The mechanical typewriter, which
originated in the USA about a century ago,
represet = Bl
nted
the first
major
advanc
e overl
pen or
pencil.
Its two
prin-
cipal
advantages were that a competent typist
could write much faster with a typewriter

-
-
-

Fig. 9.40 - Text flow to Left side.

The mechanical typewriter, which
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could write much faster with a typewriter

18

-

Fig. 9.41 - Text flow to Right side.

CHAPTER 9

The mechanical typewriter, which
originated in the USA about a century ago,
= fhted

uJ

represe

the first major
advanc e over
pen or pencil.
Its two prin-
cipalll Tadvanta
g e s were
that a compet
e n t typist
could write
mu ch Taster

with a typewriter than with pen or pencil
and that the writing produced was

Fig. 9.42 - Text flow to Both sides.

The mechanical typewriter, which
originated in the USA about a century ago,
= |

uJ

represented the first major advance over
pen or pencil. Its two prin- cipal

Fig. 9.43 - Text flow to Neither side.
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9.8 Duplicate
Menur>Objecte>Duplicate...

Duplicate allows an object or selection to be
copied a number of times at specified horizontal
and vertical offsetffig. 9.44) It is particularly
useful for creating tables and grids from lines or
frames.

Number of times specifies the number of
duplications to be made.

Vertical offset is the vertical shift made before
each duplicatiorffig. 9.45) This value should be
positive for a downward shift, negative for an
upward shift or zero for no vertical shift.

Horizontal offset is the horizontal shift made
before each duplicatioffig. 9.46) This value
should be positive for a rightwards shift, negative
for an leftwards shift or zero for no horizontal
shift.

¥ Duplicate object __HIE3]
Mumber of times 1_|L|;|

Wertical offset|  3mm

Harizontal offset| 3mm

Cancel ]2

Fig. 9.44 - The Duplicate dialogue box.

DupLicatre 125

Making One Duplication Ctrl+Shift+D

You can make one duplication of an object or
selection by pressing Ctrl Shift D. The offsets
used are the same as those set oDtipicate
dialogue box.

Fig. 9.45 - The single line has been duplicated
to form a series of 10 lines, 4mm apart using:
No of times =9, Vertical offset = 3mm,
Horizontal offset = Omm.

Fig. 9.46 - The single 10mm x 10mm frame has been duplicated to form a

series of 8 frames, 5mm apart using:

No of times = 7, Vertical offset = 0mm, Horizontal offset = 15mm.
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9.9 Shape Regular polygonchanges any object into a

Menur>Object>Shape... Cirl+H regul_a_r po_lygon with the number qf sides
] S specified(fig. 9.48) The polygon will have the
Shapeopens a dialogue box which indicates the ¢5me size bounding box and shape as the
shape of the selected object, and allows you t0  ,,nding box of the original object. If you wish to
change iffig. 9.47) draw perfect regular shapes such as triangles,
Rectanglechanges an ellipse or polygon into a hexagons, octagons etc., your original object must
rectangle. The rectangle will be the same size antie perfectly square.

shape as the bounding box of the original object. i, changes any object into a star with the

Ellipse changes a rectangle or polygon into a number of points specified.
ellipse. The ellipse will have the same size

bounding box as the bounding box of the original

object.

Polygonchanges a rectangle or ellipse into a
polygon. The polygon will have the same size
bounding box and shape as the original shape, but
will be constructed from straight and curved line
segments thus allowing a rectangular or elliptical
shape to be edited in path edit mode.

I = ol [d = |
The mechanical T h e
typewriter, which mechanical
originated in the typewriter, which
USA about a originated in the USA
m century m o about a century ago, [
ago, represented the first
repre major advance over

s e pen or pencil. lts

# Alter shape | two principal

@ Rectangle 4 = B = |
I = B 3 = E1
" Ellipse T h e T h e
mechanical mechanical
" Palygon typewriter, which typewriter, which

. iginated in the USA ariginated in the USA
~ Reaul I I_ﬂ' — originate g
Bguiar polygon Sl | —I—I mbout a centu ry ago,mn mabout a century ago, [

 Star represented the first major represented the first
advance over pen or major advance over
pencil. Its two pen or pencil. Its
Cancel | OK principal t w o
. = 8 M = |

Fig. 9.47 - The Shape dialogue box. Fig. 9.48 - Regular polygons.
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9.10 Front/Back 9.11 Group/Ungroup
Menu=Object>Front Ctrl+Shift+U Menu=>Object>Group Ctrl+Shift+K
Menu>Objectr>Back Ctrl+Shift+H

Group turns a number of selected objects into a
There are two ways to send objects to the back osingle group. A group has a single bounding box
bring them to the front. enclosing all the objects in the group, and can b
moved, rotated, duplicated, grouped etc. just as

Using menu options thouah it ingle obje(tg. 9.49) If th
If a number of objects occupy the same area of tha oo g1 1t WETE 8 SIng'e © joig. 9.49) e

! . . r IS resi ragging, all th ' in th
page, the object created last is said to be at the t oupis eS|Zf—:-d by dragging, all t e_objects n t
: roup are resized by the same relative amount. |
of the stack and obscures other objects lower

down the stack. Treront option brings the. - E HA0E SRACE IEEC A T e
selected object to the top of the stack. It is only P y

: . : . when there is more than one object selected.
available when there is a single object selected
which is not already at the front. Ungroup breaks down a group into the objects

The Back option pushes the selected object to thethat make it up. It is only available when there is

bottom of the stack, hiding it behind any other single group selected. It has the same key short
. cut asGroup.

objects that occupy the same area of the page. Itis

only available when there is a single object

selected which is not already at the back.

Using keyboard short-cuts.

When using the keyboard short-cuts the object is
moved one layer at a time. In this way you can
change the following order of a stack of frames.

Beware that you can send an object behind the
main text frame, making it invisible. To retrieve
such an object either put the main frame at the
back or drag an area holding down the shift and
control keys. The object outline will be visible if it
has been totally enclosed within the dragged area,
and the selection can then be moved forward.

|

A Bl
The mechanical write much faster with a

typewriter, which | |typewriter than with pen
originated in the USA| |or pencil and that the
about a century ago,| |writing produced was
represented the first major|  |consistent and clearly
advance over pen or| |legible. It was not
Dpencil. Its two principal | |surprising, then, that thelf
advantages were that a| |typewriter heralded an
competent typist could| |‘office revolution’ in

Three frames in a group.
4 = cal|

Fig. 9.49 - The Group option allows a number of objects to be
grouped together and manipulated as a single object.
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9.12 Make Local/Make Master 9.13 Snap to Grid
Menu>Object=>Make Local Menu>Object=>Snap to Grid

Make local converts a Master object generated byThis option causes the top left corner of the

the Master Pages, into a normal object that can bgelected objects to snap to the nearest grid point. It
edited in the usual wajake local is only only applies if either the grid or grid lock is
available when the selected object or objects are enabledsee 7.4)

Master objects.

Make master converts a Master object that has
been made local, back into a Master object.

Make masteris only available when the selected
object or objects are Master objects that have been
made local.

Any changes that were made to a local object
are lost when it is made back into a Master
object.

Refer to Chapter 11 for more details about Master
objects.
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Working with Pictures

A General Picture Handling

10.1 Importing Pictures. . . ... .. .
10.2 Selecting Pictures. . ... .. e
10.3  Moving Pictures . ... ...
10.4 Resizing PICtUIES . ... ...
10.5 Rotating Pictures. . ........... ... . .
10.6  Cropping Pictures .. . .......... .
10.7  Modify Picture. . ... e
10.8 Optionsonthe EditMenu............... .. .. ... . .......
10.9 Object Linking and Embedding. . . .............. ... ......

B Large Picture Support

10.10 Importing pictures . . . ...t
10.11 Setting Picturechoices. . ........... .. .. .. .. i
10.12 Referenced Picturesand MailMerge . . ...................
10.13 Snags, Hintsand TipS. . .. ... ..ot

This chapter describes how to import pictures into frames, and then
manipulate them in various ways.

The handling of large and/or high resolution pictures or complicated
vector files is mentioned separately in the second part of this chapter
starting with an introduction to this aspect of picture handling.
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10.1 Importing Pictures The imported picture is centred and scaled to fit
To import a picture, drag the picture file into a inside the frame but keeping its original aspect

frame. You may import standard Windows bitmaﬂ'atio .. its original shape. If the frame is

(.bmp), JPEG, RISC OS Sprite and Draw files rectangular, the entire picture will be visible
plus other popular formats detailed in the (figs. 10.1 and 10.2ptherwise the edges of the

Ovation Pro release notes. If you try and load an pi_cture are cropped to suit the shape of the frame
unrecognised picture format, the file will be (figs.10.3 and 10.4)

interpreted as a text file and you will be asked to Menuc>Filec>lmport...

confirm whether you wish to proceed loading it Aq an alternative to drag and drop you can use this
(see 3.3) menu entry to open a standard Windows open file
A warning is given if there is insufficient memory window and select the picture file you want.

to load the picture.

The frame may be any shape, but must be
completely empty or already contain a picture (in
which case the old picture is overwritten). You
cannot import a picture into a frame that already
contains text unless all the text is deleted first,
otherwise the picture is embedded in the text (see
later).

Fig. 10.1 - Fit to frame with aspect lock. Fig. 10.3 - Fit picture in elliptical frame.

Fig. 10.2 - Fit to frame with aspect lock. Fig. 10.4 - Fit picture in irregular frame.
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Importing at a Specified Scale

If you hold down Ctrl when importing a picture,
the picture is imported at the scale specified in
Choices(see 14.7)By default this is 100% i.e.
the original picture size.

Embedding a Picture

SeLecting Pictures 131

10.2 Selecting Pictures

If a picture hasn’t been selected, operations suct
as move, rotate, cut, copy etc. apply to the
selected frame and its contents. If the picture ha:
been selected, these operations apply to the
picture only; the frame remains unchanged.

If you drag a picture into a text frame which is notChoose the Select tool on the toolbox and left

empty, the picture is imported into an
automatically generated picture frame which is
embedded into the text at the pointer position.

The picture is imported at its original scale, but
scaled down to fit if necessary.

Saving Pictures

If there is an active picture frame, the

Save pictureoption becomes available on thige
menu. This allows you to save the picture in the
frame to disc, or to another application. The
picture is saved in the same format that it was
loaded in.

. 10.5 - A selected picture.

double-click on a picture to select it. A three-
pronged resize tool is displayed over the centre «
the picture confirming that it is selectéy. 10.5)

Right click over a selected picture to deselect it.
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10.3 Moving Pictures Using the Info Palette

To move a picture within a frame, ensure that theYou may use the info paletfég. 10.7)to position
Select tool is active then double-click over the  the picture in the selected frame (in this case the
picture to select it. Now left click and hold over picture does not need to be select&dandY are
the picture (not over a handle) and when the Hanthe offsets from the top left corner of the frame to

tool appeargfig. 10.6)you can move the picture. the top left corner of the picture, and can be
modified to change the position of the picture.

You can constrain movement to the vertical or Press Return afterwards to update the document.

horizontal direction by holding down Shift before ' '
dragging and keeping it held down while moving Alternatively, click on the up and down buttons to

the picture. move the picture in the appropriate direction.
You can position the picture within the frame Note that theX andY fields towards the left side
precisely using the info palette or thi®dify of the info palette refer to the picture frame,
picture dialogue boxsee 10.7) F6  WhereaX andY towards the right edge refer to

the picture itself.

Fig. 10.6 - Use the hand tool to drag
the picture to a new position.

Picture frarme ¥ 9mm iy | 49.95mm Seale | 20 ﬂ}{ Umm jAI a j
1132 ¥ 187 87mre H[4967mm Aspect| 100 :II ¥ Ornm :II Fitl Ctr

Fig. 10.7 - The info palette gives the position of the current picture. You can reposition it by changing the X and Y values. The
info seen here reflects details of Fig. 10.6
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10.4 Resizing Pictures Aspectis the ratio of the horizontal scale of the
Menu=PicturessModify picture... F6 picture to the vertical. You can enter a new value

_ ) _orclick on the up and down icons to change the
To resize a picture, ensure that the Select tool is aspect one percent at a time. A value of 100%

active then double-click over the picture to select ,aans that the picture is displayed in its original

it (fig. 10.8) To resize the picture, drag the handleghape, To stretch a picture sideways increase th

at the end of the diagonal line on the resize value, and to squash a picture sideways decreas
gadget. liAspect lockis selected on thilodify this value. For example, to make a picture twice

picture dialogue box, the picture shape willbe  \yiqe as its original, set Aspect to 200%.

retained. . :
Resizing Frame & Picture

If you resize a picture frame by dragging its
handle using the right mouse button, the picture
resized too. WittAspect lockset the picture will
Be resized to fit the height of the frame. Otherwis

You can resize the picture precisely by using the the picture will follow the size of the frame.
info palette or théodify picture dialogue box

To resize the picture in the horizontal direction

only, drag the handle at the end of the horizontal
line. To resize the picture in the vertical direction
only, drag the handle at the end of the vertical lin

Fit
(see 10.7) o : L
] This option scales the picture so that it fits the
Using the Info Palette frame. If theAspect lockoption on the

You may use the info paletfBg. 10.9)to resize  Modify picture dialogue box is selected, the
the picture in the selected frame (in this case the picture shape will remain unchanged. If

picture does not need to be selected). Aspect lockis not selected, the picture may be
Scaleis the scale of the current picture as a stretched to fit the frame exaCtly. Ctrl+J can be

percentage of its original size. You can enter a  used as a short cut.
new value or click on the up and down iconsto Ctr

change the scale one percent at a time. Changingrp,;g option will centre the picture without

this value affects scaling in both X and Y changing its scale. It is especially useful if due tc
direction, so the picture shape is not changed. rescaling the picture has moved out of sight.

Ctrl+E can be ued as a short cut.

Fig. 10.8 - Double click on the picture to select it
instead of the frame.
Drag the handles to scale the picture.

Picture frame w| Immo | 43.55mm - Segle | 90 ill}{ Ornm :II“E‘I 0 :II
1132 v[18757mn W[ 4967mm Aspect| 100 = ¥[ Omm = Fit | cur]

Fig. 10.9 - The info palette allows the scale and aspect ratio of the picture in the selected
frame to be altered. The Fit option, fits the picture to the frame..
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10.5 Rotating Pictures Using the Info Palette

Whenever a picture frame is active, A on the info When a picture is selected and the Rotate tool
palette(fig. 10.9)shows the angle of rotation for chosen, the options on the info paléfig. 10.12)
the picture. The angle is in degrees and is apply to the rotation of the picture instead of the
measured anti-clockwise. You may enter a new Object.

value and press Return or click on the up and A s the angle of rotation of the picture. The angle
down icons to increase or decrease the angle by of rotation is in degrees and is measured anti-

one degree or by ten degrees while holding downc|ockwise. You may type in a new value followed
Shift. The picture is rotated about the centre of thgy Return to rotate the picture to the desired

frame. angle. Alternatively click on the up and down
To set an exact angle use the Angle dialogue boXcons to increase or decrease the angle by one
on theModify picture menu degree.

Menu=>PicturesoModify picture... F6 Clicking on the 3 x 3 grid will position the

Using the Rotate Tool crosshair at the same relative position on the
9 frame containing the picture. The 9 points relate to

Ensure that the Select tool is active then double- yo centre, the fours corners and the centres of the
click over the picture to select it. Now choose the¢, ¢ sides.

Rotate toolfig. 10.10)then left click and drag on o _ )
any part of the picture until it is at the required If Crosshairis selgcted, the_plc_tu_re is rotated
angle(fig. 10.11) about the crosshair, otherwise it is rotated about

_ _ o its centre.
The centre of rotation for the picture is indicated

by a small crosshair, which can be dragged toa  RRotating is not possible when a picture has
new position if required. been locked.

I = |

<

—— Rotate tool

:9\
I~ The crosshair
[ = /._'I

Fig. 10.11 - When a picture is selected you may use the rotate tool to rotate the picture
about the centre of rotation indicated by the crosshair.
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Fig. 10.10 - The Rotate tool.

Ratate AE jJJJpCfDSShaif g | oo° | 1800 | -on°
Frr
11 rrr 452 | 1350 | -135°] -45°

Fig. 10.12 - When a picture is selected and the Rotate tool chosen, the info palette
provides options concerned with rotating the picture.
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10.6 Cropping Pictures It is important to remember that the Crop tool only
results in a changed view within the picture frame.
But the original picture is not changed in any way,
as can be seen by resizing the picture frame.

The Crop toolfig. 10.13)allows you to crop or
cut off unwanted edges of a picture leaving the
part you do want filling the frame.

Position the pointer at the top left corner of the
rectangle you want to retain and drag to the
bottom right corne(fig. 10.14) When you release

the mouse button the part of the picture you haveThe Crop Info palette gives information while

chosen is ‘fitted’ into the fram@@ig. 10.15)as cropping a picture frame. It does not allow you to
follows: set dimensions.
» If Aspect lockon theModify picture To reset, select the picture using the Select tool

dialogue box is selectddee 10.7)the picture and then click Fit on the Picture Info palette.

is scaled to fit the frame without changing
shape.

» If Aspect lockis not selected, the picture is
scaled to fit the frame precisely, changing its
shape is necessary.

You can’t crop a picture if it has been locked.

Cropping can actually be done by dragging from
any corner to the opposite diagonal corner. When
using the Crop tool, you must start within the
picture frame. You can eventually drag beyond
the picture frame, resulting in a scaling down of
the cropped picture.

—— Crop tool

) OIOE8 o

I2|<|(

Fig. 10.13 - The Crop tool.

CropprING PicTurES

This also means that by selecting the picture (by
double clicking on it) one can move the picture to
reposition it within the frame.

Fig. 10.15 - The cropped picture.
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10.7 Modify Picture Tile
Menur>Picturer>Modify picture... F6 This allows the picture in a frame to be repeated

TheModify picture dialogue boxfig. 10.16 & ona rectangulqr grid. The andY.dlsFance icons
. . . ; are the separation between copies in the frame of
fig. 10.17)is available from the main menu when

4 picture frame is active reference of the original picture. So for example if
P _ ' _ o the distance is 10mm and the scale the picture is
It can also be displayed by triple-clicking over a rendered at is 50% the distance you see will be

picture. 5mm(fig.10.18)
Scale Perfect joins between copies of pictures may not
This is the scale of the current picture as a be possible. If you get slivers of frame

percentage of its original size. You can enter a  background showing through, try a small negative
new value or click on the up and down icons to value for the distances.

change the scale one percent at a time. Changing

this value affects scaling in both X and Y

direction, so the picture shape is not changed.

Aspect

This is the horizontal scaling of the picture. You
can enter a new value or click on the up and down
icons to change the aspect one percent at a time. A
value of 100% means that the picture is displayed
at its original shape. To stretch a picture sideways
increase this value, and to squash a picture
sideways decrease this value. For example, to

make a picture twice as wide as its original, set Tile X
Aspectto 200%. -0 0 88 8 8 8 8 8

This is the angle of rotation of the picture in the AdL00a000d

frame. You can enter a new value or click on the

up and down icons to change the angle one degree AdAd00840000

at a t.ime- The ?n9|e i? SpeCi.ﬁed in d.egreeS, and ¢Fig, 10.18 - A tiled bitmap image, size 34x17 pixels with
positive angle is applied anti-clockwise. settings: Scale 50%, Aspect 100%, Tile X=5mm Y=7mm

T Modify picture |

Scale| 90 % w|a] x| Odmm v | 4]
Aspect| 100 % =|a| v| Omm =]
Angle| U © | |’ ™ Tile

Skew_ﬂ . LILI }{I Ormirm ‘fl Ormrmn

& Po lock = Centre lock ¢ Lock

Modify picture... F& V¥ Aspect lock [ Auto scale ™ Hide picture
Info.. [T ¥ &Y from bottarn left
Reference...
Fi

oy Fit Apply Cancel oK
Frocess...
SCreet...

Fig. 10.17 - The Modify picture box provides options for altering the
Fig. 10.16 - The Picture menu. properties of pictures.. Values as used for fig. 10.18.
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Aspect Lock

These show the offsets from the top left corner oflf Aspect lock is selected, the Auto scale, Fit and
the frame to the top left corner of the picture. Youcrop options will scale the picture to fit the frame
can enter a new value or click on the up and dowretaining its original shape. If Aspect lock is not

icons.

X and Y from bottom left

When this is selected théandY coordinates will
show the offset of the origin of the pictures
internal space from the bottom left corner of the
picture frame.

Skew

selected, the Auto scale, Fit and crop options wil
stretch the picture to fit the frame precisely.

The diagonal scale gadget is also affected by thi
option.
Auto scale

If Auto scale is selected, then re-sizing a picture
frame with Select causes the picture to be re-siz

This is the angle of skew for the picture. You cant00. This normally only happens if you re-size a

enter a new value or click on the up and down

picture frame with the right mouse button.

icons to change the angle of skew one degree at gide picture

time. A positive value skews the picture to the
right (fig. 10.19)and a negative value, to the left

If Hide picture is selected, the picture in the fram
is hidden and replaced by a cross. this may be

(fig. 10.19). The angle is specified in degrees and,qqf,| if the picture is slow to redraw.

must be within the range -80° to 80°.

No Lock
No lock is the default setting and allows the

picture to be moved, resized or rotated from the

dialogue box, info palette or by dragging.
Centre Lock

If Centre lock is selected, the picture is locked to

the centre of the frame. The X and Y values

cannot be changed, nor can the picture be moved

from the info palette or by dragging.
Lock

This option locks the picture so that it cannot be
moved, resized or rotated from the info palette or

by dragging.

Fig. 10.19 - Picture skewed 25°

Fig. 10.20 - Picture skewed -25°
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10.8 Options on the Edit Menu Delete picture Ctrl+K
Menu=>Edite> This option deletes the selected picture.

TheEdit menu(fig. 10.21)contains a number of  Select all Ctrl+A

operations that you can apply to a selected picturgyhen one object has been sele@etect all

If you do not have a selected picture, the results in all frames on the present page being

operations on this menu will apply to the frame. gglected.

To select a picture double-click on it so that the Clear Ctrl+Z
resize gadget is displayéiy. 10.22).Right click
to deselect a picture.

Cut picture Ctrl+X

Cut deletes the selected picture and places it on
the clipboard. The previous contents of the
clipboard are overwritten by this operation.

Clear deselects the selected picture(s).

Copy picture Ctrl+C

Copy copies the selected picture onto the
clipboard. The previous contents of the clipboard
are overwritten by this operation.

Paste picture Ctrl+Vv

Pasteinserts the picture that is on the clipboard,
into the active picture frame. A picture can be
pasted into an@vation Pro document, not just

the one from which it was cut or copied. After
pasting, the clipboard contents remain unchanged.
This option is only available if the clipboard
contains a picture and there is a picture frame or
empty frame active.

Undo Deselect  Citl+Z

Beda 7 [
Cut Picture Cirl+
Copy Fictura Cirl+
Paste clipboard  Cirl+
Delete Ficture Cirl+k
Ermbed aliject

select all i+,
Clear

Eitidl... Etl+E
il e =3

Fig. 10.21 - The Edit menu. Fig. 10.22 - A selected picture.
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Drag & Drop Pictures and memory use

Instead of usin@ut, Copy andPasteto move or  If you copy a picture or picture frame within the
copy a picture via the clipboard, you can use the same document using ‘drag and drop’, the

drag and drop facility to do this directly. resulting copy is simply a pointer (or reference) t
the original and uses no extra memory. Howevel
if you ‘drag and drop’ to another document, an
entirely separate copy is made in the destination
document.

To use drag and drop, first select the picture you
wish to move or copy. Now press Alt and left
click over the picture so that the drag and drop
tool is displayed. Then drag until the pointer is
over the required frame and release the mouse The same is true when pictures or picture frames
button to insert the picture. The destination frameare copied usinGopy andPastevia the

must be empty or contain a picture (in which caseclipboard. However, since the clipboard is treate:
the original picture is overwritten). as a separate document, a separate copy is kepr
the clipboard until it is overwritten by another
object. For example, if you import a 100K picture
copy it to the clipboard and then paste it back 6

_ ] ) times, only 200K or RAM will be used (100K in

If you hold down Shift Alt while dragging, the  he document and 100K on the clipboard). When
above operations are transposed. So, if you drag gnother object is copied to the clipboard, causing

and drop within the same document, the picture igp picture to be overwritten, the resulting RAM
copied if you drag and drop to another document, ,caq will be only 100K.

the picture isnoved

If you drag and drop within the same document,
the picture isnoved if you drag and drop to
another document, the picturecispied

If you start a drag operation and wish to cancel it,
press Esc.
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10.9 Object Linking & Embedding (OLE)

Windows OLE, sometimes known as COM or
Active X is not currently supported. See the
Ovation Pro release notes for news of
developments.

CHapTER 10
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Large Picture Support

Ovation Pro provides some facilities for handling large pictures. These are
referenced pictures and proxy pictures.

Normally pictures are embedded in Ovation Pro documents. So for example a
document containing five 20Mb pictures will be at least 100Mb in size. A
referenced picture on the other hand is not embedded in a document. Instead
the document contains the filename/path of the picture (the reference) and the
picture is stored on disc separate from the document.

Typically referenced pictures will be used by those producing documents
including high resolution pictures for professional printing. By keeping the
pictures separate from the document it becomes easier to modify because it
uses less memory. In addition referenced pictures are only loaded when needed,
this is a simple form of virtual memory.

There are a couple of other situations in which referenced pictures are useful.
Firstly if you have a large number of documents which contain the same picture.
The classic example is a logo used on a letterhead. By making this a referenced
picture there can be a substantial overall saving in disc space.

The other possibility opened by referenced pictures is mail merging where the
pictures in the merged documents change depending on the data used.
Traditional mail merge allows you to personalise documents by inserting
someone's name and address, now you can also include their picture.

A proxy picture is a small fast to render picture which is used in place of a large
or slow to render picture whilst the document is edited. The standard use of
proxy pictures is in conjunction with large referenced pictures. The referenced
picture is only ever loaded into memory when the document is printed, the rest of
the time the proxy is used. Another less common use is for pictures that are slow
to render e.g. complex vector pictures.

On the following pages you can find information on:

Importing Pictures . . . ... . 142
Setting Picture choices .. ........ ... 145
Referenced Pictures and Mail Merge. . . ............. ... 146

Snags, Hintsand Tips .. ........ ... . . 147

141
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10.10 Importing Pictures

If Shift is held down when a picture is drag and
dropped into a frame, a new dialogue box will
appeal(fig.10.23).

Proxy

The two button®roxy andReferencecontrol if

the imported picture will have a proxy generated

for it and if it will be referenced. A referenced
picture must exist on disc, you can't drag the

picture from another application. The menu icon

to the far right of théroxy button allows you to

open another window to set the parameters for thgontrol the Proxy and Reference aspects from two
proxy image(fig.10.24).

Proxy image, size

The buttons on the left control teezeof the
proxy. If for example the source picture is 2

CHapTER 10

Proxy image, colour depth

The group of buttons on the right set tdudour
depthfor the proxy. Normally you will use scaling
and colour depth so that the proxy picture is
smaller than the original picture, i.e. it is scaled
down and has a lower colour depth.

Dithering
TheDithering button controls if dithering will be

used when making the proxy picture in low colour
depths.

Once a picture is imported it is still possible to

new entries which appear on tRAeture menu,
accessible from the main menu when a picture
frame is selecte(fig. 22.25)

Menuc>Picturem........

inches square, then selecting base/2 will generate
a proxy picture 1 inch square. Assuming the same
resolution the proxy picture would have (1/2) *
(1/2) i.e. (1/4) the number of pixels.

Epictureimpot K|

Ficture I CAMyJunkilmstuffiTestvAdBug. spr

™ Proxy IEiaSEM Bbpp EI

[T Reference

Cancel | ]2

Fig, 10.23 - This window appears when a picture is dragged and
dropped into a frame if the Shift key is held down.

T Proxy picture |

—Size — Colour Depth
" Baseff 1 Base C dbpp 16 bpp

i Basefd  Base™? & Bbpp 32 bpp
" Basefd 1 Base™

I+ Dithering
Current praxy sizel 0 Ficture sizel 3l
Remove praxy picture | Remove all proxy pictures |

Cancel | Make proxy picture

Fig, 10.24 - The window to set the Proxy parameters.

kadity picture... FB
Info...

Feference...
Froxy...

Frocess..

SCreen...

Fig, 10.25 - The Picture menu
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Reference... Collect referenced picturesallows you to create
Menu=Picture=>Reference... a directory, into which all the referenced pictures
in the document will be copied from their current

SelectingReference...will open the dialogue box locations. This a way of gathering all the pictures

showing the location of the referenced pictiig: for a document in one place before sending the

10.26) document and pictures for printing. When the
The top icon shows théath to the current picture Picture Reference box is first opened the path
and can be edited to change the picture pointed tghown is in position independent form - which
You can drop a file into this icon to set up a path means it makes use of tfféedir} macro (just

or click on the button to the right to browse for a described). If you simply click o@ollect

file. TheReference Picturebutton will set the referenced pictures this sort of path will be used
path, loading the picture if necessary. This is alsofor the collected pictures. So you can

a way of replacing a picture with a referenced ongubsequently move the document and its pictures

TheEmbed picture in documentandEmbed all ~ around - e.g. from disc to disc. Alternatively if
pictures in documentbuttons load the current ~ You drag and drop a folder in to the icon or
referenced picture or all referenced pictures in thdrowse for a folder, the absolute path of the
document - effectively these buttons scrap the ~ destination directory will be used.

references. You might use them if you wanted to In general the collection option allows you to
prepare the document for passing on to someonechange all the reference paths in a document,

else and the pictures are not too large. providing they are valid to start with. For example
The paths are subject to the usDahtion Pro you might change all the references from absolute
macro expansion. So text{rraces }will be to position independent.

expanded. A common example is
{filedir}\picture.bomp

This expands to a file called ‘picture.bomp’ in the
directory containing the document. The point is
that as long as the picture is in the same directory
as the document this reference will work, so you
can move the document and picture without
having to change the references. The form
common in HTML files also works

\picture.omp

¥ Picture reference |
— This picture
Path | *E|
Embed picture in document | Referance picture |
—All pictures
Path {filedirhPFictures *El
Embed all pictures in document Collect referenced pictures |
Cancel | 0] 4

Fig, 10.26 - Picture reference window
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Proxy...
Menur>Picture=>Proxy...

CHapTER 10

There is a button on the main menu
View=>Options window (fig. 10.28)

SelectingProxy... will open a dialogue box

allowing the proxy picture to be controlled

(fig. 10.27)

Menuc>Viewr>Optionse...... Ctrl+Shift+O

WhenUse proxiesis ticked proxy pictures will be
used for on screen display in the current window.

The top section is the usual way of selecting the You'd probably untick this if you wanted to check
size of a proxy picture. The two icons underneathif the document displayed correctly with the real
this display the size of the picture and the currentPICtures, prior to printing It.
proxy picture (if there is onellake proxy

picture will create a new proxy picture using the
chosen settingfkemove proxy pictureremoves
the proxy, and finalllRemove all proxy pictures
removes all proxy pictures from the current

document.

pProxypictwre ______________HE|

—Size — Colour Depth
" Bage/8 1 Base T 4bpp O 1B bpp

= Base/2 1 Base™

& Bazsefd  Base™ @ Bhop 32 hpp

¥ Dithering

Current proxy sizel a Ficture sizel BBl

Remove proxy picture | Femove all proxy pictures |

Cancel |

Make proxy picture

Fig, 10.27 - The Proxy window

¥ view options |

W Toolbox W Pictures

I Buttan bar ™ Guidelines
¥ Info palette [T Print margins
[ Rulers [ Facing pages
[ Pasteboard I~ Invisibles

[ Spelling errors v Use proxies

Apply Cancel 0]4

Fig, 10.28 - The View Options window
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10.11 Setting Picture Choices proxies for vector files of quite modest size. You
MenuMisceChoicesPictures can also set the default parameters for creating

_ ] ] _ proxy picture by clicking on the menu icon to the
Some large picture handling options can be set irg,, right of Proxy if over.

the Picture Choices window (fig. 10.29).

ThePicture cacheis an area of memory which is
used for holding referenced pictures whilst they
are needed e.g. when printing. This memory is
shared between all documents.

You can uséicture choicesto set the maximum
size for the cache. Note that an attempt will be
made to load any picture, no matter how big.
Typically the picture cache maximum size
controls how many pictures will be held in
memory at any one time. As the picture cache
becomes full, pictures will be removed from it to
make space for new pictures.

Below this choice, there are two features which
work in a similar wayReference if overallows
you to tellOvation Pro to automatically reference
a picture on loading if it is over a given size.

Proxy if over automatically creates a proxy
picture if the original is over a given size. Note
that this assumes the raw file size is a reliable
indication of the size of the picture. Usually it will
be, but for example you might want to create

¥ Application choices |
e 1= I Ficture choices
( " Picture frame inget | Omm
Frint
Runaround errar 2
E:’ Picture import with Ctrl| 100 %
Seneral

[T Centre lock ™ Aspect lock

g& ™ Auto scale

¥ Check for missing fonts

— Picture cache max size | 200 Ll;l
. — [T Reference if over 200k ;I;I
'f/ ™ Proxy if aver 200k LILI *’El
Picture ll
Save Cancel | )78

Fig. 10.29 - The Picture Choices window
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10.12 Referenced Pictures and To create a document for displaying sheets of clip

Mail Merge art.

Normally mail merge is a way of customising
documents with text. Typically you may have a (b) Hold down shift and load a picture from disc

(a) Create a page design with a number of frames.

comma separated value (CSV) file from a into each frame, selecting the reference button.
database with the names and addresses of the The picture should be some sort of ‘default’. Also
people you want to send a standard lettésee notice that you have to do this once for each

12.5).Referenced pictures allow the possibility of frame, you can’t just copy the picture and you
adding pictures to documents under the control otan’t copy the frame with the picture in it. This is
a CSV file. So not only can you address your so that you get a separate picture within

letter to Mr. Jones, you can also include his Ovation Pro in each frame.

picture in it. Some possible applications; (c) Now for each picture on the page except the

(1) Producing identity cards. Given a standard last one, open theeference...window
card layout and a database of names and

X Menuc>Picturec>Reference...
pictures.

_ _ and change the path to something like:
(2) Producing catalogue sheets of clip art. A _ _
{macv=field(1); if(macv=="")

simple program will produce a list of all the —CAPictures\araphi el
picture files in a given directory as a CSV file. macv= %\ Icluresigraphic.emts, €1se
nextrecord()}

You can then have a document which displays
a number of these pictures on each page. ~ This says see what the first field in the mail merge

CSV file is, if it is null then use the default name,

To set up for mail merge, load a referenced otherwise use the field as the reference for the

fgcé?;glla;ygslczlgye?gjtrsvlgglnn?1ottorzzﬁ?naer%l;:r:;_re picture and then move to the next record in the

Select the picture box and open Reference... CSViile.
window. The last picture on the page should have a

. reference path like;
Menuc>Picturec>Reference... P

_ {macv=field(1); if(macv==
The correct sort of text to enter is as follows; macv="C:\Pictures\graphic.emf"}
{macv=field(1); if(macv=="")

d) Create a CSV file of your pictures. One eas
macv="C:\Pictures\picture.omp";} () y P y

way to do this is using the ListDir application.

This can be found in the Extras.ListDir directory.
Roughly translated the path for the picture is take

from the first field in the current CSV file record
(i.e. field(1)), if that is the null string (which is the For general information on mailmergisge 12.5.
value when there is no mail merging going on)

then the path is the given string (C:\ etc.), a good

choice for this latter is the path to the original

referenced picture.

(‘e) Mail merge in the normal way.

All the tricks you can use with mail merge fields
are also possible with the contents of the reference
path. For example you could add code to scan the
contents of a directory for pictures. Or supply a
picture depending on the contents of other fields
e.g. a smiley picture for those with more than £0

in their account and a frown for those with less
than £0.
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10.13 Snags, Hints and Tips

1. If you use large picture features the resulting
Ovation Pro document may not work with older
versions ofOvation Pro.

2. There is considerable scope for ending up with
a referenced picture where the reference points at
a non-existent file. Typically this will generate an
error when redrawing the page. The problem then
is how to get at the window that will let you

change the reference path for the picture. What
you need to do is use the main menu and open the
View options window and deselect ‘Pictures’.

You can then safely expand the window and
change the reference.

3. If you save a document as DDL or a Stylesheet
then when it is reloaded the file name is lost. This
precludes the use of relative paths.

4. If a referenced picture has a document relative
path and you copy it to another document the path
will be converted to an absolute one.

5. The paths to referenced pictures are stored in
documents. These paths have different forms on
different operating systems. An effort has been
made to make the Windows version of

Ovation Pro able to understand RISC OS paths.
Unless different machines are sharing files on a
common file system, usually only document
relative paths will be transferable between
computers.

6. Pictures loaded via filters, that is pictures in file
formats whichOvation Pro does not support
directly for example .gif can be referenced in the
Windows version oOvation Pro however note

that this is not the case for the RISC OS version.

7. Often you may have a document where many
picture frames contain the same picture.
Obviously it would be wasteful if the document
contained one copy of the picture for each frame,
Ovation Pro makes every effort to only have one
copy of the picture in the document.

Snacs, Hints & Tips

147
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Notes:
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Pages, Chapters & Master Pages

111 OVeIVIEW. o ottt e 150
11.2  Creating New Documents. . ...ttt 152
11.3 Edit Master Pages. . ......... . i i e 155
11.4  AddingaNew Chapter . ... 157
11,5 ModifyingaChapter . ... 157
11.6  Importing a Chapter using Copyand Paste ................. 158
11.7 Deleting Chapters. . ... . i 158
11.8 Page Insertion & Deletion. .. .......... ... ... . .. 159
11.9 Examples of documentlayout. .. ............. .. .. .. ... ... 161

This chapter describes how to create new documents, how to insert,
delete, copy and paste chapters, how to insert and delete pages, and
how to edit master pages.
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11.1 Overview Each page added to the chapter is based on the

Ovation Pro documents consist of one or more master page for that chapter.

chapters, each containing one or more pages. Master pages i@vation Pro aredynamic This

Initially a new document consists of one chapter means that if the master page is changed, all the
containing one page, but new chapters and pagegages in the chapter are instantly updated from the
may be inserted as required. master pages.

Pages are normally displayed in the window in  Master pages can be displayed and edited just like
order, with page and chapter breaks indicated by other pages.

broad grey lines. Master Objects

Master Pages Frames or lines drawn on the master pages are
Each chapter hasmaaster pag€2 master pages in calledmaster framesr master linesand are
double-sided documents) which controls the automatically inserted on all the pages in the
format of all the pages in the chapter such as the chapter. Normally, master objects can only be
paper size, margins, headers and footers. Mastermodified on the master pages. If you want to
pages enable you to create a template for the  modify a master object on the document page, you
pages in your document, ensuring a consistent must make itocal first (see 11.3)

appearance is obtained throughout.

¥ Documentl.dpd
Eile Edit iew Text Stele Ohject Fage Misc Applets Help

| o s <| PO E] Bl Ele o

8 O« #]

r—
L—d

Default master frame

4] |

Text frame #| 10mm | 190mm Avrial *t
11 [ 1omm W[ 27iem [NOB| 2| U] 1]

|0 O]#*|& 0

Fig. 11.1 - The active document window.
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Default Master Frame

Each master page normally hadedault master
frame (fig. 11.1)This frame is used for the body
of the text in a document. It is automatically
linked to the master frame on the following page.

If you type or import text so that it flows over the
end of the default master frame, a new page is
inserted at the end of the chapter and the text
flows onto it. This process is calladtomatic

page insertion

If you delete all the text from the default master
frame on the last page of a chapter, that page is

Overview 151

Goto Page

You can go directly to any page in the document
by choosingGoto pageon thePagemenu.

Menu>Page>Goto page... Ctri+G

Enter the required page number then press Return
or click OK (fig. 11.2)

Ovation Pro finds the page by searching from the
beginning of the document until the page number
is found. If you have a multi-chapter document
with duplicate page numbers, you should enter the
full chapter and page number in the farm

It is also possible to use more complex formats

deleted. This process is calladtomatic page
deletion The page is not deleted if there are any
additional objects on it i.e. if the page doesn’t
match its master page.

Current Page & Chapter

The current chapter and page number is shown in
the icon in the bottom left corner of the info
palette. The number is in the foep, wherec is

the chapter number ampds the page number.

If there is more than one page visible in the
document window, the current chapter/page is the
one in the centre of the window.

¥Gotopage KK

Current page 151

Goto page

Cancel I

Fig 11.2 - The Goto page dialogue box.

e.g. S.* takes you to the first page in chapter S.
(See 12.2Range.)
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11.2 Creating New Documents Sideways

Menu=Filec>New. .. Ctrl+N If Sidewaysis selected, the paper will be turned
on its side. So if you want to use A5 paper with
landscape orientation, choo&b from thePage
menu and choos®ideways

If you chooseNew on the File menu thidew
documentwindow opens. This allows you to
specify the format of the default master pages for
a new documer(fig. 11.4) All the settings for the Sidewaysswaps the paper width and height

default master page can easily be changed at a dimensions, so it affects both standard and non-
later stage. standard paper sizes.

The initial values are based on the default Sidewaysautomatically enables sideways
document. The standard default master page ~ Printing, but this may be disabled if required on
defines an A4 page containing a default master thePrint dialogue boxsee 12.3)

frame with 20mm margins all round. Colour
Page Colour allows the paper background colour to be
Pageis the page size, which is setAa by specified using the standa@ation Pro colour

’ picker.

default. You may choose another standard size
from the menu, or choo$@ther to specify a non- If Bleedis enabled on thErint dialogue box
standard size using th&andW options. (see 12.3)the paper background colour will

Please note that this option just sets the page sizEXt€nd the bleed distance over the paper edges. _
in Ovation Pro, and does not set the paper size for! '€ @mount of Bleed can be changed in Choices:

printing (which is done using the printer drivers). Menu=>Filem>Choices>Print...
e, Cirl+M
Open... Chrl+0
Irfo.. gNew document |
Save Ctrl+3 Page |A4 ] H] 297mm  Sideways
Save AS. Culnurl "El w/l 210mm
Sawve stary...
[Ee. — [ Default master frame
Save shylesheet.. Columns | 1 LILI Jﬁl
Fewvert to sawved —— — —
Top 10rim Left | 10mm Header| Omm
Frint... Cirl+F — " e —
4zt FEEe. Bottam 10mm Right 10mim Footer| Omm
Save as default [ Double sided ¢ Left ¢ Right & HMirror
Fecent Documents k
' 3
S@“Dnew Cancel QK
Exit

Fig 11.3 - The File menu. Fig 11.4 - The New dialogue box defines the default master pages.
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Default Master Frame Columnsis the number of columns in the default

If Default master frameis selected, the master ~master frame. Advanced options may be specified
pages will be created with a default master frame0n the dialogue box that is obtained by clicking on

which has the margins specified. the icon to the right of th€olumns option

If Default master frameis not selected, the (see 9.2 and fig 9.14, copied on this page)

master pages will be created without a default ~ Top, Bottom, Left andRight specify the margins
master frame i.e. completely blank. In this case around the default master frame i.e. they

you will have to draw all your own frames either determine the size and position of the frame

on the master pages or directly on the document (fig 11.5)

pages. Header andFooter specify the space reserved at
This can be useful when Creating a document the tOp and bottom of the default frame into which

which does not have a natural one frame per paggeader and footer information may placed. The
text flow e.g. a template for printing labels. header space is measured from the top of the
Another situation in which it is useful is where ~ frame; the footer space is measured from the
there is a set of frames completely covering the bottom(fig 11.5)

Default master frame. Normally a new page will

be added because of the automatic page insertion

produced by the text overflow in the default

master frame, and this extra page may be

undesirable.
Top margin
Header
T Column specification HE
& Gutter width Ernrn|
" Column width 190mm
Left Main Right _
margin frame margin — Column guide
™ Display column guides
Guide wn:ithl *H
Guide cnlnur- *H
Cancel | 024
Footer
Bottom margin Copy of Fig. 9.14 - Dialogue box for

Fig 11.5 - The page margins. setting column specification.
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Double sided

If Double sidedis selected, two master pages are
created; one for left-hand pages and one for right-
hand pages.

Typically this enables you to have a bigger inside
margin for binding, or to alternate the position of
page numbering so that it is always on the outer
edge (like the page numbering for this user guide).

If Left is selected, the settings fGolour,
Columns and all the margins refer to the left-hand
master page only.

If Right is selected, the settings Golour,
Columns and all the margins refer to the right-
hand master page only.

If Mirror is selected, the left and right master
pages use the same settings, exceptlgfatand
Right margins change tOuter andinner
margins(fig. 11.6)

Please note th&tage H, W andSidewaysmust
be the same for both left and right master pages.

@)

uter Left Inner | Inner Right
nargin page margin | margin page

3

Oute
margi

Fig 11.6 - The page margins for a double-sided document.

=

CHapPTER 11
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11.3 Editing the Master Pages Frame Handling
Menu>Page>Edit master pages If you draw a frame on the master pages and leave
Ctrl+Shift+C it empty, the frame contents can be edited in the

document. Do this if you wish to put empty guide

ChooseEdit master page(fig. 11.7)to edit the games on each page of the chapter.

master pages. A new document window is opene
showing the master page or pages for the currentf you draw a frame on the master pages and put
chapter. The title bar of the new window confirmssome text or a picture in it, the contents of that
that you are viewing the master pages. You may frame cannot be edited in the document i.e. the
use the vertical scroll bar to look at the master ~ contents are determined by the frame on the
pages for any other Chapters that exist. The master page. This is useful if you want the same
chapter number for the currently displayed masteteXxt or picture to appear on each page of the
page is shown in the icon in the bottom left corneghapter.

of the info palette. If the document is double- Headers and Footers

sided, there will be two master pages for each
chapter identified by and or R after the chapter
number in the info palette.

The same rules given above for frames also apply
to the headers and footers.

» If they are blank in the master pages, they may

The master pages may be edited just like normal 4 adited in the document.

pages. You can type directly into the header or
footer spaces or draw other objects anywhere on*
the page. When the master pages are closed, this
information will be automatically updated Please note that you cannot import pictures
throughout the chapter. directly into the header or footer space, but you

You can alter the size, shape and attributes of thé&@n draw additional frames for pictures if required.

default master frame, but you cannot type or
import any text into it - the contents of the default
master frame can only be edited in the document.
You can create objects with text or pictures in the
default master frame. Sé#aster Objectson the
following page.

If you enter text into them in the master pages,
they cannot be edited in the document.

Edit master pages Citl+Shift+C
Fage guicelines...

Mew chapter *
bodify chapter...

Copy chapter

Faste chapter k

Delete chapter

Inser page...
Delete page...
Goto page... Cirl+G

Fig 11.7 - The Page menu.
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Page Guidelines Master Objects

When you are viewing the master pages, the Any objects drawn on the master pages will
Guidelines option on thdPagemenu becomes appear on each page in the document. If the
available. double-sided option has been selected objects

drawn on the left-hand master pages will only
appear on left-hand document pages and likewise

This option opens a dialogue box allowing you 10 ¢4 right-hand pages. These objects are referred to
change the paper size, colour and margins for the;gmaster objects

current chapteffig. 11.8) ,

_ ) _ ) Master objects can be selected, but do not have
The options available are identical to those on thg,5ndles and cannot be modified in any way unless
New dialogue boxfig. 11.2). they are made local. To make a selected object
Closing the Master Pages local, chooséake local from theObject menu

Click on the close icon to close the master pages(fig. 11.9)
The document will be updated with the changes Menu=>ObjectevMake local
you have made.

MasterpageMenu>Page>Page guidelines

Once an object has been made local, it can be
modified in any way and is not updated by the
master pages.

A master object that has been made local can be
changed back to a master object by choosing
Make master from theObject menu. All changes
applied since it was made local will be lost.

X Poge guideines forchopier 1 |

S ideways
Culnurl *E|| wl 210mm Barder...
Textflow..  Cil+Shift+T
— [v Default master frame Shape... Cirl+H
Columns | 2 x| 4] ﬁl Duplicate..  Ctrl+Shift+D
Top 12mm Left | Smm Header| 10mm el At
— — — hlake [mca]
Battam 15mm Right | 20mm Footer| Omm
Frant
[v Double sided & Left ¢ Right (¢ Mirror Bk
Shap to grid
Artange...
Cancel Ok ,
Fill...

Fig 11.8 - The Guidelines box allows you to alter the master pages. Fig 11.9 - The Object menu.
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11.4 Adding a New Chapter

Menur>Page>New chapter....... Menu=>Page>Modify chapter...
To insert a chapter, chooBefore current You can use th®&lodify chapter option at any
chapter or After current chapter from the time to change various aspects of the current
Page>New chapter menu(fig. 11.10) chapter(see 11.4).

The new chapter inherits the master pages from The same options are available as when adding a

11.5 Modifying Chapters

the current chapter, but of course these may be new chapte(see 11.4)

edited as described earlier.

When you insert a chapter, thodify chapter
dialogue box is displaye(dig. 11.11)

Start on left andStart on right determine
whether the first page of the chapter starts on a
left-hand or right-hand page.

Start number is the page number for the first
page in the chapter. If left blank the page numbers
will follow on from the previous chapter.

Numeric, Roman upperandRoman lower are

the three page number styles available. They are
used whenever you insert a page number using
Page numberon thelnsert menu.

Count preceding blank pagesif the page

numbers in the chapter follow on from those in the
previous chapter then when this option is selected
the numbers will include any blank pages between
chapters. Pages are called blank if they are missed
out between chapters. For example if one chapter
ends on a right hand page and the next chapter
starts on a right hand page.

Omit header on first pageandOmit footer on
first page allow you to omit the header or footer

on the first page of the chapter. T Modify chapter 1 |
Click onOK to insert the chapter. © Statonleft & Start on right

—Fage number

Start numl:uerl 149

& MNumeric T Roman upper © Roman lower

[T Count preceding blank pages

[ Omit header on first page

™ Omit footer on first page

Base an chapterl 1

Betare current chapter...
After current chapter...

Cancel |

DIk

Fig 11.10 - The New Chapter menu.

Fig 11.11 - The Modify chapter dialogue box.
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11.6 Importing a Chapter 11.7 Deleting a Chapter
Menu=Page>Copy chapter Menur>PagevDelete chapter
Itis possible to copy chapters to the clipboard an&hooseDeletechapter to delete the current
paste chapters from it. chapter.
This provides a way of moving chapters from oneof course it is not possible to delete a chapter if it
document to another, changing the order of is the only chapter in the document.

chapters in a document, or duplicating a chapter.

The Page menu has entries @opy chapterand
Paste chapter ThePaste chapterentry has an
associated sub menu which allows a choice of
pasting the new chapter before or after the current
one(fig. 11.12)

Editmaster pages Cirl+shift+C
Fage guidelines...

Mew chapter »
hdodify chapter...
Copy chapter

Faste chapter Befare current chapter
Delete chapter After current chapter

Insert page...
Delete page...
Goto page... Cirl+G

Fig. 11.12 - Copy and Paste for chapters
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11.8 Page Insertion & Deletion Inserting Pages

When editing text in the default master frame, Menur>PagevInsert page...
pages are automatically added when text
overflows at the end of the chapter. If text is
deleted leaving pages at the end of the chapter
empty, these pages are automatically deleted.

To insert a page based on the master pages,
choosdnsert page This opens a dialogue box
allowing you to specify the number of pages to
insert and where they should be inserted
However, it is possible to manually insert or (fig. 11.13)

delete pages. Before explaining how this is done g .-k onOK to insert the pages.

good understanding of what happens when _ _
inserting or deleting pages is necessary. For example, import 10 pages of text into the

_ default master frame of a new document. Now if
When you have only text in your document and N9, insert 5 pages before page 1, you will create

local objects, you can insert or delete any amount 5 page document. However, the last 5 pages w
of pages. The end result remains the same as teX{q pank and therefore automatically deleted. So
is automatically reflowed as has been explained the final document will be the same as the origin

above. ) -
If the last 5 pages had contained any additior

objects, they would not be deleted. The page:
11 to 15 would then only have those objects
and no text on those pages in the master frar

But if your document has local objects you will
lose these if you delete pages on which they are
present. On the other hand if you insert a page
before a page having an object, that object will
now be on the page after the one you just inserted.
And most probably the newly inserted page will
now been reflowed with the text that initially was
alongside the object which has moved up a page.

Put in a simple way: inserting or deleting
pages has no effect on text present in the
default master frame but moves objects when
inserting and moves and possibly deletes
objects when deleting pages.

This means that after deleting or inserting
pages in a document with local objects you
must check the text and object layout.

T nsert page |

Insert | 1l pages

i+ hefore i~ after

page 159

Cancel e

Fig 11.13 - The Insert page dialogue box.
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Deleting Pages Double sided documents
Menur>Page>Delete page... With double sided documents it is better to insert

To delete a page, chooBeletepage This opens  ©F delete an even number of pages. This is

a dialogue box allowing you to specify the range especially important if the left and right hand
of pages to deletgfig. 11.14) pages have a different layout.

Click onOK to delete the pages.

This option deletes pages and any objects on those
pages, but it does not delete any text in the default
master frame. This text will flow onto the next

page and new pages will be automatically added

at the end of the chapter to accommodate the
overflow.

This means that in some cases your document will
be unchanged after deleting pages. For example,
import 10 pages of text into the default master
frame of a new document. Now if you delete all

10 pages, 10 new pages will be automatically re-
inserted to accommodate the text.

But if you have a 10-page document with local
objects as well as text on all pages, deleting 10
pages will result in the loss of all objects. Only the
text in the master frame will remain.

When inserting or deleting pages it is possible to
use more complex formats to select page numbers
e.g. S.* for the first page in chapter Se¢ 12.2,
Range.)

¥ Delote page __ HIE|

Delete fram page | 160

to page| 160

Cancel ] 4

Fig 11.14 - The Delete page dialogue box.



Section 11.9 ExampLes 161

11.9 Examples 5. Put the caret in the footer and insert the page

Examples of how to set up two typical types of number usingnsert=>Pagenumber.

documents are given below. Menu>Miscr>Insertr>Page number

Example 1 The page number is indicated by a # on master
This is a single-sided document with just one pages. Align the page number to the centre.
chapter. It has a header containing the documentgs, Close the master pages using the normal close
name and a footer containing the page number. icon on the title bar.

Both name and number are centfigl 11.15) Now type or import the text for the document. As

1. ChooseNew from the File menu and set each page is filled, a new page is inserted with the
Header andFooter to 10mm. name in the header and the correct page number in

2. Click onOK to close the dialogue box and  the footer.
create the document.
3. ChooseMenur>PagevEdit master pages

4. Type the document name in the header, and
align it to the centre using the appropriate icon
on the info palette.

Document Name

Fig 11.15 - Example 1.
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Example 2 6. Use the vertical scroll bar to scroll down to the
This is a double-sided document with multiple right-hand master page. The icon in the bottom
chapters, and a wider inside margin to left corner of the info palette will sho®R.
accommodate the binding. It has a header 7. TypeChapter 1 in the header of the right-
containing the chapter number and a footer hand master page, and align it to the right edge
containing the page number. Both name and using the appropriate icon on the info palette.
number are positioned on the outside edges of the |nsert the page number in the footer and align
pageqfig. 11.16). it to the right edge.
1. ChooseNew from the File menu and set 8. Close the master pages using the normal close
Header andFooter to 10mm. icon on the title bar.
2. ChooseDouble-sidedandMirror , then set Now type or import the text for the document. As
thelnside margin to 15mm each page is filled, a new left or right hand page is
3. Click onOK to close the dialogue box and  correctly inserted.
create the document. To add another chapter, use New chapter
4. ChooseéPagevEdit master pages Ensure that Option on thePagemenu(see. 11.4)Ensure that

you are viewing the left-hand master page, You set the correct starting side for the new
which is indicated byLL in the bottom left chapter, so that it follows on from the previous
corner of the info palette. chapter.

. TypeChapter 1 inthe header of the left-

hand master page, and insert the page number
in the footer (as described in Example 1).

Chapter 1 Chapter 1

Left page Right page

Fig 11.16 - Example 2. View -facing pages set on in the Options menu
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Printing & Mail Merge

12.1  Printers & Printer Drivers . ...
122 BasicPrinting . .......... i e
12.3  Advanced Print Setup Options . . .. ............. ... ...
12.4  POSISCript Printing .. ...
12.5 Mail Merge, the basic principles . . . ............ ... ... ...
12.6 Mail Merge, advanced features

12.7  Mail Merge, some examples

Ovation Pro uses Windows printer drivers to print documents exactly
as they appear on the screen, at any resolution that your printer can
deliver. To print a document, you must have a printer driver installed that
is suitable for your printer. A wide range of printer drivers are supplied
with your computer, and others are available separately from other
suppliers.

The Mail Merge facility allows a document to be printed a number of
times merging different data into each printout. Typically this feature
could be used to print a standard letter to a number of different names
and addresses.

The following Mail Merge examples show how fields can be used to
generate special results.

1. Generating address labels: multiple addresses on one page
Adding sequential numbers to documents: raffle tickets
Adding random number to documents: bingo tickets
Creating new Mail Merge data from other fields

Generating Mail Merge data from other sources
Manipulating Mail Merge data (e.g. removing blank fields)

L
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12.1 Printers & Printer Drivers Page Size and Paper Size

Ovation Pro can print on any printer, provided a Thepage sizes the size of the page set in
suitable printer driver has been installed in the ~ Ovation Pro. Thepaper sizas the size of the
printer manager. It is essential that you choose theaper that is fed into the printer.

correct driver for your printer, otherwise it will at |t is very important that printer driver is set up to

best produce a poor quality printout, or at worst have the same paper size as the paper being fed
deliver pure rubbish. Each printer driver has a  into the printer.

default configuration, such as resolution and
guality, and you may need to change this to
produce the results you require.

Usually the paper size should be set to the same
page size used i@vation Pro, but in some cases

. they may be different. For example, you may wish
Connection to print an A5 page on A4 paper, or printing two
You should configure the printer driver to use the A5 pages side-by-side on A4 paper.

correct port.for your printer. Normally thislwill be Landscape Pages

the parallel interface, but you may also print to th

serial port, to USB, to the network or to file. ?\Iormally, Ovation Pro prints each page of the

_ document upright on the paper. However, if the
Resolution page was set to [&ideways it is printed

Most printer drivers support a range of print sideways on the paper i.e. the print option
resolutions, so you must make a trade-off betwee8idewaysis automatically selectgdee 12.3)
print quality and speed. Higher resolutions give

better print quality, but take longer to print.

Quality

You can configure most drivers to print in mono
(black and white), grey scales or colour (if it is a
colour printer). The quickest results will generally
be obtained by printing in mono.

Portrait i
Sideways

also called
Landscape




Section 12.1

Print Margins

Menu=>ViewsOptions=>Print margins
Ctrl+Shift+O

Most printers cannot print right up to the edges of
the paper i.e. there is a margin around the paper
on which the printer cannot print. You can view
this margin by selecting tHerint margin option

on theOptions dialogue box. The print margin is
shown as a grey margin around the p@ige 7.5)

The area inside the print margins is the printable
area. If the page size is bigger than the paper size,
the print margin will show the area that cannot be
printed.

If any objects on the page extend into the print
margin, they will not be printed. There are a
number of solutions to this problem:

* Redesign the page so that all objects fit wholly
within the printable area.

» |If there is space at the opposite edge of the
paper, shift the page across when printing.
OptionsX andY on thePrint dialogue box
allow you to do thigsee 12.3, Advanced Print
setup options)

» Scale the page down when printing so that all
objects fit in the printable area. Any easy way
to do this is using thEit option on thePrint
dialogue boxsee 12.3)

Print=>Print setup

Note that the print margin is read from the printer
driver, so a printer driver must be loaded for it to
be displayed.

PrinTERS & PRINTER DRIVERS

165
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Print Speed & Memory Requirements If required, you can make extra memory available
The time taken to print a page depends upon the in the following ways:

type of printer you are using and the complexity « Quit any other unneeded applications before
of the page. PostScript and other laser printers are printing.

usually the quickest printers. Inkjet and in

particular dot-matrix printers tend to be the

slowest.

You can normally speed up printing in a number
of ways:

* Reduce the print resolution. You could use a
lower resolution for draft printouts, then
switch to the highest resolution for the final

copy.

* Reduce the print quality. If you are only
printing in black and white, ensure that your
printer driver is configured to mono (dot-
matrix and inkjet printers only).

* Free more memory before printing.
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12.2 Basic Printing Format
Menu=File=>Print. .. Ctrl+P Choose the format of the printed pages from the

To print a document, first ensure that the correct Print format menu(fig. 12.2)

printer driver has been loaded and configured. Normal

Normal is the default format, and prints pages in
the order they appear in the document. Each page
is printed upright at 100% scale, and centred on
the paper. However, you may change the scaling,
orientation etc. using the advanced print options
Printer (see 12.3).

This shows you the name of the printer that will
be used and allows you to change it from a menu
of available printers.

Now choosd-ile=>Print to open thérint
dialogue boxfig. 12.1)which provides all the
basic print options.

Because printer drivers or printer hardware
will occasionally crash your computer it is
Print Setup good practice to save your document before
If you click onPrint setup, the dialogue box trying to print it.

expands to display the advanced print setup

options(see 12.3, fig 12.8)

Copies
Copiesis the number of copies of each page that
you want to print. For a multi-page document,

each page in turn is printed the specified number
of times i.e. in the order 1,1,1, 2,2,2, 3,3,3 etc.

You may use th€ollate option if you want pages
to be sorted into order automatically i.e. in the
order 1,2,3, 1,2,3, 1,2,3 etc.

Some printers, such as PostScript and other laser
printers, retain a copy of the printed image in their
memory, so printing multiple copies of the same
page takes only slightly longer than printing one

copy.
X Print |
Frinter HF Color Laserlet PS *H
Copies| 1| =]+ Format Mormal ]
& Al pages " Range 19 to 33 v Morrmal
& Al sides  Right r Left Parmphlet
Galley
[T Pause [T Reverse [ Collate Printers pairs
[ Mo pictures [~ Reflect ™ Tumble Booklet g
Thumbnails — #
I~ Print setup Set Cancel Print Tile(1x1]

Fig. 12.1 - Basic options on the Print dialogue box Fig. 12.2 - The Print format menu.
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Pamphlet To print the pamphlet, chooseont to print the

Pamphlet prints 2 pages side-by-side on each ~ front side of the paper only, then turn the paper
sheet of papefig. 12.3) The pages are printed in Over and choosBack to print the back side. So if
such an order that when folded they create a ~ You have an 8-page document, choesmnt to
pamphlet with correctly ordered padég. 12.4) print pages 8/1 on the first sheet and 6/3 on the
Typically this option is used to produce small A5 second. Turn the paper over and selisitk and

booklets printed sideways on A4 paper, although Reverseto print pages 2/7 on the back of 8/1, and
other sizes may be used too. pages 4/5 on the back of 6/3. You should now be

able to fold the sheets in half for a correctly

By default each page is printed sideways at 71% ordered booklet.

scale, and the pair of pages are centred on the . .
paper. These settings are suitable for printing an You may need to experiment to find the correct

A4 document on A4 paper, producing an A5 way to turn the paper over, so that the back side is
pamphlet. However, you may change the scaling printed correctly.

orientation etc. using advanced print options  |f you print the pamphlet witiAll sides selected,
(see 12.3)For example if your document is A5, gl sheets will be printed on one side only. This
the scaling should be set to 100%. may be useful if you wish to print multiple copies

Your document may have any number of pages, ©f the pamphlet on a photocopier.

but the number of pages in the booklet will be However if your printer has a duplex uri]
rounded up to a multiple of 4 pages. So if you  sideswill result in sheets being printed on both

print 7 pages, you will get an 8-page booklet withsjdes. It is necessary to enable the duplex unit, to
the last page blank. To obtain sensible results,  do this uséroperties (see 12.3)
pamphlets should always start on a right-hand

page. The typical way of printing a pamphlet with a

duplex unit, is to seletll sidesand from the
Properties window “flip on short side”.

Please note that when pamphlet printing you may
find that the edges of the document are not printed
because they fall in the print margin. In this case
you should select theit option, or reduce the

scale manuallysee 12.3)

4 1 2 3

Fig. 12.3 - A 4-page document Pamphlet printed.

Fig. 12.4 - A folded 4-page pamphlet.
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Galley If All sideson thePrint dialogue box is selected,

Galley prints 2 pages side-by-side on each sheet €ach sheet is printed in turn on one side of the
of paper(fig. 12.5) Galley printing is useful for paper.

producing draft copies of documents at a smaller You may print on both sides of the paper by using

scale and thus using less paper. the Front andBack options on thérint dialogue
Pages are printed in the order they appear in the box. Choosé-ront to print the front side of the
document. By default each page is printed paper only, then turn the paper over and select

sideways at 71% scale, and the pair of pages areBack andReverseto print the back side. So if you
centred on the paper. These settings are suitablehave an 8-page document that starts on a left-hand

for printing an A4 document on A4 paper, page, choosBront to print pages 1/2 on the first
producing an A5 pamphlet. However, you may sheet, and 5/6 on the second. Turn the paper over
change the scaling, orientation etc. using and choos®ack to print pages 3/4 on the back of

advanced print optionsee 12.3)For example if ~ 1/2, and pages 7/8 on the back of 5/6.

your document is A5, the scaling should be set toyou may need to experiment to find the correct
100%. way to turn the paper over, so that the back side is
Notice that pages are printed on the same sides &inted correctly. You may need to use the

they appear in the document. So if a document Reverseoption to reverse the order of printing the
starts on a right-hand page, the first page printed back side.

will be a blank left-hand page. If you want to Please note that when galley printing you may
avoid this blank pagffig. 12.6) you should set  find that the edges of the document are not printed
the document to start on a left hand page using because they fall in the print margin. In this case
Start on left on thePage~Modify chapter you should select tHeit option, or reduce the
dialogue box. scale manuallysee 12.3)

1 2 3 4

Fig. 12.5 - A 4-page document Galley printed. Document starts
on right-hand page

1 2 3 4

Fig. 12.6 - A 4-page document Galley printed.
Document starts on left-hand page
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Printers pairs All pages

This is the same as Pamphlet but used for A4 siz&electAll pagesto print all pages in the
printouts without scaling or sideways printing. document. The page numbers are shown in the
Booklet, Thumbnails & Tile icon to the right oRange

The following printing formats are also available Ran9e

if the Imposition applet has been installed: SelectRangeto print the range of pages specified
in the writable icon. Page numbers specified

* Booklet ) should be the same as those shown in the
e  Thumbnails )
. Tile document. So if you have a document whose start

page is 8, you may print the first 4 pages by
Booklet specifying the range 8 to 11.

Booklet is equivalent t(_) ‘Four-up’ printing found e page number of the current page (the one in
on other systems. It prints 4 pages on each sheetyg centre of the document window) is shown on

of paper. The pages are printed in such an order yhg info palette and theiler>Info dialogue box.
that after printing the front and back of the sheet,

it can be folded twice and trimmed to form an
eight-page booklet.

If your document has more than one chapter and
the page numbering is not continuous, the page

) o number format must be specified in the farm

If 'Use half-sections' is ticked, and the booklet hagyerec is the chapter number ands the page

4 pages, then those four pages will be printed on yymper. So for example, if you have a document
one sid_e of the sh(_eet. Remembe_r to print just the yith 2 chapters each starting at page 1, and you

Front side, otherwise 2 sheets will be printed.  \yish to print the first 4 pages from chapter 2, you
If 'Use half-sections' is ticked, and the booklet hashould use the range 2.1 to 2.4.

12-pages, 20 pages etc. (a multiple of 8 plus 4 orpe following forms can be used for page

less) the outer four pages will be printed numbers:

separately as a 4-page section. The remainder of

the pages will be printed as standard 8-page the first page in the document with page

numberN e.g. typed as 6

sections. _

. S.P  page numbeP in chaptelS e.g. 2.6
Thumbnails S/P - ditto - e.g. 2/6
Normally Ovation Pro prints one page onto each AN  absolute pageumber N e.g. A6
sheet of paper, but with Thumbnails it prints as i.e. the Nth page in the document.
many as it can. In order to print more thanone aN  -- ditto -- e.g. a6
page per sheet, the page size has to be smaller S* first page in chapte® e.g. 2.*
than the paper size or Scale must be setto less S. -- ditto -- e.g. 2.
than 100%. The number of pages that will fitis Sf  -- ditto -- e.g. 2.f
also affected by the Sideways option. S.F --ditto - e.g. 2.F
The Thumbnails menu will let you choose as S| last page in chapt& (letter L) e.g. 2.|
many pages as will fit in the paper area or the S:.L --ditto--e.g. 2.L

printable area, or you can specify how many A page range can be written as:
thumbnails are required. Finally you can have the ,

: : Pn  start and end with page Pn
contents of all the thumbnails the same. This MaYs 1 on Start with page Pn and end with page Qn
be useful for tasks like printing business cards, pag pag

where you only have to design one card, but can Page ranges can be concatenated with a comma.

have a matrix of 4 by 8 printed out. The following examples are valid:
Tile 1.1-6.5
1,2,3,9,18,20

By using the Tile print format you print one large

page across a number of smaller sheets of paper.1’6’88_99
You might use this facility to print a large poster 1to15

onto a number of A4 sheets of paper. Al 1o AB, Al0 to 15.6,36,45
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All sides Collate
All sides causes both left-hand and right-hand  If Collate is not selected)vation Pro prints
pages to be printed. multiple copies of each page, so pages are printed

Left andRight allow you to print either the left- 1" the order 1,1,1, 2,2,2, 3,3,3.

hand or right-hand pages. This enables you to If Collate is selected when printing multiple

print double-sided documents by printing one  copies,Ovation Pro prints multiple copies of the
side, then turning the paper over and printing the document, so pages are printed in the order 1,2,3,

other. 1,2,3,1,2,3.

If you are pamphlet or galley printingll sides Some printers such as dot-matrix, take the same
causes both sides of eaglteetto be printed. The amount of time to print each copy of a page. In
Left andRight options change tBront and this caseCollate may be used to stack the pages

Back, and allow you to print either the front or  in the correct order.

back of the sheets. This enables you to print ovever, other printers such as PostScript, can
doubl_e-glded pamphlets or gallies (see the earherkee'O an image of the last page, and print multiple
description oPamphletandGalley). copies of it very quickly without any further
Pause reprocessing. In this case it is faster to leave

If Pauseis selected, printing will pause between Collate not selected, so that multiple copies of
each page printed until you click @ontinueon  €ach page are printed consecutively.

thePrinting dialogue box. No pictures

Reverse If No picturesis selectedDvation Pro will

If Reverseis selected, printing starts with the last ignore pictures and just print text. Only the picture
page instead of the first. frame guideline is printed. On some printers such

as PostScript, printing pictures is very slow, so
this option may be useful for quickly printing
draft copies.

If your printer stacks pages face-up they will be

incorrectly ordered after printing. In this case you

can useRreverseto correct the page ordering. You

may also need to use this option when printing th&eflect

back side of double-sided documents. Reflect prints a mirrored image of the document -
however this only works if the printer driver
supports it.

Tumble

If Tumble is selected andll Sidesis selected,

then printing on the even sides will be rotated by
180 degrees. Keft/Right or Front/Back are
selected all printing will be rotated by 180 degrees.

This is useful for using a printer with a duplex
unit (which allows printing on both sides of the
paper in one pass). Tumble provides the same
functionality as the “flip on short side” and “flip
on long side” provided by printer drivers for
duplex units.

It is also useful when preparing printout to be sent
to a commercial printer where it is necessary to
arrange the pages as required for the printing
machine.
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Set Printing Multiple Documents

All the options on th@rint dialogue box are You can print multiple documents by dragging a
stored in the document when it is saved. Click onselection directly from disc to the printer driver in
Setto set the values without actually printing the icon on the Printers and Faxes window.
anything.

Print

Click onPrint to print the document. The pointer
changes to an hourglass and Bmmting dialogue
box is displayedfig 12.7) It shows thd?ageand
Copy being printed, and if you are mail merging,
the currenRecord.

The green slider gives a visual indication of how
much of the print job has been completed, but
please note that this is only accurate to the nearest
whole page.

Separationindicates the colour of the plate being
printed when printing separations.

Click onCancelto terminate printing. There is

only a limited amount of multitasking possible
when printing i.e. when the hourglass occasionally
turns back to the standard pointer, so there may be
a delay befor€anceltakes effect. Usually it is
quicker to press Esc instead.

Click onPauseto pause printing. Again, there
may be a delay befoRausetakes effect. When
paused, th€auseoption changes tGontinue
which you should click on to continue printing.

Frinting BigDoc_ dpd |

F'agel 215 Cnpyl 1 Record .
Separation %
[

Fause | Cancel |

Fig. 12.7 - The Printing dialogue box.
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12.3 Advanced Print Setup Options Scale

SelectPrint setup to expand th@rint dialogue ~ Scaleallows you to set how big the page is

box to display the advanced setup options printed on the paper. At 100%, the page is printed
(fig. 12.8) at exactly the size specified in the document. So a

frame that is 100mm square in the document is

Fit :
o _ . printed exactly 100mm square on the paper. To
If Fit is selectedScaleis automatically set so that print the page at half size, set the scale to 50%. If

the entire page fits_ in_side the printe_lble area. The you want to print an A4 page at A5 size, set the
consequence of this is that your printed output  ¢.oie to 71%.

may become smaller, but all of it will be printed.
Aspect

Aspectallows you to set the horizontal scale of

the printed page. A value of 100% means that the
page is printed the same shape that it appears in
the document. To stretch the printed page
sideways, increase this value, or to squash it
WhenFit is selectedScale X andY are shaded  sideways, decrease this value. So to print the page
and cannot be manually altered. 10% wider, seAspectto 110%.

When calculating the scalkEit takesBleed and
Printers marks into account i.e. it ensures they
are within the printable area.

X andY are automatically set so that the page is
centred within the printable area. However, if
Centre is also selected, the page will be centred
on the paper. This may result in the scale being
reduced further.

% Print HE|
Frinter Generic PostScript Printer E
Copies [ 1 = | «]| Format Marmal E

& All pages " Range 163 to 154

& Al sides " Right T Left

[ Pause [T Revarse [ Collate

[ Mo pictures [ Reflect ™ Tumble

W Print setup

™ Fit Scale 100 Aspect| 100

¥ Centre " [ 2.95mm i [ BBmm

[T Sideways [~ Print to file

™ Bleed [~ Printers marks El
Separations. .. Frint sheet... | Froperties... |

et Cancel Frint

Fig. 12.8 - The extended Print dialogue box.
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Centre Bleed

If Centre is selectedX andY are automatically  If Bleedis not selected, the exact page area is
set so that pages are printed in the centre of the printed on the paper.

paper. If Bleedis selected, the page area plus an extra
WhenCentre is selectedX andY are shaded and 3mm margin all around the page, is printed.

cannot be manually altered. If you want an object to go to the edge of the

X, Y paper, you must print the page on a bigger piece
X and Y are the offsets from the bottom left of paper and trim it afterwards. Unfortunately
corner of the paper to the bottom left corner of thdnaccuracies in trimming may result in a gap along
page(fig. 12.9).They allow you to accurately the edge of the paper. The solution is to bleed the
position printed pages on the paper. object off the page, then use Bieedoption to

print a slightly larger page. Trimming the paper to
the page size should then give perfect results

(fig. 12.10)

Sldgways _ _ The amount of bleed may be changed, and saved,
If Sidewaysis not selected, pages are printed in the Choices dialogue bdsee 15.4)

upright on the paper. This is often called portrait _ _ )
printing. Menu=>Misc=>ChoicesvPrintc>Bleed

Bleed andPrinters marks are taken into account
if they are selected.

If Sidewaysis selected, pages are rotated through
90° and printed sideways. This is often called  Print to file

landscape printingSidewaysis automatically —|f Print to file is selected, you will be prompted to
selected if the page format in the documentis  enter a file name to save the printer data to instead
defined to beSidewaysin theNew or of sending it to the printer.

Page guidelinegdialogue boxes.

Properties...

This opens the usual Windows window allowing
you to configure the current printer. Some settings
e.g. number of copies are also provided by the
Ovation Pro print window.

4+—— Paper

Page

X

<
<

P

Fig. 12.9 - X and Y specify the position of the
printed page on the paper.
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Printers marks Print Sheet
Printers marks are positioned outside the ~ When the print format is set Ramphlet or
page area of your documdfig 12.10) If Galley, thePrint sheetoption becomes available
Crop check has been set iBhoices(see 15.4) and allows you to easily print individual sheets.
you will be alerted if the printable area is The Print sheet dialogue box shows the pages that
bigger than the paper size. If you decide to will be printed on the front and back of each sheet
proceed the printout will be cropped. of paper(fig. 12.11)

If Printers marks is selectedgrop marksare Sheetshows the sheet number that is currently

printed around the edges of the péig 12.10). being displa_yed followed by the total _number of
These are used to trim a page to size when it hassheets required for the document. Click on the up

been printed on a larger piece of paper. In and down icons to step to other sheets.
addition,registration marksare printed at the Print sheetprints the current sheet. The options
centres of each side of the page. These are usedgeont andBack allow you to choose whether to
help align separated film. print the front or back of the current she@ath

The window which opens when you click on the prints the front and then the back, this is useful if
icon to the right oPrinters marks lets you your printer has a duplex unit i.e. if it can print on
choose which crop and/or registration marks are t0th sides of the paper.

be printed. The number of copies, scaling etc. are all set

The thickness and size of the printers marks may  on the normaPrint dialogue boxfig. 12.8)
be changed in Choicésee 15.4)

Fig. 12.11 represents what you see when you open the
\ & \/4 print sheet window for this chapter and select the sheet
Object N which contains this page (the Pamphlet print format

bleeding must be chosen first).

Front will print pages 176 and 173 sideways on an A4
sized page. Turn the page around. put back into the
Crop printer, then select Back to have pages 174 and 175
marks printed on the reverse side.

Fprintsheet K]

& | & @ Front © Both © Back

1 Registration marks

176 173 174 175

\ SheetIT LILI anE—

Cancel | Print sheet

v

\
| |- |

Fig. 12.10 - Page showing Printers marks
and object bleeding off the edge of the page.

Fig. 12.11 - The Print sheet dialogue
box allows you to print individual sheets.



176  PrinTinG & MaiL MErRGE

12.4 PostScript Printing

The PostScript printer language has an important
role in professional printing and so it is given
special treatment i@vation Pro.

PostScript printing can work like printing to any
other sort of printer. You can install a suitable
Windows printer driver for your PostScript printer
and print to it as normal. It will often be useful to
create a file of PostScript data, perhaps to take tc
print shop or to pass to another progrésee

13.7).

However the standard Windows PostScript printe
drivers have shortcomings, not everything you ca
design inOvation Pro will be correctly

reproduced on paper by them. For example it is
common for them to have problems with masked
bitmap images (i.e. images with areas of
transparency)Ovation Pro therefore can generate
PostScript itself. This “Direct PostScript” should
be better than the PostScript generated by the
standard Windows drivers. That means it should
be smaller (faster to print) and give more reliable
results.

You can control iOvation Pro or Windows
generates PostScript fradisc>Choices>Print
selectDirect PostScript output.

The icon to the right of this allows you to open the
PostScript choices windo(fig. 12.12)

Languagesets the level of PostScript that is used.
Best results will be obtained with a higher level,
however you cannot use a level higher than that
supported by your printer, e.g. a level 2 printer
cannot understand special level 3 commands. The
final optionPrinter level automatically sets the
level which the printer driver says it supports, and
is the option usually used.

Download font ascontrols the format of fonts in
PostScript output. Type 1 will give better results.

Generic PostScriptif this is selecte@®vation Pro

will generate all the PostScript itself, this means
the PostScript conforms to the relevant standards,
however it does not contain any PostScript for
printer dependent features. If not selected
Ovation Pro will insert the PostScript into a
wrapper provided by the Windows printer driver.
Typically you would use generic PostScript if you
wanted to produce a PostScript file to use in
another program.

CHaPTER 12

—Language
= Level 1
 Level 2
" Level 3

o Printer level

— Diownload font as—
& Type 1
 Type 3

¥ Generic PostScript (ignore printer features)

ipt HE|

Cancel

24

Fig. 12.12 - PostScript choices.
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12.5 Mail Merge A simple CSV file containing people’s names,

The mail merge facility allows you to print a might look like this:

document a number of times, merging different  Smith,John,Mr,34567<CR>
data into each printout. You insenerge tagsnto ~ Jones,Sue,Miss,34985<CR>
the text at the required places, and specifya  Clarke,lan,Mr,33450<CR>
comma separated val€SV) file which contains Simpson,Linda,Mrs,33986
suitable data. When you print, the merge tags areCreating CSV Files

replaced by the data. This process continues until, | may create your own CSV file by typing the
all the data has been exhausted. data in the format described above, in a text editor
Typically mail merge could be used to print a such as Edit. Press Return at the end of each

standard letter a number of times, merging record, and only insert spaces where they are
different names and address into each copy. needed as part of the text in each field. Once the
CSV File Eormat data has been prepared it should be saved to disc.

The data used for mail merge must be in CSv  Creating CSV Files in Ovation Pro

format. Many applications output data in this You may create CSV files usir@vation Pro in a
format, or if you wish you can create your own similar manner. However, when you save the file,
CSV file. you must us&iler>Savestory to save the file as

A CSV file comprises a number of records plain ASCII text.
separated by a carriage return or line feed. Each  If you later reload the CSV file into

record comprises a number of fields each Ovation Pro for editing, you must ensure that
separated by a comma. any quotation marks in the file are not

field 1.field 2.field 3<CR> converted to smart quotes using 8raart

field 1.field 2.field 3<CR> quotesfacility. If the CSV file contains

field 1.field 2.field 3<CR> quotations marks, you should disaBleart
field 1.field 2.field 3 guoteson Choices(see 15.7)

The example above has four records each Other CSV files o
containing three fields. Notice that a carriage 1N general one can export a CSV file directly from
return is not needed after the last record. a Database to disc.

If data in a field contains a comma, the entire field
must be enclosed in double quotes:

“field 1,2" field 3,field 4<CR>

The filetype of the CSV file may be set to Text or
CSV.
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Inserting Merge Tags Example CSV File & Document
Menu>Miscr>Insert->Merge tag. .. A simple CSV file might look like this:

Cul+Shift+M  gmith, John,Mr,34567<CR>
Once you have prepared the CSV file, you shouldlones,Sue,Miss,34985<CR>
create thévation Pro document inserting merge Clarke,lan,Mr,33450<CR>
tags where you want to insert défig. 12.13) Simpson,Linda,Mrs,33986

To insert a merge tag, position the caret at the  TheOvation Pro document might look like this:
required position and pre€drl Shift M to To: [Merge 3] [Merge 1]

display theMail merge tag dialogue box Dear [Merge 2]

(fig. 12.14) Now enter the number of the field 0 11,5ks you for your valuable

be inserted and click d@K. Fields are numbered order, ref, [ Merge 4].

from 1 upwards. A tag of the forfivierge n]

is inserted in the text, whenreis the field number. _ _ )
when the mail merge is started, the merge tag wilfVhen you use mail merge, the first record printed
be replaced by the field whose number is will look like this:

specified. This will happen for each record in the To: Mr Smith

CSV file. Dear John
The merge tagMerge n] , can be edited just 1 hanks you for your valuable
like normal text, but it behaves just like a single Order, ref. 34567.

character. You may apply effects and styles to the -
merge tag, and these will be applied to the data The second record will be:

when it is merged. To: Miss Jones

Dear Sue
Thanks you for your valuable
order, ref. 34985.

Notice the use of spaces between the merge tags,
and the last tag which is highlighted in bold.

¥ MailMerge.dpd =] E3
File Edit Miew Text Style Ohbject Page Misc Applets Help

e &l Eelse|xo] =s| =S

Ovation Pro Mail Merge Example

ﬂ\-{emo
To: [Merge 3] [Merge 1]
Dear [Merge 2] ¥ Mail merge tag |
Field numl:nerl |
Thanks for your valuable order, ret. [Merge 4].
Cancel | Dk

A | 1
Fig. 12.14 - The Mail merge
Fig. 12.13 - An example Mail merge document, partly shown tag dialogue box.
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Starting the Mail Merge
Menur>Filew>Print... Ctrl+P

To start the mail merge, first open thiger> Print
dialogue box and set the number of copies and t
print format that you require. Once this has been
done, click orSetto set the options without
printing the document.

Now chooséMail mergeto open théMail merge
dialogue boxfig. 12.15)

Menur>Filem>Mail merge...
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Ignore headings record

Thelgnore headings recordbutton allows you to
makeOvation Pro ignore the first record in the

thV file. Some CSYV files use this record for the

names of the fields.

First

TheFirst button will mail merge in the first
record of the CSV file. Once this has been clicked
on the other buttons will become available.

Next

The name of the CSV file to be merged should pd\extmerges in the next record, after having

entered into the icon labell&SV file. The
easiest way to do this is to just drag the CSV file
into this icon.

To perform the mail merge click d?rint.

Ovation Pro will now print the document once for
each record in the CSV file. The current record
being printed is indicated in th&inting dialogue
box.

Before printing each page, the merge tags are
replaced by the data from the CSV file and the
text reflowed. If the fields in the data file are

selected-irst.

Clear

Clear terminates the merge process, and the
merge tags in the document revert to their usual
appearance e.g, [Merge 1].

First, Next andClear let the merge takes place
without any printing, so you can preview the malil
merge without using paper. At any time frnt
record button will print the document in it’s
current state i.e. with merge tags replaced by a
record from the CSV file.

longer than the merge tags, the text may overflowgsjx

its frame. To reduce the possibility of this
happening always ensure there is some blank
space at the bottom of text frames containing
merge commands.

The example CSV file, named CSVfile, and the
document shown on the previous page, named
MailMerge, are supplied witBvation Pro in the
directory 12_Examples.

®Mailmerge EH]|
o= ﬁlel E

™ Ignore headings record Fields. ..

First | Nextl Clearl i | Frint recond

Set | Cancell Print

Fig. 12.15 - The Mail merge dialogue box.

TheFix button permanently replaces the mail
merge tags with their current values. Use this with
care! Effectively it creates a new document and
you lose the old one.
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12.6 Mail Merge, advanced features 12.7 Mail Merge, some examples
Fields 1. Generating Address Labels

Mail merge fields are conventionally referred to The problem: you have a CSV file of names and
by a numbed..n corresponding to the field in  addresses, one name and address per record. You
the CSV file being merged. So fieldis replaced  have sheets of A4 sticky labels, perhaps 20 to a
by the first field in the CSV file and so on. page, and you want to print the names and address

It is possible to associate with each field, two 20 t0 @ sheet on the labels.

strings, firstly anamewhich is not currently used. And the solution;

Secondly &ommandThis is a macro whichis 5 ‘pegjgn a label. Insert into it mail merge tags for
evaluated each time the merge field occurs in theeach field in the CSV file. e.g. 1,2,3. After all the

document. usual tags, add one more, e.g. tag number 99
A button on the mail merge window, called (fig. 12.16)

Fields...allows access to a window which can be b. Open the Fields window. Click on New, enter a
used to manipulate these field strings. number of 99, and a namem#xt. For the body of

Menu>Files>Mail merge...=>Fields... the field entefnextrecord()} (fig. 12.17)
Various tricks can be played using field c. Duplicate as many labels across and down the
commands: page as you require.

1. Adding sequential numbers to documents whilst. Remove from the last label on the page mail
printing; merge tag 99.

2. Adding random numbers to documents whilst e. You can now do a standard mail merge
printing; operation on the page, for each label on the page,
3. Generating new mail merge data on the basis Q"€ record from your CSV file will be merged.
other fields e.g. The document Examplel in 12_Examples
{if(field(1)=="Mr.") macv="his" demonstrates the above.

else macv="her"} A questionable area with this technique is what is

4. Merging more than one CSV file record into  meant by the ‘last label’, this is the last piece of

one print of one document. This provides a text that the mail merge data will be merged into,
solution to the old problem of how to do a usually it will be the frame which is at the front,
mailmerge on a sheet of address labels; i.e. on top of all the other frames.
5. Generating mail merge data from other sources, s ~
e.g. a database. [Merge 1]
6. Manipulating mail merge data, e.g. removing [Merge 2]

) [Merge 3]
blank lines from addresses.

[Merge 4]

Some examples follow for usirkgelds. For these [Merge 5]
examples a CSV file calledK is included in the [Merge 6]
directory 12_Examples. [Merge 99]
A description of all the script functions can be
found in the separate Script document. 1 16\ - A Tbel SeoE /l .

. . . . . - e merge tags in a lapel. See ample
Mail Merge can also be done with pictu(ese 9 Jeagst xamp
10.12

FMerge fields
42 B
It is possible to control the way merged printing is

It is not possible to have more than one merged
print of a document on one sheet of paper.

Fig. 12.17 - Entering the command in the Fields window
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2. Adding sequential numbers to
documents.
Or how to print your own raffle tickets.
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3. Adding Random numbers to documents
Or how to print your own bingo tickets.

Here we want to have random numbers appearir

The situation here is that we want each documentn documents. The solution is similar to that in th

to have its own unique number.
The solution;

a. Install theJnique number applet.
b. Create a field, say number 99.
c. For the body of the field enter:

{macv=(unique_getprefix() +
unique_getnumber());unique_putnumber(
itos(stoi(unique_getnumber()) + 1));}

The unique number generated will follow the
same rules as explained for the unique number
applet.

d. Use tag number 99 in your document when
inserting the merge tag. Ctrl+Shift+M

previous section. The only problem is obtaining
random numbers. To do this it is necessary to ac
a random number generator to eation Pro
script library. This is provided in the !MergeLib
script in the Library folder in the directory where
Ovation Pro is installed.

Now follow the steps in the previous section, but
this time step c is;
c. {macv=itos(merge_random(49))}
It is supposed that 49 is the highest possible
number. Otherwise change this number.
If you really were printing bingo tickets you’d
have to add some checks to prevent the sam

numbers being printed more than once on
individual tickets.
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4. Creating new mail merge data from 5. Generating Mail Merge Data From Other
other fields. Sources

The first example of this is using the POBar appldtsually mail merge data comes from the ‘CSV
(which creates UK Post Office bar codes) to file’ a file implicitly associated with the mail

automatically insert bar codes into the mail merganerge operation. With the fields features this need
no longer be the case. It is for example quite

] possible to use theirst andNext buttons with no

a. Create a new field, e.g. tag number 99. Now  cgy file at all. Even if the CSV file is being used

This is done as follows;

assuming that the CSV file you are merging some data can come from other sources. You
contains the post code in field 6, enter this for the.,,1d read a name from the CSV file. and then
field body. find data associated with that name in another file,
{macv=bar_code(" field(6),"1A")} and merge it into the document.

b. Insert mail merge tag 99 in your document to bA ‘mail merge’ with no CSV file gets into the
printed, e.g. usually a label. This tag should be realms of macro text. One idea is to set up a tag
surrounded by white space, be in the POBar fontwhich allows you to write “Continued on page
at 14pt, and be horizontal or vertical. [X]”. When the fields are replaced X would be

The document Example4 demonstrates the abovdilled in with the page reference - this would
Note that you must have the POBar applet and probably make use of the book mark manager.
font installed for any of the above to work. Another idea would be to support text of the form

Another example is customising printed “page 1 of [X]".

documents on the basis of some mail merge field.
For example setting up the following for the body
of a field.

{if(field(1)=="Mr".) macv="his" else

macv="her"}

With this field created, you can use the
corresponding tag in place of the words “his” and
“her”.

Yet another idea is to create some data if a field in
the CSV file is blank. This field definition might

be used;

{if(field(5)=="") macv="No fax

number” else macv="Fax: "+field(5)}
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6. Manipulating Mail Merge Data

The first example of this is how to remove blank
fields from records. Typically some addresses wil
have 4 lines, others 5, but the post code will
always be in the 6th field. You want to avoid
unsightly blank lines.

A horrible solution is followed by a simpler one.
For each of the fields in the CSV file, set up a
field with this body. Note that one number
changes for each field. The line below is for
field 5.

{inti=1,j=1;while(j<=5 &&

i<=maxfield()) {if(field(i)!="")j++;

i++;} macv=field(i-1);} (fig. 12.19)

The document Example 6 demonstrates this.

Notice that the above code ugeaxfield() to

set the limit on the number of fields that will be
searched for blanks. However the example CSV
file UK in 12_Examples only uses fields 2 to 6 for
the address, later fields are used for other
information which we don’t want to appear on the
label. To get around that, replaoexfield()

with the number 6. It is also necessary to replace
eachmacv=field(i-1) with
macv=(j<=5)?""field(i-1) ;

replacing 5 with the appropriate number.

[Merge 1]
[Merge 2]
[Merge 3]
[Merge 4]
[Merge 5]
[Merge 6]

-
Fig. 12.18 - The merge tags in a label

|1—| ane I{int =1 =1 while(j<=1 && i<=maxfield(]) {i =
[2 ] tw [=2 88 ix=maxfield() {iffeld()i=""j++ i++
[3 ] three [=3 & ix=maxfield() {ifeld()i=""j++; i++
[4 ] four f=4 8.8 i<=maxfield() {iffeld (=" ++; i++

-

Iesw.. | Delete |

Cancel | 0K I

Fig. 12.19 - The general commands for the merge tags to
avoid blank lines. Field 1 shows the start of the command
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The above field definitions are tedious to type.
The 'MergeLib file mentioned in section 3,
provides a function which does all the hard work.
You can now use for the field bodies;

{macv=merge_strip(5,maxfield())} (fig. 12.20)

Here the first number is the intended field number
(1 to 6 in the example), the second argument of
the function can as before be replaced with the last
field of data to be entered, as in the last but two
paragraph this could be;

{macv=merge_strip(5,6)}

In both of these cases you would of course define
six fields, and enter these macros with the first
number stepping between 1 and 6. The document
Example6a demonstrates this.

P Merge fields HE
I 1 I one I {macv=merge_strip(1 61} =
I 2 I two I {macv=merge_strip(2 B}

I 3 I three I {macv=merge_strip(3 61}
I 4 I four I {macv=merge_strip(4 5]}
J|
Mew... | Delete |
Cancel | Ok I

Fig. 12.20 - Using the script command "merge_strip".
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Notes:
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The first part of this chapter describes how to prepare Ovation Pro
documents for lithographic (litho) printing. Litho printing is the most
widely used printing process today, and is suitable for most applications
(except for very short runs of less than, say, 500 copies).

If your document only needs to use two or three basic colours, you can
print it very economically using spot-colour printing. If you want to print
using the full range of colours, then you should use full-colour printing.

When printing it is often necessary to modify the appearance of pictures
and graphics. Information on this is given in the second part of this
chapter.

B. Image Processing

13.9 TheProcessDialogue BoX...............c .. 200
13.10 Brightness, Contrast& Gamma .............. ... 202
13.11 Custom Colour Map . ...t 205

13.12 DUOIONES. . . .t ottt e e e e e 206
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13.1 Installation

This chapter describes the facilities provided

by theOvation Pro Colour Supplement This
supplement to the main program is provided in the
form of an extension applet, which must be
installed before it can be used.

The applet is calle@olSupp It must be installed
in the usual waysee Chapter 18)

By default the Colour Supplement applet is
installed, so unless you have removed it, you
probably need to do nothing.

CHapPTER 13
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13.2 Litho Printing Printing

After completing and checking your document, A litho press uses a printing plate wrapped around
the first job is to have it typeset. This involves @ revolving cylinder. The printing plate, which is
printing the document to a PostScript file and ~ Presensitized with a light-sensitive coating, is

sending it to a typesetting bure@ee 13.8). placed in contact with the film and exposed to
Occasionally, a bureau will acceptation Pro high-intensity light. After exposure the plate is
files directly. treated with an emulsion developer leaving a hard

image on the plate, which is then treated with a

The bureau will print a very high qualioyiginal greasy medium.

of your document using an imagesetter.
After being mounted in the press, the plate is first

dampened and then coated with ink. The areas
coated with grease attract ink, while water on the
areas not to be printed, repels ink. The ink is then
A cheaper alternative istaomide(photographic  transferred to a rubber blanket cylinder, before

paper), which needs to be photographed to being transferred to the paper.
produce the printing plate. This is often called

camera-ready copy

For high quality or full-colour work, they will
usually producdiim. This can be used directly to
make the printing plates.

The process is often calledfsetlitho printing
because the printing plate does not come into
Your printer will be able to tell you which is the  contact with the paper.

best material for a particular job. Colour Printing

Proofs The process described above prints one ink onto
For full-colour work, it is essential to proof your  the paper. To print another ink, the operator has to
work before it is printed. A proof is a high quality change the plate, change the ink and then print
colour print produced directly from the set of four onto the paper for a second time. This explains
film separations. The two dry-proofing processes why two-colour spot printing is cheaper than full-
that are often available are callédromalinand colour printing using four inks.

Matchprintproofs. They are quite expensive, but
allow you to check that everything is correct
before the more-expensive print job commences.

Some printing presses can print more than one ink
at a time, but due to the more complex setting up

required, they are normally only economical for
Ask your bureau which proofing process is long print jobs.
available, and how much it will cost.
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13.3 Spot-Colour Printing Specifying Colour

If your document only needs to use two or three Whgn you print spot-cplour separations, each
basic colours, you can print it very economically basic colour and any tints are placed on a separate

usingspot-colour printing If you want to print platg. It is essential for you to tell the printer the
using the full range of colours, then you should Precise colour to be used for each plate. You can
usefull-colour printing, do this by choosing colours from a standard

Spot colour work is simpler to achieve than full- swatch.

colour work, and two or three spot-colour work is Spot colours defined iBvation Pro are used for

always cheaper than full-colour work. the screen display only, so it doesn’t matter if they

. . . 9on't match the eventual printed colour. However,
First you need to decide whether you want to prin. . : .
in order to help you visualise what the printed

with two or three colours. Using three colours will ) LT .
: o document will look like, it is useful to define the
be more expensive, but will give a greater scope :
screen colours to match the printed colours. You

for designing the document. can do this by defining colours using CMYK

Note that in addition to the basic colours you can yalues obtained from the colour swatch you are
use any number of tints of those colours. For using.

example, if you are doing a two-colour job using

black and red, you can use greys and pinks. In order for the printer to know the colour of each

plate,Ovation Pro prints the colour name at the
Menu=Misc=>Edit colours... top of each separation. Therefore, it is useful to set

Use theMisc=Edit colour dia|ogue box to the Ovation Pro colour name to the name given

create named colours for each of the spots (in the>n the swatch.

example above, both black and red already exist),

and for each colour choose t8pot colour option

at the bottom of the dialogue b(fig. 13.1)

FEditcolowr ________________EK

Chart...
Edit. ..
Transparent —
. Red Civerprint. ..
|:| Green 5
| ew
|:| Cyan b Refarme
. hagenta _
| B S T j [elete
™ Spot colour T Man-printing
Apply | Cancel | a]’e

Fig. 13.1 - The Edit colour dialogue box.
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13.4 Full-Colour Printing

In printing, most colours can be reproduced by
mixing the correct proportions of the three process
colours - cyan, magenta and yellow. Black and
greys can be reproduced by combining equal
amounts of cyan, magenta and yellow, but in
practice this gives poor results, so a black ink is
also used to add finer detail and greater density.

When you print separations, any colours that have
not been designated as spot colours will be
separated into CMYK components. When the
CMYK separations are printed, they will combine
to reproduce the colour of the original.

Tint Charts

When full-colour printing, your document can use
any colours defined using thslit colour

dialogue box. However, the eventual printed
colours may differ from those viewed on the
screen(see 13.9)It is therefore essential to select
colours fromtint charts

A tint chart usually shows samples of over a
thousand tints made up from cyan, magenta and
yellow. Once you have found the colour required,
you should read the cyan, magenta and yellow
values from the chart and use them to define a
colour inOvation Pro. The chosen colour may not
look correct on-screen, but provided it has been
defined using the CMYK model, the printed
colour should match the colour in the tint chart.

FuLL CoLour PRINTING
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13.5 Colour Correction
RGB to CMYK Correction
In order to print RGB (and HSV) colours used in

Ovation Pro documents in a full-colour process,
these colours must be converted to CMYK. A

CHapPTER 13

copying them into the Colour Supplement applet.
CMYK to RGB Correction

Ovation Pro provides a system to improve the
display of CMYK colours (intended for output to
a four-colour press) on an RGB colour monitor.

simple translation that assumes process inks usedo enable this feature, choddse inks to display

in printing are the inverse of RGB light, gives
inaccurate colour reproductioBvation Pro
provides a correction system that improves this.

CMYK colours from the Colour Choices
dialogue boxfig. 13.2)

Note that even though this does improve the

Before printing full-colour separations you shouldaccuracy of CMYK colours on-screen, you should

select thdJse correction tableoption on the
Colour Choices dialogue bdgig. 13.2)

Menu=>Misc=>Choices»Colours

When this is selecte@vation Pro uses a special
algorithm and separation tables to apply
correction when converting RGB colours to
CMYK colours.

Note that this does not affect colours defined
using the CMYK colour model. Nor does it affect
spot-colour printing.

TheUse correction tablesubmenu allows
different separation tables to be chosen for
different typesetters. The default tablgpeSet ,
should be suitable for most situations.

Alternative compatible tables can be added by

not entirely rely on the colour you see on the
display. For precise colour reproduction always
specify colours using CMYK values chosen from
tint charts(see 13.4)

The sub-menu provided above this option allows
you to choose different ink mapping files that
control how RGB is mapped to CMYK for
different printing processes. Currently two ink
mapping files are provided. Both are for SWOP
printing (Standard Web Offset Printing) colours.

Note that currently the ink mapping file is only
used for converting CMYK to RGB, not for
separating RGB into CMYK.

¥ Application choices |
—_— -] I Colour correction choices
E"' & Use correction table ¢ Mo correction
ey
— Tahle I Typeset *H
Text [ Use inks to display CMYK colours
hap I SWOP on coated stock H
ave Cancel 04

Fig. 13.2 - The Colour Choices dialogue box.
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13.6 Preparing Your Document Colour Level Overprint
Overprinting You can specify that a particular colour will
Menu>Misce>Edit colours. .. overprint by choosing the colour on thdit

colour dialogue box and then choosi@yerprint

Overprintingis used to compensate for this colour from theOverprint dialogue box
misalignment of printing plates during printing. (fig. 13.7).

Suppose your document contains some black texgyerprint limit specifies the tint above which an

printed on a cyan background. The black plate  opiact colour will overprint its background. So the
will contain the black textfig. 13.3) The cyan default value of 90% means that overprint will

plate will contain the cyan background witha o}y occur with tints of 90% and above. This
‘knock-out’ for the black texffig. 13.4) option prevents lighter tints, which are less
If the document is printed with the plates exactly opaque, from overprinting.

in register, the black text will be printed exactly
over the white ‘knock-ouf(fig. 13.5) However, if
there is misregistration, thin white gaps can be
seen around the tefftg. 13.6) This problem
doesn’t just happen with text, but applies to all
overlapping objects.

Object Level Overprint

You can specify that a particular object will
overprint by choosin@verprint on the colour
picker when applying colour to an object.

Overprinting helps solve this problem by
preventing the background from being knocked-
out. So in the example above, the background is
printed solid cyan without the knock-out, and the
black text is printed on top of the cyan.

This generally only gives acceptable results when
printing relatively opaque inks, such as black.
Overprinting less opaque colours, such as yellow,
may show a colour shift when overprinted.

Overprint Overprint
Fig. 13.3 - The black plate Fig. 13.4 - The cyan plate with
containing the black text. knock-out for black text.

¥ Overprint

[~ Owerprint this colour

Cwerprint limit| 90 %

OVETIITL:

Cancel | Ik

Fig. 13.5 - Correctly printed Fig. 13.6 - Printed with
with no misregistration. misregistration. Fig. 13.7 - The Overprint dialogue box.
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Font Mapping Ovation Pro Page Size
Most PostScript printers have some fonts built in Set the required page sizeOnation Pro using
and these are the equivalents of common theNew (see 11.2pr Page guidelinegsee 11.3 -

Windows fonts. For example Helvetica is the Page guidelinesjlialogue boxes.

PostScript equivalent of Arial. The maximum page size that you can typeset

When printing to a PostScript printer it is possibledepends upon the typesetting bureau you are

to send the definitions of fonts along with the restusing. You should have no problem up to A3, but
of the document (download fonts). The problem isabove that you should check the maximum width
that such fonts add to the size of the data with your bureau. Remember that printers marks
transferred and use memory in the printer. There increase the overall dimensions by 14mm. That is
is thus some interest in using the built in fonts.  if you use the default values for the crop marks
However as the technology has improved this  (see 12.3 - Printers marks).

issue has become less important.

There may also be situations in which you don't
want the built in fonts to be used. For example
they may not contain all the characters that the
Windows fonts do e.g. the Euro €.

If you are producing a file to send to a bureau it is
important to consider the fonts that they will have
available.

For these reasons there is a mechanism to control
how Windows fonts are mapped onto PostScript
fonts. It consists of two elements. If you open the
Printers and Faxes window, and then right click
the printer of interest and select Properties, then
use the Device Settings tab there will be an entry
Font Substitution Table. This allows you to
arrange for each Windows font to either be
asigned an equivalent from the fonts built in to the
printer or to never be substituted.

Secondly if you open the printer properties
window (from the expanded Ovation Pro print
window) there will be PostScript options and a
sub-option of True Type font download option.
The actual values of this may vary however one
(e.g. outline or use soft fonts) will force all fonts
to be downloaded and another (e.g. automatic or
substitute with device font) will download only
fonts which appear in the font substitution table
without PostScript equivalents, the rest will use
the fonts in the printer.
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Printing Pictures Checking the Separations

You can set half-tone screen information for the At any time you can use tl8eparationsmenu to
selected picture on thdalftone screendialogue  view any of the individual separations on-screen.
box (fig.13.8)

Menu=>Picture>Screen...

Menu>Viewr>Separations

This menu will help you check that correct

The options in this dialogue box are intended for number of separations are being printed i.e. there
experienced users, and should not normally be are no additional spot colour plates. Experienced

altered. users will be able to use this option to check that

Note that you can also change the half-tone scredfi€ Overprint settings are correct.
information for all pictures in a docume(see
13.7, step 6)

Frequencyis the density of the half-tone screen,
measured in lines per inch. Usually a frequency of
100 is suitable for monochrome work and 150 for
process colour work.

Check with the bureau/printer if you are in doubt.

Spot specifies the shape of the half-tone dot. Use
the default, unless you are experienced in creating
PostScript separations.

Angle specifies the half-tone screen angle for the
ink highlighted in the panel above. Unless you are
experienced in creating PostScript separations,
you should use the default angles as supplied. If
the wrong halftone screen angles are set, an
undesirable screen clash, called moiré, may occur.

Halftone screen |

¥ PostScript screen

Freguency | 190 Ipi Spntl Dat ﬂl

—Plates

Black: 150 Ipi, 457

Cyan: 150 Ipi, 105°
Magenta: 150 Ipi, 75°
Yellow: 150 Ipi, 90° =

Angle I? "

Apply Cancel Qe

Fig. 13.8 - The Screen dialogue box.
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13.7 Creating a PostScript File ©® Choose a suitable PostScript paper size.

O |If you are producing full-colour PostScript printer drivers provide a wide range of
separations, ensure that colour correction is standard paper sizes e.g. A2, A3 and A4.
enabled and the correct table is selected However, printers marks increase the dimensions

of the page, so using these standard sizes may
result in your page being cropped.

The standard colour correction table called
TypeSetshould normally be used. This is
confirmed in the title bar of th@eparations To avoid this you might create your own custom
dialogue box. paper size when producing PostScript output for
typesetting. Set the paper size to @wation Pro
page size, plus 14mm for the printers marks. The

You can chang(_a the (_:olour correction table USinggraphics margins should be set to 0. So the paper
the Colour Choices dialogue b¢see 13.5) size for an A4 page should be 224 x 311.

Menu=>MiscChoiceswColour Note that if you do not set a big enough paper
® Load a suitable PostScript printer driver size,Ovation Pro will warn you when printing.
and configure it to print to file. However, to avoid this warning every time you
print, you should set up a suitable paper size
before printing as described above.

Print=>Print setup=>Separations

A wide variety of PostScript printer drivers are
supplied with Windows. These produce various
types of PostScript. In general using a higher level
of PostScript will give the best results, however
you need to know that the final destination of the
PostScript file is compatible with it.

You can print to file in various ways. One
approach is to use Add Ports in the Windows
Printer installation Wizard, then New Port and
enter for the port name the file name (or right
click to get Properties for a printer in the Printers
and Faxes window and select the Ports tab). This
way you can have a printer driver that always
prints to file.

Alternatively Windows may have a port called
File which you can select for any printer driver.
This will prompt for a file name during printing.

Another method is to seleBrint to file on the
expandedvation Pro print window. If you do

this when you start the printing process you will

be prompted for a file name. If you have followed
one of the methods in the previous two paragraphs
you do not need to select this option.
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O Set the options on the Print dialogue box.
Menu>File=>Print Ctrl+P

Reflect causes pages to be mirror printed, and
should usually be selected if you are printing to
film. However, please check with your bureau
first. If they requireemulsion side dowrReflea
should be selected; if they requemulsion side
up, Reflea should not be selected.

ChoosePrint setup to expand th@rint dialogue
box to display the advanced setup options.

Centre should be selected.

Bleed cause®vation Pro to print an extra 3mm
margin around the edge of the page. If your

document contains objects that bleed off the edg

of the page, choose tiBdeed option.

Separation names &
other info Crop
marks

\ Registration marks /

Colour bar

Fig. 13.9 - Printers marks.
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Printers marks should be selected. This causes
Ovation Pro to print the following special marks
around the edge of the pa@ig. 13.9).

Crop marksshow the edges of the page and are
used to trim the page to size.

Registrationmarks are used to help align the
separated film when preparing the printing plates.

Separation namesauses the name of the ink to be
printed on each separation. The document name,
page number, date and time are printed after the
ink name. You can edit this information or add
your own text using th&ext option on the
Separationsdialogue box (see overleaf).

él'heCoIour baris used to check the quality of the

colours on the proofs. Note that the colour bar is
not printed on spot separations.
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O Set options on the Separations dialogue box. TheText icon allows you to specify any
additional text that is to be printed after the

) separation name in the top left corner of the page
Colour separationsshould be selected when you (see fig. 13.9)In addition to ASCII text you can

are printing full colour or spot colour separations ;ysert macros which will be expanded during

Print=>Print setup=>Separations

(fig. 13.10). printing. The following macros are particularly
The Platesmenu allows you to choose which useful:

separations to print. {filename}

All processprints separations for the four process{filepath}

colours. This is the default setting. {chapternumber}

All spots prints separations for all spot colours. Eg:?ee}number}

ThePlatesmenu also list the four process coloursime)

followed by any spot colours that have been {datetime}

defined. You can choose to print individual plates
by ticking and unticking them directly on the
menu. {filename} P{pagenumber}{datetime}

The default string is set to:

which typically expands to:
Documentl P1 11:41am 27 February 1997

Separations |

[ Colour separations

Plates All plates ﬂl

Text | lename] Pipagenumber} {datetime] [#

SCreen. .. |

Cancel )74

Fig. 13.10 - The Separations dialogue box.
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® Set options on the Screen dialogue box.

Print=>Print setupr>Separations.>Screen

PostScript screencauses half-tone screen

information to be written into the PostScript file,

and should usually be select@dy. 13.11).

Note that the options in this dialogue box are
intended for experienced users, and should not

normally be altered.
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@ Print to the PostScript file.

Once all the above options are set correctly, click
on OK in thePrint dialogue box to create the
PostScript file.

When printing the usudrinting dialogue box is
displayed showing the progress that has been
made. the icon in the bottom left-hand corner of
this dialogue box shows the colour of the
separation currently being sent to the printer.

Frequencyis the density of the half-tone screen,
measured in lines per inch. Usually a frequency of
100 is suitable for monochrome work and 150 for
process colour work.

Check with the bureau/printer if you are in doubt.

Spot specifies the shape of the half-tone dot. Use
the default, unless you are experienced in creating
PostScript separations.

Angle specifies the half-tone screen angle for the
ink highlighted in the panel above. Unless you are
experienced in creating PostScript separations,
you should use the default angles as supplied. If
the wrong halftone screen angles are set, an
undesirable screen clash, called moiré, may occur.

Halftone screen |

W PostScript screen

Frequency | 150 Ipi Spntl Dat ﬂl

—Flates

Black: 150 Ipi, 45°

Cyan: 150 Ipi, 105°
Magenta: 150 Ipi, 75°
Yellow: 150 Ipi, 90° hd

Angle I? ®

Apply Cancel Ik

Fig. 13.11 - The Screen dialogue box.
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13.8 Submitting the File to a Bureau

Check with the bureaux what format discs they
can handle.

Make sure that any PostScript files are gives a
file extension.

To format and write to Apple format discs, you
need to purchase a separate utility to do this.

For small jobs you will be able to send the
PostScript files using floppy discs. For bigger jobs
you will have to use one of the following
alternatives:

» Split the job into separate parts so that each
part will fit on a floppy disc.

* Use afile archiver to compress the files in Zip
format. However, you must ensure that the
bureau has suitable software to decompress the
files.

» Transfer files using removable drives such as
CDR or Zip drives.

» Transfer the files electronically via email or an
ftp or web site.

CHapPTER 13
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B. Image Processing

13.9 TheProcessDialogue BOX......... ...,
13.10 Brightness, Contrast & Gamma . ...,
1311 Custom ColourMap . ...t
13.12 DUOIONES. . . o ottt e e e

Ovation Pro enables you to modify the appearance of imported bitmap
and vector graphics using simple brightness, contrast and gamma
sliders. You can also define custom settings by editing points on the
colour map. Any of the three standard colour models may be used to
make adjustments.

Ovation Pro also allows you to change colour pictures into
monochrome pictures, and to change the foreground and background
colours of monochrome pictures.

Image processing can be applied to Sprites, JPEGs, Draw files and
Windows .bmp files.
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13.9 The Process Dialogue Box
Menu=>Picture=>Process...

TheProcessdialogue boxfig. 13.1)is available

CHapPTER 13

Update

By default theUpdate option is selected, meaning
that the picture is updated instantly as changes are
made in thé>rocessbox.

from the main menu when a picture frame is ' . .
active. Image processing can only be applied to |f Updateis not selected, the picture is not

one picture at a time.
Model

This is the colour model that will be used when

updated until you click o®@K. This prevents the
picture from being updated after each change you
make, which might be quite slow for very large

. . pictures.
you are modifying the picture. For CMYK
pictures,CMYK is the default model. For other Default
pictures RGB is the default model. You can Click on Default to cancel any processing that has

choose any colour model for any picture,

been applied to the picture.

irrespective of the picture type. However note thaif you have closed therocessdialogue box, you

processing a CMYK picture using the RGB can always return to the previous picture settings
setting will often mix colours between the CMYK ysing theUndo option.

plates. This may be highly undesirable.

Colour

This is the colour component that will be

modified. The colour map displays a coloured
curve for each of the components.

If you choos@All, all colour components for that
model will be modified in one operation, and the
curve of the map is shown in black.

Process |

[
o
i
=

faodel
’76' REE Chi¥kl  HSYW

Caolour
’76' Al R

Brightness |

Contrast |

Garnmma |

[T Duatone Luwer-El Upperl— EI

I~ Use spots W Update

Default | Cancel |

D]

Fig. 13.1 - The Process dialogue box.
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Colour Map

Thecolour mapillustrates the changes made by
the brightness, contrast and gamma sliders. Later
on in this chapter you’ll see how it can be used to
define a custom colour map.

The map shows a picture’s input values on the
horizontal axis, plotted against output values on
the vertical axigfig. 13.2).

When the map is a 45° line from 0, 0to 1, 1,
output values equal input values i.e. normal
brightness and contra@dig. 13.3)

1 (white)
5
Q.
=
o
0 (black)
0 Input 1
(black) (white)

Fig. 13.2 Colour map.

THe Process DiaLocue Box

Fig. 13.3 Output values equal input values.

0.5

201
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13.10 Brightness, Contrast & Gamma
Menur>PicturecoProcess...

You can change the brightness, contrast and
gamma values of a picture using the sliders
located in the centre of tirocessdialogue box.

Brightness

Drag theBrightnessslider to the right to increase
brightness, or to the left to decrease brightness.
When the slider is in the middle, there is no
modification.

Brightness may also be specified by setting a
value in the writable icon to the right of the slider.

CHapPTER 13

CMYK and HSV Models

With the CMYK model, the brightness slider
increases or decreases the levels of Cyan,
Magenta, Yellow and Black. So, an increase in
levels of CMYK, results in a decrease in
brightness. A decrease in levels of CMYK, results
in an increase in brightness.

With HSV, the brightness slider increases or
decreases the levels of Hue, Saturation and Value.
It is not very useful to increase or decrease all
three HSV levels simultaneously, but it can be
useful adjusting them individually.

A value of 0 means no modifications, -100 means

minimum brightness and 100 means maximum
brightness.

The colour map illustrates the changes made to
the brightness slider. If you increase the

brightness, the line on the map moves up and the
output values become higher than the input values

(fig. 13.4) If you decrease the brightness, the line
moves down and the output values become lowe
than the input valugdig. 13.5)

r

Note that the brightness slider adjusts the levels of

colour according to the current colour model, so
the description given above is only true for the
RGB colour model.

0.75

Fig. 13.4 Increased brightness.

Fig. 13.5 Decreased brightness.
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Contrast CMYK and HSV Models

Drag theContrast slider to the right to increase  With the CMYK model, the contrast slider
contrast, or to the left to decrease contrast. Whenincreases or decreases the levels of Cyan,

the slider is in the middle, there is no modificationMagenta, Yellow and Black. So, an increase in
levels of CMYK, results in a decrease in contrast
A decrease in levels of CMYK, results in an
increase in contrast.

Contrast may also be specified by setting a value
in the writable icon to the right of the slider. A
value of 0 means no modifications, -100 means
minimum contrast and 100 means maximum With HSV, the contrast slider increases or
contrast. decreases the levels of Hue, Saturation and Valt

The colour map illustrates the changes made to It is not very useful_ to increase or dec_rease all
the contrast slider. If you increase the contrast, thif'e® HSV levels simultaneously, but it can be
line on the map is rotated anti-clockwise, reducindfSeful adjusting them individually.

the range of input valugfg. 13.6) If you

decrease the contrast, the line is rotated clockwise,

reducing the range of output valu@g. 13.7).

Note that the contrast slider adjusts the levels of
colour according to the current colour model, so
the description given above is only true for the
RGB colour model.

Fig. 13.6 Increased contrast. Fig. 13.7 Decreased contrast.
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Gamma

Drag theGamma slider to the right to increase the
gamma value, or to the left to decrease the gamma
value. When the slider is in the middle, there is no
modification i.e gamma value is 1.

Gamma may also be specified by setting a value in
the range is 0.05 to 5.75, in the writable icon to

the right of the slider. The up/down icons can be
used to step through this range in 0.01 increments
for values below 1, and 0.05 for values above 1.

The colour map illustrates the changes made to
the gamma slidgffigs. 13.8 & 13.9)

Note that the gamma slider adjusts the levels of
colour according to the current colour model.

Fig. 13.8 Gamma value of 1.8. Fig. 13.9 Gamma value of 0.75.

CHapPTER 13
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13.11 Custom Colour Map Curved Segment

Menu>Picturec>Process. .. Choose this tool to convert the current map into
: series of curved line segments. You can edit the
You can create custom colour maps using the 4 : . i
tools providedfig. 13.10) map by draggl_ng the c_ontrol_pomts. Cllc_k Select

_ T to add new points, or right click over points to

Linear delete them.
Choose this tool to reset the colour map to a 45° |,yert

Ilnc_a from 0, 0 tq 1, 1. This se_ts output values equ%hoose this tool to flip the colour map upside
to input values i.e. normal brightness and contrast

down. This produces a negative of the curve
Note that the brightness, contrast and gamma  currently shown on the graph.

sliders are only available when this tool is SeleCteRI'ote that you can use the Invert tool to invert the

Straight Segment adjustments made by the brightness, contrast ar
Choose this tool to convert the current map into agamma sliders.

series of straight line segments. You can edit the

map by dragging the control points. Click Select

to add new points, or right click over points to

delete them.
Linear | i
Straight segment ./

Curved segment

=
o

Fig. 13.10 - The custom colour map.

Invert
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13.12 Duotones
Menuc>Picture=>Process...

The Duotone option allows you to specify the two
colours used in a monochrome picture. If the
current picture is multi-coloured, it is converted to
monochrome first.

Lower allows you to specify the new colour for
the black component of the monochrome image
using the standard colour pickélpper allows

you to specify the new colour for the white
component of the monochrome image.

Duotoneis particularly useful when commercially
printing documents using spot colours. It allows a
colour or monochrome picture to be printed using
white and any individual spot colour, or even
using two spot colours.

DeselecDuotoneto revert back to the original
image.

Fig. 13.11 - The original Fig. 13.12 - In black and
picture white

CHapPTER 13
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The Spelling Checker

14.1  Spellchecking . ... .
14.2  Dictionaries. .. ...
14.3 Check Story/From Caret. . . ...t
144  CheckWord . . ... ..
145 Check Document .. ........ ...t
146 CheckasYou Type. ...t s
14.7  Creating & Editing Dictionaries. .. ........................
14.8  Hyphenation EXceptions. . . ...
14.9  Relocating Spellcheck Dictionaries. . . .....................

Ovation Pro will allow you to check text visually by marking up words or
interactively. The spell checker can also find repeated words.

The Ovation Pro spelling checker checks the spelling of words in the

document and identifies those that have been misspelt or mistyped. To
help you make corrections, it can suggest the correct spelling or allow
you to browse through a dictionary for the correct word.

The spelling checker cannot identify correctly spelt words that are used
in the wrong context, so you should always read your documents
carefully after spellchecking.

This section also describes how to create and maintain user dictionaries
and how to add words to the hyphenation exceptions dictionary.

It is also explained how to organise dictionaries when using
Ovation Pro on a network.



208  THe SpreLLING CHECKER CHapPTER 14

14.1 Spellchecking 14.2 Dictionaries

Experience shows that checking text, especially The spelling checker works by checking the words
when reading a document from the screen is prorne a document against the words in the currently

to missing mistake®vation Pro has two loaded dictionaries. If a word can be found in a
facilities to help check your text: dictionary, it is assumed that it is spelt correctly.
* interactive spell check. Main Dictionary

marking wrongly spelt words. The main dictionarainDict , contains over
Before either of these can function properly, a 67,000 UK English words covering basic
dictionary must be available. Normally vocabulary. Each word ending is treated as a
Ovation Pro uses the dictionary named separate word, so there are entriesralk
MainDict by default. walks , walker ,walking ,walked etc. It also

contains many real names such as country and city

names. These names are capitalised in the
Interactive approach dictionary, so the spelling checker will insist that
The text of the document is checked and if a they are correctly capitalised in the document.

potential error i; found a window opens giving v g, may add any words to the main dictionary,

you several options. but it is recommended that any personal words

To activate this procedufpellcheckis used. such as names of people, towns and roads, or any
Menuc=MiscebSpelichecks....... specialist terms are put into user dictionaries.

User Dictionaries

You may supplement the main dictionary with any
number of user dictionaries. These may contain

Ovation Pro can also mark all words it believes  personal names, foreign words or technical terms

Spelling errorsin the View Options menu

The visual way

_ _ _ For your convenience an empty user dictionary
MenUEDVIGWE:>OptI0nSE:> ...... Ctl’|+Sh|ft+O Ca”edUsercht |S Supplled by default

A special user dictionary callddlyphDict is

'also supplied. This contains hyphenation

e.g. wrognlyy. exceptions and is used by the hyphenator, not the
spelling checker. However, it is maintained in the
same way as other user dictiona ese 14.8).

Words not in the dictionary are underlined in red

Repeated words

A special facility is the indication of repeated
words when using the interactive spell check. A
‘repeated word’ is the common typographical
error of typing the same word twice e.g. “the the”.
The Spellcheckerror window has an icon at the
bottom which displaysRepeated wordif this is

the source of the errgfig. 14.2)
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Rules for Capitalisation Please note that dictionaries can contain more than

When the spelling checker compares words in théne copy of the same word, if each copy has a
document against those in the dictionaries, it takedifferent lower-case/upper-case format.
the capitalisation of the words into accounti.e. | oading & Attaching Dictionaries

whether the letters are in lower-case, Upper-case|f v spelicheck a document without loading any
or a mixture of both. dictionaries first, thélainDict andUserDict
The rules for capitalisation are as follows: dictionaries are automatically loaded. These

. Aword in the document in all upper-case will Should be suitable for most applications.

match with the same word in the dictionary, Alternatively you may explicitly load the
regardless of the upper-case/lower-case formatictionaries required using the option
of the word in the dictionary. SpellcheckDictionary (fig 14.1).

So the wordntroduction in the Menu=>Misc=>Spellchecke>Dictionary...
dictionary will match witHNTRODUCTION

_ The process of loading a dictionary involves two
in the document.

stages:
« Aword in the dictionary in all lower-case will , 1he dictionary is physically loaded into
match with the same word in all lower-case or memory if it is not already in memory.

in lower-case with an initial capital. o _
* The dictionary is attached to the current

document. This means that it will be used
when the document is spellchecked.

* Aword in the dictionary in mixed lower-case hg names of the dictionaries attached to a
and upper-case will only match with the same . ment are saved with the document. So when
word in exactly the same format (orinall  {he gocument is reloaded and spelichecked, the
upper-case as permitted by the first rule above)y o riate dictionaries are automatically loaded

So the wordPostScript  in the dictionary from disc.
will only match withPostScript  or
POSTSCRIPTIn the document. |

So the wordnarch in the dictionary will
match withmarch or March in the document.

. . " G B
The general rule is that words that are valid in all Hess owse
lower-case, must appear thus in the dictionary. Browse | maindict "0
Addto| userdict H
he =
she
tee
thee
therm
then j
Check story... the
Check word... Crl+44 Ll Add |
Check document...
Check from caret... lgnore
Check as wou type
- Repeated word
Dictionany...
. Cancel |
Fig. 14.1 - The Spellcheck menu.

Fig. 14.2 - ARepeated Word found.
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14.3 Check Story/From Caret Ignore
Menur>Misc>Spellchecks...... If you consider that the queried word, despite its

ChooseSpellcheck>Check storyto check all the omission from the Ioadgd dictionaries, is correct
) . . as it stands, you may click on the Ignore option.

words in the current story against the words in thel'he spell check will then resume at the following

currently loaded dictionaries. The check starts at ord

the beginning of the story and continues to the en '

of it, irrespective of the position of the caret or of Words that are ignored are placed in a special
selected text. dictionary embedded in the document called

. llgnore . If you spellcheck a document more
Alternatively, Spellcheck>Check from caret g Yy P . . .
than once in the same session, words ignored in

will check the speliing of all the words from the the first spell check will not be queried again in

word containing the caret to the end of the story or .
: subsequent spell checks. This feature can save
from the start of a selection.

considerable time.
Remember that if you have not explicitly loaded

any dictionaries, th®ainDict andUserDict
dictionaries will be automatically loaded for you.

Each loaded document that has been spell checked
may have its own ignore dictionary.

An ignore dictionary remains resident until the
document is closed or until the dictionary is
deleted using th8pellcheck>Dictionary

dialogue box. Alternatively you may use an option
on theChoicesdialogue boxsee 15.7)which
causes the ignore dictionary to be saved with the
document. This means that ignored words will not
be queried next time the document is loaded and
spell checkedfig. 14.4)

¥ Spellcheck EE Next

If there are no spelling errors, the message
No spelling errors is displayed.
Otherwise the word is highlighted and the
Spellcheckdialogue box is displayed with the
gueried word in the writable icdffig. 14.3)

# Guess  Browse If_y(_)u don’t want the W(_)rd adding to the ignore
dictionary for example if you want to examine any
Browse | maindict  *H other occurrences click on this option. The spell
e check will then resume.
Addto| userdict O
— ¥ Edit llgnore |

I:Dr'r'lr'l"l.ISSIEIr'l —_— D

amissian

omitting ASC| |
HyphDict
hyphenator
MainDict

El FostScript |
— spellcheck
OmmiIssion
spellchecked =
Replace Add |
lgnore et
Add word | Delete word |
Cancel | ]34 |
Cancel

Fig. 14.4 - An example !Ignore dictionary
Fig. 14.3 - The Spellcheck dialogue box. created while spellchecking this chapter.
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Guess Replace

If Guessis selected, the window above the If the queried word is incorrect and the intended
gueried word shows the words that the spelling word is not listed in the guess or browse window,
checker suggests may be the correct spelling. Thgou may correct the misspelt word directly in the
guesses are made on the assumption that one ofwritable icon. Alternatively left click over the

the following simple typing errors has been madeclosest word in the guess or browse window to
transfer that word to the writable icon, where it

* There is a single typing error.
ge yping may be edited.

* A pair of letters have been transposed. _ _ .

_ o Notice that ifBrowseis selected, the browse
* There is one missing letter. window is continually updated to show the words
» There is one extra letter adjacent to the queried word as it is edited.

In the example dialogue box shown, the queried When you have corrected the queried word, click
word isommission , and one of the guesses is onReplaceto replace it in the document and
correctly shown asmission . continue the spellcheck.

If the queried word is incorrect and the intended Add

word is listed in the guess window, you can If you consider that the queried word is not only
replace the misspelt word in the document by correct but also sufficiently important to merit a
double-clicking over the intended word in the place in a dictionary, click oAdd. The spell
guess window. The new word will replace the  check will then resume at the following word.
misspelt word, taking the same upper-case and
lower-case format. The spell check will then
resume at the following word.

The dictionary to which the word is added is
shown in the icon to the right of the words
Add to. If you have not explicitly loaded any

Browse dictionaries, the default dictionary to which words
If Browseis selected, the window above the are added ifserDict . This may be changed by
gueried word lists the words MainDict that choosing another dictionary from the menu.

are adjacent to the queried word in the dictionaryPlease note that words are not physically inserted
The default dictionary being browsed is into dictionaries until the spell check has

MainDict , but this may be changed by choosingcompleted.
any loaded dictionary from tHg&rowse menu.

Use the vertical scroll bar to browse through the TheCursorup  andCursor down  keys
list of words. If the queried word is incorrect and in the spell check window allow stepping

the intended word is listed in the browse window, through words. This allows error correction
you can replace the misspelt word in the without taking your hands off the keyboard.

document by double-clicking over the intended

word in the browse window. The new word will

replace the misspelt word, taking the same upper- Holding down Control when clicking on Add

case and lower-case format. The spell check will ~ or Replace will carry out the action but

then resume at the following word. without resuming the spell check. Useful if
you want to see how the text looks after
replacing a word.
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Cancel

You may cancel the spell check at any time by

clicking onCancel If any words have been added
to any dictionaries (except the ignore dictionary)

during the spellcheck, you will be asked if you
wish to retain the chang€g. 14.5)

The End of the Spell Check

When the spell check has finished, you will be
asked if you wish to retain the changes made to

the dictionariegfig. 14.5)

T Ovation Pro

"

@"‘O Dictionaries changed. Retain changes?

A

I\

Mo |

Yeg

Fig. 14.5 - Click on Yes to retain the changes made

to any dictionaries during the spellcheck.

CHaPTER 14
14.4 Check Word
Menu=>Miscr> Spellcheck>Check word...
Ctrl+W

ChooseCheckword to check the spelling of just
the word at the caret. If the word is present in one
of the loaded dictionaries you will hear a beep,
and no further action is taken.

If the word is not present in any of the loaded
dictionaries, th&pellcheckdialogue box is
displayed with the queried word in the writable
icon. The procedure for correcting the queried
word is the same as f@heck story described
earlier.

When the queried word has been corrected or
ignored, the dialogue box is closed and the spell
check stops.
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14.5 Check Document
Menur>Misc>Spellcheck>Check document...

ChooseCheck documentto check the spelling of
all the word in all stories in the document. The
procedure for correcting queried words is the
same as fo€heck story described earlier.

CHeck DocumenT & CHeck as You Type 213

14.6 Check as You Type
Menu>Miscr>Spellcheck>Check as you type

This checks the spelling of each word after you
have typed it. The word ends when you type a
space, tab, carriage return or punctuation mark.

If the typed word is absent from the dictionaries
currently loaded, a beep will be heard. At this
point you can:

* Ignore the warning if you consider the word to
be correct.

» Correct the spelling in the document.

* ChooseCheck word to use the facilities on
the Spellcheckdialogue box to correct the
word.

Words are not checked if you move the caret off
the word before you have finished typing it, nor

are words created as a result of the insertion or

deletion of characters.

Another way of checking while you type is by
settingSpelling errorsin

Viewr>Optionsto Spelling errors
Ctrl+Shift+O

If this is done then wrongly typed words are
marked.



214  Tue SpeLLING CHECKER

CHapPTER 14

14.7 Creating & Editing Dictionaries Selecting a Dictionary
Menur>Misce>SpellcheckDictionary ... Most of the operations described below apply to a

The Spellcheck>Dictionary option opens the
Dictionary dialogue boxfig. 14.6) This allows
you to load, remove, create, delete and edit

dictionaries.

The small window lists all the dictionaries that
currently exist. Those that are loaded and attached
to the current document are ticked. Apart from
MainDict , UserDict and any other user
dictionaries you have created, this window will
often list two further dictionarie$jyphDict and
llgnore

HyphDict contains a list of words that are
hyphenated in a special way by the automatic
hyphenato(see 14.8)HyphDict is
automatically loaded and attached to the current
document, but may be edited, deleted and re-
created just like any other dictionary.

The embedded dictionatignore  contains a

list of words that were ignored during previous
spellcheck operations on the current document.
llgnore  may be edited and deleted just like
other dictionaries. Unlike other dictionaries,
llgnore is normally deleted when the document
is closed, unless you choose to save it with the
documen(see 14.2)

¥ Load/edit/create dic...H |

o - Losd
French _I = |
hyphdict Remove
[talian Create
maindict :
puzzle-uk Edit
userdict ~| Delete
Cancel (]

14.6 - The Dictionary dialogue box allows you to
load, remove, create, delete and edit dictionaries.

selected dictionary. To select a dictionary, left
click over its name so that it becomes highlighted.
You may only select one dictionary at a time.
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Load Create

ThelLoad option loads the selected dictionary (if TheCreate option opens th€reate dictionary
it is not already loaded), and attaches it to the  box(fig. 14.7) which allows you to create a
current document. A tick next to the dictionary  dictionary with the name specified.

name indicates that it is attached, and will be
checked against next time the document is
spellchecked.

A warning is given if you attempt to create a
dictionary with the same name as an existing
dictionary.

Remove You can create and save any number of
Remove detaches the selected dictionary from thgictionaries with your document.

current document, and if it is not attached to any

other loaded documents, removes it from memory.

This means that the selected dictionary will not béelete

checked against next time the document is spell The Deleteoption deletes the selected dictionary.

checked. Since this action is irreversible, you will be asked

Please note th&emovedoes not actually delete for confirmation before the deletion takes place.
the dictionary.

¥ Create dictionary |
Dictionary namel |

Cancel | Ik

14.7 - The Create dictionary dialogue box.
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Edit Add

Dictionary files cannot be edited directly in a text To add a new word to the dictionary, simple type
editor since they are in a special compressed it into the icon below the word list, and press
format. TheEdit option allows you to examine Return or click orAdd. Your new word is

and edit the contents of a dictionary. inserted into the dictionary in the correct place,
and highlighted in the word list. If you are adding
a number of words to the dictionary, remember to
clear the writable icon before typing each new

Remember that most words in the dictionaries
should be in lower-case letters so that they will
match with all lower-case words or words with

initial capitals. If words in the dictionary have ~ Word.
capitals, the spelling checker will insist that Notice that as you type into the writable icon, the
gueried words are capitalised. word list continually updates, showing you the

words adjacent to it in the dictionary. This feature
may be used at any time to locate words in the
dictionary.

Click onEdit to open thd=dit dialogue box for
the selected dictionarfig. 14.8) Alternatively,
double-click on the dictionary name in the
scrolling window. The name of the dictionary To add a word based on a word in the word list,
being edited is confirmed in the title bar. left click over the word in the word list to transfer
it to the writable icon. Now edit the word as
required, then press Return or clickAad to add

it to the dictionary.

The window in the dialogue box lists the words in
the dictionary in alphabetical order. You may use
the scroll bar to scroll through the list of words.

The number of words in the dictionary is shown irDelete

an icon at the top of the window. To delete a word, left click on it so that it is
highlighted, then click oDelete
Saving the Dictionary

Click onOK to save the dictionary with all the
changes you have made. Click©@ancelto close
the dialogue box without updating the dictionary.

# Edit maindict EHE|
67579 words

; =

A-bormb

A-bombs

aardvark

aardvarks
aardwolf

aardwaolfs j

Add word Delete word

Cancel )74

14.8 - The Edit dialogue box allows you to
edit dictionaries.
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Import & Export

In addition to adding words individually into a
dictionary, you may import words in bulk from
file. To do this, prepare an ASCII text file of
words, with each word separated by a carriage

HypHeENATION ExcepTions 217

14.8 Hyphenation Exceptions

The special dictionary callddyphDict is used

by the automatic hyphenator to deal with words
that do not hyphenate correctly using the standard
algorithm. So if you find that a word is regularly

return or line feed character. Now drag the file of hyphenated incorrectly, you may add it to

words to theedit dialogue box and drop it on the

HyphDict . This may be done in one of two

word list, where it will be merged into the existingways :

dictionary. Please note that with large dictionaries,

this process may take some time to complete.

Right clicking over the word list in thedit
dialogue box, will open a menu offering “Import

Words” and “Export Words”, these options open
the standard Windows Open and Save dialogues.

Exported text files will contain each word in the
dictionary separated by an end of line code.

If the word is added tblyphDict without

any hyphens, then it will be ignored by the
automatic hyphenation algorithm i.e. it will not
be hyphenated

If the word addedHyphDict contains one or
more hyphens, it will only be hyphenated at
one of the hyphens. So if you add the word
auto-matic , it will only be hyphenated
betweerauto andmatic .

Please note th&typhDic t is only used when
automatic hyphenation has been enaléee 5.6)
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14.9 Relocating Spellcheck Dictionaries

Dictionaries are installed by separate installer
programs. The first time one of these is run you
will be offered a choice of location.

CHapPTER 14

Spell Checking on a Network

A common requirement when running

Ovation Pro on a network or when more than one
user shares a computer is to allow users to share
MainDict , but have their own user dictionaries.

The installer foMainDict  will offer you a

choice of setting up a UserDictionary folder for
each user. If this is selected then when

Ovation Prois re-run, each user can browse the
same shared version BfainDict , and add

words to their own copy dfiserDict . Any new
dictionaries created, are saved locally in the users
profile and override any shared dictionaries with
the same name.

If MainDict is edited, it is automatically saved
locally and overrides the original shared version.
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Customisation

15.1 Stylesheets. . ... ... e
15.2  Changing the Default Document. .. .......................
15.3 Application Choices . ...
15.4  Print Choices. . ... .
155 General ChoiCces. . ...
156 VieW ChOICES ... it e e e
157 TextChoiCes . .. ... ... e e i e
15.8 Picture Choices. . ... ... e
159 Line ChOiCES. . . . oot e
15.10 Colour Correction Choices . ...,
15.11 Document Preferences. ............ .. i
15.12 General Preferences. . ......... .. . i
15.13 View Preferences . ........... i e
15.14 TextPreferences. . ... ... ... i

This chapter describes the ways in which you can customise
Ovation Pro for general use or for specific applications.

Stylesheets fully describe the format and style of documents. You can
save the stylesheet from a document and use it as a template for
creating other similar documents. You may also save a stylesheet so
that it is used as default for each new document opened.

Application Choices allow you to configure the application in various
ways. There is just one set of Choices that affects all documents.

Document Preferences allow you to configure individual documents.

In addition to the above options, you may also customise the button bar
(see Chapter 16) and the menus (see Chapter 17).



220  CusTOMISATION CHapPTER 15

15.1 Stylesheets The following information is saved in stylesheets:
Menur>Filer>Save stylesheet » Defined styles
The Savestylesheetoption opens the usual » Defined colours

Windows save windowfig 15.1) which allows . Master pages
you to save a stylesheet for the current document.
The procedure for saving a stylesheet is identical®
to that described previously for saving documents  View options, Grid and Zoom

(see 3.9) » Toolbox and info palette position
The stylesheet describes the format and style of
the document from which it is saved, but it doesn't . ) )
have any actual contents. Whenever you save a Please note that objects, text and.plctures in the
document, its stylesheet is automatically saved document pages are NOT saved in stylesheets.
with it. However, if you want to use the same

layout for other documents, you can save the

stylesheet separately.

Objects on the master pages.

Preferences

A stylesheet may be re-loaded just like any other
document i.e. by double-clicking on it, or using
Open on th®vation Pro File menu.

So if you want to create a new document based on
the style of an existing document, save the
stylesheet from the document, then double-click
on the stylesheet to create a new document. Every
time you need to create a new document having
the same layout, just load the stylesheet from disc.

Save As HE
Save in; I _4 Manual j gl

| 1172_Examples

File name:

stylesheet Sawve I
Save as type: IDTP Style Sheet (*.dps) j Cancel |

Fig. 15.1 - The Save stylesheet window.
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15.2 Changing the Default Document
Menur>Files>Save as default

The Save as defaulbption allows you to

overwrite the default document with a stylesheet

based on the current document. The default
document is the blank document that appears
when you click on New on th@®vation Pro File
menu and then click on OK.

To change the default document:

1. Click on New on th®vation Pro File menu
and then click on OK to open a blank

document (or load any other document whose

layout you want to use).

2. Modify the document as requiregdvation Pro
uses a stylesheet to define the default
document, so you may change any of the
attributes that are saved in stylesheets

CHancING THE DerauLt Document. 221

A feature for advanced users, is that it is possible
to save a document (i.e. as opposed to a
stylesheet) as the default document. This has to be
done manually by opening the foldevation Pro
saves fileDefault.dps in. This is in the
Application Data folder for the current user. A
typical path for it is:

C:\Documents and Settings\David
Pilling\Application Data\DavidPilling\OvationPro

The first “David Pilling” being replaced with your
user name.

If you do this, the first object of each type in the
document which is not a master object is used as a
prototype.

By this mechanism it is possible to make new text
frames default to transparent fill or have no text
runaround etc.

(see 15.1)Typically you might want to change Sometimes this approach will overlap with
the page margins, document zoom, defined options in the choices window being provided to

styles or colours.

Note that the default document cannot contain®
objects, text or pictures, except those on the

master pages.
3. Click onSave as defaulto save the current

control the defaults for objects (see below).
ettings in the choices windows take precedence.

document as the default document. You will be

prompted for confirmation before the old
default document is overwrittgfig. 15.2)

4. Click on New on th®vation Pro File menu
and then click on OK to open a new default
document.

T Ovation Pro

~

@'0 About to update default document. Are
A you sure you want to proceed?

N\
Ma | fes

Fig. 15.2 - Confirmation box when using Save as default.
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15.3 Application Choices
Menur>Miscr>Choices...........
ChooseChoicesfrom the Misc menu to open a

dialogue box that allows th@vation Pro
application to be configurgdig. 15.3)

Note that choices are attached to the application,

and affect all the documents that you create or
load i.e there is one set of choices for all

documents.

There are seven groups of choidesnt,
General, View, Text, Picture, Line andColour.

Click on the appropriate icon in the scrolling pane

at the left of the dialogue box to display all the

associated choices. The choices are described on

the following pages of this user guide.

Once you are happy with the choices, clickQit
to apply them for the current session only.

Alternatively, click onSaveto apply the choices

and save them so that they will be used by default

next timeOvation Pro is run. You will be

prompted for confirmation before the old choices

are overwritten.

In addition to the settings in the choices dialogue

box, clicking onSavealso saves the order of the
tools in the toolboXsee 2.6)

¥ Application choices |

=

Print

- |

™ Crop check

Frint choices

™ Mail merge one record per print job

ﬂ“l? W Direct PostScript output 'El
.%Y,.v"
_General | Bleed | 3mm
@? Reg. width | 0.03mm
_ Miew Crop H length | 7mm Gap| 3Imm
ﬁE Crop % length | 7mm Gap| 3mm
= T
Text Reg. H length | Brmm Gap| 4.5mm
*‘|'.._;ﬂ1 Reg. % length | 4mm Gap| 4.5mm
B
F'iciLre - Reg. radius | 1.5mm
Save Cancel 0]%

Fig. 15.3 - The Choices dialogue box

CHapPTER 15
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15.4 Print Choices

Menu=>Misc=> Choices>Print

For all available choicesee fig. 15.4

Crop check

If Crop checkhas been selected you will be

PrinT CHoiIcES 223

Bleed and the following icons

If Bleedis selected an additional margin all
around the page is printed. Useful if you want an
object to go to the edge of the pafsre 12.3 and
fig. 12.10)

The other icons let you set the sizes of the crop
and registration marksee 12.3 Printers marks).

alerted if the area being printed is bigger than the
available area on the printer.

Mail Merge...

If off a mail merge will produce one print file (or
print job) containing all the merged versions. If
set then a file (or print job) will be produced for

each merged version. This may make more sense

if you recall that some printing services append a
cover sheet to each print job, a fax printer may

make a phone call for each print job.

Direct PostScript output

If selectedOvation Pro will send data direct to
PostScript printers, bypassing the printer driver

(see 12.4 PostScript Printing)

[ Crop check

Print choices

™ Mail merge one record per print job

¥ Direct PostScript output *E||

Bleed

ey, width
Crop H length
Crop % length
Feqy. H length
Reqy. v length

Feq. radius

Fig. 15.4 - Print choices.

3rnrn|

[ 009mm
il Gap 3mim
fmm Gap| Jmm
Emm Gap| 4.5mm
A Gap 4.4rmim
1.8mm
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15.5 General Choices

Menu=>Misc=>ChoicesyGeneral

General choices are associated with the general
operation ofOvation Pro (fig. 15.5).

Date Format

Date format sets the format of the date string
inserted by thdlenur>Miscr>Insert=>Date
option(see 3.2)A full explanation of this format
is given inAppendix D

Time Format

Time format sets the format of the time string
inserted by thdlenur>Miscr>Insert=>Time
option(see 3.2)A full explanation of this format
is given inAppendix D

Save Buffer

If Save bufferis not selected, the undo buffer is
flushed whenever documents are saved.

If Save bufferis selected, the undo buffer is
saved with document{see 3.4)This means that
when you reload the document, you can undo
operations that were performed in a previous
session. Another advantage is that when you

CHapPTER 15

Buffer Size

Buffer sizeis the size of the undo buffer. The
larger the buffer size, the more operations can be
undone. Note that different types of operations use
different amounts of memory in the buffer, so the
buffer size cannot be directly related to the actual
number of steps.

Give Warnings

Give warnings allows you to enable or disable
various warning prompts that are displayed in
certain circumstances.

Windows clipboard

If selectedOvation Pro will use the Windows
clipboard, allowing data exchange with other
programs that use it, as well as normal clipboard
operation withinOvation Pro.

Clipboards

Ovation Pro supports multiple clipboards. This
icon lets you set the number of clipboards.

To use the multiple clipboards more easily, install
the Clipboards applet.

Check documents

reload a document, the caret will be at the positiomhese two buttons enable checking of documents

it was when the document was saved.

General choices

Date format | %20 %ST %MO RCESYR

Time format Y0212 Yo% AM

[T Save buffer Buffer size| 9 ¢

W Give warnings

W Windows clipboard  Clipboards | 1
W Check documents after loading

¥ Check documents before saving

Fig. 15.5 - General choices.

for corruption after loading and before saving. If
corruption is detected you are given a choice to
continue or not, selecting ‘No’ will then produce

an error message which describes the nature of the
corruption.

Obviously corruption of documents is undesirable,
however this feature will at least allow you to
avoid overwriting a good copy of a document with
a bad one, or continuing working on a damaged
document.

In addition to checking for corruption, a check is
also made if the document contents have changed
since it was saved. This check can reveal
problems with filing systems.

Both these options should be selected unless you
have a good reason.
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15.6 View Choices Attach Info Palette

Menu=>Misce>ChoicessView If Attach info palette is selected, the info palette
is attached to the document wind¢see 2.7)If
the document window is moved, the info palette
moves with it.

View choices are associated with the way
Ovation Pro documents look on the screen
(fig. 15.6). _ _ _
Flashing Caret If Attach info palette is not selected, the info

palette becomes attached to the screen and doesn't

Flashing caretallows you to have a flashing move with the document window. If the choices
caret, making it easier to locate in the document. 5r6 saved, the position of the detached info palette
Period is also saved.

Period in the time in centi-seconds that the If Allow off-screenis selected, the info palette
flashing caret is switched on/switched off. can move off screen for example when the

Attach Toolbox window is expanded to fill the screen. This may

If Attach toolbox is selected, the toolbox is be useful on a multi-monitor system.

attached to the document wind¢see 2.6)If the  Instant Updates on Path Edit
document window is moved, the toolbox moves If Instant updates on path editis selected,

with it. surrounding text is continually updated as paths
If Attach toolbox is not selected, the toolbox are edited in Path Edit Modsee 8.11)
becomes attached to the screen and doesn't MOVR |nstant updates on path editis not selected

with the document window. If the choices are  g,rrounding text is not updated until Path Edit
saved, the position of the detached toolbox is als@ode is exited. This may be useful if path editing
saved. becomes very slow due to the text reflows.

If Allow off-screenis selected, the toolbox can  ~rosshairs when moving selection

move off screen, for example when the window 'Sif this option is selected large crosshairs will be

expan_ded to fill the screen. This may be useful Ondisplayed whilst objects are being moved.
a multi-monitor system.

“iew choices
¥ Flashing caret I 50 Period
W Attach toolbox W Allow off-screen

¥ Attach info palette | Allow offscreen
¥ Instant updates on path edit

[T Crosshairs when moving selection

Fig. 15.6 - View choices.
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15.7 Text Choices Smart Quotes

Menu=>Misce>Choices> Text If Smart quotesis selected, plain quotation marks

) , ) . in imported text are converted to fancy quotes
Text choices are associated with text editing, text(see 3.3)otherwise they remain unchanged.

styles and text framd$§g. 15.7)
Single Shift Font

Single Shift Fontspecifies the font used by the
single shift font facility(see 3.2)

Overtype

Overtype controls what happens when you type
while there is some text select@ge 3.6)

If Overtype is selected, the selected text is deleted

Text Frame Inset and replaced by the typed text.

Text frame insetis the default inset used by text
frames(see 9.2)If you don't want text frames to
have an inset by default, set this value to 0.

If Overtype is not selected, the selected text is
deselected and the typed text is inserted before it.

Unicode

Rename Styles . . . . :
This determines iDvation Pro uses the Windows
Rename stylesontrols what happens when text ) . .
font manager in Unicode mode. Generally it

containing defined styles is transferred to another

o should be selected. Some of the standard
document containing the same style names, but . )
. ) Ovation Pro characters can not be displayed
with different attributes.

without Unicode. However Unicode support is

If Rename styless selected, a clashing style poor in the Windows 95, 98 and ME series, and
name in the transferred text is renamed by addingiou may find turning off Unicode is necessary.
a number to the end of the name. Windows NT, 2000, XP and later have proper

If Rename styles is not selected, a clashing style Unicode support.
name in the transferred text is discarded, and thesave Ignored Words

style in the destination document is used. If Save ignored wordss selected, the dictionary

Rename Colours of ignored words generated by the spelling
Rename colourscontrols what happens when textcheckertignore , is saved with the document
containing defined colours is transferred to whenever it is saved. This means that when the
another document containing the same colour ~ document is re-loaded, previously ignored words
names, but with different colours. are ignored when the document is spellchecked.

If Rename coloursis selected, colours names are If Save ignored wordss not selected, the
renamed, otherwise they are discarded (operatiorflictionary of ignored words is not saved with the

is the same aRename stylesabove). document.
Min length
| Text handling choices Min length sets the minimum length of words
Single shift fDm| Symbol E which will be spell checked.

Check repeated word

If Check repeated wordss selected the spelling
| Rename styles [ Rename colours checker will report repeated words, e.g. the the.

v Smart quotes Font menu show sample

If this is selected a sample of the currently
highlighted font will be shown whilst the font

[ Save ignored words |T = | « | Min length menu is open. Holding dowshift when the font
menu is open temporarily reverses this setting. For
example if you don’t have this option selected you
[v Font menu show sample can press$hift to see a font sample.

Text frame inset | 1mm

[v Overtype [v Unicode

[v Check repeated words

Fig. 15.7 - Text choices.
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15.8 Picture Choices Centre Lock
If Centre lock is selected, th€entre lock option

oMisce> Choi i : It . )
MenuswMisce Choices: Picture in theModify picture dialogue box will be
Picture choices are associated with picture selected by defau{see 10.7)

handling(fig. 15.8) Aspect Lock

Picture Frame Inset If Aspect lockis selected, thAspect lockoption
Picture frame insetis the default inset used by  in theModify picture dialogue box will be
picture framegsee 9.3) selected by defau(see 10.7)

Runaround Error Auto Scale

Runaround error controls how accurately If Auto scaleis selected, thAuto scaleoption in

Ovation Pro traces the picture when usiRicture  the Modify picture dialogue box will be selected
runaround (see 9.7)The value entered is the by default(see 10.7).

average error for each pixel traced. Smaller Valueﬁicture Cache Max size

will give more accurately traced pictures, although ,
the trace will then take longer to complete. Reference if over
Proxy if over

Picture Import with Ctrl ) , ]
These choices are explainedlid.11.

If you import a picture into a picture frame while
pressing Ctrl, the picture is imported at a pre-  Check for Missing Fonts

defined scalésee 10.1)Picture import with This button in the Picture choices window allows
Ctrl specifies that scale. So, for example, if you you to specify that a check will be made for
want to ensure that imported pictures are always missing fonts in graphics.

scaled to 75% of their original size, §atture

; twith Ctrl o 75% If any fonts are missing a warning will be given
import wi rl to 0.

during loading. As with missing fonts in text,
Ovation Pro generates ‘events’ which may be
used to tell a font manager to find and load the
needed fonts. If you have such a font manager
already set up then fonts in pictures will now work
with it too.

There is a potential catch with this feature and

referenced pictures, to check the fonts used, the

graphics have to be loaded, so if you had a

Picture choices document with many large referenced images
T loading it might take a long time.

Picture frame inget| Omm
Fonts which are missing are substituted. So text

2 . .
FDEEE] Efel will appear but not in the correct font.

Picture impart with Ctrl| 1000 9%
™ Centre lock W Aspect lock
[T Auto scale

W Check for missing fonts

Ficture cache max size | 20M LILI
[T Reference if over 200K« 4]
™ Proxy if over 00K Ll;l *El

Fig. 15.8 - Picture choices.
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15.9 Line Choices

Menu>Misce>Choices»>Line

Line choices are associated with line drawing

(fig. 15.9)
Default Line Width

Default line width sets the default width for all
lines drawn irOvation Pro. Choose a predefined
width from the menu, or enter your own value in
the field at the bottom of the me(gee 9.4)

Default Triangle Width

Default triangle width is the default width of the
triangle for lines with arrowheads. Choose a
predefined width from the menu, or enter your
own value in the field at the bottom of the menu.
The width is specified as a multiple of the line

width (see 9.4)
Default Triangle Height

Default triangle height is the default height of
the triangle for lines with arrowheads. Choose a
predefined height from the menu, or enter your
own value in the field at the bottom of the menu.
The height is specified as a multiple of the line

width (see 9.4)

Line choices

Default line width
Diefault triangle width

Default triangle height

Fig. 15.9 - Line choices.

0.25mm

2
4

|t |t |
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15.10 Colour Correction Choices
Menuw>Misce> Choices>Colour

In general the colours one sees on screen are not
the same as the colours output by a printer. When
printing RGB (and equivalent HSV) colours must
be converted to CMYK colours. For use on screen
CMYK colours must be converted to RGB.

The conversion from RGB to CMYK is done
usingcolour correction tables.

Colour correction choices lets you select whether
this colour correction should take place or not and
which table will be used.

Use inks to display CMYK coloursis used to
give a more realistic display of CMYK colours on
screen.

See 13.5 for a full discussion.

I Colour correction choices

& lse correction table Mo correction
Table I Typeset ﬂl
[ Use inks to display CMYK colours

Map I SYWOP on coated stock ﬂl

Fig. 15.10 - Colour correction choices.
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15.11 Document Preferences
Menur>MisceoPreferences. .. Ctrl+Shift+P
ChooseMVliiscw>Preferencesto open a dialogue

box that allowvation Pro document
preferences to be configuréih. 15.11)

Preferences are attached to documents, so you
may have different settings for different
documents. When a document is saved, its
preferences are saved with it.

There are three categories of preferences:
General, View andText. Click on the appropriate
icon in the scrolling pane at the left of the
dialogue box, to display all the associated

Preferences. The Preferences are described on the

following pages of this user guide.

Once you are happy with the preferences, click on
OK to apply them to the current document.

Alternatively, click onSaveto apply the
preferences and save them so that they will be
used by default each time a new document is
opened. You will be prompted for confirmation
before the old preferences are overwritten.

K Documontpreforences _______HIE3|

rs

[

I General preferences

Document units | mm

Start chapter number| 1

Chapter/page separator

[~ Auto save every| 3

[~ Prompt for auto save

bl

mins

[« Auto page insert [v Auto page delete

Document feature level I 4 LI;I

Save Cancel

Dk

Fig. 15.11 - The Preferences dialogue box.

DocumeNT PREFERENCES
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15.12 General Preferences confirm that you want to save the document under
MenusMiscesPreferences. ©>General the same name or you can save it under a new

Ctrl+Shift+p ~ Name.

If Prompt for auto saveis selected, the normal
Savewindow will be displayed before the
document is saved. Click @K to save the

Document Units document, or click outside tf&avewindow to
Document unitsspecifies the default units for the cancel.

document. You may choose millimetres (mm), Auto save does not operate if the document has

inches (in) or points (pt) from the menu e -
(fig. 15.13) The chosen units are used whenever qover been saved, or if it has not been modified

: . . Since it was last saved.
measurement is entered into a dialogue box or

menu. They are also used for the page rulers andAutosave also only takes place if at least 10
tab ruler. seconds have elapsed since the last keystroke,

otherwise it is postponed by 10 seconds. This
prevents a burst of typing ending up in Seve
window.

General preferences are associated with the
general setup of the documdfigy. 15.12)

Start Chapter Number

Start chapter number is the chapter number for
the first chapter in the document. If you split a
document into a number of separate files, you m@uto Page Insert/Delete

need to use this option to ensure that each sectiohhese control the automatic insertion of pages
starts with the correct chapter number. when the text in an auto linked text frame chain

overflows the last frame and deletion when there

Chapter/Page Separator isn’t enough text to fill it.

Chapter/page separatoris the character used to

separate the chapter number and page number.
This is used for example in automatic paragraph
numbering(see 5.8)

This feature will be useful if you want a document
which is a fixed number of pages long and don’t
want it to keep changing in size as you work on it.

Another consequence is that with auto page
insertion and deletion turned off, the insert and
delete page entries on the page menu will do
exactly what you tell therfsee 11.8)So if you

If Prompt for auto savedis not selected, the insert a page the document is guaranteed to end up
document will be saved without any user one page longer - because there will be no auto

intervention required, except the first time that th%age deletion of any excess page after the
document is saved after loading. You must then jnsertion.

Auto Save

If Auto saveis selected, the document will be
automatically saved at the interval specified.

| s — Document feature level
eneral preferences .
P The higher the feature level the greater

Document units | mm E functionality the document supports. For example
feature level 5 or higher allows Unicode
Start chapter number | 1 characters to be used in documents. However
Chapter/page separator| - older versions oDvation Pro may not load
documents with feature levels higher than 4. You
| Auto save every| 3 mins can reduce the feature level if you want to produce
[~ Prompt for auto save a document that will work on an old version of
Ovation Pro.
|+ Auto page insert v Auto page delete
v mm
Document feature level 4 jj i
ot

Fig. 15.12 - General preferences. Fig. 15.13 - The Units menu.
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15.13 View Preferences Snap to Objects
Menu=Misc=>Preferences. .oView If this option is selected, the edges of objects that
Ctrl+Shift+P are moved or resized will snap to the edges of

. ) _ other objectgsee 8.4)
View preferences are associated with the way the

document looks on the scregiy. 15.14) This option is automatically disabled if grid lock
_ is selected.

Pasteboard Width Guideli Front/Back

This is the width of pasteboard added to each side uidelines to Front/Bac

of each page. The width of the pasteboard above 1 Nis option determines whether ruler guidelines
and below each page is fixed at 10mm. are drawn in front of all objects or behind all

: . . Objects(see 8.4)
This option does not enable the pasteboard, which

is done using an option on thigeewr>Options
dialogue boxsee 7.3)

Menu>View=>Options=>  Ctrl+Shift+O
Ruler Origin X/Y
The ruler origin is normally at X =0, Y =0 i.e.in
the top left corner of the page. You may change
the ruler origin by modifying these values. All

object coordinates i@vation Pro are measured
from the ruler origin.

Snap to Ruler Guidelines

If this option is selected, the edges of objects that
are moved or resized will snap to ruler guidelines
(see 8.4)

This option is automatically disabled if grid lock
is selected.

“iew prefarences
Pasteboard width | 100mm

Ruler arigin %| Omm

Ruler arigin | Umrm
¥ Snap to ruler guidelines
W Snap to ohjects

& Guidelines to front " to back

Fig. 15.14 - View preferences.
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15.14 Text Preferences

Menur>MiscroPreferences..oText
Ctrl+Shift+P

Text preferences are associated with text styles

and formattingfig. 15.15).

Baseline Grid Spacing

This specifies the spacing of the baseline grid

(see 5.4)

Baseline Grid Origin

This specifies the origin of the baseline grid,

measured from the top of the pggee 5.4)

Superscript Size

This specifies the superscript size, as a percentage

of the normal character sitgee 4.4)

Subscript Size

This specifies the subscript size, as a percentage

of the normal character sitsee 4.4)

Small Caps Size

This specifies the size of small caps, as a

percentage of the normal character ¢see 4.6)

Decimal Tab Character

This option specifies up to three characters that

are aligned to decimal taljsee 5.5)

Hyphenation Character

This allows you to enter up to three characters that
will be used for hyphenation. If the icon is left
blank the default ‘-’ character will be used. Words
are broken at this character if they won't fit on a
line.

Text handling preferences
EBaseline grid spacing|  15pt
Baseline grid arigin T
Decimal tab character

Hyphenation character

Superscript size| 55 %

Subscript size| B2 %

Small caps size |BBES %

Fig. 15.15 - Text preferences.
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Defined Colours

16.1 OVEIVIEW. . ottt e e e 234
16.2 Editing Colours . . ... e 235
16.3 ColourModels. . ... e 237
16.4 ColourCharts . ... e 240

This chapter describes how to define your own colours, and add them to
the standard Ovation Pro colour picker.
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16.1 Overview

Whenever a colour is chosenQwation Pro, it is
chosen from the standard colour pickiey. 16.1)

Menuc>TexteoColour...

The colour picker allows a colour to be chosen
from the default set of colours, and an optional
tint applied(see 4.5)

There are two main advantages of using named
colours:

* They can be applied quickly and consistently
throughout the document by choosing their
names. Without a name, a colour would have
to be applied by setting its RGB value, which
is slow and prone to error.

» If you're not happy with a colour used
throughout the document, you can just edit the
definition in one place and all occurrences of
the colour are updated throughout the
document.

This chapter describes how to add, remove or edit
colours on the colour picker.

¥ Colour picker |
10
B | 20
[ ]white 30
Transparent 40
50
k0
Z0
[]Cyan s 50
Current colour 50
\ . Magenta
M1 w_n_... LI v 100
-\ Tint] 100 % v |a| *H,
Previous colour—" | , \ _
[~ Overprint Tint menu
Cancel | Ik

Fig. 16.1 - The standard Ovation Pro colour picker.
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16.2 Editing Colours
Menur>Misce>Edit colours...

ChooseMisc=Edit colour to display the

Edit colour dialogue boxfig. 16.2) This box

displays the colours available in the scrollable
window.

Editing operations apply to the selected colour,
which is highlighted in the window. To select a
colour, left click over it.

¥Editcoowr @]

N Chart...
[ Jwhite Edit...
Transparent —
. Red Owerprint...
|:| Green N
. Elue B
[ cyan — Bename
. Magenta —
M1 w_n-... LI DE|EtE
[T Spot colour T Mon-printing

Apply | Cancel | ]

Fig. 16.2 - The Edit colour dialogue box.

# New colour |

Colour name

Baszed on Black ﬂl

Cancel 8]

Fig. 16.3 - The New colour dialogue box.
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New

To create a new colour, chodsew and type the
name of the colour into tHeéew colour dialogue

box (fig. 16.3) The name must not be the same as
any existing colour name.

If there is a colour selected when you choose
New, the new colour will be based on the selected
colour. However, you may base the new colour on
any existing colour, by choosing the colour name
from the menyfig. 16.4)

Click onOK to create the new colour and close
the dialogue box. The colour you have created is
added to the list of colours in the window, and
automatically selected ready for editing.

Black

Shfhite
Transparent
Red

Gireen

Blue

Chran
hagenta
el ow

Fegistration

Fig. 16.4 - Base new colour
on a colour from the menu.
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Rename

To rename the selected colour, clickR@name
to open thdRenamecolour dialogue box
(fig. 16.5).Type in a new name and click @K.

CHaAPTER 16

Chart

To create a new colour based on a colour from
one of the standar@vation Pro colour charts,
click onChart (see 16.4)

Please note that you cannot rename the colours Edit
Black, White, Transparent or Registration or thosg g edit the selected colour, click &ulit.

that were created from a colour chart.

Delete

Click onDeleteto delete the selected colour.
Please note that you cannot delete the colours
Black, White, Transparent or Registration.
Spot

When selected this indicates that the selected
colour should be printed on a separate [lste
13.3).

Non-printing

When selected this flags the selected colour as
‘non-printing’. And, as you might expect,

anything in this colour will appear on screen, but

not on printed material.

T Rename colour |

Old name

Green

Meswy name |

24

Cancel |

Fig. 16.5 - The Rename colour dialogue box.

If the colour was created usiiNgw, the colour
model dialogue box will be displayésee 16.3)

If the colour was created usi@hart, the colour
chart dialogue box will be displayésee 16.4)
Overprint

Used to control how colours will be printed on
colour plates they do not appear(see 13.6)



Section 16.3 CoLour MopeLs 237

16.3 Colour Models « Type in theRed, Green andBlue values
directly. After typing a value you must enter it

dialogue box is displayedig. 16.6) This allows by press Return, Tab or the up/down cursor

you to specify a colour from one of three colour keys. Presslng Return in the Blue field, is the

models: RGB, CMYK or HSV. same as clicking on OK.

* Click on the up/down arrows. This allows fine
tuning of a colour, changing the values by 1%.
Clicking with the Shift key held down,

When you click orkdit, theColour choice

Please note that if the selected colour was
originally chosen from the colour chart, the
Colour chart dialogue box is displayed instead

(see 16.4) changes the values by 0.1%.
RGB Colour Model « SelectTransparent to create a transparent
colour.

This colour model specifies colours by mixing

Red, Green and Blue liglfig. 16.6) This is the In the RGB model, th€olour sliceis a plane
default model used for new colours. through the RGB colour cube. The slice is taken

g\/ith a single value of brightness. The brightness

There are 5 ways of choosing a colour in the RG . .
value can be set with a separate slider.

model.
Click onOK to apply the colour and close the

» Drag the Red, Green or Blue sliders. Asyou .
dialogue box.

move a slider the resulting colour is shown in
the box at the bottom left of the window. At
the same time, the numeric values change to
show you the percentages of the colours
chosen.

» Click anywhere in the colour slice, or drag
continuously around it.

; Click to ch .
Type values in Val|(l.:JeSO change Click here to choose

directly RGB model

Drag on sliders to
change values

Brightness slider
Brightness (+) | 100 «| «] _"/

Result of colour m|X\. I Transparent

Fig. 16.6 - The RGB colour model.

Cancel | Ok
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CMYK Colour Model

This colour model is often used when you want to
create colour separations for four-colour process
printing. Click onCMYK to choose this model

(fig. 16.7)

There are 5 ways of choosing a colour in the
CMYK model.

» Drag theCyan, Magenta, Yellow andBlack
sliders. As you move a slider the resulting
colour is shown in the box at the bottom left of
the window. At the same time, the numeric
values change to show you the percentages of
the colours chosen.

» Type in theCyan, Magenta, Yellow and
Black values directly. After typing a value you
must enter it by pressing Return, Tab or the
up/down cursor keys. Pressing Return in the
Blue field, is the same as clicking @K .

* Click on the up/down arrows. This allows fine
tuning of a colour, changing the values by 1%.
Clicking with the Shift key held down,
changes the values by 0.1%.

e SelectTransparent to create a transparent
colour.

Click onOK to apply the colour and close the
dialogue box.

Colour editor .
Click here to ——| Click to change
T & CMYK C Y O RGk values

choose CMYK
a6
100+~ N | T.c values in
00 :_J ”i_“-————————— directly

246 ]l ~_| Drag on sliders to

E—— change values
el ness 00 ] - ﬁ
Result of colour tirighiness: (v) [=1I=
mix \|i I Trensparend

Fig. 16.7 - The CMYK colour model.
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HSV Colour Model .

This colour model is often used by artists

(fig. 16.8).You start with the basic colour, and
then add elements of white and black to get the
exact colour. Hue is the basic colour. Saturation is
the amount of white added to the colour. Value is
the amount of black added to the colour i.e. the
brightness.

CoLour MopeLs 239

Click on the up/down arrows. This allows fine
tuning of a colour, changing the values by 1%.
Clicking with the Shift key held down,
changes the values by 0.1%.

Select onlransparent to create a transparent
colour.

In the HSV model, th€olour sliceis a surface
through a colour cone. The slice is taken with

There are 6 ways of choosing a colour in the HS\tonstant brightness (or V).

model.

_ _ The colour slice shows all the colours available by
* Drag the Hue, Saturation or Value sliders. As varying theSaturation andHue components, but
you move a slider the resulting colour is keeping thé/alue component constant.

shown in the box at the bottom left of the
window. At the same time, the numeric values
change to show you the percentages of the
colours chosen.

» Click anywhere in the colour slice, or drag
continuously around it.

* Type in theHue, Saturation or Value values
directly. After typing a value you must enter it
by pressing Return, Tab or the up/down cursor
keys. Pressing Return in thalue field, is the
same as clicking 00K .

Click here to

. choose HSV
Type values in

directly

Colour editor

Colour slice

Click onOK to apply the colour and close the
dialogue box.

Click to change
values

.......

........

Drag on sliders to
change values

[0 <]l
Brightness (v) | 100 =] ] |—/

Result of
colour mix \. B

Cancel | ]34

Fig. 16.8 - The HSV colour model.
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16.4 Colour Charts

TheOvation Pro Colour chart dialogue box

(fig. 16.9)is displayed by clicking o€hart or if
you select an existing chart colour by clicking on
Edit.

This facility allows you to choose colours from
pre-defined colour charts, a number of which are
supplied by default. The icon labell€thart

shows the current chart name, but you may choo&®

another chart from the meiiig. 16.10) The
colours in the chart are displayed in the main
window. Use the horizontal scroll bar to view all
the colours in the chart.

There are three ways of choosing a colour from
the chart.

Click on the colour or its name, then click on
OK to close the dialogue box and add the
colour to the list of available colours.

If you want to choose a number of colours,
double-click on each name then finally click

CHaAPTER 16

Type in the name of the colour in the writable
icon provided. As you type each character,
Ovation Pro will attempt to find and highlight

a matching colour name in the chart. Now
double-click on the colour to choose it, or

click onOK to choose the colour and close the
dialogue box.

After choosing a colour and closing the

lour chart dialogue box, the chosen colour is
added to the list of available colours. The chart
name and colour name are combined to create a
full name. For example, if you chooktustard

from theRainbow chart, the full colour name is
Rainbow Mustard

You can easily create your own colour charts
(see Appendix G)

The various charts are used in different printing
processes. When creating a Web page layout you
are advised to use the colours in the NetSafe chart.

onOK. This closes the dialogue box and adds

the selected colours to the list of available
colours.

¥ Colour chart

Fale Fink Terracotta Tar
Fink Beige Brov
Fed Fale Orange Amb ¥ Generic
H=%tane
Burgundy Feach Kha FrocessChiy’
Frocessk
Yermilion Orange Pale ¥ Rl
RGB-04grey
RGB-16grey
RN i RGE-256grey
Chart I Rainbow "H | Cl:ull:uurl Burgundy RO16-RGE
FOZEERGE
Cancel | Ok Weh Safe
Fig. 16.10 - The Colour

Fig. 16.9 - The Colour chart dialogue box, with 'Burgundy selected.

charts menu.
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Macros

17.1 The Macros Dialogue BOX. . . .......... i
17.2 Creating Button Macros ............ ..y
17.3 Creating Key Macros . ...ttt
17.4  Creating User MacCros. . . . ..o vt e
175 Defining Macros . . ...
17.6  OtherMacro Operations . . ...........i i,
17.7  Summary of Pre-defined Buttons . .. ......................

This chapter describes the macros facility which allows three types of
macros to be defined:

Button macros represent buttons that appear on the button bar. You can
add buttons to the button bar that type in strings, execute keypresses
for common options or call functions directly in Ovation Pro.

Key macros represent keys on the keyboard allowing them to be
redefined. Virtually all the keys may be redefined including special key
combinations using Ctrl, Shift etc.

User macros allow common constants to be given simple textual
names. They are useful for defining constants that you may wish to use
several times in other macro definitions.
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17.1The Macros Dialogue Box

Menu=>Misc>Macros...

ChooséVlisce>Macros to display theMacros
dialogue boxfig. 17.1) Each row in the table
represents a single macro, and comprises:

e The macro name.

* An optional icon used to represent the macro
on the button bar (button macros only).

e The actual macro definition.

* An option which determines whether the
button will appear on the button bar (button

macros only).

The optiondButton, Key andUser control the

type of macros being displayed.

By default

Button is selected, causing the dialogue box to

display all the button macros.

®Macros _ HE|

I frame 4'| {picktool(3 0)} r -

| tne 7 Ipicktoal(4 i} r

I pathedit WI {picktool(11,0)} r

I rotate <, I {picktoal(2 00} I

: : Bl
™ Record & Buttan T Key  User

Edit... | Pewy. .. | Copy... | Delete |

Dave As. Save Cancel 04

Fig. 17.1 - The Macros dialogue box showing the buttons that have been defined.

CHapPTER 17
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17.2 Creating Button Macros When you have completed the dialogue box, click
ChooseButton on theMacros dialogue box to onOK to create the button.
display the button macros, then click Maw to The new button name will appear in the first

display theNew button dialogue boxfig. 17.2) column at the bottom of the macro list, but at this
stage doesn’t yet appear on the button bar. If you
Jpave assigned a sprite to the button, this will be
displayed in the second column.

Type in a name for the button you require
(maximum 12 characters). The button name mu
not be the same as any other macro already
defined or the name of any keyboard key. So youThe icon in the third column contains the actual
cannot define buttons called A, h, F3, Print etc. definition, which at this stage is blank. If you type
some text into this icon, choosing the button on

The width of the button displayed on the button : _
the button bar will type the text into the document.

bar is determined by the width of the text you ) ; _

type, so choose short names if you want to fit lots™ Ul détails of how to define macro bodies are

of buttons on the button bar. The button name ~ 91Ven later in this chapter.

doesn’t have any significance if you choose to us&he final column is an option which determines if
a sprite to represent the button. the button appears on the button léaration Pro

If you wish to assign an icon to your button, click IS SUPPlied with a wide range of predefined
on the icon to the right of tH8prite option to buttons, but only a small selection are actually

display the button boffig. 17.3) enabledsee 17.7)

The button box is a palette of sprites that may be
used for button legends. Use the vertical scroll bar
to scroll through the entire list, and choose the
sprite you require by clicking on it. The button

box will then be closed and the sprite name
displayed in théNew dialogue box. If you should
then decide not to use the sprite, you can deselect
the Sprite option.

HNewbuton _ HK|

Button narme Mg,rName|
Sprite r ﬂl

Cancel | Ok

Fig. 17.2 - The New button box.

¥ Button box K E
& ? -
infa Fey choices
=l =|

filainfa Saveas save
i Eh
export stylesheet revert -

Fig. 17.3 - The button box.
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17.3 Creating Key Macros The new key macro name is displayed in the first

ChooseKey on theMacros dialogue box to column at the bottom of the key macro list
display the key macros, then click iew to (fig. 17.5) The icon in the second column is for

display theNew keydialogue box(fig. 17.4) the actual definition, vyhich z;_lt t_his st_agg is blank.
If you type some text into this icon, it will be

Now press the key or key combination that you typed into the document when the keypress is

wish to define. You may define any key onthe i, oked. Full details of how to define the macro

main keyboard or keypad except for Escape,  pgies are given later in this chapter.
Break and Return. In addition you may also define

key combinations using one or more of the Cirl,
Shift, Alt and Windows keys.

The key name you have chosen is displayed in the
New keydialogue box.

When you have correctly chosen the key you wish
to define, click orOK to close the dialogue box.

T New key |

Keg,fl

Cancel | Ik

Fig. 17.4 - The New key dialogue box.

®Macros _HE|
| Ctrl+B | {clipboard) -
| Crl+L | {objectforward(1)}

| Ctrl+H | {objectbackward(1]}

I Ctrl+nsert I [filename}

: : hd
I Record " Button o~ Key C User

Edit... | Flewy. . Copy... | Delete |

Saueﬂ«s...l Save | Cancel | DI

Fig. 17.5 - The Macros dialogue box showing the keys that have been defined.
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17.4 Creating User Macros

ChooseJser on theMacros dialogue box to
display the user macros, then click on New to
display theNew macrodialogue boxfig. 17.6)

Type in a name for the macro you require

(maximum 12 characters). The name must not be
the same as any other macro already defined or
the name of any keyboard character. So you
cannot define buttons called A, h, F3, Print etc.

If you intend to use this macro in other
definitions, it will be an advantage to keep the
name as short as possible.

When you have correctly typed the user macro
name, click orOK to close thé&New macro

dialogue box.

T New macro |
Macro narme I MAME]
Cancel | 024

Fig. 17.6 - The New macro dialogue box.

The new user macro name will be displayed in the
first column at the bottom of the macro list

(fig. 17.7).The icon in the second column is for
the actual definition, which at this stage is blank.
Full details of how to define macro bodies are
given overleaf.

®Macros ____HM|
I nextclip I [setcurrentclipboard{getcurrentclipboard(+17} =
I previlip I {setcurrentclipboard{getcurrentclipboardi)-11}

I bigcopy I fnextcliplcopyselection()}

I bigpaste I {pasteselection()} prevelip}

=

[~ Record " Button " Key FUser

Edit... | Mew, .. Copy... | Delete |

Saveﬂxs...l Save | Cancel | ]

Fig. 17.7 - The Macros dialogue box showing the user macros that have been defined.

CRreating User Macros
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17.5 Defining Macros Glyph names

To define a macro, left click in the definition icon If the definition string corresponds to the name of
to the right of the macro name, and type ina @ glyph(see Appendix Hgnclosed in bracey
string. The string may contain all the usual ASCIIthe relevant character is introduced. This will

characters, but must not begin witor <. often be a more natural way of producing special

In addition to the normal printable characters, youcharacters than using the | code notation.

can introduce any ASCII characters in the range d/acro expansions
to 31 or 127 to 255 using special escape sequendéthe definition string is a macro name enclosed

(see Appendix B) in braceq} it will be evaluated.

If you wish to start the string with or <, you {dtp} expands the user maaitp

must use the alternative sequengesor|< . {mc1{mc2} expandsnclandmc2

John types John Function expansions

Regards|M  types Regards followed by CR  |f the definition string enclosed in brad@s

'O types « (ASCII code 143) doesn’t match a macro name or keypress, it is
|<6> types the string:6> passed to the script language and executed as a
Key expansions function.

If the definition string corresponds to the name of{setalign(1)} calls setalign()

a key enclosed in brac@s, that key will be
invoked(see Appendix CAll the keys on the
keyboard may be used except Return, Escape a
Break. Keys may also be prefixed by the
following sequences:

System expansions

Iathe definition string is enclosed in angle
nbracket3<> then it is evaluated in a special way.
Firstly if the string represents a number (decimal
or hex) it introduces a character with the relevant

S_ Shift plus key code value. If it is further enclosed in % % it is
C_ Ctrl plus key evaluated as an environment variable otherwise it
A_ Alt plus key is read from the registry.

W_ Window plus key Examples

CS_ Ctrl Shift plus key '

AS Alt Shift plus key <65>

AC_ Alt Ctrl plus key Character code 65 i.e. ‘A’.

ACS_ Alt Ctrl Shift plus key <%USERNAME%>

WCS_ Window Ctrl Shift plus key Environment variable. These can also be read
WAS_ Window Alt Shift plus key using the getenvs() script language function.
WAC _ Window Alt Ctrl plus key

<HKLM\Software\DavidPilling\Dictio

naries>

Registry variable, HKLM is used as an

If a key in a definition has already been redefinedabbreviation for HKEY_LOCAL_MACHINE.

using a key macro, the new definition will be usedSimilar abbreviations are understood for the other
unless the key name is preceded by a single quot@ot keys in the registry.

character. In that case, the original operation of

the key is invoked i.e. the one predefined in

WACS Window Alt Ctrl Shift plus key

Ovation Pro.

{F1} invoke the keypress F1

{C_V} invoke keypress Ctrl V

{S_F3} invoke the keypress Shift F3
{CRight} invoke the keypress Cursor Right
{F3} invoke the keypress F3

{'F3} invoke the original keypress F3
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17.6 Other Macro Operations Copying a Macro
Recording Macro Definitions This option copies the macro definition that

The previous pages describe how to type in macrgPNtains the caret. Theopy dialogue box allows
definitions, but it is possible to record definitions YOU 10 type in a different name for the new copy.

directly from the document. It is useful if you Operation of this dialogue box is identical to that
wish to program a button, key or macro with a for the New option described previously.
complicated key sequence. Deleting a Macro

First, choose the macro you wish to define by leftThis option deletes the macro definition that
clicking in its definition icon. Select tHeecord contains the caret. The macro is not completely

option, and click in the document window withoutdeleted untiOK is clicked, so if you wish to
closing theMacros window. Now anything typed restore the deleted macro, click Ganceland
into the document will be recorded in the macro then reopen thklacros dialogue box.
definition, including any special keypresses. Saving the Macros

Switch off recording when you have finished by

; ) Click on Save to save all the macro definitions so
deselecting th&®ecord option.

that they will be loaded automatically each time

Expanding Macros Ovation Prois run.
Double-click on the macro name to expand it.  Click on Save As to display a standard save box,
Editing a Button Macro allowing you to save macros in a named file. To

Click onEdit to display theEdit button dialogue reload thg macros,.double-click. the file or drag it
box (fig. 17.8) You may use this dialogue box to to anOvation Pro window. Loading a macros file

change the sprite assigned to the button. in this way overwrites any macros currently

] o ] loaded.
Please note that thedit option is only available

for button macros.

# Edit button HE|
Button narme frarme

Sprite frarme 3 ﬂl

Cancel | Ok

Fig. 17.8 - The Edit button dialogue box.
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17.7 Summary of Pre-defined buttons File Menu

The following pages list all the predefined buttons . .
available inOvation Pro. By default only a @ File info dialogue boxsee 3.1)
selection of these are enablsde 2.8)but you Save(see 3.9)

may enable the buttons that you require or add _

your own buttons. Many of the buttons may be % Save(without prompt).

used as templates for your own buttons. So for Save story/picture(see 3.9 & 10.2)
example, the butto@ourier sets the font to

Courier but you may copy the button and edit its ﬂ Save stylesheefsee 15.1)

definition to set another font. To do this you will N 3.4
need some knowledge of twation Pro script ﬂ evert to savedsee 3.4)

language and functions, which are described in Print dialogue boxsee 3.1Q)
detail in the separate Script manual. =

More button sprites can be added via a Mail merge dialogue boxsee 12.5)

Buttons.spr file in the Custom applet. Some
buttons present on the Button bar may originate Edit Menu
from an applet and these have their own Buttons
files.

# Select all(see 3.5)

Remember to click oBaveto save any changes
you make.

i | Clear selection(see 3.5)

Cut selection(see 3.6)

#]| Copy selection(see 3.6)
E Pasteselection(see 3.6)

Tools "% Deleteselection(see 3.6)

k| selecttool. 71| ShowrhideClipboard (see 3.6).

E Frame tool. @ Embed object from clipboardsee 8.10)
E Rotate tool 5| Undo (see 3.4)

a Magnify tool. g Redo(see 3.4)

Find dialogue boxsee 3.8).

Help menu [ New documentsee 11.2)

Ovation Pro Info dialogue boxsee 2.2)
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T
++|

+

+4+
+4+
+4+

[=

5%

New view (see 7.2)

Options dialogue boxsee 7.3)
Show/hideToolbox (see 7.3)
Show/hidelnfo palette (see 7.3)
Show/hideRulers (see 7.3)
Show/hidePasteboard(see 7.3)
Show/hidePictures (see 7.3)
Show/hideGuidelines(see 7.3)
Show/hidePrint margins (see 7.3)
Enable/disabl&acing pageqsee 7.3)
Show/hidelnvisibles (see 7.3)
Grid dialogue boxsee 7.4).
Enable/disable gri¢see 7.4)
Zoom dialogue boxsee 7.5)

75% zoom(see 7.5)

1259 | 125% zoom(see 7.5)

@ |

Zoom toFit window (see 7.5)

Zoom toFit screen(see 7.5)
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Text/Picture Menu

i3

i

urier

g @ o
= 2
—

i | o | @ | |5 | |- B e |~ |= |z |@

&
5]

LG

14ptL

Modify text dialogue boxsee 4.6)
Font menu(see 4.2)

Set font to Courier.
Sizemenu(see 4.3)

Set type size to 13pt

Effect menu(see 4.4)

Set text taNormal (see 4.4)

Set text tdBold (see 4.4)

Set text tdtalic (see 4.4)
Underline text(see 4.4)
Reverseout text(see 4.4)

Set text tdSuperscript (see 4.4)
Set text tdSubscript (see 4.4)
Text Colour dialogue boxsee 4.5)
Text Format dialogue boxsee 5.4)
Alignment menu(see 5.2)

Left align text(see 5.2)

Centre align text(see 5.2)

Right align text(see 5.2)

Fully Justify text(see 5.2)

Single spacdine spacingsee 5.3)
Double spacdine spacingsee 5.3)
Set 14pt absolute leadirfgee 5.3)
Display Tabs ruler(see 5.5)
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Style Menu

[S] Style menu(see 6.6)

E Edit style dialogue boxsee 6.2)

Style#1

IXL

Apply Style#1l to text(see 6.6)

Remove Local effectsee 4.1)

Object Menu

Modify object dialogue bofsee 9.1)
Border dialogue boxsee 9.6)

Text flow dialogue boxsee 9.7)
Duplicate dialogue boxsee 9.8)
Shapedialogue boxsee 9.9)

Bring toFront (see 9.1Q)

Put toBack (see 9.10)
Group/Ungroup objects(see 9.11)
Make local/master(see 9.12)

Snap to grid (see 9.13)

Edit master pageg(see 11.3)
InsertNew chapter(see 11.4)
Edit Page guidelinegsee 11.3)
Modify chapter (see 11.6)
Delete chapter(see 11.5)
Insert page(see 11.7)

Delete pagdsee 11.7)

Goto page(see 11.1)
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Misc Menu

'K,\i

R4

7 | o MR |2 |<F |

~
7]
b

3 |

5o 210 5 @

—
# |3 8
i¥ (2

~
]
v

S =E:]

Check word (see 14.4)

Check story(see 14.3)

Check document(see 14.5)
Check from caret(see 14.3)
Check as you typgsee 14.6)
Dictionary dialogue boxsee 14.7)
Characters box (see 3.2)

Insert menu(see 3.2)
InsertChapter number (see 3.2)
InsertPage number(see 3.2)
InsertDate (see 3.2)

InsertActive date (see 3.2)
InsertTime (see 3.2)

StartNew page(see 3.2)
StartNew line (see 3.2)
InsertHard space(see 3.2)
InsertHard hyphen (see 3.2)
InsertSoft hyphen(see 3.2)
InsertMerge tag (see 3.2)
Preferencesdialogue boxsee 15.11)
Edit colour dialogue boxsee 16.2)
Macros dialogue boxsee 17.1)

Choicesdialogue boxsee 14.3)
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Applets

18.1  Adding Features with Applets 252
18.2 Installing Applets. . . ... . 252
18.3 Inside Applets .. . ... 253

Many new features can be added to Ovation Pro by installing Applets.
Applets may allow new graphics filetypes to be used, provide new print
formats, and extend text handling capabilities.
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18.1 Adding Features with Applets 18.2 Installing Applets

Applets are software extensions that can be usedApplets will usually be supplied in the form of a
to add new features tovation Pro. An example  file with a .0oap extension.

appletis the Colour Supplement, which provides apqets can be installed by double click running

the professional colour printing features describegyam from Windows Explorer, or by dragging and
in Chapter 13. dropping into theévation Pro Applet Manager
Many applets are supplied with the program and window, or by using the install option in the

can be installed if required. Each applet comes Applet Manager window.

with its own documentation. Most are accessed through a menu called Applets

In addition to the applets supplied, new applets ai the right of the main menu. However, they may
being developed by David Pilling and third partiesalso add options to other menus, define new
and can be found on the web. keypresses, provide new tools on the toolbox or

Some of the features provided by applets are; ~ 2dd buttons to the button bar.

« Rendering EPS files An Applet can be installed or not. In addition an
installed Applet can be active or inactive. Inactive
Applets will appear in the Applet Manager

» Graduated, patterned and hatched fills window but will not be loaded whedvation Pro

is started.

» Automatic entry of smart quotes and ligatures

* Page and Style palettes
By selecting the Applet name in the Applet

) Manager you can set it to be active or inactive by
* Mines game clicking on the appropriate button. Clicking on

« New Print imposition formats Delete will uninstall the Applet, i.e. remove it
from disc, use this option with care.

» Simple pocket calculator

Applets are handled using the Applet Manager
window (fig.18.1) The important point is that changes made in the
Applet Manager only take effect the next time

Ovation Prois run. So to change an Applet from

Applets increase the amount of memory used by jnactive to active you must make the change in the
Ovation Pro and slow down the loading time, so itapplet Manager, then qu@vation Pro and

is recommended that you only install the Applets finaly start it again.
that you need.

Menu=>AppletscoApplet Manager

Selecting an Applet and clicking on Help topics
will display the documentation for it.

FApplets ______ HH|

1.03

Ahbreviations

inactive Autornatic abbreviation expansion as-you-type.

Access 1.01 inactive Allows documents tao be made read-anly, or passward protected.
Arrange 1.01 active Spaces or aligns selected objects.
Bookmark 1.02 inactive Provides options to create, delete and goto bookmarks,
Calculator 1.03 active Calculatar for adding and subtracting numbers at the caret.
Clipboards 1.13 active  Multiple-clipboard manager
Colpal 1.04 inactive Palette which allows colours to be applied and edited. ~
Active | Inactive | Delete | Help topics | Install... |

Changes only take place the next time the program is run. Cancel | 0]%

Fig. 18.1 - The Applet Manager dialogue box.
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18.3 Inside Applets For full technical information about Applets see

This section contains some very brief technical e APplet SDK and the Script Language Manual.

information about Applets. Reading it is not
necessary but if you enjoy rummaging around
inside programs it may provide some useful
pointers.

Applets are installed in a directory Applets inside
the directory wher@®vation Pro is installed. An
Applet may consist of a single dynamic link

library file (dll) however it can also consist of a
collection of files inside a further folder. In this
latter case you can load the files into editors and
change them. As usual any changes will only take
effect the next tim®vation Pro is run.

These are some of the files you may find in an
Applet.

Help.txt or Help.dpd Documentation.

Info.txt provides information on the version
number of the applet. This is a typical example:

majorversion:1
minorversion:2
info:Pop-up calculator
author:David Pilling
majorcompatible:2
minorcompatible:46

This tells you that the applet version is 1.02 and
that it is compatible with versions Glvation Pro
greater than or equal to 2.46.

DirectoriesLibrary  andAutoRun can contain
script files just like the directories of the same
names inside the mai@®vation Pro directory.

An AResources directory can hold resource

files which will be automatically merged in with

the main programs resources. These include, Help,
Messages, Sprites and Buttons files. Finally some
applets have a dll file as well. Any given applet

can have one or all of the above files.

Some simple Applets will just supply resources
and so have no code files. Most applets are based
on the script language and have Library and/or
AutoRun directories. The code in an Applet dll

file is linked to the main program at run time.
Applets use dll files to contain resources like
window definitions, but they can also contain
executable code written in a compiled language
like C or C++.
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Notes:
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Ovation Pro Script Language
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Ovation Pro contains an integrated script language that may be used to
control many aspects of its operation, such as the menu organisation,
macros and configuration. The script language is an advanced feature
of Ovation Pro, and you do not need to understand it to make full use
of the software.

Since the initial release of Ovation Pro the documentation of the script
language has almost doubled in size. It has therefore been decided to
not include all this material in the main manual anymore. Only a short
introduction is given on the following page.

For full documentation on the script language see the separate manual.
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19.1 Overview

The integrated script languageQwation Pro is
based on a simple subset of the C programming
language.

If you are familiar with C programming, then
using the script language should pose few

OvaTtioN Pro ScripT LANGUAGE

problems. If you are not familiar with C, then itis .
recommended that you obtain one of the many
beginners books on the C that are available.

The important point to note about the script

language, is that you do not need to use it or
understand it to make full use ©f/ation Pro.

CHapPTER 19

The Script manual describes the following
resident functions that may be accessed from the
script language.

System Functions

These functions are mainly concerned with
accessing Windows.

Windows functions
String functions
File input/output functions

Ovation Pro Functions
These functions carry out operations in

However, you may wish to use the script languag®vation Pro.

for the following reasons:

The entireOvation Pro menu structure is
controlled by the script language. By editing
the menu scripts you may re-organise the
menus, add menu entries or change the .
function of menu options. You may also add
menus to the button bar.

The macros system which allows you to define.
button bar buttons and re-define keys, is basel
around the script language. An understanding«
of the script language will allow you to .
generate your own advanced button and key

macros. ¢

Ovation Pro choices and preferences are savetl
in script files. Creating script files of this type «
allow you to configure the software for
different applications.

Macro functions

Menu control functions
File menu functions
Edit menu functions
View menu functions
Text/Picture menu functions
Style menu functions
Object menu functions
Page menu functions
Misc menu functions
Miscellaneous functions
Macros

Examples of the use of the script language can be
found in the folder wher@vation Pro is installed,

Script programs can write text to the caret or typically this is C:\Program Files \DavidPilling

read text from the caret, so it is possible to
write scripts that generate or modify
documents.

\OvationPro\. Script files have the extension .csc.
Or open theMacros... window

Menuc>Misce>Macros...



Font Management

Font names are used to identify the typefaces in documents. Problems
occur when a document is loaded and the fonts used to create it are not
available. This might happen because the fonts have been removed
from Windows or perhaps because the document has been sent to
another computer which does not have the fonts installed.

There are also many situations in which the fonts available are identical
to those used in a document but have different names. For example
PostScript printers contain a font called Helvetica, all the characters in
the Windows font Arial have identical widths and heights (metrics). On
RISC OS (another operating system) the font Homerton has identical
metrics to Helvetica. Anyone loading a document from RISC OS on a
Windows computer would probably want any references to Homerton
replacing with Arial.

The Ovation Pro font manager allows you to control how font names
are handled. It will let you arrange for missing fonts to be substituted
when documents are loaded. You can use different names for fonts and
make Ovation Pro ignore chosen fonts.
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Font names As for the other Font Manager options the

Usua”y when someone refers to a font they mearY\lindOW works like a card file database. Click on
a font family, in other words a collection of fonts New to create a new record, then pick the font to
with the same design but different widths, weightdgnore from the menu. You can create as many
and styles. Windows font families have four font ignore records as you want, the video
members at most. For examp|e the font fam"y recorder Style buttons at the bottom rlght allow
Arial consists of Arial, Arial Bold, Arial Italic and You to step through them. Delete will delete the
Arial Bold Italic. Some font families like Symbol current record. Finally Duplicate makes a copy of
have just one member. Fonts on other operating the current record in a position just after it.
systems like RISC OS may have many more thanyou can turn on or off all the font ignore rules by
four members. Th@vation Pro font manager using the button “All font ignores active”.
works with font family member names not with
. ; Replace
family names. In other words you can’t say ] .
replace Homerton with Arial, you have to say Replace is concerned with what happens when a

replace Homerton Bold with Arial Bold and so on.document is loaded and a font used iniitis
missing. You can set up rules that specify which

Font Manager Window font family members are to be used to replace

Menu=>MiscvFont manager... others. When a document with missing fonts is
The MiscroFont manager...window lets you loaded you are given a choice between making a
control font handling. permanent replacement or a temporary

a{eplacementsee 2.3)Whichever of these is
chosen the fonts used come from those entered in
this section of the font manager.

There are three options selected by the buttons
the top, Ignore, Replace and Map.

gnore o ) _ Font replacements take place in the order they are
Ignore is simple, it lets you specify fonts that you qefined, and only occur if the new font actually

want to be ignored b@vation Pro, this means exists on the system. By selecting an empty string
they won't appear on the font menu. You might {4 the Original name you can set a default

want to ignore a font if you are using the font  yepjacement font for any missing fonts which are
manager to give it a different name using the font,t covered by explicit replacements.

mapping facility. Or you might ignore fonts to

keep the font menu short. One way of getting a list of the missing fonts in a

document is to load the document and select

= lgnore  Replace Map  PostSeript " lgnore & Replace  Map  PostSeript
¥ All font ignores active ¥ All font replacements active
0 il By |~ B s (Homertan Bolg)| "% P
Riﬁ\':gfgjg; [ Avial Bold |

NERY | Delete |Dup|icate| Eﬂl 141 Llﬂl NERY | Delete |Dup|icate| Eﬂl 141 Llﬂl
SaveAs...l Save | Cancell 0]24 I SaveAs...l Save | Cancell 0]24 I

Fig. A.1 - Font manager ignore window. Fig. A.2 - Font manager replace window.
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temporary replacement from the missing font
window and then use the FontList applet.

If the font replace rules are changed while a

FonT MaNacemENT 259
example on RISC OS, Homerton Medium would
appear as Homerton.Medium (i.e. with a period in
the middle).

document is open and temporary replacement waslthough all this may sound complicated a full set
chosen on loading then the on screen display willof font maps is provided for handling documents

change. If permanent replacement was chosen,

from RISC OS. These should be useful examples.

then the document must be loaded again to see the s names created by mapping appear on the

results of any new font replace rules.

Map

If you do want to retain the names of missing
fonts an alternative approach is to generate the
names of the missing fonts on the font menu
whilst using other fonts for display. For example
the font menu might show the name Homerton
whilst the font Arial is used for display. This will
work well since the two fonts have the same

font menu in italics.

If the font mapping function is used to create a
font member name that already exists then there is
no effect. This allows you to have a font map that
only has an effect if the font member actually does
not exist. If you want to force the fontmap
command to have an effect even when the font is
present, just use the font ignore facility as well.

If the Windows font in the fontmap command
(Windows name) does not exist the font map rule

metrics - the characters are the same size. Whennhas no effect.

you take the document back to a system with the
font Homerton installed it will use that font.

The font map window is more complex than the
others, for each font map you have to enter the
family name of the font (Typeface), the family
member name (Weight) and the name of the
Windows font to be used for display (Windows
name). The italic and bold buttons should be set
appropriately. Finally and optionally you can ente
the name of the font as it is stored in the saved
document, in other words as it appears on the
computer where the document originates. For

¥ Font Manager HE

 lgnare  Replace & Map  PostScript
I All font maps active
Typeface
(Homerton) I Corpus
Weight -
{Homertan Bald) ICurpus Medium
Windows narne ICDurier Mew 'ﬂl
(Arial Bold)
Mame in file -
e, Beld ICDrpus.Medlum
can be blank)
[ ltalic " Bold
M | Delete | Duplicate | |<]| 4| ” 1431 b3 | |>||
Save As. | Save | Cancel | (8]24 I

Fig. A.3 - Font manager mapping window.

Using the font mapping window you could
rearrange Windows fonts so there were more than
four fonts in one family. You might do this to
reverse the situation where a font with more than
four family members has been converted into a
number of font families for Windows. However
note that bold and italic effects should only be
used once in each family.

You might also use the font map facility to give
names of your own to fonts. For example you
could have a memorable name on the font menu
and arrange for the correct font name to be stored
in the document.

The Save button in the font manager window
saves all the settings for future use.

Save As... lets you save the font manager settings
as anOvation Pro script file. This is useful

because you can save a set of rules as a file and
only use them when you need them. If you do this
it may be useful to edit the file produced so they
only contain settings different to the defaults.

A script file can be run by double clicking it.
Script files can be edited in normal text editors.
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Notes:



Character Sets & Escape
Seqguences

The tables overleaf list the full ISO Latinl character set used by
Ovation Pro. They give the keyboard code number followed by the
character in Arial (which will be the same as most script fonts), DPDings
(identical to Selwyn which is like Dingbats but with a different character
order) and Symbol (identical to SymbolB and Sidney) fonts. Characters
not available directly from the keyboard may be obtained by holding
down Alt and typing the code on the numeric keypad. When Alt is
released, the character is inserted at the caret position. Alternatively you
may use the Characters facility on the Misc menu or the single shift font
change facility to insert non-standard characters.

The final column gives the escape sequence that may be used to
represent special characters in macro definitions (see 16.5).
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= v » S @ » S
£ £ 8§ & d £ g 8§ & 4 € £ § 5 4
00 - - - |@ 032 spc spc spc - o644 @ = O -
oL - - - A 033 | & | - 065 A & A -
02 - - - |B 034 " =< [O - 066 B + B -
03 - - - |C 035 # o # - 067 C 4+ X -
o4 - - - D 036 $ O - 068 D % A -
o5 - - - |E 037 % & % - 069 E % E -
06 - - - |F 038 & ©® & - 070 F 4+ o -
o7 - - - |G 039 ' @& 0O - 071 G < I -
o8 - - - |H 040 ( » ( - 072 H % H -
09 - - - 041 ) = ) - 073 | %% I -
om0 - - - |J 042 * @ [0 - 074 J © 9§ -
011 - - - |K 043 + 1w + - 075 K % K -
012 - - - |L 044 , ¥ , - 076 L #* A -
013 - - - M 045 - #H - - 077 M * M -
014 - - - N 046 . & . - 078 N # N -
015 - - - |0 047 | = | - 079 O * O -
o6 - - - |P 048 0 <& 0 - 080 P % N -
017 - - - 1|Q 049 1 o 1 - 081 Q % © -
018 - - - |R 050 2 e 2 - 082 R 3 P -
019 - - - IS 051 3 v 3 - 083 S ¥ I -
020 - - - T 052 4 © 4 - 084 T * T -
021 - - - U 053 5 X 5 - 085 U * Y -
022 - - - |V 054 6 % 6 - 086 V * ¢ -
023 - - - W 055 7 X 7 - 087 W % Q -
024 - - - X 056 8 % 8 - 088 X % = -
025 - - - JY 057 9 # 9 - 089 Y % WY -
026 - - - [Z 058 : + : - 090 Z % Z -
027 - - - | 059 ; + ;- 091 [ =x [ -
028 - - - | 060 < & < - 092 \ % O -
029 - - - ] 061 = t+ = - 093 | * ] -
o0 - - - 0 062 > & > - 094 ~ % 0O -
03T - - - | 063 ? % 2?2 - 095 < -
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S S 3 5%; S S 3 g g 8 = aié’
S - £ S @ S - S 9 % S - NS S %

096 ® 0 - 0128 € - |'l@  0160nbsp nbsp nbsp |! spc

097 a © o - 0129 W - NA 0161 ¢ Y |U

098 b v B - 0130 W - B 0162 ¢ ¢ ' |

099 ¢ X x - 0131 - - IIC 0163 £ ¢ < |#

ol00d % & - 0132 , ( IID 0164 a e / |$

010l e * & - 0133 ... - IIE 0165¥ & o |%

0102 f % ¢ - 0134 t O IIF 0166 ! % f |&

0103g O vy - 0135 £ - NG 0167 § = & |

0104 h Q n - 0136 - - 'H 0168 = & ¢ |(

0105 i O 1 - 0137 %o - 1 0169© ¢ v |)

0106 | & ¢ - 0138 - - 11J 0170 2 ¥ & |

0107 k » Kk - 0139 < K 0171 « & o |+

01081 @ A - 0140 E | L 0172 - @ «~ |,

0109m O u - 0141 - - M 0173 - @ 1t |-

0110 n W v - 0142 v - IIN  0174® ©® - |.

0Ol110 @ o - 0143 § - o 0175~ @ + |V

0112 p ¥ m - 0144 - - P 0176 ° ® ° |0

0113 q % 6 - 0145 * - Q0177 + ® =+ |1

0114 r % p - 0146 * - R 01782 @ " |12

0115s A o0 - 0147 * NS 0179 3 > |13

0116 t ¥ 1 - 0148 " NT 0180 @ x |4

0117 u % v - 0149 - - U 0181 p O |'s

0118 v <« w - 0150 — ) 'V 0182 ® o |6

0119w » w - 0151 — <« W 0183 - @& =« |17

0120 x | & - 0152 - - X 0184, © =+ |8

o121y 1 ¢ - 0153 ™ - 'ly o185 : @ =z |9

0122z 1 ¢ - 0154 - - 'Z 0186 ° © = |

0123 { ¢ { - 0155 > ) i 0187 » ® = |

0124 | °* | - 0156 ce ) |1\ 0188 v @ .. |

0125 } & } - 0157 - 1] 0189 % @® 0O |=

0126 ~ = 0O - 0158 fi 1" 0190% © 0O |>

0127 - - - |? 0159 fl } . o191, @® O |2




264  CHARACTER SETs AND EscaPeE SEQUENCES
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& &

g g
> & & £ 3 > £ & £
g < Q %] ] x < Q %] W
0192 A @® O ||@ 0224a m=» ¢ |
0193 A @ 0O |'/A 02254 = 0O |a
0194A ® 0O |'IB 02264 > 0O |b
0195A @® 0O |IC 0227a > 0O |ec
0196 A ® O |ID 0228& » 0O |d
0197 A ® O |JlE 0229& = S |le
0198 &£ @ O |IF 0230 = O |if
0199 C n |IG 0231 ¢ % 0O g
0200E ® O |'H 0232¢& =» [ |[h
0201 E O 1 0233 é o O |l
0202E © 0O |UJ 0234 & = O |
0203E ® 0O |lK 0235¢& = 0O |k
02041 © 0O L 0236 1 = 0O |
0206 1 @ O |M 0237 i = 0O [|m
02061 ©© O |IN 023817 = O |[n
02071 ®@ O O 02397 = 0O |o
0208 @ O |lP 024008 - - |p
0200N @ O |'IQ 02414 = 0O |q
02000 ®© O |IR 02420 = [ |r
02116 ©® O |[!S 0243 6 = [ |'s
02120 > 0O |IT 024406 ~ 0O |t
02130 - 1 U 02456 = | |u
02140 <« V IV 02466 + O |
0215 x 3 O |'W 0247 + * O |w
0216 @ ~ = |IX 0248 ¢ =»» 0O |
0217U = O |IY 02490 « 0O |y
0218 U ~ 0O iz 02500 = 0O |z
0219 0 > « || 0251 0 o O |Y
02200 = 0O |0\ 0252 & = O |
0221 Y — 0O | 0253y » 0O |}
0222 b —-» 0O | 0254 p = 0O |~
0223 R = O |l 0255y - - |?




Key & Constant Macro Names

When defining macros, the key names listed overleaf may be used in
macro definitions to represent keys on the keyboard (see 17.5). Various
other constant macros are predefined.
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Keyboard

EscF1F2F3F4AF5F6 F7 F8 F9
F10 F11 F12

"1234567890-=BS
Tabgwertyuiop][]
asdfghjkl;*#Return
\zxcvbnm,./Space

Print Slock

Insert Home PageUp
Delete End PageDown

Cup
CLeft CDown Cright

NLock K/ K* K-
K7 K8 K9 K+
K4 K5 K6

K1 K2 K3 Enter
KO K.

AprpenDIX C

Constant

ActiveDate

ChapterNumber

Date

DateTime

DeleteB (Deletes the character before the caret).
DeleteF (Deletes the character after the caret).
FileName

FilePath

FileDir

HardHyphen

HardSpace (non-breaking space)

PageNumber

NewFrame

NewLine

NewPage

NewPara

SoftHypen

TabChar (Tab is the key macro for the tab key).
Time

emspace (breaking, non-delimiting em space)
emspace_d (breaking, delimiting em space)
emspace_n (non-breaking, non-delimiting)
emspace_nd (non-breaking, delimiting)
enspace (breaking, non-delimiting en space)
enspace_d (breaking, delimiting en space)
enspace_n (non-breaking, non-delimiting)
enspace_nd (non-breaking, delimiting en space)



Date & Time Format

Options on the Misc=>Insert menu (Section 3.2) allow the current date
and time to be inserted into documents. This chapter describes how to

define the format of the date and time strings that are inserted.
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Date and Time Format Any other characters separating the components
Menu=Misc=>Choices>General are inserted in the string unchanged.

The date and time is controlled by the stribgge SO, for example, ibate format the components
format andTime format in theGeneralsection ~ are%ZDY, %ST, %MQ %CE and%YR, with two
of theChoicesdialogue boxfig. D.1). Each spaces separating them. Tiime format the
format string is made up of a number of components aréZ12 %Mland%AMwith a
components that begin with the charaéefhe% colon separating them.

character is followed by a two-character code  The default date and time strings produce the

from the table below, which may be preceded by fllowing results when inserted into a document.
Z if you want leading zeros to be suppressed. 3rd February 1995

Code Meaning Example _

CS centiseconds 99 2:07pm

SE  seconds 59 Examples

MI minutes 45 Format string Output string
12 hours in 12-hour format 07 %ZDY%ST %M3 %YR  3rd Feb 95

24 hours in 24-hour format 19 %ZDY/%ZMN/%YR 3/2/95

AM  ‘am’ or ‘pm’ am %ZMN-%ZDY-%YR 2-3-95

PM ‘am’ or ‘pm’ pm %WE the %ZDY%ST Friday the 13th
WE weekday, in full Friday Week %ZWK %CE%YR Week 5 1995
W3 weekday, first 3 letters only Thu %12:%MI:%SE 02:35:09

WN weekday, as a number 5 %Z24:%ZMI%AM 14:35pm

DY day of month 12

ST  suffix ‘st’, ‘nd’, ‘rd’ or ‘th’ st

MO  month, in full March

M3  month, first 3 letters only Jan

MN  month, as a number 12

CE century 20

WK week of the year pol & Aopicaion choices K|

I General choices

Date format | %Z0Y %ST %MO %CE%YR

Time format %212 Yot SN

[T Save buffer Buffer size| & |
W Give warnings

W Windows clipboard  Cliphoards | 1

[T Check documents after loading

[T Check documents before saving

Save Cancel 8]

Fig. D.1 - Choices dialogue box.



Keyboard and Mouse Short-cuts

This appendix lists all the default keyboard and mouse short-cuts. They
may be redefined if required using the Macros facility (17.3). In the short-
cut definitions that follow, the symbol * is used to represent the Ctrl key
and [Jis used to represent Shift.
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Caret Movement

«— —

1 i

O O
i) )
A(— A—>
AN AN
Ay AL

Page Movement

Page Up
Page Down
[lPage Up

[lPage Down
"Page Up

"Page Down
Home

[Home

Deleting Text
Delete

Backspace

[Delete
[IBackspace
"Delete

"Backspace
A[Delete

Selecting Text

Click and drag
1 left click
2 left clicks

[12 left clicks
3 left clicks
4 |left clicks
5 left clicks
1 right click
01 left click

AprprenDIX E

Drag & Drop

Caret left/right one character To drag and drop text, first select the text then
Caret up/down one line press the left mouse button and drag it to the
Caret left/right one word required insertion point.

Caret up/down one
paragraph

Caret to start/end of line

Caret to start/end of text . -
story To drag and drop (move) an object within a page,

Scroll up/down through story Press and hold down_the left pytton, pause and
then drag to the required position. Alternatively
press Control and drag with the right button. For
drag and drop between pages or documents see
the next paragraph.

To drag and drop a picture, first double-click to
select the picture then press Alt and drag the
picture to a suitable frame.

Scroll up one screen
Scroll down one screen
Move to start of previous

page

The following operations apply when dragging to
within the same document:

Move to start of next page Left drag Move text
Move to start of first page in Alt Left and drag Move object or picture
chapter [JLeft and drag Copy text

Move to start of last page inAltL Left and drag  Copy text, object or picture

chapter The following operations apply when dragging to
Move to start of first page in gnother document:

document
. Left and drag Copy text
(;\/Iove to start of last page in OLeft and drag Move text
ocument

Alt Lfet and drag
Alt[J Left and drag

Copy object or picture
Move text, object or picture
Delete character to right of
caret

Delete character to left of
caret

Delete word at caret

Delete previous word
Delete from caret to end of
line

Delete from caret to start of
line

Delete line of text

Select text region
Clear selection

Select word + following
spaces

Select word only

Select line

Select paragraph
Select story
Extend/reduce selection
Extend/reduce selection
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Text Size, Kerning & Scale Working with Objects
N N> Decreasel/increase font size When drawing, mOVing or reSiZing ObjeCtS:
by 1pt - - Nudge pointer left or right
ANk A Decreasef/increase font size T ! Nudge pointer up or down
through range Escape Cancel the operation
N n Decrease/increase kerning When drawing objects:
or tracking by 1/1000 em Presd] To constrain rectangle or
AL AO Decrease/increase kerning ellipse to a perfect square or
or tracking by 1/100 em circle
NN Decrease/increase horizontal\yhan moving objects:
scale by 1% _ Press] To constrain movement to
A~ Decrease/increase horizontal horizontal or vertical

scale by 5% . .
When resizing objects:

Presst To maintain original aspect

Key Presses in Dialogue Boxes ratio of object

[Tab Move caret to previous Press] To constrain shape to a
Writable iCOI’] perfect Square

Tab Move caret to next writable
icon _ o

Return Same as clicking OK Working with Pictures

Escape Same as clicki@ancel Double-click on a picture to select it.

A selected picture may be moved by dragging.
When using ‘bump’ arrows for increasing and  Press Shift to constrain movement to horizontal or
decreasing values, Shift can be used to increase vertical.

the step size by a factor of 10. A selected picture may be resized by dragging the

handles on the Resize gadget.

Selecting Objects A selected picture may be rotated using the Rotate
Left Click on an object to select it, deselecting any0ol.

other objects. Right Click on a picture to deselect it.

Left Click Ctrl on an object to add or remove it Triple-click on picture to opeNlodify picture

from the selection. dialogue box.

Press Ctrl Shift and drag a rectangle around a

number of objects to be selected. Function keys

Press Ctrl Shift and double-click to select objects Key Key with Ctrl
hidden beneath other objects. F1 Help Body text
F2
F3
F4
F5

F6 Modify text/picture

F7 Modify object

F8

F9

F10

F11 Characters (see Misc menu)
F12 Single shift font change
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Keys with Ctrl and Ctrl Shift

Ctrl

Select All
Bold

Copy

Insert Date
Centre
Find/Replace
Goto page
Object sHape
Italic

Justify
Delete object
Left align

New document
Open document
Print dialogue box
Remove styles
Right align

Save document
Open Thesaurus
Underline

Paste selection
Spellcheck Word
Cut selection
Redo

Undo

Subscript
Discretionary hyphen
100% zoom
200% zoom
150% zoom
400% zoom
50% zoom
Variable zoom

FN<LSXs<CHOITOTOZZIr"«~"IOTMMOO®T>

shift baseline up 1%

VANOOO~NOOTE,WNPE!
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Miscellaneous Key Presses

Return
Ctrl Shift CReturn
"Return
Clip Board Tab
Edit master page "Tab
Duplicate Insert
Edit style Mnsert
Font menu Hinsert
Grid lock "Space

Object backwardsCtrl Shift -

Show Invisibles ~ Ctrl -

Group/Ungroup
Remove effects
Show/Hide Print Margin Merge command

Normal

View Options
Preferences
Swap char pair

Show Rulers

Swap case
Text flow

Object forwards

ReVerse
Select Word
Return to caret

Zoom options

Superscript
Hard hyphen

shift baseline down 1%  down by 5%

up by 5%

decrease font size by 1pt 36pt ---> 8pt
increase font size by 1pt

8pt ---> 36pt

When a line has been selected:
> increase line width with 5mm
< decrease line width with 5mm

New paragraph

New line

New page, frame or column
Insert tab character

Display Tab/Indent ruler
Paste contents of clipboard
Insert filename

Insert file path
Non-breaking space
Non-breaking (hard) hyphen

Soft hyphen (discretionary)



Defining Borders

This section describes how to edit the borders styles supplied with
Ovation Pro, or add your own styles.
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Border Definition File Border Styles

Menu=>Object>Border...  Ctrl+Shift+F Lines which begin with the commaibrder,
¢ define the actual borders. The syntax of the

Ovation Pro supports two types of borders. Firs :
Border command is:

simple lines suitable for use on all types of
frames, including irregular ones. These are Border <name> <definition>
defined in Text files, using the format described Where:

below. Second graphical borders. These use the
same format as ‘Impression’ and are defined in
Draw files which can be edited and created usingdefinition is a string that defines the lines
the Draw program. and gaps in the border. A number in the string

All the borders that appear in tfject>Border refers to a line style number and an underline
dialogue box are defined in files in the directory '€Presents a gap. For example:

name is the name of the border.

<OPD>\Borders\!Borders.txt Border Example 11_3

The format of the Text files defining simple In this example, the border named Example
borders is explained below. consists of two lines of style 1 and one line of
Line Styles style 3, with a gap between them. These are

plotted from the outside, inwards to the frame

Lines which begin with the commaihthe, define
edge.

the line styles that may be used in border
definitions. The syntax of thene command is: The total thickness of the border is determined by

Line <n> <pattern> <size> <join> the value specified on thi&order dialogue box.

Where:
n is the number of the line style.

pattern is a word whose bit pattern defines the
line pattern.

size is the size in 1/1000 pt, at which the pattern
is plotted.

join is the line join style, as follows:

0 mitre
1 round
2 bevelled

These line style definitions are exclusively for the
borders and have nothing in common with lines
drawn using th&ine tool.



Defining Colour Charts

This section describes how to define the colour charts that may be used
when defining colour using the Misc =>Edit colours option.
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Defining Colour Charts HSV
Charts are defined in ASCII files and saved in  If the colour model i$1SV, there should be three

directory<OPD>\Colours . The chartis given  Vvalues after the colour name, relating to the Hue,

the same name as the name of the file that definegaturation and Value for the colour. Hue should
it. be specified in the range 0 to 360°, and the other

values in the range 0 to 100%. All values are

The format of the file that defines a colour chart is
accurate to 1 decimal place.

shown in the extract below:

// 56 Named Colours RGB .

/1 23/10/95 If the colour model iRRGB there should be three
values after the colour name, relating to the Red,

HSV Green and Blue values for the colour. All values
should be specified in the range 0 to 100% and to

Pale Pink,0,20,100 an accuracy of 1 decimal place.

Pink,0,30,100 CMYK

Red,0,100,100 If the colour model iI€MYKthere should be four

Burgundy,0,100,70 values after the colour name, relating to the Cyan,

Vermilion,15,100,100 Magenta, Yellow and Black values for the colour.

Terracotta,15,100,80 All values should be specified in the range 0 to

1# 100% and to an accuracy of 1 decimal place.

Formatting the Chart

The colours you define are displayed in a series of
columns, with 7 colours per column. You can

The next line contains a word which defines the introduce a blank space into the chart at any time
colour model for the data. The word mayH®8V, by defining a colour a&# (see earlier example).
RGL_%or CMYKand ghould be terminated with a Loading the Chart

carriage return or line feed character.

Lines like the first two which start withh are
comments, and have no effect.

Once you have created the colour chart, you must
The following lines define the colours which save it and re-ru@vation Pro in order for it to
appear in the chart. Each definition should have appear on th€hart menu of theChart dialogue
either four or five fields separated by a comma, pox. Once it has registered on the menu, you can
and should be terminated by a carriage return or freely edit the colours in the chart without having

line feed character. to re-runOvation Pro. Charts are only loaded

The first field is the name of the colour. The from disc when they are needed, so there is no
length of this name added to the chart name memory overhead in creating lots of charts (other
should not exceed 22 characters. then using disc space).

The values after the colour name, define the
colour.



Glyph Names

The shapes representing the characters in fonts known as glyphs, can
be identified by names. These names are recognised as constant
macros and can be used in macro definitions, so for example a key can
be made to insert one. In addition they can be entered in the search and
replace strings, this can be useful because not all the characters used
by Ovation Pro can be shown in Windows text icons.



278  GryrH NAmMES AprpPEnDIX_H

For codes in the range 32 to 126 and 160 to 255 0Ox4c 076 L L

this table shows the code number in hexadecimal)x4d 077 M M

in decimal, the glyph and the glyph name. The 0x4e 078 N N

code numbers are the same for Unicode, Window@x4f 079 @) @]
Western and RISC OS Latin 1 character sets. Nox50 080 P P

that Windows designates code 173 as soft hyphe@ix51 081 Q Q

0x20 032 space 0x52 082 R R

0x21 033 ! exclam 0x53 083 S S

0x22 034 " quotedbl 0x54 084 T T

0x23 035 # numbersign Ox55 085 U U

0x24 036 $ dollar 0x56 086 V V

0x25 037 % percent 0Ox57 087 W W

0x26 038 & ampersand 0x58 088 X X

0x27 039 ' quotesingle Ox59 089 Y Y

0x28 040 ( parenleft Oxb5a 090 Z Z

0x29 041 ) parenright Ox5b 091 [ bracketleft
Ox2a 042 * asterisk Ox5c 092 \ backslas_h
Ox2b 043  + plus Ox5d 093 ] bracketright
0x2c 044 ’ comma Ox5e 094 A asciicircum
ox2d 045 . hyphen Ox5f 095 _ underscore
Ox2e 046 . period 0x60 096 grave
0x2f 047 / slash 0Ox61 097 a a

0x30 048 0 zero 0x62 098 b b

0x31 049 1 one 0x63 099 C c

0x32 050 2 two Ox64 0100 d d

0x33 051 3 three Ox65 0101 e e

0x34 052 4 four 0x66 0102  f f

0x35 053 5 five Ox67 0103 g g

0x36 054 6 six 0x68 0104  h h

0x37 055 7 seven 0x69 0105 | |.

0x38 056 8 eight Ox6a 0106 | j

0x39 057 9 nine Ox6b 0107 Kk k

Ox3a 058 ; colon Ox6c¢c 0108 | [

Ox3b 059 ; semicolon Oxéd 0109 m m

0x3c 060 < less Ox6e 0110 n n

0x3d 061 = equal Ox6f 0111 o 0

O0x3e 062 > greater Ox70 0112 p p

Ox3f 063  ? question Oxr1 0113 g q

0x40 064 @ at 0x72 0114 r r

0x41 065 A A 0x73 0115 s S

0x42 066 B B Ox74 0116 t t

0x43 067 C C 0x75 0117 u u

0x44 068 D D O0x76 0118 v v

0x45 069 E E Ox77 0119 w w

0x46 070 F F O0x78 0120 X X

0x47 071 G G Ox79 0121 vy y

0x48 072 H H Ox7a 0122 z z

0x49 073 | | Ox7b 0123  { braceleft
Oxda 074 ] J Ox7c 0124 | bar
Ox4b 075 K K Ox7d 0125 } braceright
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Ox7e 0126
Oxa0 0160
Oxal 0161
Oxa2 0162
Oxa3 0163
Oxa4 0164
Oxab 0165
Oxab 0166
Oxa7 0167
Oxa8 0168
Oxa9 0169
Oxaa 0170
Oxab 0171
Oxac 0172
Oxad 0173
Oxae 0174
Oxaf 0175
0xb0 0176
Oxb1 0177
0xb2 0178
0xb3 0179
Oxb4 0180
0xb5 0181
0xb6 0182
Oxb7 0183
0xb8 0184
0xb9 0185
Oxba 0186
Oxbb 0187
Oxbc 0188
Oxbd 0189
Oxbe 0190
Oxbf 0191
0OxcO 0192
Oxcl 0193
0Oxc2 0194
0Oxc3 0195
Oxc4 0196
0Oxch5 0197
0Oxc6 0198
Oxc7 0199
0Oxc8 0200
0xc9 0201
Oxca 0202
Oxcb 0203
Oxcc 0204
Oxcd 0205
Oxce 0206
Oxcf 0207

Oxd0 0208

tu——- K O th & —

® ©

A

) |@'J

IR

o Brv —— [y )

M

O T T T MM M RO By B3 > > >0 @ R 8

asciitilde
nbspace
exclamdown
cent

sterling
currency
yen
brokenbar
section
dieresis
copyright
ordfeminine
guillemotleft
logicalnot
hardhyphen
registered
macron
degree
plusminus
twosuperior
threesuperior
acute

mu
paragraph
periodcentered
cedilla
onesuperior
ordmasculine
guillemotright
onequarter
onehalf
threequarters
guestiondown
Agrave
Aacute
Acircumflex
Atilde
Adieresis
Aring

AE

Ccedilla
Egrave
Eacute
Ecircumflex
Edieresis
Igrave

lacute
Icircumflex
Idieresis

Eth

Oxd1
Oxd2
0xd3
Oxd4
0xd5
0xd6
Oxd7
0xd8
0xd9
Oxda
Oxdb
Oxdc
Oxdd
Oxde
Oxdf
Oxe0
Oxel
Oxe2
Oxe3
Oxe4
Oxe5
Oxeb
Oxe7
Oxe8
0Oxe9
Oxea
Oxeb
Oxec
Oxed
Oxee
Oxef
0xfO
Oxf1
0xf2
O0xf3
Oxf4
Oxf5
0xf6
Oxf7
Oxf8
0xf9
Oxfa
Oxfb
Oxfc
Oxfd
Oxfe
Oxff

0209
0210
0211
0212
0213
0214
0215
0216
0217
0218
0219
0220
0221
0222
0223
0224
0225
0226
0227
0228
0229
0230
0231
0232
0233
0234
0235
0236
0237
0238
0239
0240
0241
0242
0243
0244
0245
0246
0247
0248
0249
0250
0251
0252
0253
0254
0255

o< ocoocon 00O K= — — — @ @ O DO g rom»oryRPRTLCOCCAXOOROO0O 2
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Ntilde
Ograve
Oacute
Ocircumflex
Otilde
Odieresis
multiply
Oslash
Ugrave
Uacute
Ucircumflex
Udieresis
Yacute
Thorn
germandbls
agrave
aacute
acircumflex
atilde
adieresis
aring
ae
ccedilla
egrave
eacute
ecircumflex
edieresis
igrave
iacute
icircumflex
idieresis
eth
ntilde
ograve
oacute
ocircumflex
otilde
odieresis
divide
oslash
ugrave
uacute
ucircumflex
udieresis
yacute
thorn
ydieresis
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For codes in the range 128 to 159 things are more
complicated because the code numbers are
different on different systems. This table shows
the Unicode number in hexadecimal, the code to
type, the Windows Western code, the RISC OS
Latin 1 code, the glyph and finally the glyphname.

Unicode  Key Win RISC OS Glyph Glyphname

0x20ac 0128 128 128 € Euro

0x174 0129 - 129 W Wcircumflex
0x175 0130 - 130 W wcircumflex

- 0131 - -

0x201le 0132 132 150 ” guotedblbase
0x2026 0133 133 140 ellipsis
0x2020 0134 134 156 T dagger
0x2021 0135 135 157 T daggerdbl

- 0136 - -

0x2030 0137 137 142 %0 perthousand
- 0138 - -

0x2039 0139 139 146 < guilsinglleft
0x152 0140 140 154 & OE

- 0141 - -

0x176 0142 - 133 Y Ycircumflex
0x177 0143 - 134 y ycircumflex

- 0144 - -

0x2018 0145 145 144 ‘ guoteleft
0x2019 0146 146 145 ' quoteright
0x201c 0147 147 148 “ guotedblleft
0x201d 0148 148 149 ” guotedblright
0x2022 0149 149 143 . bullet
0x2013 0150 150 151 - endash
0x2014 0151 151 152 — emdash

- 0152 - -

0x2122 0153 153 141 ™ trademark

- 0154 - -

0x203a 0155 155 147 > guilsinglright
0x153 0156 156 155 ce oe

0x2212 0157 - 153 - minus
0xfb01 0158 - 158 fi fi

O0xfb02 0159 - 159 fl fl

AprpPEnDIX_H



Document Description Language

The Document Description Language (DDL) is a file format that
describes Ovation Pro documents in textual form. This short appendix
describes why the DDL may be useful and when it should be used.

However, it does not give full DDL syntax which is beyond the scope of
this user guide.
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Purpose of the DDL

ApPpPENDIX |

Using DDL on Problem Documents

A document saved in DDL format may be read orOne side effect of saving a document as DDL and

altered by loading it into a text editor such as
Notepad. One purpose of the DDL format is to
allow foreign file format converters to be easily
written. So, a foreign file could be converted to
DDL format and then loaded in@vation Pro.
Likewise, anOvation Pro document could be
saved as a DDL file, which could then be
converted to another format. Conversion via the
DDL is much easier than using the native
Ovation Pro file format (which is compacted and
not easily deciphered).

Most of the existing loaders for alien files (e.g.
RTF and Impression) work by transparently
converting the file to DDL format and getting
Ovation Pro to load it.

Saving in DDL Format

loading a DDL document is th@ation Pro is
forced to analyse and tidy the structure of the
whole document. This means that if you get a
document which behaves badly, a possible fix is
to save it as DDL and then reload the DDL
version.

When you save a document or text story, you may
choose to save it in DDL format. Once saved, the

resulting text file could then be interpreted by a
separate program for processing or conversion.

Loading DDL Files

If you double-click on a DDL format document, it

will be loaded intdvation Pro in the usual way.

Alternatively you can load it by using Open on the

File menu. If a DDL file just describes a text
story, then it may be dragged into@wation Pro

text frame or loaded via Import on the File menu.

Native Format Versus DDL Format

In normal circumstances you should save
documents iOvation Pro format, rather than
DDL format. There are three reasons for this:

e Ovation Pro files are usually more compact.
» Ovation Pro files contain flow information,

which specifies exactly where each line of text
appears on the page. This means that they load

more quickly than DDL files, which must
calculate the flow information during loading.

e Ovation Pro files contain document view
information such as zoom. DDL files do not
contain this information, and will use the
defaults on loading.



Expression Evaluation and Units

Within Ovation Pro there are many writable icons into which values can
be entered. It is possible to enter expressions and use various units
using the same format in all of them.
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Units

The following units and abbreviations are
supported.

Millimetre mm, m, M
Inch in, i,",1
Point pt, p, P
Pica pi, P
Centimetre cm,c, C
Didot di,d, D
Cicero ci, Cl
Foot ft, '

Yard yd
Twips tw

APPENDIX J

Expression Evaluation

In any icon where you type a value, you can type
in an expression.

For example;

10+20

6*2.123

The operator precedence is

unary +/- (e.g. using - for a negative value)
(and) (brackets)
/and * (division and multiplication)

units and % (e.g. mm)

+ and - (addition and subtraction)

More advanced examples;

The didot is the equivalent of the point outside thet0Omm+10%

UK and USA. There are 12 didot’s in 1 cicero. A 5/6

point is 1/72nd of an inch. A didot is 0.0148 inch
or about 1/68th of an inch

A pica is equal to 1/6 of an inch, or 12pt.

There are 1440 twips in an inch or 20 twips in a
point.

Paper Sizes

A3 297x420mm 11.69x16.53in
A4 210x297mm 8.27x11.69in
A5 148.5x210mm 5.85x8.27in
Letter 215.9 279.4mm 8.5x11in
Legal 215.9x355.6mm  8.5x14in
Tabloid 279.4x431.8mm  11x17in

here " is short for inch, but note that the value of
this is (5/6) inches and not 5/(6 inches).

Values may contain 0..9, the decimal point
represented by ‘.’ or ", if prefixed by # they are
treated as hexadecimal and may also contain a..f.
Note that #100d is 4109 and not a value of 256
didots which could be written (#100)d.
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A B
Accent Back to back

A mark on a character denoting pronunciation in &rinting on both sides of a sheet.

given language e.g. the acute on é. Banner

Additive colours A main heading across the full width of a page.
Red, Green and Blue. The primary colours of lighg,5e alignment
that may be mixed to generate all colours in

photographic reproduction. SeeBase line grid lock.

Base line

The imaginary line upon which the bases of
capitals sit.

Alignment

The arrangement of the surplus space in a line of
type. Type may be aligned left, centred, aligned
right or fully justified, (i.e. space divided equally Base line grid lock

throughout the line). Vertical alignment is the The alignment of base lines to a common grid.
arrangement of surplus space vertically in a framPBéZier curve

Alphanumeric set A mathematically defined curve between two
A set of characters containing letter and figures, points. The curve is edited my dragging control
but possibly containing punctuation marks and  points.

other symbols. Binding margin

Ampersand An inside margin that is wider than the standard
The symbol & used in place of the word ‘and’.  margin to allow for punching or binding.
Antialiasing Bit-depth

A technique which reduces the jagged edges of The number of bits used to define the number of
fonts or bit-mapped images by displaying pixels agirey levels or colours available e.g. 24-bit colour.
the edges in intermediate shades of the image
colour. This has the effect of softening the edges
of the image.

Bitmapped font

A font with jagged edges made up of pixels as
opposed to a smooth-edged outline font.
Ascender

The part of a lower-case letter which extends
above the x-height e.g. the upper part of b.

Bitmapped graphic

An image such as a Sprite made up of pixels as
opposed to an object-oriented graphic such as a
ASCII Draw file.

An abbreviation for American Standard Code for Bleed

Information Interchange. This defines how
numeric codes are assigned to the alphanumeric
characters used by most computers.

The part of a page that extends beyond the trim
marks of the page.

Aspect ratio Body . . . .
The ratio of an object’s width to its height. Ztie main part of a story not including headings
Autoflow Bold

The facility to flow type automatically from one

frame or page to another. A type style in which characters are emphasised

with thicker-than-standard black lines.
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Border Chromalin

A decorative outline drawn around a frame, used A proofing system.
to highlight the contents of the frame or to

S T \ , Cicero
distinguish it from its surroundings. A European unit equal to 4.511mm or 12 Didot
Box rule points.
A paragraph or graphic, ruled off on all four SideSCIipart
Bromide A set of pictures and symbols for importing into
A high quality print on paper coated with silver documents.
bromide emulsion. Clipboard
Bullet In DTP software, a temporary store for text,
A large dot or symbol normally preceding listed pictures or objects which have been cut or copied
items which require emphasis. from the document. The contents of the clipboard
C may be pasted back into any document.
© CMYK

The four process colours of Cyan, Yellow,

The mark used to identify the copyright owners :
Magenta and Key (Black) used in four-colour

name and to signify that an item is protected by

international copyright laws. printing.

Cap line Codet

An imaginary line running across the top of SeeColour bar

capitals. Collate

Caps A printing option that puts pages in the correct
An abbreviation for capitals i.e. upper-case letter£rder when printing multiple copies.

Colour bar
A standard set of colour bars, printed outside the

page area, used in four-colour printing to show the
strength and registration of the colours.

Caps and smalls

Type consisting of capitals for initial letters and
small caps for lower-case letters.

Caption Col ’
I olour correction
Descriptive text normally attached to an , )
illustration. The adjustment of colour values to improve colour
reproduction of the printed image.
Caret

Colour model

The system in which colours are defined and
edited. The most common models used in DTP are

The I-shaped cursor in DTP software which
indicates where text will appear when typed.

Case RGB (Red, Green,Blue), HSV (Hue, Saturation
Alphabetic characters may be either lower-case and Value) and CMYK (Cyan, Magenta, Yellow
(small letters) or upper-case (capitals). and Key).

Centred Colour separations

Alignment of type so that it is centrally placed on The division of colours into separate plates for
each line, with any remaining space divided printing using the spot-colour or four-colour

equally between the left and right margins. Type process.

may also be centred vertically in a frame.
Column

Character A section of a frame or page divided vertically

Any printable letter, number or symbol.
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Column rule Desktop publishing
The vertical line drawn between columns. The activity of document creation or graphic
Condensed type design using a desktop computer. The final result

: is usually camera-ready artwork or data files in a
A typeface with a narrow appearance or a normalform suitable for hiah-end orintin
typeface that has been squashed horizontally. 9 P 9:

Didot point
Contrast The E it for t [ to 0.0148in
The degree of separation of tones in an image. € European unit for type equatfo ©. n-
Dingbat
copy A font of decorative symbols such as Selwyn font
The text from which the printed page is to be y y '
prepared. Discretionary hyphen
cpi See Soft hyphen.
Abbreviation for Characters Per Inch. Dithering
cpl A technique used to simulate extra colours by

Abbreviation for Characters Per Line. mixing colours in different patterns.

Document description language (DDL)

Crop . :

The process of discarding the unwanted edges o]ﬁatype of language used to describe an entire
. ocument.

graphic. _

Crop marks Dot gain

The process during reproduction where halftone

Marks which act as a guide for cropping the dots grow in size.

printed material.
Dot matrix printer

A low-cost printer that creates printed characters
by hitting the correct combination of pins through
an inked ribbon.

Cut and paste

The process of deleting an item from a document
placing then placing it elsewhere. In DTP

software, this is done via the clipboard.
Double page spread

Cyan .
One of the four process colours, often called Two fa-cmg pages of a document.
process blue. Draw files
D Object-oriented graphics that are compatible with
Dash the Acorn Draw module and the Draw application.
as
Either an em-dash — (ASCII 151) or an en-dash Drop ca_p_ ) o
(ASCII 150), as opposed to a hyphen - . A large initial charactgr at the peglnnlng of a
) paragraph that drops into the lines beneath.
Decimal tab

Drop shadow

A shadow behind an image or frame, designed to
bring the object forward.

A tab stop which aligns the decimal point in
decimal numbers on the tab stop.
Descender

The part of a lower-case letter which extends
below the baseline e.g. the tail of y.
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Duotone F

Normally refers to the process of printing a Facing pages
halftone in two colours using two halftones

) ., Pages that face each other in a double-sided
generated from the same original. This is also

, ' document.

called duplex halftone. Strictly speaking, a ,
duotone is a monochrome image printed in two  Family
shades of the same colour. A set of typefaces in all sizes and styles.
Duplex halftone Feint ruling
SeeDuotone Lines horizontal lines drawn on a page as a guide
E for placing text.

o First line indent
Ellipsis

The indent applied to the first line of a paragraph.
A zero first line indent combined with a positive
left indent is used to produce a hanging indent.

The symbol ... indicating that the end of the text
has been omitted.
Em

A linear measurement equal to the point size of
the type, but traditionally the area of the capital
letter M.

Em dash
A dash that is an em wide — (ASCII 151).

Emulsion side

The side of photographic film which hold the
emulsion. The emulsion on positive film is on the Flat plan

back of the film (emulsion side down) while on A diagrammatic plan used to organise the layout
negative film it is on the front (emulsion side up). of a document.

Fixed word spacing

The standard spacing between words for
unjustified text.

Fixed hyphen

SeeHard hyphen

Fixed space
SeeHard space

En Flush left/right

Half the width of an em. Seel eft align/Right align

En dash Flush paragraph

A dash that is an en wide — (ASCII 150). Paragraph where the first word is not indented, but
EPS set flush against the left margin.

Abbreviation for encapsulated PostScript which is-ont
a standard graphics file format. A complete set of alphabetic and numeric
characters, punctuation marks or other symbols of

Exception dictionar
P / matching style and size. Also called a Typeface.

A user-defined list of words that should not be

hyphenated using the standard hyphenation Foolscap
algorithm. In Europe a paper size of 13%" x 17",
Expanded type Footer

A typeface with a wider appearance or a normal Text or graphics repeated at the bottom of every
typeface that has been stretched horizontally.  page (above the bottom margin). Typically, the
footer contains the page number.

Export
The facility to save all or parts of a document in Footnotes
an appropriate format for use in another Short, explanatory notes printed at the bottom of a

application e.g. text may be saved as an ASCII filpage or at the end of a chapter and referenced to
the appropriate passages in the main text.
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Format Handles

Collective term for paragraph attributes such as In DTP software, small squares attached to the
justification, indentation, tabs etc. active object, and used to re-size or re-shape the
Fount object.

SeeFont. Hanging indent

The effect where the first line of a paragraph is
flush with the left margin and subsequent lines are
indented, so that the body of the paragraph
appears to ‘hang’ from the first line.

Four-colour process

The colour printing process using the colours
Cyan, Magenta, Yellow and Key (Black).

Frame

Boxes in which text and graphics are placed whe
creating documents using DTP software. normall
frames may only be rectangular, but in Ovation
Pro they may be any regular or irregular shape. Hard hyphen

A non-breaking hyphen. Words separated by a
hard hyphen are never split between lines.

Hanging punctuation

¥Eunctuation marks allowed to fall outside the right
argin.

Frontispiece
An illustration facing the title page of a book.

G
GIF
Abbreviation for Graphic Image Format. A

Hard space

A non-breaking space. Words separated by a hard
space are never split between lines.

: . Header
standard bitmapped graphic format. .
Text or graphics repeated at the top of every page
Glyph (below the top margin). Typically, the header

A shape representing a character code in a font. kbntains the chapter name.

a text font, a letter, in a symbol font, a symbol.
Heavy

Greeking SeeBold.
A process in some DTP systems which SUbStitUteﬁinting

text or pictures with a grey tint to speed up screen , )
redraw. A technique used by the font manager to improve

Grid the rendering of outline fonts, especially at lower
ri

resolutions.
A matrix of equally spaced lines or points drawn
in the background, allowing objects such as
frames and lines to be positioned with greater
accuracy and consistency.

Horizontal Scale

A style effect which allows type to be condensed
or expanded horizontally.

Hue

The pure pigment of a colour, not including any

Guideline

A line which appears on the screen as an aid in :
laying out the document, but which is not printed, Plack or white.
Gutter Hyphenation

The common term for the margin between The process of introducing hyphens in words at

columns in multi-column documents. A standard the €nd of lines so that they are split across two
gutter width is 1 pica (12pt). lines. The position of the hyphen in the word is

determined by a hyphenation algorithm
H and exceptions dictionary.
Halftone I
An image reproduced by the halftone process. ThI
halftone process is where an image is simulated
by a pattern of dots of varying sizes.

e .
mage file
SeeBitmapped graphic
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Imagesetter L

A high-resolution output device used to produce [ aminate

film or camera-ready artwork on bromide paper. 5 transparent plastic coating applied to paper or

Import cardboard giving it a protective finish.
The introduction of text or graphics from another | andscape

ap!olication into a document either directly or fromrp4 orientation of a page such that its longest
afile on disc. edge is horizontal.

Indent Leader

The leftindent is the distance between the left A |ing of characters (usually dots) that lead the
margin and the start of the line of text. The right eye across the page between tabbed text.
indent is the distance between the end of the line

of text, and the right margin. Leadering

) SeelLeader
Inferior character

SeeSubscript Leading
Inset The vertical spacing between lines of text.
Pronounced ‘ledding’, it takes its name from the

The margin around the inside of a text or picture gy s of lead that were used to space out lines of
frame, which prevents the contents of the frame type in mechanical printing. I@vation Pro,

running into the frame edge. leading may be specified as an distance between

Italics the baselines of type (as a percentage or an

A specially designed sloping version of a typefac@bsolute value) or as a gap between the bounding
3 boxes of type.

Jaggie
The term used to described the stepped
appearance of bit-mapped fonts and images.

Left aligned

A paragraph format option where text is aligned to
the left margin, leaving the right edge ragged. Left
aligned is also referred to as ‘flush left’, ‘ranged

JPEG left’ or ‘ragged right’.
A popular compressed bitmapped graphic formatLega|
Justification A standard paper size 8.5 inches wide by 14

The arrangement of the surplus space in a line ofinches long.
type where extra white space is inserted between atter

the words and letters in a line so that both left an
right edges are aligned to the margins.

K Letterspacing

Kerning The spacing between letters. Letterspacing may be
Fine adjustment of white space between letter  adjusted using kerning, tracking or by fully

pairs to enhance their appearance. It is mostly  justifying the paragraph.

used to reduce the white space between charactq_r% King

in larger font sizes.

% standard paper size 8.5 inches wide by 11
inches long.

The process of connecting a number of text

Key _ o frames together so that text of one story flows
The black plate in CMYK printing. automatically from frame to frame.
Keyline

A line indicating the size and position of an
illustration.
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M Pamphlet
Macro A short, unbound booklet.

A single label that identifies a larger unit of text. Paragraph

The text is often a sequence of commands that  |n Ovation Pro a paragraph is defined as the text
may be executed by ‘expanding’ the macro. between two carriage returns.

Magenta PCD
One of the four process colours, sometimes callegeePhoto CD
process red. Photo CD

Margins A CD containing high resolution bitmapped
The blanks areas around the edges of a page.  graphic images.

Master Frames Pica

Frames which appear on the Master Pages and a& unit used in typesetting. A pica is equal to 1/6
a result appear on each page in the document.  of an inch, or 12pt.

Master Pages Point

Special pages in DTP software that act as a The standard unit of measuring type size. In DTP
template for all the pages that are inserted into th@ork, a point is equal to 1/72 of an inch. Strictly

document. Master pages define the format of the speaking a point is 0.013837in or 72.27 to the inch.
page and may contain text, pictures and lines thabortrait

are to be inserted on every page. Usually there are

separate master pages for every chapter of the 1N orientation of a page such that the longest
document. edge is vertical.

Mono spaced Posterize

The situation where all characters in a font have 10 divide a continuous tone image into a number
even spacing regardless of their actual widths. S¢ flat tones.

a mono spaced letter ‘I’ uses the same horizontalProcess colours

space as an ‘M’. A typical mono spaced fontis geeCMYK

Courier. The opposite of Mono spaced is

Proportionally spaced. Proportionally spaced

The situation where characters in a font have been
N designed with varying widths. So a proportionally
Negative leading spaced letter ‘I’ uses less horizontal space then the
The situation where the absolute leading is smallégtter ‘M. The opposite of proportionally spaced
than the size of the type e.g. 12pt text on 10pt  is Mono spaced.

leading. R

@) Ragged left/right

Outset SeeRight aligned/Left aligned

SeeStandoff Ranged left/right

P Seel eft aligned/Right aligned

Page Register marks

One side of a leaf. Marks positioned outside the page area used to
Page description language (PDL) ensure that the separations are accurately

A type of programming language, such as superimposed.

PostScript, used to describe a document to a
printer.
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Right aligned Small caps

A paragraph format option where type is aligned Capitals that are smaller in size than standard

to the right margin, leaving the left edge ragged. capitals. Normally they are generated by scaling
Right aligned is also referred to as ‘flush right’,  full size capitals, but strictly speaking they should
‘ranged right’ or ‘ragged left’. be a specially designed font.

Rivers (of white) Soft hyphen

A problem that occurs in badly justified type A hyphen inserted into a word by the user which
where spaces between words form streams of is only displayed if that word appears at the end of
continuous white areas down the page. a line and needs to be split. Also called a
Discretionary hyphen.

Rule

A straight horizontal or vertical line used to Story

separate or emphasise areas of type. In DTP software, an independent block of text

Runaround contained within a text frame, or in a series of
. . . link frames.

The way in which type fits around frames and Inked text frames

irregular graphics. Strikeout/strike through

The term describing type with a horizontal line

Running head _
drawn through its centre.

SeeHeader
S Stylesheet

, In Ovation Pro, a file which describes the exact
Sans serif

format and style of a document and which may be
A typeface which lacks ‘serifs’, the minute cross- used as a template for other documents. A

lines finishing off the main strokes of the stylesheet contains master page definitions,
characters. Helvetica is an example of a sans serifefined styles, view options etc.

typeface. Subscript

Screen angle Smaller sized characters set below the baseline, as
The angle at which halftone screens are rotated tih H,O. Also called Inferior.

minimise undesirable dot patterns.

Superscript
Script Smaller sized characters set above the baseline, as
A typeface designed in the style of handwriting. in n2. Also called Superior.
Separations Swatch
SeeColour separations. A sample of material, paper or colour.
Serif T

A small cross-line finishing off the main strokes

_ ) _ Tab leadering
of the characters in some fonts. Times is an

. Seeleader
example of a serif typeface.
. Tabloid
Set sold A standard ize 11 inch ide by 17 inch
Type which has been set without any leading. Ior?gan ard paper size L1 inches wide by 27 inches
ikev:‘lf hich all I hi Tab stop
ornffan(:gsw ich allows you to siant text, graphics , horizontal position to which type is aligned

when the Tab key is pressed.
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Text chain §]
A text story that flows through a series of linked ycRr
frames.

SeeUnder colour removal
TIFF o _ Under colour removal
An abbreviation for Tagged Image File Format. At,o process of removing equal (usually) amounts

standard bitmapped graphic format. of Cyan, Magenta and Yellow and replacing them
Tiling with Black. This process reduces the amount of

The process of printing a sheet over a series of Nk used and gives better reproduction of certain
smaller sheets which must be joined to create thecolours.

complete image. Unjustified
Tint Type that is left aligned or, strictly speaking, not
The effect of adding white or allowing the fully justified.

background to show through a solid colour. Tints \/

are specified as percentages of the solid colour. Vignette

T.racking An image with no discernible border or an image
Fine adjustment of the space between charactersyhich gradually fades into the background. Also

Tracking is similar to kerning, but applies to used to describe a graduated fill.
selected text instead of letter pairs. W
Trapping

. : ... Word underline
The deliberate overlapping of colours to eliminate

gaps that may be caused by registration problems? taesé :tyle that underlines all characters except
when printing P '

Word wrap

The forcing of words that are not hyphenated and

which will not fit on the end of the line to be

Trim marks
SeeCrop marks

Typeface carried over to the next line.
SeefFont X
Type family x-height
SeeFamily. The height of the main body of lower-case
Typesetting characters excluding their ascenders e.g. the
The process of setting text in a typeface in height of a, c, e, i, m, etc.
preparation for printing. Y
Yellow

One of the four process colours.
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Notes



Index

To ease finding certain topics in the Index, several styles have been
used depending on the subject.

General index information is in the general Bodytext style of the manual,
but in the Index named "MainBody".

References to files, applications or functions are in Courier style
References to menu topics are in Bold style.

References to menu selections in windows or options available on

the Info palette are in Arial style.

This system is not always followed, especially in the case of sub-entries
falling under a common main entry.

At times certain topics appear often in the manual. The main page
reference giving specific information on the subject is then printed in
Bold style.

The page numbering continues throughout all Chapters, Appendices
and this Index, starting with page 1 in Chapter 1.
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I B
IBorders ........... ... ... 274 Background (textcolour) . ................ a7
llgnore  ......... . . .. 210,214 barcodeinsertion. . .................... 182
BaselineGrid . ......................... 90
1 baselinegridorigin. . ................... 232
. Baselinegridspacing. . . ................ 232
Istindent........... ... ..., 59,63 Basic PHNNG « . . oo 167-172
Bleed .................. 86,152,173,174,223
A BOAVIEXt .+ .o oo 20,74
absolute leading . ....................... 580ld ...... .. ... 44497,
activedate. . .......... ... .. ... ... 2Booklet (print) . ........ ... . 170
Add to (dictionary) . . ... 211 Border.... . ..o 120,272
Add (dictionary) . .. ... 211Border. . ... .. 120-121
Adding a New Chapter. . ................ 157 based on Draw file 274
address labels (generating). . .. ........... 181 based on line 274
Align . .. 114 definition file 274
Alignment . ...................... 53,56,59 Draw file 120
Allcaps . ... 47 drop shadow 121
Angle (halftone screen). . ................ 193 line style 120
Angle (picture) . . ... . 136 select side 121
Angle (textframe). . . ................... 113 transparent colour 120
Applets . ........ .. . 251-254brightness (picture). . . .......... o ... 202
adding features using — 252 Brightness, Contrast & Gamma.. .......... 202
disable 252 brightness, valuerange. . ................ 202
inside 253 bromide.......... . ... 187
installing 252  Browse (spellcheck). ................... 211
Application Choices . .. ............. 222-228BufferSize .. ... ... 224
Applyruler .. ... 78Bullet. . . ... 70
Aspect (picture). .. ... .. 133,136 character after 70
Aspect (pPrint) . . ... 173 character before 70
AspectLock . ....... ... ... . .. 227 style 70
Aspect Lock (picture) . . ......... .. ... 137 bulletpoints . ........... ... ... . 69
Attach Info Palette . . .. ................. 225 Bulletsymbol. . ......... .. ... ... ...... 69,70
Attach Toolbox . .. ..................... 225 button
Auto hyphenation. . ................ 56,60,65 box 243
Autolnsert . ... ... 69 create new 243
Autokerning ............ .. ..., 56,60 gap between buttons 16
Auto PageDelete. .. ................... 230 position 16
AutoPage Insert. . ............... .. ... 230 sprite 243
AULOSAVE . . . v oot ettt 230Buttonbar. . ... 11
AutoScale . .......... .. 227 number of rows 16
Auto scale (picture) . ... .. 137 open/close 85
autoscrolling . .......... ... ... ... 97 position 16
auto-link position of a button 16
create. . . ... 95 view 85
delete 95  button macro
auto-linking . ........ ... .. . 95 creation 243
auto-running applications. . .. ............ 252 editing 247
Buttons pre-defined. . ............... 248-250
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C Default triangle width 228
hoices(picture)
camera-ready COPY . . . ..o v v 18'? Aspect Lock 297
caret . ... 12
movement 21 Auto Scale 227
Centre Lock 227
Case....... I SRR 47 Picture Cache Max size 297
Centre Lock (picture) ............. 137,227 .
Picture Frame Inset 227
Centretab. . ...... ... .. .. 62 Picture import with Ctrl 297
Changing the Default Document . . ........ 221 > Imp
Proxy if over 227
chapter .
Reference if over 227
add new 157
Runaround error 227
copy 158 Choices(print)
current number 14,151
Bleed 223
delete 158
. . Crop check 223
Importing 158 .
: mail Merge 223
modify 157 .
Preprint pass 223
number 22,23 .
. Print memory 223
number: numeric or Roman 157 : .
set Crop and Registration marks 223
paste 158 ,
. Choices(text)
start left/right 157
Check repeated words 226
start number 157 .
Chabter/ ‘ 230 Min length 226
apter/page separator. . . .............. Overtype 296
character
. : . Rename colours 226
insertion with Alt key 24
Rename styles 226
set 24 :
. Save ignored words 226
special 24 . .
. Single shift font 226
transposing 21 Smart quotes 226
CharacterSets. . ................... 261-264 .
Text frame inset 226
Characters.... . ........ ... .. 24 : :
Check repeated words 226 Choices(view)
P Attach Info Palette 225
Check document....................... 213
Attach toolbox 225
Check fromcaret... ................... 210 . . .
Crosshairs when moving selection 225
Checkstory................ . ... ...... 210 .
Flashing caret 225
Checkword.............. ... ... ...... 212 ,
. Instant updates on path edit 225
Choices .
Period 225
default save 222
Choosecurve. ..........coiiiiinnnn.. 108
temporary use 222 .
. CICEIO . . .t e 42
Choices(colour) :
. clashing colournames ................... 30
Use correction table 228 clashing stvle names 30
Use inks to display CMYK colours 228 g sty
Choi I Clear ... . 103
0|ces(gen_era) Clear (selected pictures) . ............... 138
Buffer Size 224 .
. Clipboard... ........ ... ... ... ... ..... 30
Clipboards 224 .
Clipboards ............ ... .. .. ... 224
Date format 224 .
) . Clipboards applet. . .................... 224
Give warnings 224 . .
clipboards, multiple . . .................. 224
Save buffer 224 :
Time ‘ 594 closingdocuments .. .................... 38
'me format CMYK colours (display) . ............... 190
Windowsclipboard 224 .
. . Collate (print) . . . ................ 36,1671
Choices(line) .
. . Collect referenced pictures . . ............ 143
Default line width 228 colour overprint 191,236
Default triangle height 228 P '
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colourchart. . ......... ... .. ... ... ... 23&Create (dictionary). . ................... 215
Colour chart, format. . .................. 276create customcolourmaps. .............. 205
ColourCharts......................... 24(Creating a PostScript File. . . ............. 194
Colour Charts, defining .. ............... 275Creating Button Macros. . . .............. 243
Colour Model CreatingKeyMacros................... 244
CMYK 238 Creating New Documents. .. ......... 152-154
HSV 239 CreatingUserMacros. . ................. 245
RGB 237 Crop(sizeofmarks).................... 223
ColourModels .................... 237-239Cropcheck . .......... ... .. ...... 175,223
Colour... (text) ............ ... ........ 234 Crop Infopalette. . . .................... 135
Colour cropmarkssize............ ... .. ... .. 223
Delete 236 Croptool........ ... ... ... . . 135
Edit 235 Cropping Pictures. .. ................... 135
line ........ . . . 228Crosshair. . . ... 102,134
New 235 Crosshairs when moving selection . ....... 225
Non-printing 236 CSVile
picker 46,234 and Smart Quotes 177
Rename 236 create 177
selecting 46 example for mail merge 178
Spot 236 format 177
Tint 46 ignore headings record 179
colour (paper background) . .............. 152Ctr (=centre picture) . . .. ................ 133
Colour (Process..). . ... 200 CurrentChapter . ........... ... .. ....... 14
colour(text) ......... ... .. . 46CurrentPage. . ... i i 14
Colourbar............................ 19%Custom ColourMap. . .................. 205
Colour correction Customisation. . ................... 219-232
CMYK to RGB 190 CUut. .. 30
RGB to CMYK 190 Cutframel/line/selection. . .............. 103
Colour Correction Choices. .. ............ 228Cutpicture . ... .. 138
colour correctiontables .. ............... 228
colour mapProcess..)................. 2010 D
colourmaptools. ...................... 205
oo Spe‘lifymg e (o gedate 22,23
S Dateformat . ...................... 224,268
colourpicker. . ........ ... .. .. o 46
decimaltab ............. ... .. ... ..... 62,78
Colour Supplement  ................ 186 .
ecimaltab character .. ................ 232
colourswatch......................... 1883
ColSupp applet 186 DL .t 281
: T Default linewidth ... ................... 228
column guides, Display . . ............... 115
Default masterframe . . ................. 153
Columns. ... 115 . :
. Default triangle height . .. ............... 228
in master frame 153 : .
. i Default trianglewidth . . . .. .............. 228
Commercial Colour Printing. . ........ 185-198 :
Defined Colours .. ................. 233-240
Contents......... ... . ... . . . ... .. -V ofined Stvles 73.82
contrast (picture) . . ................. 202,203D YIES o
also seestyle(s)
contrast, valuerange. . .................. 20% -
Copies (print) 167 efiningBorders . ..................... 273
""""""""""""" Defining Macros. . .....................246
COpY. ot
Delete. . . ..o 30
Copychapter. ........................ 158 L
) : dictionary 215
Copy frame/line/selection. .. ........... 103
. style 79
Copypicture . ... 138
. text 21
Copyright. . ... ... ..
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INDEX
Delete frame/line/guideline. . ... ........ 103 master objects 100
Deletepage. . ............ ... .. ...... 160 picture 139
Delete picture. . . ................... 92,138 Draw fileborders . .. ................... 120
Deleteselection...................... 103 Drawing & Editing Objects ........... 91-110
Design size (Draw borders) . ............. 120 Drawing Aids . . . .. ... ... 97-98
dictionary . ............ also seeSpellcheck  Dropcap. . ..o v it 60
add word to 211 Duotone. .......... ... 206
adding words 216 Duplicate. . ....................... 125
attaching to document 209
creating & editing 214 E
default loading 209 :
edit
delete 215
. Inset curve 108
deleting words 216 .
edit 216 Picture runaround 109
export words 217 Standoff curve 109,123
P . Edit COIOUrS.... .+ oo veee e 188,191,235
how to select to edit 214 .
. . Editcolours(text)...................... 46
hyphenation exceptions 208 .
. Editmasterpage . .................... 155
ignore 210 .
import words 217 Editstyle. .. ........... ... ... ... ... 75,77
Editing a ButtonMacro .. ............... 247
load 215 .
loading 209 Editing Text . ............ ... ........... 20
) Editing the Master Pages ............ 155-156
main 208
effect,current. . ........... ... .. ... ..., 45
remove 215
effects
save changes 216 Vi 40
user 208 applying
. clear 40
didot............ ... . . ... 42
current 40
document
format 52
amount of words 22 :
close 38 toggling 44
) Effects (localtext). .. ................ 39-50
info 22 ;
electronicmanual . ....................... 3
name of 11 .
Ellipse. .. ... .. e 126
save default 221 . .
scrolling of 11 Embed all pictures in document. . . ........ 143
) Embedobject ...................... 104
size 22 . .
story size 29 Embed picture in document. . ............ 143
: embedded object, modifying . ............ 105
window ! embedding a picture in a text frame 131
Document Description Language (DDL). . . . 281 Embedding Objects . ................... 104
DocumentiInfo......................... beddi it direct] 105
Document Preferences .. ............ 229-p37MPeaAdINg pictures directly ...
: ndcap (line)......................... 118
Documentunits . ...................... 23 O
. Enhanced justification . .................. 60
DocumentView ..................... 83-90 .
scape sequence (find & replace). . ......... 34
DocumentZoom. . ............. ... ...
. Escapesequences .................. 261-264
Doublesided ......................... E dina M 247
double sided documents xpandingMacros .. . ...................

page insert and deletion 16
Double (underline) . . .................... 49
Drag & Drop

move/copy text 31

drag and drop

linked frames 100

expression evaluation . also see Appendix J, 43
Expression Evaluation and Units 283
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F frame link
Facing pages. . . 88 f:r?qggilunnnk 08
fan-fold paper 11" & 12" .. .............. 164
. show flow 96
Fields... ... 180 frames
Elll colour (textframe) .................. 114 aligning and spacing out (picture) 116
film. ... 187 2
) auto-linking 95
Find ... 32 chanaing a link 9%
Find&Replace. . ....................... 32 ging
. . L drawing 92
First Line (position in text frame). . ........ 115 "
L editing text 94
Fit (picture). . ...... ... 133 I )
. . elliptical/circular 92
Fit(print) . ........................ 165,173 .
. . linking 94
Fix(mailmerge)....................... 179 :
. perfect square/circle . . .............. 92
FlashingCaret .. ...................... 225
rectangular 92
Flushzone . ....... ... .. .. ... 68 :
special notes 96
Font .. ... .. . . . . 41
text flow 96
FONt. oo 47 .
. unlink 96
change size 42
Frames on Masterpages. . ................ 95
current 41 o
. auto-linking 95
size (current) 43 o
. linking 95
SIZes 42 Frequency 193
font mapping (POStSCIpt). . . ... 192Front/Back ........................... 127
Footer. . ... 153 "
: full-colour printing. . ................... 189
and pictures 155 Function expansions (macros) 246
omit on first page 157 Pansions (macros).. ...
rules for editing 155 G
Foreground (textcolour) ................. a7
Format .................. 52,56,60,65/D, Galley ......... ... ... 169175
Format(print) ...................... 36,167 gamma value (picture) . .. ............... 204
format effects gamma, valuerange ... .................. 204
clearing local 52 General Choices......... seéChoices) 224
copying 52  General Preferences. . . seéPreferences) 230
local 52  Getting
Formatting Text ..................... 51-71 Started 7-18
frame Give Warnings . . ....cov it 224
bounding box 57 Globalclipboard....................... 224
borders 272 Gotopage... ... 231
break 96 Grid ... 89
close path 93 lock 89
guidelines 87 object 89
handling 155 precedence 90
inset 57 show 89
irregular 93 spacing 89
perfect circle 92 sub divisions 89
perfect square 92 text baseline 890
resizing with picture 133 Group. . ..ovv e 127
tool 92  Guess (spellcheck). .................... 211
frame auto-link Guide colour (columns) . ................ 115
create 95 Guide width (columns).................. 115
delete 95  Guidelines
Master frame 95 column 87
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frame 87 Info (document)........................ 22
ruler 87 Infopalette.............. ... ... ..... 141,

Guidelinesto Front/Back . . .............. 231 moving 15

Gutterwidth . ......................... 115 open/close 85

ink mapping CMYKtoRGB ... .......... 190

H INNEr . .. e 154

Insert . ... ... 23

Hscale. ... 47,48 file/dir pathname. .................. 31

Halftonescreen. .. ..................... 193 merge tag 23

hard ?Xspehrfn """""""""""" 64 2?fnsert PAGE... o i 159

hard space IL)nset (picture frame) ................... 116

Head PACE. - 153 nset(textframe)...................... 114

CACCT - o Insetcurve . ...... ... . ... 108
and pictures 155 edit 108
omit on first page 157 reset 108
Hid ryltes for editing 15:?37 Instant updates on pathedit. .. ....... 10@25
de picture .. .. ... oot interactive help. . ....................... 18

Horizontal offset (duplication) . ........... 125 Introduction 1-6

HyphD!ct """""""""" 208,224/ invisible characters. .. ................... 88

HyphDict , howtoaddwords ........... 217 Invisibles 38

hyphen sibles. . ...
hard 64 Italic ........ ... . . L PAAOTT
no 64 3
soft 64

hyphenation. .. ...................... 64-65ustification. . ................ .. ..... 66-68
options 65 enhanced 67
zone 65 examples 67

hyphenation character . . . ............... 232 other options 68

hyphenation dictionary, activate .......... 217

K

! Kern. ... 48

icons (writable) kerning .................... seetracking
calculations 43,280 auto- 48
units 43284 values 48

Image Processing . ................. 199-206Key expansions (Macros) . . . ............. 246

import KeyMacroNames ..................... 263
other type of files 26 Keyboard and Mouse Short-cuts. . . . ... 269-272
Ovationdocuments. ................. 9knock-out (printing) . . . .............. ... 191
Ovation Pro documents 26

importtext ............. ... ... ... 261

Import!ng a Chapter """""""""" 158Iandscape .................. seeSideways

Importing large pictures. . ............... 142Large Picture Support 141-148

Importing Pictures .. ................... 13(()Jlast """""""" 49

ilrr::r;grsr:tei?a?llle(—:-tédi.n-g """"""""""" 1g5Latest Information . ...................... 6

indent Leadgr (tab). ... 63,78
o Leading ..........ciii... 54-5659
first line 59 current 55
lhe?Pglng 5579 incremental 54
right 53 negative incremental 55

relative 54
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Left(page). . ... 154MailMerge . . .......... . 177-184
Leftindent ....................... 57,63 clear 179
Lefttab . ... .. oo 62 CSV files 177
Letterspacing. . ........... ..., 66 examples 180-183
Line fields 180
colour 117 fix 179
drawing....................... 93. removing blank fields 183
feed . . ... 95 show first record 179
first .. ... 115 show next record 179
new 20 Mailmergetag............... ... 178
pattern 117 Mail Merge, advanced features ........... 180
position of 1st line in frame 115 Mail Merge, starting. .. ................. 179
thin 117 Mailmerge.... . ....... . i 179
width/height 117 mainmenu ............iiiiiinnnnnnn. 12
Line Choices. . . ... 228 MainDict  ................ 209,210,214,218
lineeffect............. ... ... .. ......... 59MainDict  (shared version) ............ 218
line segmentediting.................... l06Makelocal . ...................... 128,156
linespacing. . .......... .. .. S5Makemaster . .................... 128,156
Linetool......... ... .. ... .. ... ... .. ... 93margins
lines,join ........... ... .. ... .. .. .... 118 inner 154
Linktool........ ... ... .. ... . . 96 outer 154
linked frames margins, top, bottom, left, right . . ... ... ... 153
drag and drop 100 master
select text 94 frames 150
text flow 94 lines 150
LinkingFrames ........................ 94 object 150
lithopress. ........ ... .. ... .. ... . ... 18master frame
LithoPrinting......................... 187 default 12,150,151
Load (dictionary) . ..................... 215 deselecting 153
loading master frame, default . .. ................. 12
Ovation documents 8,9 master objects
Ovation Pro documents 9 drag and drop 100
local (master object). . .................. 150masterpage. . . ... 150
localeffects ......... ... ... . . .. . . L. 39 blank 153
52,81 changing paper size, etc. 156
Lock (frame)............ ... ... ......... 115 edit 155
Lock (picture) . . ... i 137 frame handling 155
Lockgrid. . ....... .. 89 left 154
Locktogrid .. ......... ... .. ... ...... 60,90 right 154
master pagesOvation. .................... 9
M Medium (underline). . . .................. 49
menus, different from standard .. ........... 3
Macro -
Merge (printing) . . ... 223
copy 2471 Merge ta 238
delete 247 getag............
Merge Tags, inserting. . . ................ 178
expand 247 :
save 047 Minlength. . ....... ... ... ... ... ...... 226
Macro expansions 24%odgl (RGB, C_MYK, HSV) .............. 200
""""""""""" odify... (Objects) ................112-119
Macros.... ... 242 .
Line ... mvy
Macros. . ....... . i 241-250 Object 1A
MACY .« vt e e 183,184 oo
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Pictureframe . ................ s selecting 99
Textframe................... me3 snap to grid 128
Modify chapter... .................... 157 ungroup 127
Modify picture . ...................... 136 OLE (picture editing) . . ................. 140
Modifytext....................... A7,77  Origin X/Origin Y (textframe) ........... 113
monochromeimage .................... 20@ther (papersize). . ... 152
Move pointer . .......... ... ... . ... ... 1000ther Macro Operations. . . .............. 247
movingobjects. . ... . L 1000Uter. . .o 154
movingaroundpages. . ... 2Dvation Pro
Moving pictures . . . . ........ ... .. ... 132 loading 8
multiple clipboards. .. .................. 224 memory 8
Ovation Pro Script Language (OPSL) . ... .. 255
N Ovation Pro Support. .. ................... 5
NetSafechart ......................... 246 VOIPANE . ... 191,236
New...(document) .................. 18R col_our level 191
New (style) 76 object level 191
New chaptér """"""""""""" 1'57 Overprintlimit. . ............ ... ........ 191
New Line. . .. 2023 '52 59 Overprintthiscolour. . .................. 191
""""""""""" A TTOvertype. e ... 226
NEWPAQE. . . ..o vt e it i 22,23,96 vertvoin o9
newparagraph . ........................ 2(5) YPING- v
NEeW VIEW. . ..o 84
No Lock (picture). . . ................... 137 P
NOPICIUrES . . . o it 171Page . ... 152,154
Normal (print) . ....................... 167 current number 14,151
Normal (texteffect) .................. 44,47 delete 160
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